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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product 
may only be used in accordance with the license agreement.

AirSpeed Multi Stream and AirSpeed Classic or portions thereof are protected by one or more of the following United States 
patents: 6,763,523; 6,766,357; 7,403,561; 7,433,519. Other patents are pending.

AirSpeed Multi Stream and AirSpeed Classic or portions thereof are protected by the following European patent: 1629675. 
Other patents are pending.

This document is protected under copyright law. An authorized licensee of  may reproduce this publication for the licensee’s 
own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This 
document is supplied as a guide for . Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

Copyright © 2011 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that 
the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this 
entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all 
copies of the supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be 
covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 
and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.
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The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, 
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, 
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, 
Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, 
Axiom, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, 
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, 
Command|24, Command|8, Conectiv, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, 
Dazzle Digital Video Creator, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, 
Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, DPP-1, D-Show, 
DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, 
FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, 
iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, 
Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, 
iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, 
Luna, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, 
Massive Pack Pro, M-Audio, M-Audio Micro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, 
Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, 
Mix Rack, MixLab, Moviebox, Moviestar, MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, 
NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, 
Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, Personal Q, PET, Pinnacle, Pinnacle DistanTV, 
Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media, Pinnacle Scorefitter, Pinnacle Studio, 
Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, PowerSwap, PRE, ProControl, 
ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, QuietDrive, 

http://www.apache.org/
http://jcifs.samba.org/
http://jcifs.samba.org/
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Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, 
Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, 
SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, 
Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, 
SYNC I/O, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, 
Torq Xponent, Transfuser, Transit, TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, 
Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, 
X-Session, and X-Session Pro are either registered trademarks or trademarks of Avid Technology, Inc. in the United States 
and/or other countries.

Footage
Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

News material provided by WFTV Television Inc.

Avid AirSpeed Multi Stream Installation and User’s Guide • 0130-30041-01 Rev I • August 2011 (8/17/11)

 This document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form.



  

6



7

Contents

Using This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Symbols and Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

If You Need Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Avid Training Services  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Chapter 1 AirSpeed Multi Stream Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

AirSpeed Multi Stream Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

AirSpeed Multi Stream Design  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Hardware and Software Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Optional Avid Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Software Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Ethernet Connections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Time-of-Day Timecode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Internal Storage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Serial Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

User Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Software Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Digital Input and Output Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Supported Media Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30

Capture Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

MXF Media Formats and Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Media Destination Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Protecting Workspaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Headframes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Playback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Playout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Studio Playout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

Play While Transfer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

Play While Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35



8

Edit While Capture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Closed Caption. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Up/Down/Cross (UDX) Conversion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

UDX Terms and Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Pillarbox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Letterbox. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Center-Crop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Anamorphic  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

Active Format Description (AFD) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

AutoAFD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

ATC and VITC Timecode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Video Format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

International Character Support (ICS) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Front and Rear Panels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Front Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Visual Status Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Rear Media Connections (All Models) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Chassis Label Location (All Models) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Control Connections (All Models)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Video/LTC Connections (SD Model) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52

Video/LTC Connections (MPEG-2 HD Model)  . . . . . . . . . . . . . . . . . . . . . . . . .  54

Video/LTC Connections (DNxHD Model)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Video/LTC Connections (AVC-Intra Model). . . . . . . . . . . . . . . . . . . . . . . . . . . .  58

Keyboard and Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Chapter 2 Installing the Hardware and Setting Up Your System  . . . . . . . . . . . . . .  61

Unpacking and Inspecting Your System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Unpack and Inspect Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Unpacking Your System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Verifying Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Inspecting Components for Damage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Installing AirSpeed Multi Stream in a Rack . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Rack-mount Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64

Rack-mount Kit Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64



9

Positioning the AirSpeed Multi Stream in the Rack . . . . . . . . . . . . . . . . . . . . . .  65

Securing the AirSpeed Multi Stream Chassis in the Rack . . . . . . . . . . . . . . . . .  66

Inserting the Hard Drives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68

Cabling Up the AirSpeed Multi Stream . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69

Connecting SDI and Video Reference Cables . . . . . . . . . . . . . . . . . . . . . . . . . .  70

Connecting Video Reference Cables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70

Connecting SDI Video Input Cables (for SD Models) . . . . . . . . . . . . . . . . .  71

Connecting SDI Video Input Cables (for MPEG-2 HD Models). . . . . . . . . .  72

Connecting SDI Video Input Cables (for DNxHD Models). . . . . . . . . . . . . .  72

Connecting SDI Video Input Cables (for AVC-Intra Models) . . . . . . . . . . . .  73

Connecting SDI Video Output Cables (for SD Models) . . . . . . . . . . . . . . . .  74

Connecting SDI Video Output Cables (for MPEG-2 HD Models)  . . . . . . . .  75

Connecting SDI Video Output Cables (for DNxHD Models) . . . . . . . . . . . .  76

Connecting SDI Video Output Cables (for AVC-Intra Models)  . . . . . . . . . .  77

Connecting Time of Day (TOD) LTC Cables . . . . . . . . . . . . . . . . . . . . . . . . . . .  78

Connecting Control and Communications Cables . . . . . . . . . . . . . . . . . . . . . . .  79

Connecting USB Devices (Mouse and Keyboard). . . . . . . . . . . . . . . . . . . .  80

Connecting Ethernet Cables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Connecting to AirSpeed Multi Stream Over the Network  . . . . . . . . . . . . . .  81

Connecting Expansion Port Cables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

Connecting Remote Serial Cables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

Connecting the Console Cables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

Connecting the VGA Cables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

Connecting the Power Cords. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

Setting Up Your System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

AirSpeed Multi Stream System Setup Checklist  . . . . . . . . . . . . . . . . . . . . . . . .  86

Changing the Computer Name. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87

Adjusting the Date, Time and Time Zone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87

Configuring Media Drives for RAID 0 Striping  . . . . . . . . . . . . . . . . . . . . . . . . . .  88

Creating RAID 0 Striping in Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88

Reconfiguring Media Drives for RAID 0 Striping (for Previously Striped Drives)  89

Verifying Your Network Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  92

Creating a Windows User Account on the AirSpeed Multi Stream. . . . . . . . . . .  92



10

Configuring Your Shared Storage (Workgroup or Team Only) . . . . . . . . . . . . .  93

Setting Up Remote Access to the AirSpeed Multi Stream Server . . . . . . . . . . .  94

Chapter 3 General Configuration Procedures. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95

General Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95

Determining Your AirSpeed Multi Stream Environment  . . . . . . . . . . . . . . . . . .  96

User Names and Passwords. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  96

User Names and Passwords for Interplay and ISIS Environments  . . . . . .  97

User Names and Passwords When Using a Standalone Transfer Manager 97

License Agreements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97

Configuration Requirements for AirSpeed Multi Stream . . . . . . . . . . . . . . . . . .  98

AirSpeed Multi Stream Configuration Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98

(Option) Installing the AirSpeed Multi Stream Device Service  . . . . . . . . . . . . .  99

(Option) Sharing the E: Drive on the AirSpeed Multi Stream Server. . . . . . . .  100

Creating a New Database in the AirSpeed Multi Stream Application . . . . . . .  100

Setting the Default Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103

Configuring Channels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  104

Configuring Channels on AirSpeed Multi Stream . . . . . . . . . . . . . . . . . . .  111

Configuring Channels for Capturing Ancillary Timecode . . . . . . . . . . . . .  115

Configuring Channels for Playing Out Ancillary Timecode (SD Only)  . . .  115

Configuring Channels for Remote Control with Avid iNEWS Command. . . . .  116

Configuring Communication Protocols in AirSpeed Multi Stream . . . . . . . . . .  120

Configuring General Purpose Interface (GPI) Inputs and Outputs . . . . . . . . .  122

Configuring Your Avid Editor to Work with AirSpeed Multi Stream . . . . . . . . .  124

Optional AirSpeed Multi Stream Configuration Procedures . . . . . . . . . . . . . . . . . .  125

Setting Database Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125

Configuring Auto Logon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  126

Locking Channel Assignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128

Avid IsoSync Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128

Configuring International Character Support . . . . . . . . . . . . . . . . . . . . . . . . . .  128

Chapter 4 Configuring the Software in a Workgroup Environment  . . . . . . . . . . .  133

AirSpeed Multi Stream Workgroup Configuration  . . . . . . . . . . . . . . . . . . . . . . . . .  133

Configuration Requirements for AirSpeed Multi Stream . . . . . . . . . . . . . . . . .  133

AirSpeed Multi Stream Workgroup Configuration Checklist  . . . . . . . . . . . . . .  134



11

Configuring the Avid Service Framework Workgroup  . . . . . . . . . . . . . . . . . . .  134

Configuring the Avid Service Configuration for Interplay Workgroup . . . . . . . .  136

Configuring the Avid Service Configuration. . . . . . . . . . . . . . . . . . . . . . . .  137

Setting Up your Credentials for Connection to Interplay . . . . . . . . . . . . . .  138

Setting Up User Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  139

Setting Up Record and Destination Templates . . . . . . . . . . . . . . . . . . . . .  140

Selecting Default Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  144

Setting Up Inventory Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

Launching Transfer Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148

Configuring Channels for Remote Control with Avid iNEWS Command,
CaptureManager, or Interplay Capture . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148

Chapter 5 Configuring the Software with a Standalone Transfer Manager . . . . .  155

Standalone Transfer Manager Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  156

Configuration Requirements for AirSpeed Multi Stream  . . . . . . . . . . . . . . . . .  157

Software Requirements for the Avid Editing Client  . . . . . . . . . . . . . . . . . . . . .  157

AirSpeed Multi Stream Configuration Checklist . . . . . . . . . . . . . . . . . . . . . . . .  158

Enabling Transfers for AirSpeed Multi Stream Servers in a Standalone 
Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158

Installing, Configuring and Starting the Interplay Transfer Engine . . . . . . . . . .  160

Installing the Interplay Transfer Engine on the Avid Editor . . . . . . . . . . . .  161

Configuring the Interplay Transfer Engine for a Standalone Environment  161

Starting the Interplay Transfer Engine on the Avid Editor . . . . . . . . . . . . .  163

Configuring the Standalone Settings for the Avid Editor  . . . . . . . . . . . . . . . . .  164

Configuring the AirSpeed Multi Stream for Standalone Transfer . . . . . . . . . . .  165

Configuring the Integration Service on the AirSpeed Multi Stream  . . . . . . . . .  168

Enabling Standalone Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  168

Setting Up User Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170

Setting Up Record Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171

Selecting Default Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  173

Setting Up Inventory Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175

(Option) Installing the AirSpeed Multi Stream Device Service  . . . . . . . . .  176

Chapter 6 Setting Up for Team Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  179

Team Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  180



12

Configuration Requirements for AirSpeed Multi Stream . . . . . . . . . . . . . . . . .  181

Software Requirements for the Avid Editing Client . . . . . . . . . . . . . . . . . . . . .  181

AirSpeed Multi Stream Configuration Checklist. . . . . . . . . . . . . . . . . . . . . . . .  182

Configuring the Standalone Settings for the Avid Editor . . . . . . . . . . . . . . . . .  182

Configuring the AirSpeed Multi Stream for Team Configuration . . . . . . . . . . .  184

Configuring the Integration Service on the AirSpeed Multi Stream . . . . . . . . .  186

Enabling Standalone Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  187

Setting Up User Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  189

Setting Up Record and Destination Templates  . . . . . . . . . . . . . . . . . . . .  190

Selecting Default Templates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193

Setting Up Inventory Rules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195

(Option) Installing the AirSpeed Multi Stream Device Service . . . . . . . . .  197

Chapter 7 Fundamentals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  199

Starting AirSpeed Multi Stream . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  200

AirSpeed Multi Stream Database Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  200

Opening a Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  201

Closing a Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  202

Locking and Unlocking a Database. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  202

Showing Properties for a Database File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  202

User Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  204

Main Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  205

File Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  206

File > Preferences Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  207

File > Advanced Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  209

Edit Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  209

View Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  210

Air Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  212

Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  212

Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213

Network Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213

Expanding the Network Tree. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  214

Browse Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215

Changing the Order and Number of Fields in the Browse Window. . . . . . . . .  216



13

Changing the Sort Order of Clips in the Browse Window . . . . . . . . . . . . .  217

Headframes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  218

Selecting Headframes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220

Changing Headframe Sizes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220

Clip Numbers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  221

MiniMonitor Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  222

Preview Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  223

Dockable Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  224

Main Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  224

Air Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  225

Right-Click Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  226

Selecting Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  228

Status Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  228

Background Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  229

Numeric Keypad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  230

Keyboard Shortcuts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  231

General Keyboard Shortcuts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  231

Preview Dialog Box Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  233

Chapter 8 Working with Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  235

Recording a Clip . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  235

Playing While Recording a Clip (PWR)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  237

Clip Recording Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  239

Copying or Moving Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241

Creating Subclips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241

Deleting Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243

Editing Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243

Editing Clips Using the Item Properties Dialog Box . . . . . . . . . . . . . . . . . . . . .  243

Editing Clips Using the Preview Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . .  245

Playback Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  248

Renumbering Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  248

Playing Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  249

Cueing Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  250

Clip Headframes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  250



14

Selecting a Default Headframe for a Clip . . . . . . . . . . . . . . . . . . . . . . . . .  251

Selecting the Timecode for a Clip. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  251

Performing a Take. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  252

Changing a Clip’s Headframe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  253

Transferring a Clip to Interplay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  254

Sending Sequences from an Avid Editor to AirSpeed Multi Stream. . . . . . . . . . . .  254

Transfer Setup Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  255

Transferring Sequences from your Avid Editor to AirSpeed Multi Stream. . . .  255

Modifying Clip File Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  255

Editing the Current Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  257

Template for Channel and Item Properties — General Tab . . . . . . . . . . . . . .  258

Template for Channel and Item Properties — Clip Tab. . . . . . . . . . . . . . . . . .  259

Template for Channel and Item Properties — Record Tab . . . . . . . . . . . . . . .  261

Template for Channel and Item Properties — Audio Tab . . . . . . . . . . . . . . . .  263

Searching for Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  264

Search Syntax Rules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  266

Chapter 9 AirSpeed Multi Stream Studio and Playout . . . . . . . . . . . . . . . . . . . . . .  267

Studio Concept. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  268

Creating a Studio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  268

Adding the Studio to Your WorkGroup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  268

Using the Studio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  270

Connect to Playout Server or Studio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  270

Send to Playout Server or Studio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  271

Monitoring Studio Transfers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  272

Transfer Status Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  273

Chapter 10 Working with the Remote Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  275

Installing the Remote Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  276

Starting the Remote Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  276

User Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  278

Main Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279

File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279

Options Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  280

About Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  281



15

Channels Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  281

Transport Buttons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285

Inventory Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285

Filter Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288

Status Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  289

View Playlists Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  290

Playlist Information Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  291

Clip Information Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  292

Right-Click Menus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  294

Connecting to an AirSpeed Multi Stream Server  . . . . . . . . . . . . . . . . . . . . . . . . . .  295

Enabling Transfers for AirSpeed Multi Stream Servers  . . . . . . . . . . . . . . . . . . . . .  296

Using the AirSpeed Multi Stream Remote Console  . . . . . . . . . . . . . . . . . . . . . . . .  298

Selecting Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  299

Changing the Sort Order of Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  299

Showing or Hiding Columns in the Inventory Pane  . . . . . . . . . . . . . . . . . . . . .  301

Filtering on a Clip Name or Video ID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  302

Playing Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  303

Cueing and Playing Clips Directly from the Current Video ID Field. . . . . .  304

Cueing and Taking Clips via the Next Video ID Field . . . . . . . . . . . . . . . .  304

Recording Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305

Crash Recording Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305

Cueing Clips for Record  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305

Recording Clips with Only a Video ID Specified (no Duration or Name) . .  306

Recording Clips with Both a Video ID and Duration Specified  . . . . . . . . .  306

Recording Clips with Only a Name Specified (no Duration or Video ID) . .  306

Recording Clips with Only a Duration Specified (No Video ID or Name)  .  307

Creating Subclips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  307

Editing the In and Out Points of a Clip . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  308

Deleting Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  308

Protecting or Unprotecting Clips from Deletion  . . . . . . . . . . . . . . . . . . . . . . . .  309

Transferring Clips to Interplay  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  310

Transferring Clips to an Avid Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  310

Working with Playlists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  311



16

Creating Playlists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  311

Playlist Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  313

Saving Playlists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  313

Opening Playlists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  314

Clearing Playlists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  314

Taking Control of a Playlist for a Channel  . . . . . . . . . . . . . . . . . . . . . . . .  314

Setting Loop Behavior in the Playlist  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  315

Working with Clips in the Playlist. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  316

Reordering Clips within the Playlist  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  316

Modifying Mark In/Mark Out Points for Clips in the Playlist  . . . . . . . . . . .  316

Setting the Follow Behavior for Clips in the Playlist . . . . . . . . . . . . . . . . .  317

Deleting Clips from the Playlist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  317

Cueing a Playlist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  318

Cueing From a Specific Clip in the Playlist . . . . . . . . . . . . . . . . . . . . . . . .  318

Playing Clips in the Playlist. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  318

Pausing Clips in the Playlist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  319

Stopping and Unloading Clips in the Playlist  . . . . . . . . . . . . . . . . . . . . . .  319

Performing an Edit While Capture (EWC) with Drag and Drop . . . . . . . . . . . .  319

Performing an Edit While Capture (EWC) with Auto Transfer . . . . . . . . . . . . .  320

Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  323

Inventory Pane Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  323

Channel Keyboard Shortcuts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  324

Playlist Keyboard Shortcuts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  325

Chapter 11 Maintaining Your AirSpeed Multi Stream . . . . . . . . . . . . . . . . . . . . . . . .  327

Copying and Restoring Databases. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  327

Reimaging Your System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  328

Checklist for Reimaging Your System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  329

Saving and Restoring Your Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  330

Loading the Windows XPE Restore Image . . . . . . . . . . . . . . . . . . . . . . . . . . .  332

Installing the Avid Service Framework  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  334

Installing AirSpeed Multi Stream Application Software . . . . . . . . . . . . . . . . . .  335

Using the Disk Configuration Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  338

Rebuilding a Database. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  340



17

Identifying Bad Media Drives  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  343

Replacing Media Drives  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  345

Windows XPe Security Update Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  345

Viewing System Health Status Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  346

Accessing the Knowledge Base . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  346

Chapter A Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  349

Physical Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  349

Power and Environment Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  350

Audio Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  350

Video Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  351

Control and Synchronization Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  352

Data Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  354

Rear Panel Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  354

Connector Pinouts and Connections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  355

RS-422 Serial Control Mechanism Connections  . . . . . . . . . . . . . . . . . . . . . . .  356

RS-422 Serial Remote RJ45 Connector Specifications . . . . . . . . . . . . . . . . . .  356

Sony BVW Extensions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  357

Supported Optional VDCP Commands . . . . . . . . . . . . . . . . . . . . . . . . . . .  358

Ethernet Connector Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  360

Expansion Port Connector Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  361

LTC Timecode Connector Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  364

USB 2 Connector Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  365

Chapter B Performing Hardware Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  367

Diagnostic Window Explained. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368

Reviewing Hardware Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368

Starting the Hardware Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  371

Playing a Video Frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  372

Capturing from an External Video Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  374

Testing Audio Outputs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  375

Capturing from the Play Frame Video (Loopback Mode) . . . . . . . . . . . . . . . . . . . .  376

Error Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  377

Diagnostic Test Failed. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  377



18

Chapter C Network Teaming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  379

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  379

Setting Up Network Teaming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  379

Chapter D Up, Down, Cross Convert (UDX) Examples . . . . . . . . . . . . . . . . . . . . . .  385

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  385

Up Convert AFD Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  386

Down Convert AFD Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  387

HD Cross Convert AFD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  387

SD Cross Convert AFD Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  388

Warnings and Cautions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  389

FCC Notice. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  389

Class A Equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390

Modifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390

Cables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390

LED Safety Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390

Canadian ICES-003 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  391

European Union Declaration of Conformity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  391

Disposal of Waste Equipment by Users in the European Union  . . . . . . . . . . . . . .  393

Australia and New Zealand EMC Regulations . . . . . . . . . . . . . . . . . . . . . . . . . . . .  393

Taiwan EMC Regulations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  394



Using This Guide

Congratulations on your purchase of an Avid ingest and playout server. You can use your 
AirSpeed Multi Stream to capture incoming media directly into Avid shared storage or play 
out media to air. Media can be captured directly into Avid Unity workspaces unattended, 
freeing the Avid editing system for editing. Use the Avid editing system to edit the captured 
media into sequences and send the sequence back to the AirSpeed Multi Stream for playout.

This guide contains all the installation, configuration, and task-oriented instructions, 
conceptual information, and reference material you need to install, configure and use the 
Avid  product.

This guide is intended for all users, from beginning to advanced.

Unless noted otherwise, the material in this document applies to the Windows® XP operating 
systems.The majority of screen shots in this document were captured on a Windows XP 
system.

n The documentation describes the features and hardware of all models. Therefore, your 
system might not contain certain features and hardware that are covered in the 
documentation.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation 
was published:

- If the latest information for your Avid product is provided as printed release notes, 
they are shipped with your application and are also available online.

- If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied on your Avid installation CD or DVD as a PDF document 
(README_product.pdf) and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes 
available. To view these online versions, select ReadMe from the Help menu, or visit 
the Knowledge Base at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, 
and to read or join online message-board discussions.

Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery 
methods that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and 
books, please visit www.avid.com/support and follow the Training links, or call Avid Sales 
at 800-949-AVID (800-949-2843).

http://www.avid.com/support
http://www.avid.com/readme
http://www.avid.com/onlinesupport


  

22



1 AirSpeed Multi Stream Overview

AirSpeed Multi Stream is a digital recorder or playback device designed to work seamlessly 
in Avid Unity environments (Avid Unity ISIS or Avid MediaNetwork). Depending on your 
configuration, AirSpeed Multi Stream allows you to capture incoming media directly into 
Avid shared (or local) storage with or without an asset manager, and play out media to air. 
Media can be captured directly into Avid Unity workspaces unattended, freeing the Avid 
editing system for editing. Use the Avid editing system to edit the captured media into 
sequences and send the sequence back to the AirSpeed Multi Stream for playout. 

Up to eight devices ( a combination of original AirSpeed and AirSpeed Multi Stream 
systems) together can be grouped to form a Studio. A maximum of five AirSpeed Multi 
Stream systems can be part of a Studio totalling up to eight systems.

Included for use with the AirSpeed Multi Stram server, the AirSpeed Multi Stream Remote 
Console is an application that can be installed on up to ten PCs on your network. Each 
instance of the AirSpeed Multi Stream Remote Console is able to connect to up to ten 
AirSpeed Multi Stream servers on your network. Once connected to an AirSpeed Multi 
Stream server (or servers), you can see the channels and inventory on the server(s) you are 
connected to. Then, remotely from your PC, you can use the AirSpeed Multi Stream Remote 
Console application to Cue, Play, Record, and Retransfer clips. You can also manage clip 
inventory, and create Playlists and play the clips out on their associated channels.

This chapter provides background information about the AirSpeed® Multi Stream media 
server. The following topics are discussed:

• AirSpeed Multi Stream Models

• AirSpeed Multi Stream Design

• Hardware and Software Requirements

• Software Overview

• Media Destination Selection

• Headframes

• Playback

• Playout

• Studio Playout

• Play While Transfer
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• Play While Record

• Edit While Capture

• Up/Down/Cross (UDX) Conversion

• Closed Caption

• International Character Support (ICS)

• Front and Rear Panels

• Keyboard and Mouse

AirSpeed Multi Stream Models

The following AirSpeed Multi Stream models are available.

• AirSpeed Multi Stream SD - Single VIO card SD only. The chassis number for this 
model is 7020-20280-XX.

• AirSpeed Multi Stream MPEG-2 HD - Dual VIO cards SD/HD. The chassis number for 
this model is 7020-20279-XX.

• AirSpeed Multi Stream DNxHD - Single VIO card SD/HD. The chassis number for this 
model is 7020-30015-XX.

• AirSpeed Multi Stream AVC-Intra - Dual VIO card SD/HD. The chassis number for this 
model is 7020-30069-XX.

n An “XX” in the model number indicates the hardware revision. Your model will have an 
actual number (01, 02, and so on.).

AirSpeed Multi Stream Design

AirSpeed Multi Stream is designed for ease of use. Once the AirSpeed Multi Stream is 
configured, based on your model, this video server captures up to four streams of video and 
up to eight audio channel pairs for HD streams, and 4 audio channel pairs for SD streams to 
a preselected Avid Unity workspace. The video standard (NTSC, PAL, 1080i, 720p) that you 
select on the AirSpeed Multi Stream should be compatible with the editing systems used at 
your site. The captured material is made available to Avid editing systems that use media 
files compliant with Material Exchange Format (MXF). 

A database in AirSpeed Multi Stream is a collection of clips, represented by thumbnail 
images called headframes, and associated data. This data includes the name of the clip, notes 
about its content, the dates captured, and so on. If the AirSpeed Multi Stream system has 
multiple databases installed, or if you have many machines networked together, there can be 
several folders in the Network Tree. A database can contain both SD and HD clips, as long 
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as they have related frame rates. For example, an NTSC 29.97 FPS clip can be in the same 
database as a 1080i 59.94 FPS clip, and a PAL 25 FPS clip can be in the same database as a 
1080i 50 FPS clip.

Depending on your model, the AirSpeed Multi Stream also supports up to four simultaneous 
channels of playout. Select the AirSpeed Multi Stream’s host name in the Send To Playback 
list on the Avid editing system and you can transfer a sequence to the AirSpeed Multi Stream 
server. Then, use Avid iNEWS® Command to manage the playout of the sequence. 

You can group from two to eight systems (a combination that is comprised of up to five 
AirSpeed Multi Stream servers, and the balance of original AirSpeeds) as a Studio by 
following an AirSpeed Multi Stream host naming method. Send a sequence to the Studio 
and all the AirSpeed Multi Stream systems in that Studio has the capability to playout the 
sequence. 

For more information on the Studio concept and configuration, see “AirSpeed Multi Stream 
Studio and Playout” on page 267.

In addition, the AirSpeed Multi Stream Remote Console is an application that can be 
installed on up to ten PCs on your network. Each instance of the AirSpeed Multi Stream 
Remote Console is able to connect to up to ten AirSpeed Multi Stream servers on your 
network. Once connected to an AirSpeed Multi Stream server (or servers), you can see the 
channels and inventory on the server(s) you are connected to. Then, from your PC, you can 
use the AirSpeed Multi Stream Remote Console application to do the following:

• Cue and play clips

• Cue and record clips

• Retransfer clips

• Manage clip inventory

• Create Playlists and play the clips out on their associated channels

For more information, see “Working with the Remote Console” on page 275.

Media that you previously captured plays back through the connections on the back of the 
AirSpeed Multi Stream. You can play back up to four streams of video at the same time.

Capture and playback can be controlled on the AirSpeed Multi Stream in the following 
ways: 

• The AirSpeed Multi Stream user interface

• Avid CaptureManager over Ethernet

• Avid iNEWS Command over Ethernet

• RS-422 serial control using VDCP, or Sony BVW protocols
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For more information, see “Configuring Channels for Remote Control with Avid iNEWS 
Command, CaptureManager, or Interplay Capture” on page 130.

AirSpeed Multi Stream creates a copy of all media captured to its local drives. The media 
remains there until deleted.

Hardware and Software Requirements

Your AirSpeed Multi Stream system requires specific Avid components and software 
versions; see the AirSpeed Multi Stream ReadMe included with your release for the qualified 
versions. The following Avid products are required:

• Avid Unity ISIS 2.0.1 or later is recommended

• Avid MediaNetwork 5.1.1 or later

• Avid Interplay®

• Avid NewsCutter®, Avid NewsCutter XP, Avid Media Composer®, or Symphony 
Nitris® editing systems.

• A network Domain Name System (DNS) server is required (or strongly recommended) 
in Avid Interplay environments.

n For the latest rsoftware equirements for your version of the AirSpeed Multi Stream software, 
refer to the Avid AirSpeed Multi Stream ReadMe for your software version. The ReadMe can 
be found on the Avid Knowledge Base. Go to www.avid.com.

n If your Avid Unity environment does not have a network DNS server, instructions for 
creating one can be found on the Avid Knowledge Base. Go to www.avid.com.

Optional Avid Applications

Optional Avid applications and hardware include:

• Avid iNEWS® Command

• Avid CaptureManager

• Avid IsoSync™

Software Installation

The AirSpeed Multi Stream software must be installed and configured onsite. For more 
information, see “Installing the Hardware and Setting Up Your System” on page 61.

http://www.avid.com
http://www.avid.com
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Synchronization

AirSpeed Multi Stream supports both blackburst and tri-level sync. When AirSpeed Multi 
Stream is capturing media, it can capture independent to the house reference signal, but the 
playout is not synced to the input reference signal. During playback, the outgoing media 
should be locked to the house reference signal provided on REF IN connector on the rear of 
the AirSpeed Multi Stream. For information on video reference output and configuration, 
see “Video/LTC Connections (MPEG-2 HD Model)” on page 54.

Ethernet Connections

AirSpeed Multi Stream systems have 4 Ethernet connections, although only 2 are used to 
control, configure, capture media to, or play out from, Avid Unity. For more information see 
“Connecting Ethernet Cables” on page 80.

AirSpeed Multi Stream connects to the Avid Unity network with a unique name and IP 
address. Avid Unity identifies each AirSpeed Multi Stream using either the AirSpeed Multi 
Stream name or the IP address. 

Time-of-Day Timecode

AirSpeed Multi Stream takes the time-of-day (TOD) timecode from the Avid Unity ISIS 
environment. The time and date are established each time the AirSpeed Multi Stream is 
turned on. If an external timecode is not connected to the LTC IN connector, the AirSpeed 
Multi Stream uses the system time as TOD.

Internal Storage

The AirSpeed Multi Stream is equipped with four internal drives. These drives are used as a 
buffer for incoming media and storing playback media. These internal drives are 
pre-configured in a 4-way RAID 0 stripe. For more information, see “Inserting the Hard 
Drives” on page 68.
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Serial Control

For flexibility, the AirSpeed Multi Stream supports more than one control mechanism. The 
AirSpeed Multi Stream supports the AirSpeed® Multi Stream Application Programming 
Interface (AMS API), the Sony® BVW protocol with Avid extensions (BVW75Serial), and 
Video Disk Control Protocol (VDCPSerial). These operations include capturing, playing, 
pausing, shuttling, and navigating to timecode. The serial control of the AirSpeed Multi 
Stream is through eight standard 8-pin RJ45 RS-422 interface connectors on the rear of the 
AirSpeed Multi Stream. 

For information on Sony BVW extensions supported by Avid, see “Sony BVW Extensions” 
on page 357.

For information on optional VDCP commands supported by Avid, see “Supported Optional 
VDCP Commands” on page 358.

For information on connecting the serial remote ports, see “Connecting Remote Serial 
Cables” on page 83. 

For information on configuring the serial remote ports, see “Configuring Communication 
Protocols in AirSpeed Multi Stream” on page 136.

User Interface

The AirSpeed Multi Stream system software UI provides windows for capturing media, 
playing media, and configuring the AirSpeed Multi Stream. The AirSpeed Multi Stream UI 
is explained in “User Interface” on page 204. 

The AirSpeed Multi Stream system software UI provides you with the flexibility to tailor 
capture and playout settings. These settings include network and workgroup settings, audio 
and video formats, and interface operations. 

You have the ability to instantly capture (crash record) to a predetermined workspace 
(default template) on Avid Unity by pressing the Record button in the AirSpeed Multi 
Stream UI, or alternately, by right-clicking on a mini-monitor and selecting Quick Record 
from the list.
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Software Overview

The AirSpeed Multi Stream system software supports all networking and operational 
requirements of the AirSpeed Multi Stream. 

Digital Input and Output Selection

The AirSpeed Multi Stream can capture and play back video from serial digital interface 
(SDI) connectors on the rear of the AirSpeed Multi Stream as follows:

• For SD models - SDI inputs and outputs using 525 lines (NTSC) or 625 lines (PAL) of 
video with embedded 48 KHz (2, 4, 6, or 8 channels) of 20 or 24-bit audio. The 
AirSpeed Multi Stream application allows you to select 16 or 24-bit only.

• For MPEG-2 HD, DNxHD, and AVC-Intra models - HD SDI inputs and outputs support 
HD - 1080i and 720p with 48KHz, (2, 4, 6, 8, 10, 12, 14, or 16 channels) of 24-bit audio. 
The AirSpeed Multi Stream application allows you to select 16 or 24-bit only.

• Closed Captioning and VITC in IMX.

• Closed Captioning and VITC in DV.

• HD Ancillary data preservation is supported for all HD formats. 

In addition, if you have minimum requirements of the following software versions, you 
will have the ability to have a data track available for use in your Editing application. 
When the composition is complete, you can send it to the AirSpeed Multi Stream server 
and it will play out the preserved ancillary data from the composition. The minimum 
software requirements are as follows:

- Media Composer v5.0 or later, or NewsCutter v9.0 or later

- Interplay v2.2 or later

- ISIS v2.2 or later

If you have these requirements, you should select the Ancillary Data Output Enabled? 
check box in the Channel Configuration dialog box. For more information, see 
“Configuring Channels on AirSpeed Multi Stream” on page 115. If you do not have the 
minimum requirements, leave the Ancillary Data Output Enabled? check box 
unchecked.

n The term power cycle, used throughout this document, means to shutdown and power up the 
AirSpeed Multi Stream.
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Supported Media Formats

The media files created by AirSpeed Multi Stream and stored on Avid Unity workspaces are 
MXF compliant. AirSpeed Multi Stream supports the following Avid media formats: 

Media File Type Supported Formats

Video (NTSC and PAL) • DV25 

n For DV25, NTSC supports DVCPRO (DV25 411)

n For DV25, PAL supports DVCPRO (DV25 411 and 
DV25 420)

• DV50

IMX IMX 30 — MPEG 30 I-frame-only compression 

IMX 50 — MPEG 50 I-frame-only compression 

MPEG-2 HD • HDV25mb 1080i

• MPEG-2-HD 35mb 1080i

• MPEG-2-HD 17.5mb 1080i

• MPEG-2-HD 35mb 1080i

• MPEG-2-HD 50mb 1080i

• MPEG-2-HD 50mb 720p

• MPEG-2 HD 35mb 720p

n For SD, each format supports 29.97 and 25 FPS.

n For HD, each format supports 59.94 and 50 FPS.

DNxHD • DNxHD 120/145 8-bit 1080i

• DNxHD 120/145 8-bit 720p

• DNxHD 185/220 10-bit 1080i

• DNxHD 185/220 10-bit 720p

n For HD, each format supports 59.94 and 50 FPS.

AVC-Intra (AVC-I) • AVC-Intra 50mb 1080i

• AVC-Intra 50mb 720p

• AVC-Intra 100mb 1080i

• AVC-Intra 100mb 720p

Audio WAVE — 48 kHz
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Capture Mode

Video and audio are captured through the SDI input and stored on an Avid Unity workspace. 
You can start a capture using the AirSpeed Multi Stream system software controls or via 
remote protocol.

MXF Media Formats and Files

The Material Exchange Format (MXF) is a format developed by the Professional MPEG 
Forum in association with organizations such as the SMPTE, The European Broadcasting 
Union (EBU) and the AAF Association.

Material Exchange Format is a wrapper or container format which encapsulates media and 
rich production metadata into a single file, which is useful for media storage and exchange. 
It is an open technology that can be implemented by any manufacturer. 

MXF has been designed to be flexible enough for use in all stages of content creation, from 
acquisition, to authoring, to distribution. The primary benefit of MXF is that it provides 
greater workflow efficiency by preserving useful metadata as media files make their way 
through the content creation process.The MXF format is independent of the type of content 
that it contains, so an MXF file can contain video and/or audio, as well as ANC data at any 
resolution or compression. In many instances, MXF files encapsulate media that is already 
formatted to one of the existing industry standards. 

MXF allows for easy exchange of material between file servers, tape streamers and digital 
archives. MXF is an ideal interchange format to enable workflow efficiencies in news 
broadcasting, post production, asset management, and archiving applications.

The AirSpeed Multi Stream creates media and metadata files in the MXF MediaFiles 
directories on the target workspaces. If the system’s unique MediaFiles directory is not 
present on the selected network media drive, the AirSpeed Multi Stream creates one. The 
AirSpeed Multi Stream also creates a subdirectory under the Avid MediaFiles (for MXF) 
directory.

The AirSpeed Multi Stream does not perform bin management operations.

n Interplay supports only the AAF data format in Avid AirSpeed Multi Stream environments.

Workspaces must already be created in Avid Unity in order to enter the workspace name 
during the AirSpeed Multi Stream setup. AirSpeed Multi Stream creates new projects, bins, 
and catalogs if the names in the configuration do not already exist.
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Media Destination Selection

AirSpeed Multi Stream uses Destination templates for selected channels to direct storage to 
particular workspaces on various storage locations. There is also a default location in the 
event you want to perform a crash record. AirSpeed Multi Stream does not remember the 
last storage destination set. 

Captured media is first stored on the internal drives of the AirSpeed Multi Stream and then 
copied to the selected Avid Unity workspace. To avoid reaching the internal drive’s 
maximum storage capacity, AirSpeed Multi Stream can be configured to automatically 
delete the media that has been saved to a workspace. The Auto Delete setting controls when 
to delete the media stored on the AirSpeed Multi Stream server and how much media to 
delete. For more information on setting Auto Delete, see “Configuring the Avid Service 
Configuration for Interplay Workgroup” on page 120. When the workspace is full, the 
AirSpeed Multi Stream continues to capture until the internal drives are filled. Once the 
internal drives are full, the AirSpeed Multi Stream stops capturing. 

Protecting Workspaces

Protect a workspace against drive failure by duplicating files on more than one drive (a form 
of mirroring). 

For best results, do not use unmirrored (unprotected) workspaces. Performance and behavior 
is unpredictable. 

For more information on protecting workspaces, see your Avid Unity ISIS or MediaNetwork 
documentation.

n For data integrity of your media, Avid recommends that you always use protection to avoid 
data loss.

Headframes

AirSpeed Multi Stream supports the display of headframes in Asset Management systems. 
Clips transferred to the Asset Management system display headframes.
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Playback

You can play back media previously captured by the AirSpeed Multi Stream. Up to four 
video streams of media (depending on the format) can be played back at the same time. 
Navigation and playback of specific clips is initiated by the AirSpeed Multi Stream user 
interface and controlled using the Operational Control buttons. 

To playback clips:

1. Load a clip in the AirSpeed Multi Stream user interface.

The clip’s headframe will be shown in the MiniMonitor or the cued window.

2. Press the Play button beneath the Mini-monitor. The Output monitor shows the playback 
of the clip.

 For more information, see “MiniMonitor Window” on page 222.

Playout

Once you have edited your media, use the AirSpeed Multi Stream as a playout server. The 
AirSpeed Multi Stream allows you to play out up to four channels at the same time. In an 
Avid iNEWS environment, or when using a MOS-enabled newsroom system, use the Avid 
iNEWS® Command application. For information on controlling clips on the AirSpeed Multi 
Stream, see the Avid iNEWS Command User’s Guide.

Before you can send your sequence to the AirSpeed Multi Stream from an Avid editing 
system, you must add the AirSpeed Multi Stream to your Send To Playback list in the Avid 
editing application. Adding an AirSpeed Multi Stream to the Send to Playback list is done 
by adding the AirSpeed Multi Stream Host Name to the TMClient.ini tab of the Transfer 
settings.

n AirSpeed Studio is not supported in the Macintosh environment, for AirSpeed Multi Stream 
servers configured with a Standalone Transfer Manager, or for Standalone original 
AirSpeed systems.

To send a sequence from an Avid editing system to playout:

1. Add the AirSpeed Multi Stream Host Name to the TMClient.ini tab in the Transfer 
settings. This process is described in “Adding the Studio to Your WorkGroup” on 
page 268.

2. Connect to the AirSpeed Multi Stream by selecting Transfer > Reconnect to Server. This 
process is described in “Connect to Playout Server or Studio” on page 270. 

3. Send a sequence to playout by doing one of the following:
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t Right-click on the selected sequence and select Send To Playback > AirSpeed Multi 
Streamname.

t Highlight the sequence in your bin and select Transfer > Send To Playback > 
AirSpeed Multi Stream name.

4. (Optional) Monitor the transfer status by selecting Transfer > Status Window.

c Do not delete the sequence or source media off of the Avid Unity workspace until you 
are sure the transfers to the AirSpeed Multi Stream or Studio are complete.

Studio Playout

An Avid AirSpeed Multi Stream Studio consists of two to eight systems (a combination that 
is comprised of up to five AirSpeed Multi Stream servers, and the balance of original 
AirSpeeds) as a Studio by following an AirSpeed Multi Stream host naming method. When 
an Avid editing system sends a sequence to the Studio, any AirSpeed Multi Stream member 
of the Studio can play out the sequence. If one or more AirSpeed Multi Stream systems in 
the Studio are offline, any other AirSpeed Multi Stream still online in the Studio can perform 
the playout.

For detailed information on the Studio concept, configuration, and using the Studio, see 
“AirSpeed Multi Stream Studio and Playout” on page 267.

Play While Transfer

Play While Transfer (PWT) allows the AirSpeed Multi Stream to playout media after 
approximately 20 seconds of media has been transferred from the shared storage. The 
transfer of the entire clip from the Avid editing system is not required with this option. 

The following applies with regards to Play While Transfer:

• When PWT is selected, the clip is available for playout when 20 seconds of media has 
been transferred. This allows the clip to be played before the transfer of the clip is 
complete. 

• If a group of clips are selected in an editor, only one clip can be designated as a PWT. 
Sending multiple PWTs requires separate STP transfers. 

• AirSpeed Multi Stream supports up to four simultaneous Play While Transfers (PWTs), 
although PWT transfers happen even if four transfers are in progress. You might see up 
to eight transfers in progress at one time if this occurs. If there are no PWT transfers, 
you will have a max of 4 transfers at one time.
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• Items that are either transferred or in progress will display in the AirSpeed Multi Stream 
Database window and will be playable if they have a duration of at least 20 seconds.

• The priority is always on playout. The highest priority clips in the system are clips that 
are transferring and playing at the same time. If the Playout point is close to the end of 
the currently transferred media, the system will speed up the rate of transfer for that clip.

• Selecting the PWT option from the editor when sending a clip for playback causes this 
transfer to begin as soon as is possible. PWT items will have a priority in the transfer 
queue and occur before existing non-PWT items in the queue.

• PWT is not supported for DNxHD 185/220 clips.

c The PWT feature is designed for time-sensitive playout needs and is not recommended 
for all of your playout media to the AirSpeed Multi Stream. 

Play While Record

The Play While Record (PWR) feature enables you to start recording a clip in SD or HD on 
one channel, and then begin to play the same recording out of another channel after 20 
seconds. In a PWR workflow, the recorded media will continue to transfer to the shared 
storage and be checked into Interplay. 

n For information on how many Play While Records (PWRs) you can perform at the same time 
on one AirSpeed Multi Stream, see the Avid AirSpeed Multi Stream Peformance Guidelines.

c This is a system intensive process. It is recommended that you limit other activities on 
the AirSpeed Multi Stream system (such as playback, re-ingest transfers, and so on) 
while performing a PWR. 

For more information, see “Playing While Recording a Clip (PWR)” on page 237.

Edit While Capture

When using a Team Configuration, you can edit media while it is being captured and 
transferred to shared storage. This allows you to start editing new media as soon as possible.

There are two different ways you can take advantage of Edit While Capture:

• Drag and drop the clip into the editor bin (Edit While Capture with Drag and Drop)

• Open the master clip directly from shared storage during the transfer (Edit While 
Capture with Auto Transfer)
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Edit While Capture with Drag and Drop - In this workflow, the Remote Console 
Standalone allows you to drag and drop one or more clip(s) to the editor bin. Once the clip(s) 
are in the Editor bin, they become partially on-line, allowing you to create sequences with 
the Avid Editor. The partially on-line media continues to grow until the capturing clip 
completes. Subsequently, the partially on-line clip is closed and the entire media will be 
available.

Edit While Capture with Auto Transfer – In this workflow, the media that is captured on 
the AirSpeed Multi Stream will be transferred directly to storage. The metadata (.aaf file) for 
the media is transferred to a predefined Avid MasterClips location (a folder on the ISIS 
5000/7000 workspace).  From the editor, you would then import this .aaf file and the media 
would be available partially on-line. The partially on-line media will continue to grow until 
the capturing clip completes. At this point, you must reimport the same .aaf file to close out 
the file.

n These workflows can only be used with ISIS 5000 or ISIS 7000 shared storage. 
MediaNetwork is not supported.

Before you can perform an Edit While Capture, your system must have been set up using a 
Team Configuration (AirSpeed Multi Stream with Shared storage).

n For information on how many Edit While Captures (EWCs) you can perform at the same 
time on one AirSpeed Multi Stream, see the Avid AirSpeed Multi Stream Performance 
Guidelines.

c This is a system intensive process. It is recommended that you limit other activities on 
the AirSpeed Multi Stream system (such as playback, re-ingest transfers, and so on) 
while performing an EWC. 

For more information on Edit While Capture workflows, see the following topics:

• “Performing an Edit While Capture (EWC) with Drag and Drop” on page 319

• “Performing an Edit While Capture (EWC) with Auto Transfer” on page 320

Closed Caption

Closed caption information can be captured on ingest and supported on playout. This 
information is embedded in the video signal, invisible without a decoder. Closed captions 
are stored in line 21 of the vertical blanking interval (VBI) or CC special for NTSC, as well 
as EIA/CEA-608 and EIA/CEA-708 ancillary caption data in HD formats.
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Up/Down/Cross (UDX) Conversion 

AirSpeed Multi Stream supports Up, Down or Cross (UDX) conversion of video formats. 
Using this feature, you can configure a channel to allow for conversion of a clip and its 
ancillary data (where available) to convert to a specific format for play-out. UDX 
preferences can be set in the Channel Configuration dialog box. UDX options available are 
the following:

• Up-Convert - SD video is up-converted to HD using one of five possible Up-Convert 
options available in the user interface. 

• Down-Convert - HD video is down-converted to SD using one of five possible 
Down-Convert options available in the user interface.

• SD Cross Convert - SD video is cross-converted (to SD) using one of six possible 
SD-Cross-Convert options available in the user interface.

• HD Cross Convert - This type of conversion only has one possible outcome, which is 
Anamorphic and based on incoming video. If you have 1080i, it is automatically 
converted to 720p. If you have 720p, it is automatically cross converted to 1080i. There 
is no selection in the User Interface for HD Cross Convert. It is just done 
anamorphically based on the incoming video standard.

For more information on using UDX Conversion, see “Configuring Channels” on page 104, 
and Appendix D - “Up, Down, Cross Convert (UDX) Examples” on page 385.

UDX Terms and Examples

This section describes the relevant UDX terms used in this guide to explain the video format 
behavior that occurs when various UDX options are selected. Examples are included where 
necessary. Terms described include the following:

• Pillarbox

• Letterbox

• Center-Crop

• Anamorphic

• Active Format Description (AFD)

• AutoAFD
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Pillarbox

A Pillarbox image typically means black “pillars” are placed on either side of an image 
when it is up-converted from a 4:3 image to a 16:9 image. 

Pillarbox is a selection in the Up-Convert and SD-Cross-Convert list boxes. If Pillarbox is 
selected when up-converting a 4:3 image to a 16:9 image, black “pillars” are placed on either 
side of the image. 

4:3 SD Image Up-Converted to 16:9 HD Pillarbox Example

The example below shows a 4:3 SD image, and then the same image after it was 
up-converted to an HD 16:9 pillarbox image.

Letterbox

A Letterbox image typically means black bars are placed on the top and bottom of an image 
when it is down-converted from a 16:9 HD image to a 4:3 SD image, or cross-converted 
from a 4:3 HD image to a 4:3 SDimage. 

Letterbox is a selection available in both the Down-Convert and SD-Cross-Convert list 
boxes. If Letterbox is selected when down-converting a 16:9 HD image to a 4:3 SD image, 
black bars are placed on the top and bottom of the SD image. 

16:9 HD Image Down-Converted to 4:3 SD Letterbox Example

The example below shows an HD 16:9 image, and then the same image after it was 
down-converted to a 4:3 SD letterbox image.
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Center-Crop

Center-crop is conversion process that, if selected, crops the image to fit in the format you 
are converting to. Center-crop works when you are up-converting a 4:3 SD image to 16:9 
HD, down-converting a 16:9 HD image to 4:3 SD, or cross-converting an SD image. 

AirSpeed Multi Stream supports the Center-Crop in the following conversion types:

• Up-convert 

• Down-convert

• SD-Cross-convert

These are described in more detail below:

Up Convert Center-Crop

If you are up-converting a 4:3 SD image that already contains a letterboxed image, and want 
to convert it to a 16:9 HD output, you probably want to just remove the black bars from the 
top and bottom. To do so, select Center-Crop from the Up-Convert list box.

n If you selected Pillarbox in this case, the video image would show black bars on the top and 
bottom (Letterbox), as well as black pillars on the sides. This is usually an undesired effect.

Example of a Up-Converted and Center-Cropped Image

The example below shows a 4:3 SD letterboxed image, and then the same image after it was 
Up-converted and Center-cropped to a 16:9 HD image.

Down Convert Center Crop

If you are down-converting a 16:9 HD image that already contains a pillarboxed image, and 
you want to convert it to a 4:3 SD full-screen output, you probably want to just remove the 
black pillars from the sides. To do so, select Center-Crop from the Down-Convert list box. 

n If you select Letterbox instead, you will end up with black pillars on the sides, as well as 
black bars on the top and bottom. This is usually an undesired effect.
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Example of a Down-Converted and Center-Cropped Image

The example below shows a 16:9 HD pillarboxed image, and then the same image after it 
was Down-converted and Center-cropped to a 4:3 SD full-screen image.

Anamorphic

In an anamorphic image, the active image is scaled to use all available pixels, both vertically 
and horizontally. In AirSpeed Multi Stream, typically you would only select Anamorphic 
when converting one 16:9 format to another. 

For example, if you are down converting a 16:9 HD image to a 16:9 SD format, and want to 
scale the image vertically and horizontally using all pixels (anamorphically), select 
Anamorphic from the Down-Convert list box in the Channel Configuration dialog box. 

n When cross-converting HD 720p to 1080i (or vice versa), AirSpeed Multi Stream provides 
the anamorphic conversion by default. There is no user interface or user interaction for this 
to occur.

16:9 SD Image Up-Converted to 16:9 HD Example

The example below shows a 4:3 SD image, and then the same image after it was 
Up-converted anamorphically to a 16:9 HD image.
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Active Format Description (AFD)

Active Format Description (AFD) is a type of ancillary data that can be attached to each 
frame of video, both into and out of AirSpeed Multi Stream. The AFD data consists of two 
parts:

• A 4-bit code that identifies the active video

• An aspect ratio that defines the overall shape of the image

As long as the Ancillary Data Output Enabled? check box is selected, AirSpeed Multi 
Stream will output AFD ancillary data for each video frame played. For information on the 
AFD codes used by AirSpeed Multi Stream for input and output AFD, including examples 
of their corresponding video formats when performing an Up, Down and Cross conversion 
with AirSpeed Multi Stream, see Appendix D - “Up, Down, Cross Convert (UDX) 
Examples” on page 385

AutoAFD

If one of the AutoAFD options is selected as the Up, Down, or SD-Cross convert option, 
then AirSpeed Multi Stream will use an intelligent algorithm to reshape or convert the video 
image. The conversion from input format to output format is detailed in Appendix D, “Up, 
Down, Cross Convert (UDX) Examples” on page 385.

If the video being played does not contain AFD information, then AirSpeed Multi Stream 
uses the “default” specified in the configuration settings. For example, if AFD exists in the 
incoming video, the setting “AutoAFD Default Pillarbox” follows the approach outlined in 
Appendix D, and will use Pillarbox, if AFD does not exist in the video.

ATC and VITC Timecode

For HD streams, we use Ancillary TimeCode (ATC). ATC is always stored and displayed in 
25/30 Hz timing, even for progressive video formats. AirSpeed Multi Stream implements 
SMPTE RP188 Ancillary TimeCode.

For SD streams, the timecode is Vertical Interval TimeCode (VITC).

Generally, when a clip is recorded, you can select from a variety of timecode choices. The 
selected option is used to set the clip’s base timecode.

At playback time, you can select whether to use the clip’s base timecode, or the frame 
embedded timecode, for output to ATC or VITC.
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Video Format

In SDI video, the ancillary data that defines the video format is called AFD, or Active 
Format Description. AFD is defined as a 4-bit number; there are 16 possible values. 
However, many of these are reserved and are not used. The most common AFD values 
include:

• SD, AFD=9: 4:3 image

• SD, AFD=10: 16:9 image, letterboxed (black bars at top and bottom)

• HD, AFD=10: 16:9 image

• HD, AFD=9: 4:3 image, pillarboxed (black bars on left and right sides)

The AFD code is used to describe the video format before and after conversion. One of the 
primary purposes of using AFD to describe the image format is so that processing and 
display equipment can make intelligent choices. For example, if the starting image is a 
pillarboxed 4:3 image (AFD=9):

When down converting this image to SD, an intelligent approach is to simply remove the 
black bars from the 2 sides. If the black bars are removed, then the resultant image is now a 
full-screen 4:3 image, and would get stamped with an AFD code of 9.

The main goal is to avoid letterboxing an image that is already pillarboxed (or vice versa). 
When this happens, you get black bars on both the top and bottom, and the left and right 
sides, and the active picture is smaller than it needs to be:
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This is generally an undesirable effect. However, if you want this, you can override the 
‘intelligent’ formatting based on AFD with fixed formatting during UDX conversions. The 
Channel Configuration dialog box provides the settings to enable you to configure how you 
want conversion formatting to occur.

For more information on input and output AFD including examples of their corresponding 
video formats when performing an Up, Down and Cross conversion, see Appendix D “Up, 
Down, Cross Convert (UDX) Examples” on page 385.

International Character Support (ICS)

AirSpeed Multi Stream includes international character support (ICS). ICS allows you to 
display and input character in languages other than English. The AirSpeed Multi Stream 
application is qualified on an English operating system running locales for the following 
languages: French, Italian, German, Spansih, Korean, Japanese, and Simplified Chinese. 
This allows you to input and display characters in your chosen language even though you are 
using the basic English-language operating system. The operating system will display the 
appropriate language in menus and dialog boxes. You can also specify the language you 
want to use for keyboard layouts.

AirSpeed Multi Stream does not support ICS for the following:

• Computer name

• Operating system login and password

• Interplay login and password

• Shared storage workspace

• Database name and database path

• In the Service tab of the Avid Service Configuration, the Interplay Credentials field 
must be English-only.

• In the Destination tab of the Avid Service Configuration, the Workspace field must be 
English only.

• In the Avid Workgroup Properties, the Workgroup, and the Host name for the lookup 
Service must be English only.

For information on configuring ICS for AirSpeed Multi Stream, see “Configuring 
International Character Support” on page 144.

For additional information on using ICS, see International Character Support on the Avid 
Knowledge Base.
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Front and Rear Panels

AirSpeed Multi Stream uses industry-standard video input and output connections in 
addition to network and control connections. The AirSpeed Multi Stream is designed for a 
19-inch (483-mm) rack occupying one and a half rack units (1.5RU). For information on 
installing the AirSpeed Multi Stream into a rack, see “Installing AirSpeed Multi Stream in a 
Rack” on page 63.

n Avid recommends using an application such as Windows Remote Dektop or Virtual Network 
Computing (VNC) to configure the AirSpeed Multi Stream when access to the AirSpeed 
Multi Stream is not available or when a keyboard and mouse are not attached.

Front Panel

The following figure shows the front of all AirSpeed Multi Stream models. All 
configuration, capture, and playback functions are done through AirSpeed Multi Stream 
software on this box or in some cases on remote systems. Although the system automatically 
powers on when it is plugged in, the power button can be used to power on and off the 
AirSpeed Multi Stream in the event of a drive failure (indicated by the LED for the problem 
media drive going dark) or other problem.

LEDs and Power Button section

The following diagram shows the LEDs on the front of the AirSpeed Multi Stream system.
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The Power button shuts down and restores power to the AirSpeed Multi Stream server. The 
Reset button restarts AirSpeed Multi Stream server, without powering off the AirSpeed 
Multi Stream server. The functions of the 9 LEDs on the front of the AirSpeed Multi Stream 
system are described in the following table:

LED Description State

Power The Power LED is located furthest to 
the right (to the left of the Avid logo 
and to the right of the Power button). 
This LED is tied to the AC power 
system that indicates when the 
AirSpeed Multi Stream chassis is 
powered on.

• Steady Green - Indicates power 
on.

• Dark - Indicates power off.

PS Power Supply Status indicator • Steady Green - Indicates good 
power.

• Steady Amber - Indicates bad 
power.

• Blinking Amber - Indicates one 
power supply is missing or no 
AC.

SA Not Used

TMP Overheat • Steady Green - Indicates that the 
AirSpeed Multi Stream is 
working properly. No overheat 
condition or fan failure.

• Steady Amber - Indicates an 
overheat condition.

• Blinking Amber - Indicates fan 
failure.

NET Network Link • Steady Green - Indicates 
successful log in to shared 
storage and asset manager.

• Blinking Amber - Indicates 
failure to log in to shared storage 
or asset manager.
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LTC LTC In Detected • Steady Green - Indicates a valid 
LTC-In has been detected.

• Blinking Amber - Indicates a 
LTC signal is detected, but it is 
an incorrect or bad signal.

• Dark - No LTC connection 
detected.

REF Reference In Detected •  Steady Green - Indicates a valid 
Reference-In has been detected.

• Blinking Amber - Indicates a 
signal has been detected, but it is 
an incorrect or bad signal (frame 
rate, standard).

• Dark - No Reference In 
connection has been detected.

ACT Active status for Play, Record, Cue, 
Cueing. Used to indicate that the 
system is most likely doing 
something important.

• Steady Green - Indicates that the 
AirSpeed Multi Stream is 
playing, recording, cueing, 
and/or has something that is 
cued.

• Dark - Indicates that the 
AirSpeed Multi Stream is not 
playing, recording, or cueing, 
and nothing is cued.

WNK “Wink”. Enables you to physically 
identify a specific AirSpeed Multi 
Stream server in a rack of multiple 
systems. 

• Blinking Green - Indicates that 
the AirSpeed Multi Stream 
system has received a request to 
identify itself.

• Dark - Indicates that there is no 
request to be identified.

LED Description State
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Media Drive LED example

The following diagram shows the a media drive and points out the location of the green 
media drive LED on the front of the AirSpeed Multi Stream system.

The Media Drive LED display a steady green light when the drive is ready. A blinking green 
LED indicates drive activity. If there is no light in the LED, this indicates a problem with the 
media drive.

Visual Status Information

You can monitor a variety of status information using the UI, and the LEDs. Monitored 
system components are displayed in the Interplay Health Monitor. For more information, see 
“Viewing System Health Status Information” on page 346.

Rear Media Connections (All Models)

The AirSpeed Multi Stream supports industry-standard inputs and outputs to provide 
flexibility for individual requirements. Back panels for all AirSpeed Multi Stream models 
are shown below.

The following diagram shows the rear media connections for the AirSpeed Multi Stream SD 
model.
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The following diagram shows the rear media connections for the AirSpeed Multi Stream 
MPEG-2 HD model.

The following diagram shows the rear media connections for the AirSpeed Multi Stream 
DNxHD model.

The following diagram shows the rear media connections for the AirSpeed Multi Stream 
AVC-Intra model.
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The following table lists the audio and video inputs and outputs for all models of the 
AirSpeed Multi Stream. Model names are referenced when differences apply.

Connector Description

Expansion Ports 1 and 2 2 GPIO inputs to be used with Avid supplied GPIO breakout cables. 

Serial Digital Interface For SD models: 

• 2 serial digital interface (SDI) inputs (2 BNC) labelled IN 1-2

• 4 SDI outputs (4 BNC) labeled OUT 1-4

For MPEG-2 HD models: 

• 4 serial digital interface (SDI) inputs (4 BNC) labelled IN 1, 2, and 
5, 6

• 8 SDI outputs (8 BNC) labeled OUT 1-8

For DNxHD models:

• 2 serial digital interface (SDI) inputs (2 BNC) labelled IN 1-2

• 4 SDI outputs (4 BNC) labeled OUT 1-4

For AVC-Intra models:

• 4 serial digital interface (SDI) inputs (4 BNC) labelled IN 1-4

• 4 SDI outputs (4 BNC) labeled OUT 1-4

Analog Reference In and 
Loop thru

1 reference input (1 BNC)
1 reference loop through (1 BNC)

LTC In and Loop thru 1 analog TC input (1 BNC)
1 analog TC loop through (1 BNC)
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Chassis Label Location (All Models)

This section explains each of the interface connections for all of the AirSpeed Multi Stream 
chassis models. The chassis identification label is on the top of the chassis. If your AirSpeed 
Multi Stream does not have a label in this location, see the documentation that came with 
your AirSpeed Multi Stream chassis.

Control Connections (All Models)

The following figure identifies the network, serial, USB, and Ethernet connectors on all 
AirSpeed Multi Stream models. Although these connections are in the same location for all 
models, for illustration purposes, the following figure depicts the rear panel of the AirSpeed 
Multi Stream MPEG-2 HD model.
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For a description of each connector, see the following table.

Label Function

EXPANSION PORT 1 and 2 A general purpose input/output for remotely controlling the 
AirSpeed Multi Stream, 29-pin DVI connector. For example, 
you can invoke a GPI command to start capturing and another 
one to stop capturing. Each expansion port also provides 4 
LTC out each. 

CONSOLE The RS-232 port is used for terminal access to the AirSpeed 
Multi Stream.

VGA The Video graphic array (VGA) connection is used for 
connecting a monitor to the AirSpeed Multi Stream. 

SERIAL There are 8 Serial Remote RJ-45 connections, used for 
controlling other devices. 

USB Universal serial bus (USB) 2 connections, used primarily for 
compatible mouse and keyboard inputs. The port can also be 
used with a trackball or other compatible pointing device.

ETHERNET
(Ethernet control interface)

1000 BASE-T data port Ethernet connection to the 
Avid Unity network. Connects to a network switch and 
provides a fast link to the Avid Unity environment.

There are 4 Ethernet ports, although only 2 (Ports 1 and 2) are 
supported for communicating with the shared storage (Avid 
Unity ISIS, or MediaNetwork). 

Port 4 is reserved for use for connecting and configuring the 
AirSpeed Multi Stream over a network interface. For more 
information, see “Connecting to AirSpeed Multi Stream Over 
the Network” on page 81.
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Video/LTC Connections (SD Model)

The following figure identifies the video and timecode connectors on the AirSpeed Multi 
Stream SD model. 

For a description of each connector, see the following table.
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Number Label Function

1 IN 1 Serial Digital Interface input number 1, BNC 
connector.

2 IN 2 Serial Digital Interface input number 2, BNC 
connector.

3 OUT 1 Serial Digital Interface output number 1, BNC 
connector. 

4 OUT 2 Serial Digital Interface output number 2, BNC 
connector.

5 OUT 3 Serial Digital Interface output number 3, BNC 
connector.

6 OUT 4 Serial Digital Interface output number 4, BNC 
connector.
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7 REF (IN/THRU) (Reference 
Input/loopthrough) 

Can be used as either:

• Video reference (REF) input for a black 
burst/tri-level or house sync signal, BNC 
connector.

• Video reference (REF) loop through sync signal 
for daisy-chaining the house sync to other media 
equipment, BNC connector.

n If you are only using one REF IN signal, and 
not looping, the 2nd connection must be 
terminated with a 75 ohm-rated terminator.If 
the AirSpeed Multi Stream is in the middle of 
your reference loop, connect the remaining 
REF IN/THRU conector to the next device’s 
REF input.

8 LTC (LTC IN/THRU) Can be used as either:

• Longitudinal timecode input, BNC. Provides a 
feed to the AirSpeed Multi Stream server for an 
analog timecode signal, allowing an alternate 
source generated timecode to be applied to the 
captured material.

• Longitudinal timecode loop through BNC 
connector. Analog timecode signal that can be 
used by external devices that require such a 
signal for their capture or command and control 
operations.

n If you are only using one LTC IN signal, and 
not looping, the 2nd connection must be 
terminated with a 75 ohm-rated terminator. If 
the AirSpeed Multi Stream is in the middle of 
your LTC loop, connect the remaining LTC 
IN/THRU conector to the next device’s LTC 
input.

For more detailed specification information, see 
“Control and Synchronization Specifications” on 
page 352

9 CONSOLE The RS-232 port is used for terminal access to the 
AirSpeed Multi Stream. Used by Avid personnel for 
troubleshooting purposes.

Number Label Function
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Video/LTC Connections (MPEG-2 HD Model)

The following figure identifies the video and timecode connectors on the AirSpeed Multi 
Stream MPEG-2 model. 

For a description of each connector, see the following table.
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Number Label Function

1 IN 1 Serial Digital Interface input number 1, BNC 
connector.

2 IN 2 Serial Digital Interface input number 2, BNC 
connector.

3 OUT 1 Serial Digital Interface output number 1, BNC 
connector. 

4 OUT 2 Serial Digital Interface output number 2, BNC 
connector.

5 OUT 3 Serial Digital Interface output number 3, BNC 
connector.

6 OUT 4 Serial Digital Interface output number 4, BNC 
connector.

7 IN 5 Serial Digital Interface input number 5, BNC 
connector.

8 IN 6 Serial Digital Interface input number 6, BNC 
connector.

9 OUT 5 Serial Digital Interface output number 5, BNC 
connector.
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10 OUT 6 Serial Digital Interface output number 6, BNC 
connector.

11 OUT 7 Serial Digital Interface output number 7, BNC 
connector. Not used.

12 OUT 8 Serial Digital Interface output number 8, BNC 
connector. Not used.

13 REF (IN/THRU) (Reference 
Input/loopthrough) 

Can be used as either:

• Video reference (REF) input for a black 
burst/tri-level or house sync signal, BNC 
connector.

• Video reference (REF) loop through sync signal 
for daisy-chaining the house sync to other media 
equipment, BNC connector.

n If you are only using one REF IN signal, and 
not looping, the 2nd connection must be 
terminated.

14 LTC (LTC IN/THRU) Can be used as either:

• Longitudinal timecode input, BNC. Provides a 
feed to the AirSpeed Multi Stream server for an 
analog timecode signal, allowing an alternate 
source generated timecode to be applied to the 
captured material.

• Longitudinal timecode loop through BNC 
connector. Analog timecode signal that can be 
used by external devices that require such a 
signal for their capture or command and control 
operations.

15 CONSOLE The RS-232 port is used for terminal access to the 
AirSpeed Multi Stream. Used by Avid personnel for 
troubleshooting purposes.

Number Label Function
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Video/LTC Connections (DNxHD Model)

The following figure identifies the video and timecode connectors on the AirSpeed Multi 
Stream DNxHD model.

For a description of each connector, see the following table.
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Number Label Function

1 IN 1 Serial Digital Interface input number 1, BNC 
connector.

2 IN 2 Serial Digital Interface input number 2, BNC 
connector.

3 OUT 1 Serial Digital Interface output number 1, BNC 
connector. 

4 OUT 2 Serial Digital Interface output number 2, BNC 
connector.

5 OUT 3 Serial Digital Interface output number 3, BNC 
connector.

6 OUT 4 Serial Digital Interface output number 4, BNC 
connector.
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7 REF (IN/THRU) (Reference 
Input/loopthrough) 

Can be used as either:

• Video reference (REF) input for a black 
burst/tri-level or house sync signal, BNC 
connector.

• Video reference (REF) loop through sync signal 
for daisy-chaining the house sync to other media 
equipment, BNC connector.

n If you are only using one REF IN signal, and 
not looping, the 2nd connection must be 
terminated with a 75 ohm-rated terminator. If 
the AirSpeed Multi Stream is in the middle of 
your reference loop, connect the remaining 
REF IN/THRU conector to the next device’s 
REF input.

8 LTC (LTC IN/THRU) This connector is SMPTE 12m single-ended, and 
can be used as either of the following:

• Longitudinal timecode input, BNC. Provides a 
feed to the AirSpeed Multi Stream server for an 
analog timecode signal, allowing an alternate 
source generated timecode to be applied to the 
captured material.

• Longitudinal timecode loop through BNC 
connector. Analog timecode signal that can be 
used by external devices that require such a 
signal for their capture or command and control 
operations.

n If you are only using one LTC IN signal, and 
not looping, the 2nd connection must be 
terminated with a 75 ohm-rated terminator. If 
the AirSpeed Multi Stream is in the middle of 
your LTC loop, connect the remaining LTC 
IN/THRU conector to the next device’s LTC 
input.

n You should have a source with less than 50 
ohms impedance, and amplitude greater than 
0.5V p-p, less than 4.5V p-p.

9 CONSOLE The RS-232 port is used for terminal access to the 
AirSpeed Multi Stream. Used by Avid personnel for 
troubleshooting purposes.

Number Label Function
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Video/LTC Connections (AVC-Intra Model)

The following figure identifies the video and timecode connectors on the AirSpeed Multi 
Stream AVC-Intra model. 

For a description of each connector, see the following table.
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Number Label Function

1 IN 1 Serial Digital Interface input number 1, BNC 
connector.

2 IN 2 Serial Digital Interface input number 2, BNC 
connector.

3 OUT 1 Serial Digital Interface output number 1, BNC 
connector. 

4 OUT 2 Serial Digital Interface output number 2, BNC 
connector.

5 IN 3 Serial Digital Interface input number 3, BNC 
connector.

6 IN 4 Serial Digital Interface input number 4, BNC 
connector.

7 OUT 3 Serial Digital Interface output number 3, BNC 
connector.

8 OUT 4 Serial Digital Interface output number 4, BNC 
connector.
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Keyboard and Mouse

You need to provide your own USB keyboard and mouse to navigate through the AirSpeed 
Multi Stream UI. The keyboard and mouse plug directly into the USB connectors in the rear 
of the chassis. 

n Using a PS2 keyboard or mouse with a PS2 to USB connector might cause problems with the 
system. It is recommended that you use a native USB keyboard and mouse.

For more information, see “Connecting USB Devices (Mouse and Keyboard)” on page 80.

9 REF (IN/THRU) (Reference 
Input/loopthrough) 

Can be used as either:

• Video reference (REF) input for a black 
burst/tri-level or house sync signal, BNC 
connector.

• Video reference (REF) loop through sync signal 
for daisy-chaining the house sync to other media 
equipment, BNC connector.

n If you are only using one REF IN signal, and 
not looping, the 2nd connection must be 
terminated.

10 LTC (LTC IN/THRU) Can be used as either:

• Longitudinal timecode input, BNC. Provides a 
feed to the AirSpeed Multi Stream server for an 
analog timecode signal, allowing an alternate 
source generated timecode to be applied to the 
captured material.

• Longitudinal timecode loop through BNC 
connector. Analog timecode signal that can be 
used by external devices that require such a 
signal for their capture or command and control 
operations.

11 CONSOLE The RS-232 port is used for terminal access to the 
AirSpeed Multi Stream. Used by Avid personnel for 
troubleshooting purposes.

Number Label Function
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2 Installing the Hardware and Setting Up 
Your System

This chapter provides information on hardware installation (including unpacking and 
inspecting, and installing in a rack), cable connections, and system set up instructions. Also 
included is information on configuring your shared storage and setting up remote access to 
the AirSpeed Multi Stream.

c Do not connect multiple AirSpeed Multi Stream servers to your Avid Unity 
environment until you have assigned a new unique IP address to each AirSpeed Multi 
Stream. 

This chapter contains the following topics:

• Unpacking and Inspecting Your System

• Installing AirSpeed Multi Stream in a Rack

• Cabling Up the AirSpeed Multi Stream

• Setting Up Your System

Unpacking and Inspecting Your System

This topic provides information on how to unpack your system and inspect it to verify that 
you have received the appropriate components for your order, and that the components are 
not damaged in any way.

Unpack and Inspect Checklist

The following table provides a checklist of tasks that must be performed when unpacking 
and inspecting your AirSpeed Multi Stream system.

Unpack your system, as described in “Unpacking Your System” on page 62.

Verify that you have all of the correct boxes and components, as described in “Verifying 
Components” on page 62.
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Unpacking Your System

Before you unpack your system, make sure the location is free of clutter and dust. Also, 
make sure you have clean power and a VGA monitor nearby.

To unpack your system:

1. Open the box.

2. Unpack your system.

Avid recommends that you keep all packaging materials for at least 90 days. If you need 
to return a system to Avid Technology, Inc., the system must be repackaged in its 
original packaging material to ensure that there is no damage to the system during 
shipment.

3. Remove all of the boxes, and lay them out so you can verify that you have received all of 
the components that should have been shipped.

4. Once all of the boxes and components have been unpacked, visually inspect the chassis 
to make sure that it is free of all scratches and dents, that there are straight connectors on 
the back, and that the power-supply securing screws are not bent.

5. The next step is to verify that you have received all of the items particular to your order. 
For more information, see “Verifying Components” on page 62.

Verifying Components

Once you have unpacked everything, verify that you have the following boxes or 
components:

• AirSpeed Multi Stream chassis

• Media drives (4 per system)

• Expansion Port cables (one cable for SD and DNxHD models, two cables for MPEG-2 
HD, and AVC-Intra models)

• Power cables (2 per system)

• USB Flash Drive (UFD)

• Rack mount supports, ear covers, clips and screws. For more information, see 
“Rack-mount Kit Contents” on page 64.

• Service ID card

• Health and Safety Guide

Verify that the components are not damaged, as described in “Inspecting Components for 
Damage” on page 63.
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n ReadMe files are not in the box. They can be found in your Avid application folder as a PDF 
document (ReadMe.pdf) and are also available online. You should always check online for 
the most up-to-date release notes or ReadMe because the online version is updated 
whenever new information becomes available. To view these online versions, visit the 
Knowledge Base at www.avid.com/readme.

If you are missing any of these components, contact Avid Technical Support before 
proceeding.

Inspecting Components for Damage

Once you have verified that all of your components have been shipped, you must verify that 
they are not damaged.

To inspect components for damage:

1. Visually inspect all of the hardware components listed in the section on the previous 
page to make sure that none of them were damaged during shipment. 

2. If you received a hardware component that was damaged, contact Avid Technical 
Support.

Installing AirSpeed Multi Stream in a Rack 

The AirSpeed Multi Stream is designed for 19-inch (483-mm) rack enclosures and requires 
one and a half EIA rack units (1.5RU), or 2.6 inches (66.7-mm) of rack space. AirSpeed 
Multi Stream provides rack nuts for those rack enclosures that do not have threaded holes. 
Rack-nut clips position the rack nuts at the holes of the rack and are used to secure the rack 
components in place. 

The AirSpeed Multi Stream ships with brackets, and rack-mount screws. If your rack has 
threaded holes, you might have to supply your own rack fasteners. If your rack does not have 
threaded holes, install the rack nuts included with the AirSpeed Multi Stream. 

c The AirSpeed Multi Stream is designed to be installed horizontally in a rack. Installing 
the AirSpeed Multi Stream on an angle or in a sloped console causes the internal drives 
to wear faster than the intended life of the drive.

w To ensure the stability of the rack enclosure, start from the bottom when you install the 
rack components in the rack enclosure.
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Rack-mount Requirements

The following rack-mount requirements are listed below:

• Elevated Operating Ambient — If installed in a closed or multi-unit rack assembly, the 
operating ambient temperature of the rack environment might be greater than room 
ambient. Therefore, consider installing the equipment in an environment compatible 
with the maximum ambient temperature (Tma) specified by the manufacturer.

• Reduced Air Flow — Installation of the equipment in a rack should be such that the 
amount of air flow required for safe operation of the equipment is not compromised.

AirSpeed Multi Stream airflow is from the front of the chassis enclosure to the rear. 
Make allowances for cooling air to be available to the front panel surface and no 
restrictions at the rear.

• Mechanical Loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading.

• Circuit Overloading — Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the circuits might have 
on overcurrent protection and supply wiring. Appropriate consideration of equipment 
nameplate ratings should be used when addressing this concern.

• Reliable Earthing — Reliable earthing of rack-mounted equipment should be 
maintained. Particular attention should be given to supply connections other than direct 
connections to the branch circuit (for example, use of power strips).

Rack-mount Kit Contents

The rack-mount kit contains the following:

• 2 – rear rack support brackets (right and left)

• 2 – plastic rack ear covers

• 2 – plastic rack ear cover clips (attached to the rack ears on the chassis)

• 8 – #10-32 screws (2 for each corner)

• 8 – rack-nut clips

• Avid service ID card (one label is affixed to the top of the AirSpeed Multi Stream 
chassis)

n Use your own rack hardware if your rack has threaded holes or unique fasteners.
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Positioning the AirSpeed Multi Stream in the Rack

The following procedure helps you decide where to install the AirSpeed Multi Stream in the 
rack. If your rack enclosure does not have threaded holes, install the rack-nut clips included 
with the rack-mount kit where the AirSpeed Multi Stream front panel secures to the rack 
enclosure. If your rack enclosure has threaded holes, do not attach the rack-nut clips. 

To position the AirSpeed Multi Stream in the rack enclosure and attach the rack-nut 
clips:

1. Select a position in the rack where you can mount the AirSpeed Multi Stream at eye 
level (or lower). The AirSpeed Multi Stream needs to be positioned at the proper 
baseline position (see the preceding figure).
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2. Slide the rack-nut clips over the holes where the AirSpeed Multi Stream brackets and 
front panel will secure to the rack enclosure; see the following figure. 

Securing the AirSpeed Multi Stream Chassis in the Rack

All Avid AirSpeed Multi Stream rack-mount components are supplied with rear mount rack 
supports (brackets). You should follow the manufacturer’s installation instructions supplied 
with each component to correctly attach the rails or brackets to the rack enclosure.

n Where necessary, this guide supplies specific rack-mount bracket installation instructions. 
These instructions supersede the manufacturer’s instructions.

You should have someone helping you lift the AirSpeed Multi Stream while you are 
positioning it into the rack.

Rack enclosure

mounting rail

Rack-nut clip slid 

over hole

Use your own rack hardware if

your rack has threaded holes or

unique fasteners
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To secure the AirSpeed Multi Stream chassis in the rack:

1. Screw the left and right mounting brackets to the rear of the rack as shown in the 
following figure.

2. Lift the chassis and place the rear of the chassis onto the rear brackets, and line up the 
rack ears on the front panel to where you want to position the rack.

3. Screw the chassis to the front of the rack through the ears of the chassis as shown in the 
following figure.
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4. Insert the rack ear covers on the rack ear clips.

If the front bezel is not installed on the front of your chassis, you can clip it on.

Inserting the Hard Drives

Once you have installed the AirSpeed Multi Stream chassis into the rack, you must next 
insert the four hard drives into the front of the chassis.

n The hard drives that were shipped with your chassis can be installed into any slot on the 
AirSpeed Multi Stream chassis.

To insert the hard drives into the chassis:

1. Unpack each drive and turn it so you can properly read the Avid name.

2. Pull open the plastic handle (with drive size label) on the front of the drive.

3. Place the drive into the slot and slowly push the drive completely into the slot.

4. Push the plastic handle (with drive size label) closed, to lock the drive into the slot.

5. Repeat steps 1 through 4 until all drives are installed in the chassis.

Once the drives are installed, you can begin cabling up the AirSpeed Multi Stream for 
your site. For more information, see “Cabling Up the AirSpeed Multi Stream” on page 
69.
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Cabling Up the AirSpeed Multi Stream

Once the AirSpeed Multi Stream is securely installed in the rack, and the drives are installed, 
you are now ready to connect the appropriate cables to the rear panel of the AirSpeed Multi 
Stream to the external devices for your particular site. This section contains the cabling 
diagrams and instructions for all AirSpeed Multi Stream models. 

The following sections describe the cabling on the rear of the AirSpeed Multi Stream for all 
models:

• Connecting SDI and Video Reference Cables

• Connecting Time of Day (TOD) LTC Cables

• Connecting Control and Communications Cables

• Connecting USB Devices (Mouse and Keyboard)

• Connecting Ethernet Cables

• Connecting Remote Serial Cables

• Connecting Expansion Port Cables

• Connecting the Console Cables
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Connecting SDI and Video Reference Cables

The SDI and Video Reference connections are marked on the rear of the AirSpeed Multi 
Stream. The following procedure describes which connector to use.

For more specific information, see the following topics:

• “Connecting Video Reference Cables” on page 70

• “Connecting SDI Video Input Cables (for SD Models)” on page 71

• “Connecting SDI Video Input Cables (for MPEG-2 HD Models)” on page 72

• “Connecting SDI Video Input Cables (for DNxHD Models)” on page 72

• “Connecting SDI Video Input Cables (for AVC-Intra Models)” on page 73

• “Connecting SDI Video Output Cables (for SD Models)” on page 74

• “Connecting SDI Video Output Cables (for MPEG-2 HD Models)” on page 75

• “Connecting SDI Video Output Cables (for DNxHD Models)” on page 76

• “Connecting SDI Video Output Cables (for AVC-Intra Models)” on page 77

Connecting Video Reference Cables

This topic contains information on how to connect video reference cables to the rear of the 
AirSpeed Multi Stream chassis.

The following illustration shows the location of the video reference connectors on the rear of 
the AirSpeed Multi Stream MPEG-2 HD chassis. The location of the REF IN/THRU 
connectors are the same for all AirSpeed Multi Stream models.
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To connect video reference cables:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect a composite video reference source (house reference, blackburst, or tri-level) to 
one of the reference input connectors (labelled REF IN/THRU). 

If the AirSpeed Multi Stream is the last device in your reference loop, terminate the 
remaining Ref Loopthrough connector with a 75 ohm-rated terminator. If the AirSpeed 
Multi Stream is in the middle of your reference loop, connect the remaining REF 
IN/THRU connector to the next device’s reference input.

3. Connect the other end of the video reference cable to your devices that are sending the 
input signal to the AirSpeed Multi Stream.

Connecting SDI Video Input Cables (for SD Models)

The SDI Video Input connections are marked on the rear of the AirSpeed Multi Stream SD. 
The following procedure describes which connector to use. To find the exact location, see 
“Video/LTC Connections (SD Model)” on page 52.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.

The following illustration shows the location of the SDI IN video connectors on the rear of 
the AirSpeed Multi Stream SD chassis.

To connect SDI video input cables on the SD chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI input signal to an incoming SDI input (one of the two labelled IN 1-2) 
for AirSpeed Multi Stream SD models.

3. Connect the other end of all SDI input cables to your devices that are sending the input 
signal to the AirSpeed Multi Stream SD.
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Connecting SDI Video Input Cables (for MPEG-2 HD Models)

The SDI Video Input connections are marked on the rear of the AirSpeed Multi Stream 
MPEG-2 HD. The following procedure describes which connector to use. To find the exact 
location, see “Video/LTC Connections (MPEG-2 HD Model)” on page 54.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.

The following illustration shows the location of the SDI IN video connectors on the rear of 
the AirSpeed Multi Stream MPEG-2 HD chassis.

To connect SDI video input cables on the MPEG-2 HD chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI input signal to an incoming SDI input (one of the four labelled IN 1-2, 
and IN 5-6) for AirSpeed Multi Stream MPEG-2 HD models.

3. Connect the other end of all SDI input cables to your devices that are sending the input 
signal to the AirSpeed Multi Stream MPEG-2 HD.

Connecting SDI Video Input Cables (for DNxHD Models)

The SDI Video Input connections are marked on the rear of the AirSpeed Multi Stream 
DNxHD. The following procedure describes which connector to use. To find the exact 
location, see “Video/LTC Connections (DNxHD Model)” on page 56.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.
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The following illustration shows the location of the SDI IN video connectors on the rear of 
the AirSpeed Multi Stream DNxHD chassis.

To connect SDI video input cables on the DNxHD chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI input signal to an incoming SDI input (one of the two labelled IN 1-2) 
for AirSpeed Multi Stream DNxHD models.

3. Connect the other end of all SDI input cables to your devices that are sending the input 
signal to the AirSpeed Multi Stream.

Connecting SDI Video Input Cables (for AVC-Intra Models)

The SDI Video Input connections are marked on the rear of the AirSpeed Multi Stream 
AVC-Intra. The following procedure describes which connector to use. To find the exact 
location, see “Video/LTC Connections (AVC-Intra Model)” on page 58.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.
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The following illustration shows the location of the SDI IN video connectors on the rear of 
the AirSpeed Multi Stream AVC-Intra chassis.

To connect SDI video input cables on the AVC-Intra chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI input signal to an incoming SDI input (one of the four labelled IN 1-4) 
for AirSpeed Multi Stream AVC-Intra models.

3. Connect the other end of all SDI input cables to your devices that are sending the input 
signal to the AirSpeed Multi Stream AVC-Intra.

Connecting SDI Video Output Cables (for SD Models)

The SDI Video Output connections are marked on the rear of the AirSpeed Multi Stream 
SD. The following procedure describes which connector to use. To find the exact location, 
see “Video/LTC Connections (SD Model)” on page 52.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.
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The following illustration shows the location of the SDI OUT video connectors on the rear 
of the AirSpeed Multi Stream SD chassis.

To connect SDI video output cables on the DNxHD model chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI output signal to an outgoing SDI output (one of the four labelled 
OUT1-4) for AirSpeed Multi Stream DNxHD models. 

Up to four SDI outputs are available for sending SDI signals out to your other devices.

3. Connect the other end of all SDI output cables to your devices that are receiving the 
output signal from the AirSpeed Multi Stream DNxHD.

Connecting SDI Video Output Cables (for MPEG-2 HD Models)

The SDI Video Output connections are marked on the rear of the AirSpeed Multi Stream 
MPEG-2 HD. The following procedure describes which connector to use. To find the exact 
location, see “Video/LTC Connections (MPEG-2 HD Model)” on page 54.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.
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The following illustration shows the location of the SDI OUT video connectors on the rear 
of the AirSpeed Multi Stream MPEG-2 HD chassis.

To connect SDI video output cables on the MPEG-2 HD model chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI output signal to an outgoing SDI output (one of the eight labelled 
OUT1-8) for AirSpeed Multi Stream MPEG-2 HD models. 

Up to four SDI outputs are available for sending SDI signals out to your other devices.

3. Connect the other end of all SDI output cables to your devices that are receiving the 
output signal from the AirSpeed Multi Stream MPEG-2 HD.

Connecting SDI Video Output Cables (for DNxHD Models)

The SDI Video Output connections are marked on the rear of the AirSpeed Multi Stream 
DNxHD. The following procedure describes which connector to use. To find the exact 
location, see “Video/LTC Connections (DNxHD Model)” on page 56.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.
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The following illustration shows the location of the SDI OUT video connectors on the rear 
of the AirSpeed Multi Stream DNxHD chassis.

To connect SDI video output cables on the DNxHD model chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI output signal to an outgoing SDI output (one of the four labelled 
OUT1-4) for AirSpeed Multi Stream DNxHD models. 

Up to four SDI outputs are available for sending SDI signals out to your other devices.

3. Connect the other end of all SDI output cables to your devices that are receiving the 
output signal from the AirSpeed Multi Stream DNxHD.

Connecting SDI Video Output Cables (for AVC-Intra Models)

The SDI Video Output connections are marked on the rear of the AirSpeed Multi Stream 
AVC-Intra. The following procedure describes which connector to use. To find the exact 
location, see “Video/LTC Connections (AVC-Intra Model)” on page 58.

n When an AirSpeed Multi Stream channel is in Record mode, the signal present at the video 
input will display on the corresponding video output.
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The following illustration shows the location of the SDI OUT video connectors on the rear 
of the AirSpeed Multi Stream AVC-Intra chassis.

To connect SDI video output cables on the AVC-Intra model chassis:

1. Ensure that you have the proper SDI video (75 ohm-rated) interface coaxial cables 
available.

2. Connect the SDI output signal to an outgoing SDI output (one of the four labelled 
OUT1-4) for AirSpeed Multi Stream AVC-Intra models. 

Up to four SDI outputs are available for sending SDI signals out to your other devices.

3. Connect the other end of all SDI output cables to your devices that are receiving the 
output signal from the AirSpeed Multi Stream AVC-Intra.

Connecting Time of Day (TOD) LTC Cables

The LTC IN/THRU connections are clearly marked on the rear of the AirSpeed Multi 
Stream. The AirSpeed Multi Stream automatically synchronizes the system clock to LTC IN 
if the signal is present. If the signal is not present, interrupted, or invalid, the system clock 
will be used. LTC can be used for a record indirectly by selecting TOD (Time of Day). This 
uses the system clock as a reference for time code. 

The following procedure describes which connector to use. To find the exact location, see 
“Video/LTC Connections (MPEG-2 HD Model)” on page 54.

To connect longitudinal timecode (LTC) in/loop thru cables:

t Connect your time of day (TOD) LTC timecode source to one of the connectors 
(labelled LTC IN/THRU) as shown in the following diagram.
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If the AirSpeed Multi Stream is the last device in your reference loop, terminate the 
remaining LTC Loopthrough connector with a 75 ohm-rated terminator. If the AirSpeed 
Multi Stream is in the middle of your LTC loop, connect the remaining LTC IN/THRU 
connector to the next device’s LTC input.

Connecting Control and Communications Cables

The following figure identifies the connectors used to connect the control and 
communication cables. The illustration shows the rear of the MPEG-2 HD model. The 
location of the control and communication connections is the same for all models. For the 
exact location of the control and communication connectors, see “Control Connections (All 
Models)” on page 50. 

For more information, see the following topics:

• “Connecting USB Devices (Mouse and Keyboard)” on page 80

• “Connecting Ethernet Cables” on page 80

• “Connecting to AirSpeed Multi Stream Over the Network” on page 81

• “Connecting Expansion Port Cables” on page 82

• “Connecting Remote Serial Cables” on page 83

• “Connecting the Console Cables” on page 84
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Connecting USB Devices (Mouse and Keyboard)

You need to provide a standard USB compatible keyboard and mouse. The keyboard and 
mouse plug directly into either of the USB ports on the rear of the chassis. Or, if you have a 
splitter, you can connect both to one USB connecter and leave the other USB connector open 
for other purposes (such as a removable USB hard drive). 

n Some USB flash devices might not appear in a Safely Remove Hardware dialog box even 
though they are plugged in. In addition, it might take several seconds for a USB device to be 
available to the system.

To connect the keyboard and mouse cables:

1. Connect a USB compatible mouse to one of the USB connectors on the rear of the 
AirSpeed Multi Stream.

2. Connect the USB compatible keyboard to the other USB connector on the rear of the 
AirSpeed Multi Stream.

Connecting Ethernet Cables

All AirSpeed Multi Stream models come equipped with four Ethernet connectors. Although 
all four are functional, we currently support the use of two connectors (Ports 1 and 2) in a 
redundant configuration. 

However, Port 4 is reserved for use for connecting and configuring the AirSpeed Multi 
Stream over a network interface. 
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For more information on connecting and configuring the AirSpeed Multi Stream in this 
manner, see “Connecting to AirSpeed Multi Stream Over the Network” on page 81

These connections are not gangable. Zone 2 configuration is supported. 

The illustration shows the rear of the MPEG-2 HD model. The location of the Ethernet 
connectors is the same for all models.

If you do not have a redundant DNS configuration, use one connection to your shared 
storage using a static IP address.

To connect the Ethernet cable:

t Connect an Ethernet CAT-5E or CAT-6 cable with a RJ-45 connector from the GigE 
connector to a Gigabit (1000BASE-T) Ethernet switch. 

Example Showing Ethernet Port Connections

Connecting to AirSpeed Multi Stream Over the Network

You can connect a PC (a remote PC or laptop, for example) to the AirSpeed Multi Stream 
via the Port 4 Ethernet connection on the rear panel. This allows you to bring the AirSpeed 
Multi Stream online over a network interface using a remote PC or laptop, a network cable, 
and VNC software. The benefit of this setup is that you can perform all required AirSpeed 
Multi Stream configuration via VNC, and bring the AirSpeed Multi Stream to 
operational/production status without the use of a direct attached keyboard, monitor, or 
mouse.

Before you can connect to the AirSpeed Multi Stream, you must have the following:

• a remote PC or laptop

• a network cable

• VNC software installed on the laptop
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RJ-45 cable (Cat 5E or better) 
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To connect to AirSpeed Multi Stream over the Network:

1. Power on both the AirSpeed Multi Stream and the remote PC or laptop that you are 
using to connect to it.

2. Connect the network cable from the remote PC or laptop to the ETHERNET Port 4 on 
the AirSpeed Multi Stream.

3. On the remote PC or laptop, change your IP address to 192.168.0.11, and Subnet Mask 
to 255.255.255.0.

n For information on how to change the IP address, follow the procedures for your Operating 
System (OS).

4. From the remote PC or laptop, use the VNC software to connect to the AirSpeed Multi 
Stream over the network. The IP address of the AirSpeed Multi Stream is 192.168.0.10.

5. You are now ready to configure the AirSpeed Multi Stream from the remote PC or 
laptop over the network. For more information, see “Setting Up Your System” on page 
85.

Connecting Expansion Port Cables

The Expansion Port connections on the AirSpeed Multi Stream are for your  GPIO devices. 

Each Expansion port has 4 LTC out BNCs (1 per SDI channel, LTC 1-4), and a General 
Purpose I/O Pins Connector (DB25), and other connections that are not enabled in the 
current version.

n These ports are not to be used to connect VGA monitors.

If you have a GPIO device that you want to control, you must connect it to one of the GPIO 
connectors labelled EXPANSION PORT 1 or EXPANSION PORT 2 as shown in the 
example below:
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The Avid supplied Expansion Port cable is shown below:

To connect the Expansion Port cable:

1. Connect the 29-pin connector to the port labelled EXPANSION PORT 1. The other end 
of the cable depends on the GPIO interface on the device you are controlling. 

For more information on GPIO connector specifications and DB25 pin assignments, see 
“Expansion Port Connector Specifications” on page 128

2. Connect the other end of the Expansion Port cable to your timecode recording devices. 
The BNC connectors labelled A, B, C, and D are for your LTC Out connections 1, 2, 3, 
and 4, respectively. 

The BNC connector labelled E is for future expansion.

3. Repeat steps 1-2 using EXPANSION PORT 2 if connecting LTC to another GPIO 
device.

Connecting Remote Serial Cables

The following illustration shows the equipment needed to connect a serial controller device 
to an AirSpeed Multi Stream server, using standard RJ-45 Category 5 Ethernet cable. This 
cable must be a straight cable with all eight conductors wired. For details on each RJ-45 
connector with signals, see “RS-422 Serial Remote RJ45 Connector Specifications” on page 
356.

SERIAL
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To connect remote serial cables:

1. Connect one end of a RJ-45 serial cable to any of the corresponding Serial outputs. 

By default, the serial ports are labelled 1-8.

2. Connect the other end of the serial cable to your RS-422 device, such as an automation 
system or edit controller. 

The remote ports can be used for: 

- Remote control via VDCP protocol

- Sony BVW protocol 

3. Connect additional remote ports by repeating steps 1 and 2. If you want to configure 
these ports, see “Configuring Channels for Remote Control with Avid iNEWS 
Command, CaptureManager, or Interplay Capture” on page 130.

Connecting the Console Cables

The CONSOLE input is an RS-232 port that is not for customer use. Avid uses this port for 
terminal access to the AirSpeed Multi Stream to perform diagnostic tests.

To connect to the console:

1. Attach one end of the RS-232 cable to the Console input on the back of the AirSpeed 
Multi Stream chassis.

2. Connect the other end to your RS-232 device. 

Connecting the VGA Cables

The VGA input is used to connect a VGA monitor to the AirSpeed Multi Stream.

To connect to the VGA:

1. Attach one end of the VGA cable to the VGA input on the back of the AirSpeed Multi 
Stream chassis.

2. Connect the other end to your VGA monitor. 

CONSOLE

VGA

Console input

CONSOLE

VGA
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Connecting the Power Cords

The last step you must perform when cabling up your AirSpeed Multi Stream is to connect 
the power cords. Two U.S. IEC power cords are shipped with the . If your local power 
distribution is not compatible with the supplied cords, you must provide your own IEC 
power cables that are compatible with your country’s power system. The power connector 
accepts 100 to 240 Vac, 50/60 Hz.

To connect power:

1. Attach the power cords to both power receptacles on the rear of the AirSpeed Multi 
Stream.

The system will power on after you connect the first power supply. The Monitor 
application will automatically launch. AirSpeed Multi Stream and Transfer Engine also 
launch.

2. Connect the other end of both power cords to a properly grounded stable power source. 

Once powered on, you must set up your system. For more information, see “Setting Up 
Your System” on page 85. 

c For maximum power protection, Avid recommends a surge protected uninterruptible 
power supply (UPS). 

Setting Up Your System

Once you have cabled up your AirSpeed Multi Stream, and the system is powered on, you 
must perform some basic system setup before you configure the software.

The default Administrator password is blank. Press Enter. Do not try to type a password.

n Some USB flash devices might not appear in a Safely Remove Hardware dialog box even 
though they are plugged in. In addition, it might take several seconds for a USB device to be 
available to the system.

Power cord

receptacles
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AirSpeed Multi Stream System Setup Checklist

The following table provides a checklist of tasks that must be performed when setting up 
your AirSpeed Multi Stream system.

Before beginning the upgrade or installation process, be sure to close all running AirSpeed 
Multi Stream applications on the server. The most convenient way to do this is to close the 
Monitor application. When closing the Monitor application you will see a dialog box asking 
you to confirm that you want the AirSpeed Multi Stream application(s) closed.  By selecting 
‘Yes’, the AirSpeed Multi Stream application(s) will be closed and will not restart 
automatically. 

n Make sure that you only close AirSpeed Multi Stream applications when they are idle, with 
no records, playouts or transfers in progress.

Change the computer name, as described in the topic “Changing the Computer Name” on 
page 87 of this guide.

Adjust the date, time, and time zone, as described in the topic “Adjusting the Date, Time and 
Time Zone” on page 87 of this guide.

Based on whether you are setting up a new system or reimaging an existing system, you 
need to either configure or reconfigure your media drives for RAID 0 striping.

If you are setting up a new system in which the media drives have not yet been RAID 0 
striped in Windows, you should follow the procedure as described in “Configuring Media 
Drives for RAID 0 Striping” on page 88.

If you are reimaging an existing system in which the media drives have already been RAID 
0 striped in Windows, you should follow the procedure as described in “Reconfiguring 
Media Drives for RAID 0 Striping (for Previously Striped Drives)” on page 89.

Verify your network connection, as described in “Verifying Your Network Connection” on 
page 92.

(Option) Create a Windows User Account on the AirSpeed Multi Stream, as described in 
“Creating a Windows User Account on the AirSpeed Multi Stream” on page 92.

Configure your shared storage, as described in “Configuring Your Shared Storage 
(Workgroup or Team Only)” on page 93.

Set up remote access to the AirSpeed Multi Stream server, as described in “Setting Up 
Remote Access to the AirSpeed Multi Stream Server” on page 94.
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Changing the Computer Name

This topic contains information on how to change the computer name on your AirSpeed 
Multi Stream system.

To change the computer name:

1. Select Start > Settings > Control Panel.

The Control Panel opens.

2. Click on the System icon.

The System Properties dialog box opens.

3. Click on the Computer Name tab.

4. Click the Change button.

The Computer Name Changes dialog box opens.

5. Type a new computer name in the Computer Name field, and click OK to close the 
Computer Names Changes dialog box. 

The System Properties dialog box opens.

n You must restart your system for changes to take effect.

6. Click OK on the System Properties dialog box to close it.

The System Settings Change dialog box opens. You will be asked to restart your 
computer now.

7. Click Yes.

8. Restart your system.

9. The next step is to adjust the date, time and time zone for your site. For more 
information, see “Adjusting the Date, Time and Time Zone” on page 87.

Adjusting the Date, Time and Time Zone

When your system ships out, it might not have the correct date, time and time zone set up for 
your site. You must determine if this information must be changed and then change it, if 
necessary. This topic contains information on how to adjust the date, time, and time zone for 
your site.

To adjust the date, time and time zone:

1. Double-click on the system time in the lower right corner of the screen.

The Date and Time Properties dialog box opens.

2. In the Date & Time tab, change the date and time to be accurate for your site.
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3. Click on the Time Zone tab.

4. Select the time zone for your site from the drop menu.

5. Click OK to close the dialog box.

6. The next step is to configure your media drives for RAID 0 Striping. For more 
information, see “Configuring Media Drives for RAID 0 Striping” on page 88.

Configuring Media Drives for RAID 0 Striping

With all of your media drives inserted, and the AirSpeed Multi Stream powered on, you need 
to configure your media drives for RAID 0 striping within Windows. 

n If this system has previously configured for RAID 0 striping wihtin Windows, and you are 
reimaging the system, you must reconfigure your Media drives for RAID 0 Striping within 
Windows. For more information, see “Reconfiguring Media Drives for RAID 0 Striping (for 
Previously Striped Drives)” on page 89.

n Make sure there are no external disks, DVD drives, including USB DVD drives attached to 
the system.

n Make sure that all Avid applications or Windows applications ( such as Disk Management ) 
that would use the Media disk drive are not running.

For more information, see “Creating RAID 0 Striping in Windows” on page 88.

Creating RAID 0 Striping in Windows

This topic contains information on how to create RAID 0 striping in Windows.

To create RAID 0 Striping in Windows:

1. Power on the AirSpeed Multi Stream.

2. Navigate to C:\Installables\Utils\Windows\Scripts. 

There are two batch files in this folder that you need to run.

3. Double-click the CreateMediaRaid.bat file to run the batch file.

4. In the same folder (C:\Installables\Utils\Windows\Scripts), double-click the 
FormatMediaRaid.bat file to run the batch file.

5. Right-click on the “My Computer” icon on the desktop, and select Manage.

The Computer Management dialog box opens.
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6. Under the Storage icon, click the Disk Management icon. 

The Computer Management dialog box should look like the following example:

7. Clos ethe Computer Management dialog box. The next step is to verify your network 
connection. For more information, see “Verifying Your Network Connection” on page 
92.

Reconfiguring Media Drives for RAID 0 Striping (for Previously Striped 
Drives)

This procedure should be used only if this system has been previously configured for RAID 
0 Striping within Windows. If it has not, you should perform the procedure for new systems 
with unstriped drives in the topic “Configuring Media Drives for RAID 0 Striping” on page 
88.

n Make sure there are no external disks, DVD drives, including USB DVD drives, attached to 
the system.
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n Make sure that all Avid applications or Windows applications ( such as Disk Management ) 
that would use the Media disk drive are not running.

To reconfigure Media Drives for RAID 0 Striping within Windows:

1. Right-click on My Computer, and select Manage from the menu.

The Computer Management dialog box opens.

2. Click Disk Management in the left pane.

3. Right-click on any “Foreign” disk, and select Import Foreign Disks from the menu.

The Import Foreign Disks dialog box opens.
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4. Make sure the Foreign disk group (4 of 4 disks) check box is selected, and click OK.

The Foreign Disk Volumes dialog box opens.

5. Click OK.

All Media disks will be reconfigured back to RAID 0 striping as shown below.

6. Close the Computer Management dialog box. The next step is to verify your network 
connection. For more information, see “Verifying Your Network Connection” on page 
92.



2  Installing the Hardware and Setting Up Your System

92

Verifying Your Network Connection

Once you have the AirSpeed Multi Stream server connected to your network, you should 
verify your network connection. This involves assigning a static or dynamic IP address 
based on the requirements for your site. This enables you to communicate with your shared 
storage infrastructure (ISIS or MediaNetwork). You should be able to get this information 
from your site’s Administrator. 

For information on setting up with ISIS, see the Avid Unity ISIS Setup Guide.

For information on setting up with MediaNetwork, see the Avid Unity Media Engine and 
Avid MEDIArray XT Setup Guide.

n When mounting volumes on ISIS, make sure that you use the UNC pathway only. Do not use 
the lettered drive as this will affect the performance of your system.

Creating a Windows User Account on the AirSpeed Multi Stream

When configuring your shared storage, it might be good practice to create a Windows user 
account (with Admin rights) with an AirSpeed Multi Stream user name and matching 
password (recommended Avid1234) that is consistent with an Interplay and ISIS user name 
and password.

n The password does not have to be the same for all three (AirSpeed Multi Stream, ISIS, and 
Interplay). It should be the same for AirSpeed Multi Stream and ISIS, but the Interplay user 
name and password can be different depending on security for your site.

n If you have the AirSpeed Multi Stream application installed, but not fully configured, the 
Monitor application will keep popping up. You can disable the Monitor application by 
closing the AirSpeed Multi Stream Application Monitor dialog box, and then clicking OK in 
the Monitor dialog box to exit and shut down.

To create a Windows user account on the AirSpeed Multi Stream:

1. Right-click on the “My Computer” icon on the desktop, and select Manage from the 
menu.

The Computer Management dialog box opens

2.  Select Local Users and Groups in the left pane.

3. Double-click the Users folder in the right pane to open it.

4. Right-click in the right pane, and select New User from the menu.

The New User dialog box opens.
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5. Type the user name in the User name field.

The Full Name and Description fields are optional.

6. Type a password for this user account in the Password field.

7. Retype the password in the Confirm password field.

8. Uncheck the “User must change password at next logon” option. 

9. Select the “Password never expires” option.

10. Click the Create button.

The new user is created and appears in the right pane of the Computer Management 
dialog box.

11. Right-click on the new user you just created, and select Properties.

The Properties dialog box for this user opens.

12. Click the Member Of tab, and then click the Add button.

13. In the “Enter the object names to select” field, type Administrators.

14. Click the Check Names button. 

The full group will be added to this user.

15. Click OK.

This user is now also a member of the Administrators Group.

Configuring Your Shared Storage (Workgroup or Team Only)

If you will be using AirSpeed Multi Stream with Shared storage (with or without Inteprlay), 
you must configure your shared storage for ISIS or MediaNetwork.

This topic is mandatory for Workgroup and Team configurations. If you are using a 
Standalone Transfer Manager, you do not have to perform this procedure.

To configure your shared storage:

1. Install the ISIS or MediaNetwork client software on the AirSpeed Multi Stream server.

2. It is recommended that you mount the volume that you intend to capture to.

For more information, see the Avid Unity ISIS Setup Guide, or the Avid Unity Media 
Engine and Avid MEDIArray XT Setup Guide.

n For MediaNetwork connectivity, AirSpeed Multi Stream uses a Client configuration, not a 
Server configuration. For more information, see your MediaNetwork documentation.
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Setting Up Remote Access to the AirSpeed Multi Stream Server

To remotely access the AirSpeed Multi Stream server from another system, we support the 
use of both VNC and Remote Desktop remote access tools.

To set up remote access to the AirSpeed Multi Stream server:

1. Select the third party remote access tool of your choice.

2. Set up remote access to the AirSpeed Multi Stream server. For more information, see the 
documentation for your remote access tool (VNC, or Remote Desktop).

When you are done, you can configure the software on the AirSpeed Multi Stream 
Server for the environment that you want to use at your site. For information on 
determining which configuration to use, see “Determining Your AirSpeed Multi Stream 
Environment” on page 96.



3 General Configuration Procedures

This chapter provides information on the general configuration procedures used when 
configuration all AirSpeed Multi Stream servers for all AirSpeed Multi Stream 
environments. There are some steps that only apply to certain environments, and not others. 
If you are not sure which environment you are configuring the AirSpeed Multi Stream server 
for, see “Determining Your AirSpeed Multi Stream Environment” on page 96.

For more information, see the following topics:

• General Information

• AirSpeed Multi Stream Configuration Checklist

• Optional AirSpeed Multi Stream Configuration Procedures

n Prior to proceeding with AirSpeed Multi Stream software configuration, ensure that your 
AirSpeed Multi Stream is installed and connected using the information in “Installing the 
Hardware and Setting Up Your System” on page 61.

General Information

Before performing these general configuration procedures, you should read the topics in this 
section first to see how they apply to your configuration.

For more information, see the following topics:

• Determining Your AirSpeed Multi Stream Environment

• User Names and Passwords

• License Agreements
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Determining Your AirSpeed Multi Stream Environment

Before you complete the General Configuration Procedures outlined in this chapter, you 
need to know which configuration your AirSpeed Multi Stream will use in it’s environment. 

• If you want to set up your AirSpeed Multi Stream in a Workgroup environment, this 
means the AirSpeed Multi Stream operates as a member of an integrated Interplay 
workgroup to utilize built in Interplay Transfer and Shared storage. For more 
information, see “Configuring the Software in a Workgroup Environment” on page 99.

• If you want to set up your AirSpeed Multi Stream in a Standalone Transfer Manager 
environment, this means AirSpeed Multi Stream uses only its own internal storage for 
storing clips and supports playing out to air via drag and drop using the AirSpeed Multi 
Stream Remote Console. In this configuration, clips are visible through Remote Console 
event listings and can be used to drag and drop files in environments where multiple 
AirSpeed Multi Stream servers are used. For more information, see “Configuring the 
Software with a Standalone Transfer Manager” on page 155.

• If you want to set up your AirSpeed Multi Stream in a Team environment, this means 
AirSpeed Multi Stream uses shared storage (no Interplay), and clips are visible through 
the AirSpeed Multi Stream Remote Console which can be used to drag and drop files 
into the Editor bin, or you can configure the Airspeed Multi Stream to transfer the clips 
directly to Shared storage. In a Team configuration, the AirSpeed Multi Stream 
application does not require Interplay to transfer media to storage. For more 
information, see “Setting Up for Team Configuration” on page 179.

Continue the procedures outlined in this chapter, and when you are done, refer to the 
appropriate configuration chapter for information specific to how to configure the AirSpeed 
Multi Stream software for the environment in which it will be used at your site.

User Names and Passwords

It is important to have the correct user names and passwords for your AirSpeed Multi Stream 
environment. For more information on the requiremenrts for your environment, see the 
following topics:

• “User Names and Passwords for Interplay and ISIS Environments” on page 97

• “User Names and Passwords When Using a Standalone Transfer Manager” on page 97
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User Names and Passwords for Interplay and ISIS Environments

When you are adding an Avid AirSpeed Multi Stream server in an Interplay workgroup, it is 
important to have consistent user names and passwords throughout your AirSpeed Multi 
Stream, Interplay, and ISIS clients. For example, you could set up and use the following 
accounts:

• On the AirSpeed Multi Stream server, set up a Windows user account (with Admin 
rights) with an AirSpeed Multi Stream user name and matching password 
(recommended Avid1234) 

• In the Interplay Administration tool, create the same user with the same password. This 
user must have Read/Write permission to the Interplay folders that the AirSpeed Multi 
Stream will use for checkin.

• In the Avid Unity Administration tool, set up the same user with the same password. 
This user must have Read/Write permission to the appropriate workspaces.

• Use this same user when configuring the AirSpeed Multi Stream in the Open 
Framework Service Configuration dialog box.

n You must use the exact user and password names. Passwords are case sensitive.

User Names and Passwords When Using a Standalone Transfer Manager

When you configure the Avid AirSpeed Multi Stream server with a Standalone Transfer 
Manager for either Local or Shared storage, it is important to have consistent user names and 
passwords throughout your Avid Editor, AirSpeed Multi Stream server, and Shared Storage 
clients. For example, you must set up and use the following accounts:

• On the Avid Editor, you must create an OS level user.

• On the AirSpeed Multi Stream server:

- Create an OS level user with the same user name and password as that on the Avid 
Editor.

- (For Standalone Transfer Manager configurations with local storage) Share your E: 
drive with Full control.

• (Option) If using Shared storage, in your Shared Storage environment, set up the same 
user with the same password. This user must have Read/Write permission to the 
appropriate workspaces.

n Passwords are case sensitive.

License Agreements

Once the AirSpeed Multi Stream is launched, you must accept the Avid End User License 
Agreement.
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Configuration Requirements for AirSpeed Multi Stream

Each AirSpeed Multi Stream must be configured with the following:

•  Site-specific settings need to be applied for the AirSpeed Multi Stream to operate with 
a standalone Transfer Manager and shared storage. Each AirSpeed Multi Stream server 
that is installed needs to be uniquely configured. 

• You must create a site-specific host name/domain name of the AirSpeed Multi Stream, 
including an IP address and mask for the network interface.

• The Shared Storage Client for Avid Unity ISIS 5000, ISIS 7000, or MediaNetwork 
(ethernet attached).

Once these requirements are met, and you have installed all of the necessary hardware and 
software for your site, you can configure the AirSpeed Multi Stream. For more information 
on specific tasks involved when configuring your AirSpeed Multi Stream, see “AirSpeed 
Multi Stream Configuration Checklist” on page 98.

AirSpeed Multi Stream Configuration Checklist

The following table provides a checklist of tasks that must be performed when configuring 
your AirSpeed Multi Stream. 

n Depending on your site’s configuration, some tasks are optional.

(Option) If your site uses Avid iNEWS Command or CaptureManager, or Interplay 
Capture to control AirSpeed Multi Stream channels for capture or playout, you need to 
install the Interplay AirSpeed Multi Stream Device Service on the AirSpeed Multi 
Stream server. For more information, see “(Option) Installing the AirSpeed Multi Stream 
Device Service” on page 99.

(Option) Share your E: drive with full control. This step is required only if you are 
configuring your AirSpeed Multi Stream with a Standalone Transfer Manager, as 
described in “(Option) Sharing the E: Drive on the AirSpeed Multi Stream Server” on 
page 100

For specific information on Standalone Transfer Manager configuration, see “Standalone 
Transfer Manager Configuration” on page 156.

Create a new database and set a default database, as described in “Creating a New 
Database in the AirSpeed Multi Stream Application” on page 100.

Configure Channels on AirSpeed Multi Stream, as described in “Configuring Channels” 
on page 104.
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(Option) Installing the AirSpeed Multi Stream Device Service

If your site uses Avid iNEWS Command or CaptureManager, or Interplay Capture to control 
AirSpeed Multi Stream channels for capture or playout, you need to install the Interplay 
AirSpeed Multi Stream Device Service on the AirSpeed Multi Stream server. The AirSpeed 
Multi Stream Device Service (located on the Command or Interplay Capture DVD) needs to 
be installed on the AirSpeed Multi Stream server that is being controlled by either 
Command, CaptureManager, or Interplay Capture.

To install AirSpeed Multi Stream Device Service on the AirSpeed Multi Stream server:

1. Locate your Avid iNEWS Command or Interplay Capture DVD, or navigate to 
somewhere on your network where it is located.

2. Navigate to the Avid_Framework_Workstation folder in the installation location for 
your site.

3. Double-click the AvidAirSpeedMultiStreamDeviceService.exe to launch the installer.

A splash screen appears, followed by a Welcome dialog box.

4. Click Next. 

The License Agreement dialog box opens.

5. Read the License Agreement, accept the terms, and click Next. 

6. Click Install to install the AirSpeed Multi Stream Device Service. 

7. You now must create a new database for the AirSpeed Multi Stream. For more 
information, see “Creating a New Database in the AirSpeed Multi Stream Application” 
on page 100.

(Option) If you are using Avid iNEWS Command to control AirSpeed Multi Stream, you 
must configure AirSpeed Multi Stream Channels for Remote Control with Avid iNEWS 
Command , as described in “Configuring Channels for Remote Control with Avid 
iNEWS Command” on page 116.

(Option) Configure Communication Protocols in AirSpeed Multi Stream, assuming you 
have external devices that will control AirSpeed Multi Stream (such as automation 
systems), as described in “Configuring Communication Protocols in AirSpeed Multi 
Stream” on page 120.

(Option) Configure General Purpose Interface (GPI) Inputs and Outputs in AirSpeed 
Multi Stream, as described in “Configuring General Purpose Interface (GPI) Inputs and 
Outputs” on page 122.

Configure your Avid Editor to work with AirSpeed Multi Stream, as described in 
“Configuring Your Avid Editor to Work with AirSpeed Multi Stream” on page 124.
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(Option) Sharing the E: Drive on the AirSpeed Multi Stream Server

Once you have the AirSpeed Multi Stream server connected to your network, you must 
verify that your system is set up to allow “Everyone” “Full control” sharing permissions, and 
to share your E: drive. 

n This procedure is required for Standalone Transfer Manager configurations.

To share your E: drive:

1. Double-click on the “My Computer” icon on the desktop.

The Explorer window opens.

2. Right-click on the WINDOWS_MEDIA_RAID(E:) volume, and select “Sharing and 
Security” from the list.

The WINDOWS_MEDIA_RAID(E:) Properties window opens.

3.  In the Sharing tab, click the New Share button.

The New Share dialog box opens.

4. Type “E” in the Share name field.

5. Click the Permissions button.

The Permissions for E dialog box opens.

6.  Click “Everyone” and “Allow Full Control” options.

7. Click OK to close the dialog box, and save the sharing.

Creating a New Database in the AirSpeed Multi Stream Application

When you create a new database in the AirSpeed Multi Stream application, you must set it to 
the default database. 

n We recommend that you only create one database on the AirSpeed Multi Stream.

To create a new database in the AirSpeed Multi Stream application:

1. Launch the AirSpeed Multi Stream application.

2. Select File > Advanced > Create New Database.

The Create New Database dialog box appears, which allows you to select the location 
and name for the new database.
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n A message dialog box opens saying a record template must be created before a newly 
created database can be used. Click OK to close the dialog box.

3. Enter information indicating where to place the various files that make up the database. 
As you enter data into the Database Path field, AirSpeed Multi Stream will complete 
many of the fields for you. Avid recommends you keep the paths and drives that 
AirSpeed Multi Stream sets under File > Advanced Options.

n AirSpeed Multi Stream requires that the hard disk on which your database will be stored 
must be the E: drive. 

4. Complete the following fields in the Location section of the dialog box:

a. In the Database Name field, type the name of the new database. It can be any name, 
but normally should be easily recognizable to all users (such as NTSC, PAL, 1080i, 
etc.).

b. In the Local Path field, type the full local path name of the directory where the new 
database will reside. This path must include the E:\ drive letter for the local drive 
(such as E:\1080i\)
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c. In the Computer Name field, type the network name of the machine where the 
database is to reside. This can be determined by looking at the network properties in 
the Windows XP Control Panel. AirSpeed Multi Stream fills in this name 
automatically.

d. In the Drive Share Name field, type the share name for the drive where the database 
resides. This can be determined by looking at the properties of the drive in Windows 
XP (right-click on the drive’s icon(E)).

5. Click Create. 

The new database is created. 

The following table describes the Advanced Options (display only) fields in the Create 
New Database Window.

Create New Database Window — Advanced Options  

Setting Description

Advanced Options — Clip 
Location

• Computer Name This field displays the network name of the machine where the clip 
files will reside. You can determine the location by looking at the 
network properties in the Windows XP Control Panel. 

• Local Path This field displays the full local path name of the directory where the 
clip files will reside. This path must include a drive letter for the 
local drive.

• Drive Share Name This field displays the share name for the drive where the clip files 
reside. You can determine the drive by looking at its properties in 
Windows XP (right-click on the drive’s icon).

Advanced Options — Proxy 
Location

• Computer Name This field displays the network name of the machine where the 
proxy files will reside. You can determine the location by looking at 
the network properties in the Windows XP Control Panel. Proxies 
are low-resolution MPEG (.mpg) files playable from your 
workstation.

Local 

• Path

This field displays the full local path name of the directory where the 
proxy files will reside. This path must include a drive letter for the 
local drive.
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6. Next, you want to set a default database. For more information, see “Setting the Default 
Database” on page 103.

Setting the Default Database

Another important task to perform in AirSpeed Multi Stream, especially after you have 
created a new database, is to set a default database. This is especially important if you have 
more than one database.

To designate (set) the default database:

1. Open the database in the Network Tree by selecting File > Open. Then, navigate to the 
“Path” (specified in the Create New Database dialog box). 

2. Select the .pff file and click Open.

3. Right-click the database in the Network tree.

4. From the menu, select Set Default Database. 

The database will automatically open when AirSpeed Multi Stream is restarted. If you 
want to set database options, see “Configuring Auto Logon” on page 126.

5. Restart the AirSpeed Multi Stream application for these changes to take affect. 

Upon restarting the AirSpeed Multi Stream application, the database that you set as the 
Default database will open automatically.

6. Next, you should configure channels on AirSpeed Multi Stream. For more information, 
see “Configuring Channels” on page 104.

• Drive Share Name This field displays the share name for the drive where the proxy files 
reside. You can determine the drive by looking at its properties in 
Windows XP (right-click on the drive’s icon).

Create New Database Window — Advanced Options (Continued)  

Setting Description
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Configuring Channels

When configuring channels on AirSpeed Multi Stream, you use the Channel Configuration 
dialog box. Tasks that can be done in the Channel Configuration dialog box include the 
following:

• Select a channel, and decide if you want its corresponding MiniMonitor to display

• Type a more descriptive name for the channel

• Select the video standard for the channel

• Select the behavior (Play Item, or Cue Item) for the MiniMonitor

• Select the stop behavior (if any) you want for clips on the channel

• Configure the ancillary output for capture and playback

• Select VITC Line numbers for Playback and Record

• Select the appropriate reference (REF IN) connected to the AirSpeed Multi Stream

• Depending on your video standard, select the desired output format behavior you want 
the clip to play out in. Selecting Up/Down/Cross-convert allows you to change output 
conversion settings for clips on a given channel based on the video standard for that 
channel.

Once you click OK, the settings in this dialog box are automatically saved and recalled when 
the AirSpeed Multi Stream application is reopened.

See the Channel Configuration Dialog Box Field Description table for more detailed 
information on the fields in the dialog box.
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Channel Configuration Dialog Box Field Descriptions  

Field Description

Channel Select Use this field to select the channel that you want to configure. Each 
channel maps to the corresponding MiniMonitors in the application 
(Channel 1 maps to MiniMonitor 1, Channel 2 maps to MiniMonitor 2, 
etc.)

In addition, each channel corresponds to the following physical 
connections on the rear of the chassis:

• CH 1 corresponds to IN 1 and OUT 1 (SD or HD)

• CH 2 corresponds to IN 2 and OUT 2 (SD or HD)

• CH 3 corresponds to OUT 3 (SD Playback only)

• CH 4 corresponds to OUT 4 (SD Playback only)

• CH 5 corresponds to IN 5 and OUT 5 (SD or HD) 
*MPEG-2 HD model only

• CH 6 corresponds to IN 6 and OUT 6 (SD or HD) 
*MPEG-2 HD model only

Display Mini-Monitor Determines whether the selected channels corresponding MiniMonitor 
appears. If there is no check mark in this box, the channel is still 
available for playing clips, but the MiniMonitor will not be displayed. 

Channel Name Use this field to type a channel name which will appear in the upper 
right hand corner of the corresponding MiniMonitor. 

Video Standard Use this field to select the video standard for the selected channel.

Mini-Monitor Control Use this field to select the behavior of the MiniMonitor for each channel. 
Options are “Play Item , or “Cue Item”. The default setting for the 
mini-monitor control is “Play Item”. 

• If this field is set to “Play Item”, when loaded into the MiniMonitor, 
the clip automatically begins to play. 

• If this field is set to “Cue Item”, when loaded into the MiniMonitor, 
the clip will cue to the In-point. To play the cued clip, press F12, 
select Air > Take, or press the space bar.

n You can load a clip by double-clicking on a clip in the database, 
dragging and dropping a clip from the database to the 
MiniMonitor, or dragging and dropping a clip between the 
MiniMonitors. When double-clicking or pressing the Spacebar, 
the clip will load into the channel that has been selected and has 
focus.
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Stop Behavior The Stop behavior field contains a check box to activate the menu. 

• Show First of Next only takes effect if there is a cued clip at the time 
of play completion. If there is a cued clip at the time of play 
completion, the cued clip’s first playable frame appears on the 
Output monitor if cued before or after the currently playing clip has 
ended. If there is no cued clip at the time of play completion, the 
currently playing clip will default to what is selected in the 
drop-down menu, regardless of whether the check box is selected. 

For cases where there is no prior clip loaded, the Preset/Cue option 
can be selected in the Protocol Setup dialog box for VDCP to show 
the first frame of the next clip.

• If the Show First of Next check box is not selected, the first frame of 
the next clip will not display if there is a cued clip at the time of play 
completion.

Select the behavior that you want this channel to exhibit when playback 
stops (Show Last Frame, Show Black, etc.)

For more information on Preset/Cue, see “Configuring Communication 
Protocols in AirSpeed Multi Stream” on page 120.

Ancillary Data Selections The Ancillary Data Selections area contains a check box that enables the 
output. For each slot (1-4), you can then select the type of metadata you 
want to input, and ensure the slot is enabled. The fields in this section are 
described below:

• Ancillary Data Output Enabled? - Check this box to allow the 
ancillary data to be played out from the AirSpeed Multi Stream 
server.

• Slot 1-4 - Lists the four available slots for selecting input data 
(metadata).

• Input Data Type - Select the type of metadata you want to input 
based on the video stream.

• DID - Data Identifier. If Custom is selected for this slot, you can 
change these values as desired.

• SDID - Secondary Data Identifier. If Custom is selected for this slot, 
you can change these values as desired.

• Enable - Make sure this check box is selected to enable a slot that 
you want to include metadata for.

Field Description (Continued)
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VITC Information The VITC Information area contains the following fields:

These fields are only available for SD formats. They are greyed out for 
HD formats.

• VITC PlayBack Line # - Enables you to select the playback line 
number that you want to output VITC timecode to.

n For NTSC, VITC playback is supported on Lines 12-19. 

n For PAL, VITC playback is supported on Lines 9-22.

• VITC Record Line# - Enables you to select the record line number 
that you are supplying the VITC timecode on.

Output Time Behavior The Output Time to Follow Clip Time check box is used to control what 
receives output for time information (ATC, VITC) when a clip is played. 
The behavior is as follows:

• When selected, the AirSpeed Multi Stream forces the output 
timecodes to follow along from the base time associated with the 
clip.

• When not selected, the output timecode is based the data in the 
ancillary track.

Field Description (Continued)
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Output Format Behavior This field is used to select the output format behavior for the channel. 
Options and descriptions are as follows: 

• Fixed - Selecting this option only plays clips that are the same as 
your video standard on the selected channel. This is the default.

• Up/Down/Cross-convert - If you select this option, depending on 
the video standard output on the selected channel, and the types of 
clips that you want to play on a given output, those clips would either 
be Up converted, Down converted, or Cross converted (SD or HD) to 
another video standard as selected in the Video Standard list for that 
channel. For more information, see the notes below.

n Up convert refers to any NTSC or PAL clip that is played on a 
720p or 1080i channel.

n Down convert refers to any 720p or 1080i clip that is played on a 
NTSC or PAL channel.

n Cross convert (for HD) refers to any 720p clip that is played on a 
1080i channel, or any 1080i clip that is played on a 720p channel.

n Cross convert (for SD) refers to any NTSC or PAL clip (either 4:3 
or 16:9) that is played on a NTSC or PAL channel with 16:9 or 
4:3 output).

• Autoswitch - If you select this option, the software ignores what the 
video standard is set to for a given channel, and the video standard 
for the channel automatically switches to that of the clip that is 
currently playing in the channel.

Field Description (Continued)



AirSpeed Multi Stream Configuration Checklist

109

UDX Options area This field is used to select the Up/Down/Cross convert options for the 
channel. Options and descriptions for each type of conversion are as 
follows: 

For descriptions and examples of the options, see “Up/Down/Cross 
(UDX) Conversion” on page 37.

SD-Cross-Convert list box options:

• Letterbox - If selected when cross-converting a 16:9 SD image to a 
4:3 SD image, black bars are placed on the top and bottom of the HD 
image. 

• Pillarbox - If selected when cross-converting a 4:3 SD image to a 
16:9 SD image, black “pillars” are placed on either side of the SD 
image. 

• Center-crop - If selected when converting a 16:9 SD image to a 4:3 
SD output, the left and right sides will be cropped off. If the 16:9 
image was a pillarboxed image, the pillars will be removed. 

If selected when converting a 4:3 SD image to a 16:9 SD output, the 
top and bottom will be cropped off. If the 4:3 image was a 
letterboxed image, the black bars will be removed.

• AutoAFD Default Letterbox - If AFD exists in the incoming video, 
this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Letterbox if AFD 
does not exist in the video.

• AutoAFD Default Pillarbox - If AFD exists in the incoming video, 
this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Pillarbox if AFD 
does not exist in the video.

• AutoAFD Default Center-crop - If AFD exists in the incoming 
video, this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Center-crop if 
AFD does not exist in the video. 

For information on the AFD codes used by AirSpeed Multi Stream for 
input and output AFD, including examples of their corresponding video 
formats when performing SD Cross conversion with AirSpeed Multi 
Stream, see Appendix D - “Up, Down, Cross Convert (UDX) Examples” 
on page 385

Field Description (Continued)
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UDX Options area 
(Continued)

Up Convert list box options:

• Pillarbox - If selected when up-converting a 4:3 SD image to a 16:9 
HD image, black “pillars” are placed on either side of the HD image.

• Center-crop - If selected when up-converting a 4:3 SD image that 
already contains a letterboxed image to a 16:9 HD output, this would 
remove the black bars from the top and bottom of the image.

• AutoAFD Default Pillarbox - If AFD exists in the incoming video, 
this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Pillarbox if AFD 
does not exist in the video.

• AutoAFD Default Center-crop - If AFD exists in the incoming 
video, this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Center-crop if 
AFD does not exist in the video. 

• Anamorphic - If selected when up-converting a 16:9 SD image to a 
16:9 HD format, the image would be scaled vertically and 
horizontally using all pixels (anamorphically)

For information on the AFD codes used by AirSpeed Multi Stream for 
input and output AFD, including examples of their corresponding video 
formats when performing Up conversion with AirSpeed Multi Stream, 
see Appendix D - “Up, Down, Cross Convert (UDX) Examples” on 
page 385

Field Description (Continued)
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Configuring Channels on AirSpeed Multi Stream

This topic contains information on how to configure channels on the AirSpeed Multi Stream.

UDX Options area 
(Continued)

Down Convert list box options:

• Letterbox - If selected when down-converting a 16:9 HD image to a 
4:3 SD image, black bars are placed on the top and bottom of the SD 
image.

• Center-crop - If selected when down-converting a 16:9 HD image to 
a 4:3 SD full-screen output, the right and left sides are cropped, and 
if the image was a pillarboxed image, the pillars are removed.

• AutoAFD Default Letterbox - If AFD exists in the incoming video, 
this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Letterbox if AFD 
does not exist in the video.

• AutoAFD Default Center-crop - If AFD exists in the incoming 
video, this setting tells AirSpeed Multi Speed to follow the approach 
outlined in Appendix D of this guide, and will use Center-crop if 
AFD does not exist in the video.

• Anamorphic - If selected when down-converting a 16:9 HD image 
to a 16:9 SD format, the image would be scaled vertically and 
horizontally using all pixels (anamorphically)

For information on the AFD codes used by AirSpeed Multi Stream for 
input and output AFD, including examples of their corresponding video 
formats when performing Down conversion with AirSpeed Multi 
Stream, see Appendix D - “Up, Down, Cross Convert (UDX) Examples” 
on page 385

Reference - Video 
Standard

This field is used to select the type of reference input (REF IN) you have 
connected to the AirSpeed Multi Stream.

Field Description (Continued)
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To configure channels on AirSpeed Multi Stream:

1. Select File > Preferences > Channel Configuration.

The Channel Configuration dialog box opens.

2. Select the channel you want to configure from the Channel Select list box. The channel 
number you select corresponds to the MiniMonitor it will display on. For example 
Channel 1 displays on MiniMonitor 1, Channel 2 displays on MiniMonitor 2, etc.

3. (Option) If you do not want to show the MiniMonitor for this channel, deselect the 
Display Mini-Monitor check box.

4. (Option) In the Channel Name field, change the name of the selected channel by typing 
a new name in the field.

5. (Option) In the Video Standard field, change the video standard for the selected channel 
as required by your site. By default, the video standard is NTSC for all channels.
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6. (Option) Select the behavior of the selected MiniMonitor. The default setting for the 
MiniMonitor control is Play Item.

t If “Play Item” is selected, pressing the space bar plays the clip highlighted in the 
database directly on the channel with focus. 

n The highlight stays on the clip, instead of moving down to the next clip in the database.

t If Cue Item is selected, you can cue the clip instead of playing the clip directly for 
the channel with focus by double-clicking on a clip in the database, dragging and 
dropping a clip from the database to the MiniMonitor, or dragging and dropping a 
clip between the MiniMonitors. To play the cued clip, press F12, select Air > Take, 
or press the space bar.

7. (Option) In the Stop Behavior field, select the check box to activate the menu for you to 
select the stop behavior you want for clips on this channel. Options are Show Black, 
and Show Last Frame.

n If this channel is controlled by VDCP, and there is no clip loaded, and "Preset/Cue" is 
enabled in the Protocol Setup dialog box, the clip will be loaded with the first frame shown 
on the output.

8. (Option) In the Reference - Video Standard field, select the appropriate reference (REF 
IN) connected to the AirSpeed Multi Stream.

9. (Option) In the Ancillary Data section, configure channels for ancillary timecode 
capture and playback.

For more information on how to configure channels to capture ancillary data timecode, 
see “Configuring Channels for Capturing Ancillary Timecode” on page 115.

For more information on how to configure channels to play back ancillary timecode, see 
“Configuring Channels for Playing Out Ancillary Timecode (SD Only)” on page 115.

10. (Option for SD formats only) To select playback and record line numbers for VITC, do 
the following:

a. In the VITC PlayBack Line # field, select the playback line number that you want to 
output VITC timecode to.

b. In the VITC Record Line # field, select the record line number that you are 
supplying the VITC timecode on.

11. (Option) Use the Output Time to Follow Clip Time check box to control what receives 
output for time information (ATC, VITC) when a clip is played. The behavior is as 
follows:

- When selected, the AirSpeed Multi Stream forces the output timecodes to follow 
along from the base time associated with the clip.

- When not selected, the output timecode is based the data in the ancillary track.
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12. (Option) To change the output format behavior for this channel, in the Output Format 
Behavior list box, select the output format behavior you want for this channel. Options 
are:

t Fixed (default) - This option (which is the default) only plays clips that are the same 
as your video standard on the selected channel.

t Up/Down/Cross Convert - If you select the Up/Down/Cross Convert option, the 
video standard that is set for this channel, and the type of clip you want to output 
(PAL/NTSC, 1080i, or 720p) determines whether the behavior is an Up, Down, or 
Cross conversion. If you select this option, you must perform Step 13. Otherwise, 
go to Step 14.

t Autoswitch - If you select the Autoswitch option, the system ignores what the video 
standard is set to for a given channel, and the video standard for the channel 
automatically switches to that of the clip that is currently playing in the channel.

13. (Option) Select the option for the type of conversion you want AirSpeed Multi Stream to 
perform on the incoming video from the appropriate list box. Available list boxes are:

- SD-Cross-Convert

- Up-Convert

- Down-Convert

For example, if you want to configure an Up convert, you would select an option from 
the Up-Convert list box in the UDX Options area, and so on.

For descriptions of the UDX options and their behavior, see the “Channel Configuration 
Dialog Box Field Descriptions” table in this topic “Configuring Channels” on page 104.

n If you want ancillary data to be preserved, make sure the Ancillary Data Output Enabled? 
check box is selected.

14. When you are finished configuring this channel, repeat this procedure for each 
additional channel that you want to configure. 

15. Click OK to close the Channel Configuration dialog box.

n If you change the video standard of the channel, you must restart the AirSpeed Multi Stream 
application for the change to take effect.

16. (Option) If you want to lock channels to MiniMonitors to prevent accidental changes, 
see “Locking Channel Assignments” on page 128.

17. Restart the AirSpeed Multi Stream application for your video standards to take effect.

18. Next, if Transfer Manager is not launched you will need to launch it. For more 
information on launching Transfer Manager, see “Starting the Interplay Transfer Engine 
on the Avid Editor” on page 163.
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Configuring Channels for Capturing Ancillary Timecode

This topic contains information on how to configure channels for capturing ancillary 
timecode.

To configure channels for capturing ancillary timecode:

1. On the Channel Configuration dialog box, make sure one of your slots is configured for 
Ancillary Time Code (ATC), and that it is enabled. This means the Enable check box 
must be selected.

2. Highlight a capture channel, and either select Edit > Template, or right-click the 
MiniMonitor and select Edit Template.

The Template for Channel (number of channel you selected) dialog box opens.

3. Select the Clip tab.

4. In the TC Src field, select ATC (ancillary time code) from the pull down menu.

5. Click OK.

Your AirSpeed Multi Stream is now set to capture ancillary timecode. To configure your 
system for playing out ancillary timecode, see “Configuring Channels for Playing Out 
Ancillary Timecode (SD Only)” on page 115.

Configuring Channels for Playing Out Ancillary Timecode (SD Only)

You have the ability to have a data track available for use in your Editing application, and 
when the composition is complete, you can send it to the AirSpeed Multi Stream server and 
it will play out the preserved ancillary data from the composition.

There are minimum software requirements for being able to use the HD Ancillary Data 
preservation functionality. For more information, see “Digital Input and Output Selection” 
on page 29.

This topic contains information on how to configure SD channels for playing out ancillary 
timecode.

To configure SD channels for playing out ancillary timecode:

1. On the Channel Configuration dialog box, for a selected channel, select the Ancillary 
Data Output Enabled? check box.

2. In the VITC Playback Line # field, if you want to regenerate the timecode based on the 
clip start time for this channel, select Output Time to Follow Clip Time.

Your AirSpeed Multi Stream is now set to play out ancillary timecode. To configure 
your system for capturing ancillary timecode, see “Configuring Channels for Capturing 
Ancillary Timecode” on page 115.
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Configuring Channels for Remote Control with Avid iNEWS Command

This topic contains information for configuring AirSpeed Multi Stream channels for remote 
control with an Avid iNEWS Command system. 

Before you configure AirSpeed Multi Stream channels for remote control with Command, 
all of the hardware and software pertaining to the AirSpeed Multi Stream server must be 
installed and configured, including the AirSpeed Multi Stream Device Service (from the 
Avid iNEWS Command DVD).

n Regardless of whether the AirSpeed Multi Stream is a capture and/or playback server, ensure 
it is in the Interplay workgroup. If it is a playback server that will be controlled by iNEWS 
Command, it must be configured to join a second workgroup—the same workgroup as the 
Command Servers.

n The AirSpeed Multi Stream Device Service can be configured to be controlled by up to two 
Command systems.

To configure Channels for Remote Control with Avid iNEWS Command:

1. On the AirSpeed Multi Stream server, launch the Avid Service Configuration 
application by selecting Start > All Programs > Avid > Service Framework > Avid 
Service Configuration.

2. Configure the AirSpeed Multi Stream Integration Service. Be sure to do the following:

a. Configure interplay authentication settings

b. Configure destination template (for recording and sending to ISIS)

c. Assign destination template in the default template tab

For more information, see “Configuring the Integration Service on the AirSpeed Multi 
Stream” on page 168.

3. Open the Workstation Service for Command, and change any desired settings for your 
specific site. Possible settings that you might want to change include the following:

a. Enable/disable time sync

b. Enable/disable health monitoring

c. Service Starter Service

4. Launch the Avid Interplay Health Monitor and do the following: 

a. Check the AirSpeed Multi Stream’s general health

b. Check Command’s general health

For more information on using the Interplay Health Monitor, see Chapter 7 of the Avid 
Service Framework User’s Guide.
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5.  Select Avid Inventory Manager.

The right panel displays information as shown in the following screen.

6. Do the following: 

a. Verify that AirSpeed Multi Stream is listed as a device.

b. Verify that there is inventory. The count (# of objects) will be listed.

c. Verify that the Available field displays “true”.

For more information on changing device settings, and adding devices, see “Channel 
Settings” in Chapter 3 of the Avid iNEWS Command Administrator’s Guide.

7. Start the Avid iNEWS Command Workstation.

8. Select Tools > System Settings.
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9. Create a Device Channel for each channel (and each AirSpeed Multi Stream) by 
selecting Channel > Device Channels. When creating a device channel for AirSpeed 
Multi Stream, make sure that you do the following:

a. Set the Channel name (use a letter such as A, B, or C).

b. Make sure the Device Name is the AirSpeed Multi Stream hostname.

c. Select AirSpeed Multi Stream as the Device Type.

d. Channel Index (AirSpeed Multi Stream has 8 playback channels indexed between 1 
and 8, although only up to 6 simultaneous playbacks are supported).

For more information on device channels, see “Device Channels” in Chapter 3 of the 
Avid iNEWS Command Administrator’s Guide. 

10. When you are done creating device channels, click Apply.

11. Add the channel to a group by selecting Channel > Groups. Use the following 
information for AirSpeed Multi Stream.

a. Select the Channel Name (usually A, B, C, D or similar).

b. Add channels for the AirSpeed Multi Stream as desired.

For more information on groups, see “Groups” in Chapter 3 of the Avid iNEWS 
Command Administrator’s Guide. 

12. When you are done, click Apply, and click OK.

13. In Command, open the Inventory panel (select View, and then Inventory) and check to 
see if the clips from the AirSpeed Multi Stream are listed (assuming there is inventory 
on the AirSpeed Multi Stream).

For more information, see “Inventory” in the Avid iNEWS Command User’s Guide.

14. (Option) If you are using AirSpeed Multi Stream with a Command server that is in a 
different Interplay Framework Workgroup than the Interplay Engine, the AirSpeed 
Multi Stream must be configured to join both the Interplay Framework Workgroup and 
the Command Framework Workgroup. continue with this procedure to add a 
workgroup.
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15. Access the Avid Workgroup Properties dialog box, and click on the Lookup tab.

The Lookup tab opens.

16. Make sure you have a Workgroup entry for both the Command Framework Workgroup 
and the Interplay Framework Workgroup. You should already have the Interplay 
FrameWork Workgroup added, so you just need to add one for the Command 
Framework Workgroup. This is done by clicking the Add button in the Workgroup area.

The Add Workgroup dialog box opens.

17. Add a new workgroup by typing the name of your Command workgroup in the Enter the 
Workgroup Name field.

18. Click OK.

19. Click Apply. 

The Restart Avid Services message box opens.

20. Click Yes to restart the service.

The service will be restarted.

21. Click OK to close the dialog box. 

The AirSpeed Multi Stream server should show up in the Interplay Service 
Configuration when viewing the Server list for both the Command and Interplay 
Framework workgroups.
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Configuring Communication Protocols in AirSpeed Multi Stream

If you have external devices that will control AirSpeed Multi Stream (such as Automation 
systems), you can define communication protocols for each channel. The default protocol is 
set to NONE.

The Protocol Setup dialog box is used to set up communication with external devices that 
control AirSpeed Multi Stream. 

The screen example shown below shows the Protocol Setup dialog box for an MPEG-2 HD 
model AirSpeed Multi Stream. For an SD, DNxHD, and AVC-Intra models, only 4 channels 
display in the dialog box.

Protocol Setup Settings  

Setting Description

Channel The AirSpeed Multi Stream Channel on which this protocol is 
running. 

Protocol The name of the selected protocol. Select from:

• NONE (AMS API)

• VDCP (LouthSerial)

• BVW75 (Sony)

Port The AirSpeed Multi Stream port through which this protocol is 
running. Each serial connection uses one of the eight RJ-45 serial 
ports on the rear of the AirSpeed Multi Stream chassis.



AirSpeed Multi Stream Configuration Checklist

121

To set up protocols:

1. Select File > Preferences > Protocol Setup.

The Protocol Setup dialog box opens.

2. Select the Channel you want to set up a protocol for by clicking on the appropriate 
Channel button (1-6).

3. In the Protocol field, specify the protocol that you want to use for a port. Options are

t NONE

t VDCP (LouthSerial)

t BVW75 (Sony)

4. In the Port field, specify the serial port that you want to use for the protocol. 

These ports are listed as Port1 - Port8 in the menu, and correspond to the Serial ports 1-8 
on the rear of the AirSpeed Multi Stream chassis.

5. (Option) Select the desired control protocol and check the desired options.

6. (Option) For VDCP (LouthSerial) only, click in the Preset/Cue check box if you want to 
load the clip with the first frame of video displayed on the MiniMonitor and Output 
monitor, assuming there is nothing previously loaded. 

7. Click OK. 

The dialog box closes. A informational message opens saying that you need to restart 
your system in order for changes to take effect.

Database (blank=default DB) The pathname of the database in use. Leave this blank to use the 
default database.

Story TC (only for VDCP) Enables you to specify story timecode cue in values as opposed to 
zero based offsets.

Preset/Cue (only for VDCP) With this option enabled, if there is nothing previously loaded on 
the channel, it loads the clip with the first frame of the video 
displayed on the MiniMonitor and Output monitor.

Auto Play With this option enabled, following the first VDCP Play command 
each new item cued will automatically take without an explicit 
PLAY command from Automation. Play ends when there are no 
longer any cued clips to play out. Under normal VDCP based 
automation control, this option should be disabled.

Protocol Setup Settings (Continued)  

Setting Description
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Configuring General Purpose Interface (GPI) Inputs and Outputs

This topic contains information on how to configure General Purpose Interface (GPI) Inputs 
and Outputs in AirSpeed Multi Stream.

To configure General Purpose Interface (GPI) Inputs and Outputs:

1. Make sure that GPI triggers are enabled in AirSpeed Multi Stream. This is done by 
selecting File > Preferences > Enable GPI Triggers. 

A check mark indicates that GPI triggers are enabled in AirSpeed Multi Stream.

2. Open the Assign GPI Triggers dialog box by selecting File > Preferences > Assign 
GPIs. 
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The Assign GPI Triggers dialog box opens.

3. Specify GPI triggers for your Inputs. GPI Input values are described below:

t OFF - If this value is selected, no triggers will work.

t Play - If this value is selected, and a clip is loaded on the given channel, it initiates a 
playback.

t Stop - If this value is selected, and if in Playback mode, the clip will stop and eject. 
However, if in Record mode, the record will be stopped.

t Cue - If this value is selected, the currently loaded/playing clip will be recued to the 
headframe of that clip. To play the clip, you must initiate the Play trigger. If no clip 
is loaded or playing, this value does nothing.

t Record - If this value is selected, and no clip is specified in the channel, it initiates a 
crash record. However, if a clip is specified, it initiates a record in the channel.

It is important to note that for Channels 1, 2, 5, and 6, you can specify Play, Stop, Cue 
and Record triggers. For Channels 3 and 4, you can only specify Play, Stop, and Cue 
triggers.
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4. Specify GPI triggers for your Outputs. GPI Output values are described below:

t NONE - If this value is selected, the specified tally will not light up.

t Server Ready - If this value is selected, it indicates that the AirSpeed Multi Stream 
is up and available for use.

t Play - If this value is selected, it indicates that the AirSpeed Multi Stream is 
currently playing back a clip on the specified channel.

t Record - If this value is selected, it indicates that the AirSpeed Multi Stream is 
recording a clip on the specified channel.

n For MPEG-2 HD, and DNxHD models, it is important to note that for Channels 1, 2, (and 
for MPEG-2 HD models) Channels 5 and 6, you can specify Play and Record triggers. For 
Channels 3 and 4, you can only specify Play triggers.

n For AVC-Intra models, it is important to note that for Channels 1, 2, 3, and 4, you can 
specify Play and Record triggers.

5. Test your GPI Inputs and Outputs by clicking the Start Test button. 

This puts the dialog box into a “diagnostics mode” which enables you to initiate each 
trigger to confirm pinouts and show how many times a particular trigger has been 
activated. When in this state, the outputs will turn the tallies On and Off to confirm 
pinouts.

6. Click OK to save your changes and close the dialog box.

Configuring Your Avid Editor to Work with AirSpeed Multi Stream

This topic contains information on how to configure your Avid editor (such as NewsCutter, 
Media Composer, or Symphony Nitris) to work with AirSpeed Multi Stream.

To configure your Avid editor to work with AirSpeed Multi Stream:

1. Launch your Avid editor application, and select Transfer Settings from the Project 
Settings window.

2. Click the TMClient.ini tab, and type the name(s) of the AirSpeed Multi Stream(s) and 
the Workgroup to which they are associated (not the Framework Workgroup).

3. Click OK.

Your Avid editor will attempt to connect to all of the devices in the list. This might take 
some time. 

For information on sending sequences back to AirSpeed Multi Stream, see “Sending 
Sequences from an Avid Editor to AirSpeed Multi Stream” on page 254.
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For information on creating a Studio with up to four AirSpeed Multi Stream systems and 
four other original AirSpeed systems, see “AirSpeed Multi Stream Studio and Playout” on 
page 267.

Optional AirSpeed Multi Stream Configuration 
Procedures

This topic contains additional configuration settings that can be changed after you have 
configured your AirSpeed Multi Stream system. Feel free to begin using your system, and 
then when you know how you want it to perform, use these procedures to further configure 
your AirSpeed Multi Stream to fit your site’s requirements. The topics included in this 
section include the following: 

• “Setting Database Options” on page 125

• “Configuring Auto Logon” on page 126

• “Locking Channel Assignments” on page 128

• “Avid IsoSync Application” on page 128

• “Configuring International Character Support” on page 128

Setting Database Options

If you want to tweak the behavior of how your database works, you can select or deselect 
various options to your site’s preferences. This is an optional step.

To set the database options:

1. Select File > Preferences > Database Option. 

The Database Options dialog box opens.
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2. Select your options according to the following table, and click OK when you are done.

Configuring Auto Logon

Auto Logon enables you to set up your AirSpeed Multi Stream server to not have to validate 
credentials every time you log on to the system. This is an optional step.

Database Options Window  

Option Description

Add Items to End of 
Workspace

When you add a new clip to a workspace, AirSpeed Multi Stream 
searches through a workspace until it finds the next available number to 
assign that item. This option directs AirSpeed Multi Stream to place 
new clips at the end of the workspace, making them easier to find. 

If, in a workspace there is no clip number 206, 214 or 217, AirSpeed 
Multi Stream normally assigns those numbers to an incoming clip. With 
the Add Items to End of Workspace option checked, new clips are 
assigned at the end of the workspace.

Keep Write Lock During 
Copy/Modify Operations

Where multiple users have access to a database, they can be copying or 
modifying clips at the same time, slowing the operation and possibly 
mixing one set of clips into another. This option locks out other users 
from a database while clips are being saved or modified, saving time 
and keeping each series of clips in consecutive order. 

Keep Database Views 
Updated

Normally, AirSpeed Multi Stream keeps all open databases current 
through automatic updates. When there are multiple users, a delay 
result while AirSpeed Multi Stream checks each database for changes. 
This option lets you disable automatic updates to speed operation. 

To manually update the database if you disable this option:

Press Ctrl+R.

Update Clip Length While 
Recording

This option determines whether AirSpeed Multi Stream dynamically 
updates the length value for a clip while recording.

Update Media Id When 
Modifying Item Number

This option determines whether the Media Id of a clip will be 
automatically updated when its item number is modified.

Give warning while 
recording

During recording, AirSpeed Multi Stream monitors the content on your 
hard drive and when it reaches the percentage indicated in the % field, 
gives you a visual warning. Use this advice to avoid having your system 
“max-out” unexpectedly in the middle of a recording session.
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To configure Auto Logon:

1. Select Start > Programs > Avid > AMS AutoLogon. 

The AMS AutoLogon dialog box opens with the current logon information displayed in 
the Current area of the dialog box.

2. If you want to change your registry settings, do the following in the Set area of the 
dialog box:

a. Type the user name in the User Name field.

b. Type the password in the Password field.

c. Type the domain in the Domain field.

d. Click the Enable Auto-Logon check box.

e. Click Apply.

The information is saved in the registry, and the data in Current Group will be 
updated.

3. Click OK to close the dialog box.
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n If you want to revert to the factory default (from the original system image), click the Factory 
Default button. The Factory default is Username: amsuser, Password: is-admin, Domain: 
localhost name, Enable Auto Logon: enabled.

Locking Channel Assignments

When this option is checked in the File > Preferences menu, it locks the channel as the 
default playback channel preventing accidental changes. 

You can also lock a channel by selecting the channel and then clicking the Channel Lock 
button on the Air toolbar. This same method also works for unlocking a channel. 

For more information on the Air toolbar, see “Air Toolbar” on page 225.

Avid IsoSync Application

The Avid IsoSync™ application lets you synchronize up to twelve channels from either 
AirSpeed or AirSpeed Multi Stream video servers and record simultaneously to different 
storage devices assigned to each AirSpeed or AirSpeed Multi Stream server. 

For example, if you had four different cameras filming the action you could sync the data 
coming from all four cameras to record through four AirSpeed video servers, or one 
AirSpeed Multi Stream video server (depending on your configuration, SD, MPEG-2 HD, or 
DNxHD) at the same time using one button. 

n Before using IsoSync, you must have set a default database in AirSpeed Multi Stream.

For more information on installing and using the Avid IsoSync application, see the Avid 
IsoSync Installation and User’s Guide.

Configuring International Character Support

You can specify a non-English keyboard layout and text entry format for the language in 
which you want to type.

n The operating system does not need to be in the same language as that in which you 
are typing.
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To specify a language in which to type:

1. (Option) Plug in a regional keyboard.

2. Click the Start button, and select Settings > Control Panel.

3. Select Regional and Language Options.

The Regional and Language Options dialog box opens.

4. In the Regional Options tab, do the following:

a. In the “Standards and formats” area, select a language.

b. In the “Location” area, select your country.
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5. Click the Languages tab.
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6. In the “Text services and input languages” area, click Details.

The Text Services and Input Languages dialog box opens.

7. In the “Installed services” area in the Settings tab, select a language and a keyboard 
layout for that language. 

8. If the language you want is not in the list, click Add, select an input language and a 
keyboard layout for the language, and then click OK. 

9. In the “Default input language” area, select an input language.

n You have to select a language in the Installed Services area (step 7) before it appears in the 
Default input Language list.

10. Click OK to close the “Text Services and Input Languages” dialog box. 

11. Click OK to close the Regional and Language Options dialog box.

A keyboard icon appears in the taskbar to allow you to switch keyboard layouts. 

n For more information, see the Windows XP Help.
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4 Configuring the Software in a 
Workgroup Environment

This chapter provides information on configuring the AirSpeed Multi Stream and related 
software in a Workgroup environment. 

For more information, see the following topic:

• AirSpeed Multi Stream Workgroup Configuration

n Prior to proceeding with AirSpeed Multi Stream Workgroup configuration, ensure that your 
AirSpeed Multi Stream is installed and connected using the information in “Installing the 
Hardware and Setting Up Your System” on page 61.

AirSpeed Multi Stream Workgroup Configuration

When configured in a Workgroup environment, AirSpeed Multi Stream operates as a 
member of an integrated Interplay workgroup to utilize built in Interplay Transfer and shared 
storage.

Configuration Requirements for AirSpeed Multi Stream

In a Workgroup environment, each AirSpeed Multi Stream must be configured with the 
following:

• You must have the Avid Unity Workgroup environment already operating before adding 
the AirSpeed Multi Stream to the environment.

•  Site-specific settings need to be applied for the AirSpeed Multi Stream to operate in 
your Workgroup environment. Each AirSpeed Multi Stream installed needs to be 
uniquely configured. 

• You must create a site-specific host name/domain name of the AirSpeed Multi Stream, 
including an IP address and mask for the network interface.
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• The DNS server IP address (required for Interplay)

• The Shared Storage Client for Avid Unity ISIS or MediaNetwork (ethernet attached)

• Interplay user name and password

• Interplay Engine

c Do not connect any AirSpeed Multi Stream to your workgroup environment until you 
have assigned a new, unique IP address to each AirSpeed Multi Stream.

Once these requirements are met, and you have installed all of the necessary hardware and 
software for your site, you can configure the AirSpeed Multi Stream. For more information 
on specific tasks involved when configuring AirSpeed Multi Stream, see “AirSpeed Multi 
Stream Workgroup Configuration Checklist” on page 134.

AirSpeed Multi Stream Workgroup Configuration Checklist

The following table provides a checklist of tasks that must be performed when configuring 
your AirSpeed Multi Stream in a Workgroup environment. Depending on your site’s 
configuration, some tasks are optional.

Configuring the Avid Service Framework Workgroup

The Avid Service Framework was pre-installed on your system with a default workgroup. 
This topic describes how to delete the default workgroup, and configure the Avid Service 
Framework to join the workgroup for your site. 

This Avid Service Framework contains the following components:

• Avid Diagnostics

• Avid Health Monitor

• Avid Service Configuration

• Avid Workgroup Properties

Configure the Avid Service Framework, as described in “Configuring the Avid Service 
Framework Workgroup” on page 134.

Configure the Avid Service Configuration for Interplay Workgroup, as described in 
“Configuring the Avid Service Configuration for Interplay Workgroup” on page 136.

Launch Transfer Manager, as described in “Launching Transfer Manager” on page 148.
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n  Regardless of whether the AirSpeed Multi Stream is a capture and/or playback server, 
ensure it is in the Interplay workgroup. If it is a playback server that will be controlled by 
iNEWS Command, it must be configured to join a second workgroup—the same workgroup 
as the Command Servers.

n The AirSpeed Multi Stream device service can be configured to be controlled by up to two 
Command systems.

To configure the Avid Service Framework on the AirSpeed Multi Stream server:

1. Select Programs > Avid > Avid Framework > Avid Workgroup Properties.

The Avid Workgroup Properties dialog box opens.

2. Select Edit.

The Services Workgroup dialog box opens.

3. Retype the name to the name of the Workgroup that you want the AirSpeed Multi 
Stream to be associated with, and click OK.

4. Delete the default workgroup by doing the following:

a. Click on the Lookup tab.

b. Select the default workgroup called “AvidWorkgroup”.

c. Click Remove.

5. Click the Add button.

The Add Workgroup dialog box opens.

n You can either create a new workgroup or join an existing one. If you are creating a new 
workgroup, make a note regarding the workgroup name so that it can be entered during 
other Avid Service Framework installations. You must use the same workgroup name on all 
Interplay clients that are connected in your network. The workgroup name is case sensitive.

6. Add a new workgroup by typing the name of your workgroup in the Enter the 
Workgroup Name field.

7. Click OK.

8. Click Apply. 

The Restart Avid Services message box opens.

9. Click Yes to restart the service.

The service will be restarted.

10. Click OK to close the dialog box.
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11. Determine whether your site is using Avid iNEWS Command, CaptureManager, or 
Interplay Capture for capture or playout. If your site is:

t Using Avid iNEWS Command, Avid CaptureManager, or Avid Interplay Capture to 
control AirSpeed Multi Stream channels for capture or Playout, you must install the 
AirSpeed Multi Stream Device Service. For more information, see “(Option) 
Installing the AirSpeed Multi Stream Device Service” on page 99.

t Not using Avid iNEWS Command, Avid CaptureManager, or Avid Interplay 
Capture to control AirSpeed Multi Stream channels for Playout, you are ready to 
configure your AirSpeed Multi Stream. For more information, see “Creating a New 
Database in the AirSpeed Multi Stream Application” on page 100.

After you have configured the there are no specific changes you need to make to the 
Avid Service Framework for AirSpeed Multi Stream, if you want more information on 
configuring the Avid Service Framework settings, see “Configuring Workstation 
Settings” in the Avid Service Framework User’s Guide.

Configuring the Avid Service Configuration for Interplay Workgroup

This topic describes how to configure the Avid Service Configuration for Interplay 
Workgroup, including creating Record and Destination templates.

Before you configure the Avid Service Configuration, you must create a user with an 
AirSpeed Multi Stream user name with matching passwords (recommended Avid1234) in 
both Interplay and Unity. For more information, see the Avid Interplay Engine and Avid 
Interplay Archive Manager Administration Guide.

There are five stages to configure the Avid Service Configuration for Interplay Workgroup. 
They are listed in the checklist below and each is described in detail following the checklist:

Configure the Avid Service Configuration. See “Configuring the Avid Service 
Configuration” on page 137.

Set up your credentials for Interplay and ISIS or Unity. See “Setting Up your Credentials 
for Connection to Interplay” on page 138.

Set up Record and Destination templates. See “Setting Up Record and Destination 
Templates” on page 140.

Select Default templates. See “Selecting Default Templates” on page 144.

Set up Inventory rules. See “Setting Up Inventory Rules” on page 146.
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Configuring the Avid Service Configuration

The first step is to open and configure the Avid Service Configuration.

n You can open the Avid Service Configuration on any workstation in the workgroup that 
includes your AirSpeed Multi Stream server, if the Avid Service Framework is installed on 
the workstation

To configure the Avid Service Configuration:

1. On the AirSpeed Multi Stream, select Start > Programs > Avid > Avid Framework > 
Avid Service Configuration. 

The Select Workgroup dialog box opens.

2. Do the following:

a. Type the name of the workgroup you want to use.

b. Select the “Always select and use this Workgroup” check box.

c. Click Select.

The Avid Service Configuration dialog box opens, and a list of all of the systems logged 
in to the Avid Service Framework appears. In the Hosts column, your AirSpeed Multi 
Stream system name appears in the list in bold type (if you are connected to that 
system).

3. Click to expand your AirSpeed Multi Stream server name to see the following services:

- AirSpeed Multi Stream Integration Service

- Avid Workstation Service

- Avid AirSpeed Multi Stream Device Service (optional)

4. Select AirSpeed Multi Stream Integration Service.

The Administrator Password Needed dialog box opens.
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5. Type a password if you have one. If not, click OK.

The Avid Service Configuration dialog box opens.

Setting Up your Credentials for Connection to Interplay

The next step is to set up your credentials to Interplay using the Service tab of the Avid 
Service Configuration dialog box.

To set up your credentials for connection to Interplay:

1. Click the Service tab.

2. Make sure both the “Interplay Enabled?”and “Transfer Engine Enabled?” checkboxes 
are enabled. If they are, the Interplay Credentials area becomes enabled allowing you to 
type your Interplay credentials in the fields. The Destination field in the Default 
Template tab also becomes enabled.

3.  Do the following in the Interplay Credentials section:

a. In the Server Name field, type the server name of your Interplay engine.

b. In the Database Name field, type the name of the Interplay database (the default is 
AvidWG).

c. In the User Name and Password fields, type the user name and password that was 
created in the Interplay Administration tool. For more information, see the Avid 
Interplay Engine and Avid Interplay Archive Manager Administration Guide.

4. Click the Apply button (upper left) to log in.
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5. After having created Users in Interplay, you must set up user profiles for each user on 
the AirSpeed Multi Stream server. For more information, see “Setting Up User Profiles” 
on page 139.

Setting Up User Profiles

The next step is to set up user profiles for each user that was created in Interplay. These users 
will have the necessary privileges to administer the AirSpeed Multi Stream with the 
AirSpeed Multi Stream Remote Console.

To set up user profiles:

1. On the Interplay Engine or a client that has access to the Avid Interplay Administrator 
application, create a user. For more information, see the Avid Interplay Engine and Avid 
Interplay Archive Manager Administration Guide.

2. On the AirSpeed Multi Stream server, select Start > Programs > Avid > Avid 
Framework > Avid Service Configuration.

The Avid Service Configuration dialog box opens.

3. Click the Avid AirSpeed Multi Stream Integration Service item in the left pane beneath 
the name of the AirSpeed Multi Stream server you are logged into. 

The name appears in bold.

4. Click the User Profiles tab.

n For the Workgroup configuration to work, you need to first add users in the Interplay 
Administration tool.
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5. Select the user by doing the following:

a. Click the Add button.

The text “NewUser” appears in the Name field.

b. In the Name field, select the user name for which you want to assign Inventory and 
Channel privileges.

c. (Optional) In the Description field, type a title or description pertaining to the user.

d. Select the Inventory and Channel privileges that you want to assign to the user you 
are adding. 

e. Click Apply.

6. (Optional) If you want to assign similar Inventory and Channel privileges to another 
user that you have created in Interplay, do the following:

a. Select (to highlight) an existing user from the User Profile list

b. Click the Copy button.

The text “NewUser” appears in the Name field and the Inventory and Channel 
privileges are the same as the user you had selected.

c. In the Name field, select the name of the user that you want to assign Inventory and 
Channel privileges to.

d. (Optional) In the Description field, type a title or description pertaining to the new 
user.

e. (Optional) If you want to change the Inventory and Channel privileges for this user, 
select the desired privileges that you want to assign to the user. 

f. Click Apply.

7. Repeat Steps 6 or 7 for each additional user that you want to create.

8. The next step is to set up Record templates. For more information, see “Setting Up 
Record and Destination Templates” on page 140.

Setting Up Record and Destination Templates

Once you have set up your credentials for connection to Interplay, you must set up your 
Record and Destination templates for your AirSpeed Multi Stream capture and playback. 

The Record and Destination Templates tabs are also used to specify the audio settings for 
each template that you use to record a high-res resolution and H.264 proxy resolution.

n  Set up for Record templates can only be done through the Avid Service Configuration. 
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To set up your record and destination templates:

1. Click the Record Templates tab.

The Record Templates tab opens.

2. Select a pre-defined Record template from the list, and click the Copy button. 

A new Record template based on the one you selected is created.

3. In the Name field, type a name for your new Record template.

4. (Option) In the Description field, type information that will appear as metadata for your 
recorded clips.

5. In the Audio Settings section, do the following:

a. (Option) Assign a name for each audio stream by typing a name for the audio 
settings in the Name field next to the stream you want to name.

b. In the Type field for each audio stream, select the audio format for each high res 
stream you are recording. 

Keep in mind that SD and DNxHD models have 1-4 streams or audio, and MPEG-2 
HD, and AVC-Intra models have 1-8 streams of audio.

c. (Option) For recording H.264 proxy audio, in the Pri/Sec (Primary/Secondary) 
column, select one stream as Pri to record H.264 proxy audio. You must have at 
least one stream selected as Pri. You can select a second stream as Sec (secondary).

A maximum of two streams of proxy audio is supported. Keep in mind, each stream 

     represents a stereo pair.

6. Click the Apply button (upper left) to create the new Record template.
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7. Click the Destination Templates tab.

The Destination Templates tab opens. Use the Destination Templates tab to specify the 
folder in which AirSpeed Multi Stream should store ingested clips and the workspace in 
which it should store the ingested media.

8. Click the New button (lower left). 

A new blank Destination template is created.

9. In the Name field, type a name for your new Destination template. Do not include these 
characters in the Name field: <, >, 

n The names of your Destination templates must be unique. You cannot have two Destination 
templates with the same name.

10. (Option) Enter additional information regarding your Destination template in the 
following fields: 

t Description

t Clip ID

t Clip Name

n In order for clips that are generated to have a unique name in the AirSpeed Multi Stream 
database, type “.$n” at the end of the clip name.

n If you leave the Clip Name field blank in the Service Configuration, you will be allowed to 
enter a clip name using the AirSpeed Multi Stream user interface. This can be done in the 
Name field in the Edit Template for Channel or Item Properties dialog box.
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t Tape Name

t Interplay Folder Path - Type the name of a subfolder in the Interplay database 
Projects folder in which to store the ingested clips. This is optional and is not 
necessary if you manage ingest through Interplay Capture (Interplay Capture 
overwrites this setting).

n If you use this setting without Interplay Capture, the single clip created is associated with 
both the low-res and high-res media and can be used for dynamic relink.

t Proxy Interplay Folder Path - In most cases, do not specify a folder in the Proxy 
Interplay Folder Path field, because it creates an unnecessary clip.

AirSpeed Multi Stream creates metadata in catalogs and incoming media by default.

11. In the Workspace field, specify the workspace or workspaces in which AirSpeed Multi 
Stream should store the ingested media. You must specify a workspace in the 
Workspace field. 

12. In the Proxy Workspace field, you have the option of specifying a Proxy Workspace if 
you want to store the high-res media and the H.264 proxy media in different Avid ISIS 
workspaces.

13. (Optional) In the Categories list, select one or more Categories that you want your 
captures to be associated with. With each subsequent capture on the AirSpeed Multi 
Stream, the clips that are checked into the Interplay Database will be associated with 
these predefined categories.

 Categories are created in the Avid Interplay Administrator application and defined by 
the Interplay Administrator. The Categories list is populated automatically by the Avid 
Interplay Engine.

For more information on how categories are created, see “Configuring Categories” in 
the Avid® Interplay® Engine and Avid Interplay Archive Engine Administration Guide.

14. Click the Apply button to create the new Destination template. 

15. Repeat this procedure for any additional Record and Destination templates that you 
want to create for your site.

Now that you have created Record and Destination templates, you must apply them. For 
more information, see “Selecting Default Templates” on page 144.
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Selecting Default Templates

Use the Default Templates tab to select the Record template, proxy resolution, and 
Destination template for each channel you are going to record. 

To select default templates:

1. Click the Default Templates tab. The Default Template tab opens. The following 
example shows the Default Templates tab as it would appear on an AirSpeed Multi 
Stream system that has H.264 proxy capabilities. Notice the Proxy column in the center 
of the tab.

2. (Option) For each channel, select the Record and Destination template that best fits your 
site’s requirements. This is done by doing the following:

a. In the Record column, in the Channel 1- Channel 4 fields, select the Record 
template for the high-res resolution.

n For each channel, the Record drop-down list contains all supported Record templates based 
on the video standard (NTSC, PAL, 1080i or 720p) of the channel. 

n Every time you switch the video standard of the channel (for example, from NTSC to 720p, 
or from 720p to 1080i59.94), the Record template is set back to None by default. You have to 
reconfigure it by setting the format Default Teplates as shown below.
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b. (Option) Below the Record Templates for channels 1-4, select a default setting for 
each format. The formats are displayed in the following Format Default Template 
fields:

t NTSC or PAL (for SD)

t 1080i

t 720p

n With each of these formats predefined, when you change the format for a given channel in 
the AirSpeed Multi Stream application and restart the application, the predefined template 
for that format will be applied to the appropriate channel. 

If the Format Default Templates are not predefined, and you switch formats of a given 
channel, the template for that channel will be set to NONE in the Avid Service 
Configuration, and you will need to manually configure each channel respectively.

c. (For H.264 enabled systems only) In the Proxy column, select an H.264 proxy 
resolution for each channel. (The correct corresponding proxy is displayed in the 
list automatically.) 

d. In the Destination column, select the Destination template for the clips and media.

n If there is no destination template set for a channel, that channel's capture won't transfer to 
shared storage.

For more information, see “Modifying Clip File Data” on page 255.

3. (Option) If you want to send HD media to the AirSpeed Multi Stream, select the 
location from the “HD send-to-playback format based on” list. 

n At least one channel in the AirSpeed Multi Stream must be designated as HD for this option 
to be available in the menu.

4. In the event that there is a failed transfer upon ingest, specify the destination you want to 
ingest to by selecting it from the “Ingest transfer workspace based on” menu.

n At least one channel must be assigned a Destination template for this option to be available 
in the menu.

5. Click the Apply button to save your changes.
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Setting Up Inventory Rules

Next, you can set up Inventory rules. 

To set up inventory rules:

1. Click the Inventory tab.

The Inventory tab opens.

2. (Option) If you want to allow Play While Transfer (PWT) functionality, make sure the 
“Allow Play While Transfer?” check box is enabled.

3. (Option) If you want to allow for control of the “overwrite” behavior during a Send To 
Playback (STP) operation, make sure the “Allow Overwrite on Send to Playback” 
checkbox is enabled. This check box is enabled by default and allows Editors to 
overwrite clips on the server when performing STPs as in all previous releases. 

When this selection is disabled, an Editor will not be able to overwrite a clip that exists 
on the AirSpeed Multi Stream, even when they select the “overwrite” flag in the 
send-to-playback dialog of the editor. This is to prevent unexpected or unauthorized 
overwriting of assets on the server. If this is attempted, the transfer will fail with an error 
saying “Error: item already exists”.

4. (Option) The “Delete XDCAM Temporary Files after Transfer?” check box is for 
diagnostic purposes and should be left checked during normal operation. The default 
state of this check box is to be On (selected). Only disable (deselect) this setting when 
an Avid representative recommends that you deselect it. It is used internally by Avid to 
gather system data.
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5. (Option) If you want to transfer ancillary data streams to Interplay (assuming you have 
the correct Interplay version), make sure the Transfer Ancillary Streams to Interplay? 
check box is enabled.

n If you are using a version of Interplay earlier than Interplay 2.2, you must make sure that the 
Transfer Ancillary Streams to Interplay? check box is not enabled. This setting is not 
enabled by default, and is intended to work in conjunction with features available in 
Interplay 2.2 and later releases. If this check box is enabled in configurations with earlier 
Interplay versions, the data track file will not be managed by Interplay and will become an 
orphan clip. This would cause loss of storage space over time and require manual deletion 
of orphan files.

6. (Option) If you want to capture and transfer proxy audio streams to Interplay (D-Track), 
select the Transfer Compressed Audio Streams to Interplay? check box to enable it. 
Otherwise, leave it unchecked.

7. (Option) If you want to generate a local MPEG-1 proxy after playback transfer 
completes, click the “Generate local MPEG-1 proxy after playback transfer 
completes” check box. Otherwise, leave it blank.

n MPEG-1 proxies are for local playback on the AirSpeed Multi Stream only. They do not get 
transferred to shared storage.

c Under heavy loads, generating proxies while ingesting or playing out can inhibit system 
performance. Therefore, it is recommended to not generate proxies while recording or 
playing out.

8. (Option) If you want to delete media after ingest completes click the “Delete after 
ingest transfer complete” check box.

This will only delete media directly off the AirSpeed Multi Stream server. Media 
transferred onto ISIS and Interplay still resides there after deletion from AirSpeed Multi 
Stream.

9. (Option) If you want to begin delete at a specific metric based on time, click the “Begin 
delete” check box, and type a percentage in the field for each option that you want to 
specify deletion parameters.

Media will delete starting with the oldest clips first.

10. (Option) If you want to delete all inventory daily, select the “Delete all inventory daily 
at (24 hour HH:MM)” checkbox, and enter a time when you want to delete your 
inventory in hour and minute (HH:MM) format.

11. Make sure that the “Restart transfer engine daily at” check box is selected, and enter a 
time when you want the Transfer Engine to restart in hour and minute (HH:MM) format. 
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n This enables the application to handle larger file counts on the Shared storage. By creating 
additional folders, the files will be listed in more manageable groups.

12. Click Apply.

13. Close the AirSpeed Multi Stream Service Configuration dialog box.

Next, you must launch Transfer Manager if it is not already running. For more information 
on launching Transfer Manager, see “Launching Transfer Manager” on page 148.

Launching Transfer Manager

This topic contains information on how to launch Transfer Manager in the event that it is not 
currently running. Transfer Manager launches automatically with Windows. However, there 
might be times when you need to close and restart it.

To launch Transfer Manager:

1. Select Start > Programs > Avid > Avid Transfer Manager.

The Transfer Manager application launches. The title bar should appear with the words 
“Interplay Mode”, and also have the Workgroup name that the AirSpeed Multi Stream is 
associated with.

2. Next, you can configure channels for remote control with Avid iNEWS Command, 
CaptureManager, or Interplay Capture. For more information, see “Configuring 
Channels for Remote Control with Avid iNEWS Command, CaptureManager, or 
Interplay Capture” on page 148.

Configuring Channels for Remote Control with Avid iNEWS Command, 
CaptureManager, or Interplay Capture

This topic contains information for configuring AirSpeed Multi Stream channels for remote 
control with an Avid iNEWS Command, CaptureManager, or Interplay Capture system. 

Before you configure AirSpeed Multi Stream channels for remote control with one of these 
systems, all of the hardware and software pertaining to the AirSpeed Multi Stream server 
must be installed and configured, including the AirSpeed Multi Stream Device Service 
(from the Avid iNEWS Command DVD).

n Regardless of whether the AirSpeed Multi Stream is a capture and/or playback server, ensure 
that it is in the Interplay workgroup. If it is a playback server that will be controlled by 
iNEWS Command, it must be configured to join a second workgroup—the same workgroup 
as the Command Servers. For more information, see the Avid iNEWS Command 
Administrator’s Guide.
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n The AirSpeed Multi Stream Device Service can be configured to be controlled by up to two 
Command systems.

To configure Channels for Remote Control with Avid iNEWS Command, 
CaptureManager, or Interplay Capture:

1. On the AirSpeed Multi Stream server, launch the Avid Service Configuration 
application by selecting Start > All Programs > Avid > Service Framework > Avid 
Service Configuration.

2. Configure the AirSpeed Multi Stream Integration Service. Be sure to do the following:

a. Configure Interplay authentication settings

b. Configure the Destination template (for recording and sending to ISIS)

c. Assign a Destination template in the Default Template tab

For more information, see “Configuring the Avid Service Configuration for Interplay 
Workgroup” on page 136.

3. (Option for CaptureManager only) Configure the AirSpeed Multi Stream Device 
Service by doing the following:

a. On the Hosts tab, type the CaptureManager host name in the Hostname field, and 
then the System Administrator password, and click OK. If you have not created one 
yet, leave the space blank and click OK. 

b. On the Device Settings tab, enter the second workgroup, and then enter the name of 
the Command workgroup.

c. If the AirSpeed Multi Stream will be controlled by two Command systems, enable 
the second system and enter the numerical value of that system, such as 2. Options 
include 1-10. The default Command system number is 1.

d. If using CaptureManager for ingest control, enable it by clicking Yes next to the 
“Enable Avid Interplay CaptureManager” field and entering the hostname of the 
CaptureManager server in the CaptureManager System Service field.

e. Click Apply.

n Upon applying the new settings, and if the CaptureManager is enabled, the system will 
append a port number to the end of the hostname you entered for the CaptureManager 
Server.

For more information, see the topic “Configuring the AirSpeed Multi Stream Device 
Service” in the Avid iNEWS Command Configuration Guide.
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4. Open the Workstation Service for Command, CaptureManager, or Interplay Capture, 
and change any desired settings for your specific site. Possible settings that you might 
want to change include the following:

a. Enable/disable time sync

b. Enable/disable health monitoring

c. Service Starter Service

5. Launch the Avid Interplay Health Monitor and do the following: 

a. Check the AirSpeed Multi Stream’s general health

b. Check Command’s general health

For more information on using the Interplay Health Monitor, see Chapter 7 of the Avid 
Service Framework User’s Guide.

6.  Select Avid Inventory Manager.

The right panel displays information as shown in the following screen.

7. Do the following: 

a. Verify that AirSpeed Multi Stream is listed as a device.

b. Verify that there is inventory. The count (# of objects) will be listed.

c. Verify that the Available field displays “true”.
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For more information on changing device settings, and adding devices, see “Channel 
Settings” in Chapter 3 of the Avid iNEWS Command Administrator’s Guide.

8. Start the Avid iNEWS Command Workstation.

9. Select Tools > System Settings.

10. Create a Device Channel for each channel (and each AirSpeed Multi Stream) by 
selecting Channel > Device Channels. When creating a device channel for AirSpeed 
Multi Stream, make sure that you do the following:

a. Set the Channel name (use a letter such as A, B, or C).

b. Make sure the Device Name is the AirSpeed Multi Stream hostname.

c. Select AirSpeed Multi Stream as the Device Type.

d. Channel Index (AirSpeed Multi Stream has 8 playback channels indexed between 1 
and 8, although only up to 6 simultaneous playbacks are supported).

For more information on device channels, see “Device Channels” in Chapter 3 of the 
Avid iNEWS Command Administrator’s Guide. 

11. When you are done creating device channels, click Apply.

12. Add the channel to a group by selecting Channel > Groups. Use the following 
information for AirSpeed Multi Stream.

a. Select the Channel Name (usually A, B, C, D or similar).

b. Add channels for the AirSpeed Multi Stream as desired.

For more information on groups, see “Groups” in Chapter 3 of the Avid iNEWS 
Command Administrator’s Guide. 

13. When you are done, click Apply, and click OK.

14. In Command, open the Inventory panel (select View, and then Inventory) and check to 
see if the clips from the AirSpeed Multi Stream are listed (assuming there is inventory 
on the AirSpeed Multi Stream).

For more information, see “Inventory” in the Avid iNEWS Command User’s Guide.

15. (Option) If you are using AirSpeed Multi Stream with a Command server that is in a 
different Interplay Framework Workgroup than the Interplay Engine, the AirSpeed 
Multi Stream must be configured to join both the Interplay Framework Workgroup and 
the Command Framework Workgroup. Continue with this procedure to add workgroups.

16. (Option) If you are installling the AirSpeed Multi Stream Remote Console on your 
Command server, in addition, you need to add an Interplay Workgroup to your 
Workgroup Properties on the Command Server. This enables you to connect the 
Command server to the Interplay network so it can link to the AirSpeed Multi Stream 
Remote Console. Continue with this procedure to add a workgroup.
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17. On the AirSpeed Multi Stream, access the Avid Workgroup Properties dialog box, and 
click on the Lookup tab.

The Lookup tab opens.

18. On the Command server, access the Avid Workgroup Properties dialog box, and click on 
the Lookup tab.

The Lookup tab opens.
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19. Make sure you have a Workgroup entry for both the Command Framework Workgroup 
and the Interplay Framework Workgroup. You should already have the Interplay 
FrameWork Workgroup added on the AirSpeed Multi Stream server, so you just need to 
add one for the Command Framework Workgroup. 

If you are installing the AirSpeed Multi Stream Remote Console on your Command 
server, make sure you add an Interplay Workgroup to your Workgroup Properties on the 
Command server as well.

 This is done by clicking the Add button in the Workgroup area.

The Add Workgroup dialog box opens.

20. Add a new Command workgroup on the AirSpeed Multi Stream by typing the name of 
your Command workgroup in the Enter the Workgroup Name field.

(For AirSpeed Multi Stream Remote Consoles installed on Command servers), add an 
Interplay workgroup on the Command Server.

21. Click OK.

22. Click Apply. 

The Restart Avid Services message box opens.

23. Click Yes to restart the service.

The service will be restarted.

24. Click OK to close the dialog box. 

The AirSpeed Multi Stream server should show up in the Interplay Service 
Configuration when viewing the Server list for both the Command and Interplay 
Framework workgroups.



4  Configuring the Software in a Workgroup Environment

154



5 Configuring the Software with a 
Standalone Transfer Manager

This chapter provides information on configuring the AirSpeed Multi Stream and related 
software with a Standalone Transfer Manager (Interplay Transfer Engine). This 
configuration supports playout automation applications such as iNEWS ® Command, DNF 
controllers and other solutions using VDCP or AMS API. 

With a Standalone Transfer Manager configuration, AirSpeed Multi Stream uses only its 
own internal storage for storing clips and supports playing out to air via drag and drop using 
the AirSpeed Multi Stream Remote Console. In this configuration, clips are visible through 
Remote Console event listings and can be used to drag and drop files in environments where 
multiple AirSpeed Multi Stream servers are used. 

AirSpeed Multi Stream Studio Playout is not supported with a Standalone Transfer Manager.

n When configured with a standalone Transfer Manager (Interplay Transfer Engine), the 
transfer of clips from AirSpeed Multi Stream (via the Remote Console) to the Editor must be 
done manually.

AirSpeed Multi Stream configured with a Standalone Transfer Manager supports the 
features of the AirSpeed Multi Stream with the exception of the features listed below:

• Avid AirSpeed Multi Stream Studio Playout

• Interplay Capture

• CaptureManager

• Frame Chase™ Editing

• Edit while Capture Functionality with Avid Editor systems

For more information, see the following topic:

• Standalone Transfer Manager Configuration

n Prior to proceeding with AirSpeed Multi Stream configuration, ensure that your AirSpeed 
Multi Stream is installed and connected using the information in “Installing the Hardware 
and Setting Up Your System” on page 61.
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Standalone Transfer Manager Configuration

When AirSpeed Multi Stream is configured with a standalone Transfer Manager it operates 
in environments where you have local or shared storage without Interplay. In these 
“standalone” environments, the Transfer Manager (TM) application acts as the transfer agent 
between the Avid editors and the AirSpeed Multi Stream Remote Console application.

For AirSpeed Multi Stream to work in a standalone environment, it is necessary to configure 
a standalone Transfer Manager. Depending on the version of NewsCutter or Media 
Composer (or editor software) you are using, you will have Avid® Interplay™ Transfer 
Engine server and client software. The following table lists the minimum supported Editor 
and Transfer software versions and the associated documentation.

All of the documentation for configuration is available on the Avid Knowledge Base. This 
documentation assists users in configuration of the standalone TransferManager. The Avid 
Interplay Transfer Setup and User’s Guide, and the Avid Interplay Transfer v1.0 Readme are 
available at the top level of the Avid Interplay Transfer CD-ROM. For the latest versions of 
the documentation, see the Knowledge Base.

n The terms “Interplay Transfer” and “TransferManager” refer to the server and Client 
Transfer software included with your version of NewsCutter or Media Composer. Therefore, 
these terms can be interchangeable when discussing the server or Client Transfer software 
in general. However, when you are referred to other documents, you must look in the 
document that relates to the actual product that you have in your environment (“Interplay 
Transfer” or “TransferManager”).

System Requirements  

Editor XP Version Transfer Software

NewsCutter XP v9.0 or later Avid Interplay Transfer Engine v2.2 or later

Media Composer v5.0 or later Avid Interplay Transfer Engine v2.2 or later

Symphony v5.0 or later Avid Interplay Transfer Engine v2.3 or later
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Configuration Requirements for AirSpeed Multi Stream

Each AirSpeed Multi Stream must be configured with the following:

•  Site-specific settings need to be applied for the AirSpeed Multi Stream to operate with 
a standalone Transfer Manager. Each AirSpeed Multi Stream server that is installed 
needs to be uniquely configured. 

• You must create a site-specific host name/domain name of the AirSpeed Multi Stream, 
including an IP address and mask for the network interface.

• You must share your E: drive with Full control.

• The Shared Storage Client for Avid Unity ISIS or MediaNetwork (ethernet attached)

Once these requirements are met, and you have installed all of the necessary hardware and 
software for your site, you can configure the AirSpeed Multi Stream. For more information 
on specific tasks involved when configuring your AirSpeed Multi Stream with a standalone 
Transfer Manager, see “AirSpeed Multi Stream Configuration Checklist” on page 158.

Software Requirements for the Avid Editing Client

In order to work with AirSpeed Multi Stream in a standalone environment, each Avid 
Editing client must have the following software loaded:

• an Avid editing application (Media Composer, NewsCutter, or Symphony)

• standalone AirSpeed Multi Stream Remote Console application

• (If you are using shared storage) The Shared Storage Client for Avid Unity ISIS or 
MediaNetwork (ethernet attached) 

• Avid Interplay Transfer Engine (server)

• Avid Interplay Transfer Engine (client)

• Avid Framework (installed with the AirSpeed Multi Stream application)
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AirSpeed Multi Stream Configuration Checklist

The following table provides a checklist of tasks that must be performed when configuring 
your AirSpeed Multi Stream using a Standalone Transfer Manager. 

Depending on your site’s configuration, some tasks are optional.

Enabling Transfers for AirSpeed Multi Stream Servers in a Standalone 
Environment

After installing and configuring the Interplay Transfer Engine on the Avid editor, you must 
install and launch the AirSpeed Multi Stream Remote Console. 

Once launched, you must enable transfers on the AirSpeed Multi Stream Remote Console to 
allow communication between it and the AirSpeed Multi Stream server.

This procedure is performed on the Avid editor.

To enable transfers for AirSpeed Multi Stream servers in a standalone Environment:

1. Locate and install the AirSpeedMultiStreamRemoteConsoleSetup.exe file.

The AirSpeed Multi Stream Remote Console will automatically be installed on your 
system.

Enable transfers for AirSpeed Multi Stream Servers in a standalone environment, as 
described in “Enabling Transfers for AirSpeed Multi Stream Servers in a Standalone 
Environment” on page 158.

Install, configure and start the Avid Interplay Transfer Engine, as described in “Installing, 
Configuring and Starting the Interplay Transfer Engine” on page 160.

Configure standalone settings for the Avid editor, as described in “Configuring the 
Standalone Settings for the Avid Editor” on page 164.

Configure the AirSpeed Multi Stream for standalone transfer, as described in 
“Configuring the AirSpeed Multi Stream for Standalone Transfer” on page 165.

Configure the Integration Service on the AirSpeed Multi Stream, as described in 
“Configuring the Integration Service on the AirSpeed Multi Stream” on page 168.
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2. Launch the AirSpeed Multi Stream Remote Console by logging into Windows® XP or 
Vista, and then launching the application in one of the following ways:

t Click on the AirSpeed Multi Stream Remote Console icon on the desktop.

t Select Start > Programs > Avid > Avid AirSpeed Multi Stream Remote 
Console.

The Avid AirSpeed Multi Stream Remote Console application will automatically 
launch.

3.  Connect to the AirSpeed Multi Stream server that you want to use. For more 
information, see “Connecting to an AirSpeed Multi Stream Server” on page 295.

4. Once connected, select File > Configure Transfer Engine.

The Configure Transfer Engine dialog box opens.

5. Select the AirSpeed Multi Stream server name that you want to configure from the 
Select Server list.

The Select Server list displays the most recently used AirSpeed Multi Stream servers.

6. Click Add to add the selected server to the Configured Servers list. 

The Configured Servers list displays the AirSpeed Multi Stream servers that are 
configured for use by the standalone Transfer Manager server.

7. (Optional) To remove a server from the Configured Servers list, select the server you 
want to remove and click the Delete button.

8. For MPEG-2 (XDCAM) systems, select the compression format you want to use for 
your transfers from the XDCAM STP Format list.

n For SD, DNxHD, and AVC-Intra systems, leave this field blank.

9. Click the Update button to save your changes.

You will be asked to restart the Transfer Engine. Click OK.
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10. Manually stop and restart the Transfer Engine.

At this point, the server is configured for ingest and playback. For MPEG-2 (XDCAM) 
servers, a profile is generated that allows you to send to playback MPEG-2, 720p or 
1080i media. This will be denoted by the <AMSservername>-HD in the Avid editor 
upon sending an HD sequence to playback.

11. Next, you should configure the standalone settings for the Avid Editor. 

For more information, see “Configuring the Standalone Settings for the Avid Editor” on 
page 164.

Installing, Configuring and Starting the Interplay Transfer Engine

The next step is to install the Interplay Transfer Engine on each Avid editor. Then, configure 
the Ingest and Playback settings on the Interplay Transfer Engine to allow communication 
with the AirSpeed Multi Stream. Finally, you must start the Interplay Transfer Engine.

n These instructions are only a subset of the instructions for installation and configuration of 
the standalone Transfer Manager Engine. See the Avid Interplay Transfer Setup and User’s 
Guide documentation for complete installation and configuration instructions.

n  It is recommended that the XferMgrServer.exe is launched prior to launching the Avid editor 
to avoid having to reconnect the Avid editor to the standalone Interplay Transfer Engine.

If the "XferMgrServer.exe" is launched following launch of the Avid editor application, the 
User must select the "Transfer", "Reconnect to server" menu option to reconnect the Avid 
editor to the standalone Interplay Transfer Engine Server.

For more information, see the following topics:

• “Installing the Interplay Transfer Engine on the Avid Editor” on page 161

• “Configuring the Interplay Transfer Engine for a Standalone Environment” on page 161

• “Starting the Interplay Transfer Engine on the Avid Editor” on page 163
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Installing the Interplay Transfer Engine on the Avid Editor

This topic contains information on how to install a Interplay Transfer Engine on the Avid 
editor.

To install a Interplay Transfer Engine on the Avid editor:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file. 

The Main Menu page opens.

2. Click Avid Transfer Server.

The Welcome window opens.

3. Click Next.

n Make sure that the FTP services get installed with the Interplay Transfer Engine.

4. Click the applicable country, and click Next.

5. Click Yes to accept the license agreement.

n If you do not accept the license agreement, the Interplay Transfer Engine installation ends 
without completing.

6. The next step is to configure the Interplay Transfer Engine for a standalone 
environment. For more information, see “Configuring the Interplay Transfer Engine for 
a Standalone Environment” on page 161.

Configuring the Interplay Transfer Engine for a Standalone Environment

After installing the Interplay Transfer Engine on the Avid editor, you must configure the 
Interplay Transfer Engine to operate in a standalone environment.

To configure the Interplay Transfer Engine for a Standalone Environment:

1. On your Avid editor, select Start > Programs > Avid > Avid Interplay Transfer Engine 
Configuration.
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The Avid Interplay Transfer Engine Configuration window opens.

2. In the Standalone Settings section, confirm that the “AAF” option is selected.

For more information on the Standalone Settings area, refer to the Avid Unity 
TransferManager Version 2.9.22 Release Notes.

3. Click the Browse button to navigate to the location in which the media will be 
transferred to.

 For example, your shared storage or local volume, such as Z:\Avid 
MediaFiles\MXF\[your editor name].1.
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4. In the System Settings area, in the Storage type list, ensure that Standalone is already 
selected. If not, select it.

5. Click Save to save your changes.

You will get a message saying that “changes will not take effect until the Transfer 
Engine is restarted.”

6. Next, you should start the Interplay Transfer Engine on the Avid Editor. 

For more information, see “Starting the Interplay Transfer Engine on the Avid Editor” 
on page 163.

Starting the Interplay Transfer Engine on the Avid Editor

If the Interplay Transfer Engine is not currently running on the Avid editor, you must start it.

To start the Interplay Transfer Engine on the Avid editor:

1. Select Start > Programs > Avid > Transfer Engine > Standalone Mode.

The Transfer Engine application launches. The title bar should show the words 
“Standalone Mode”, and also have the Workgroup name that the AirSpeed Multi Stream 
is associated with.

2. Next, you must configure the standalone settings for your Avid Editor. 

For more information, see “Configuring the Standalone Settings for the Avid Editor” on 
page 164.
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Configuring the Standalone Settings for the Avid Editor

Once all of the required software is installed, you must next configure the standalone 
settings for the Avid editor.

To configure the standalone settings for the Avid Editor:

1. In the Avid editor, do the following:

a. Open the Project Window

b. Click the Settings tab

c. Click Transfer

The Transfer Settings - Current dialog box opens.

2. Select the TMClient.ini tab.

3. In the My Workgroup area, click Edit.

The Edit My Workgroup dialog box opens.
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4. In the Server field, type the name of the Avid editor that has the Interplay Transfer 
engine installed.

5. In the Workgroup field, type a name for your workgroup that you want the AirSpeed 
Multi Stream (for example “AvidWorkgroup”) to be associated with, and click OK.

6. Click OK.

7. Next, you must configure the AirSpeed Multi Stream for standalone transfer. For more 
information, see “Configuring the AirSpeed Multi Stream for Standalone Transfer” on 
page 165.

Configuring the AirSpeed Multi Stream for Standalone Transfer

The next step is to configure the AirSpeed Multi Stream server for standalone transfer. 

To configure the AirSpeed Multi Stream for standalone transfer:

1. On the AirSpeed Multi Stream server, select Start > Programs > Avid > Avid 
Framework > Avid Workgroup Properties.

The Avid Workgroup Properties dialog box opens to the Services tab.
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2. In the Login tab, make sure that the “Automatically join the preferred workgroup” 
option is not selected. 

n This is so you are prompted to select a Workgroup in the Avid Service Configuration.

3. Click the Lookup tab.
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4. Type the name of the Workgroup (for example “localhost”) that you want the AirSpeed 
Multi Stream to be associated with, and click OK.

5. Select the Lookup tab, do the following:

a. In the Workgroup area, (left pane), highlight the local machine (server name).

b. In the Lookup Services area (right pane), click Add to add a Lookup service.

The Add Lookup Service dialog box opens.

6. In the Host name field, type “localhost”.

7. Click to select the Expected check box, and click OK to save the changes, and close the 
Add Lookup Service dialog box.

8. In the Avid Workgroup Properties dialog box, click Apply to restart the services. 

The Restart Avid Services message box opens asking if you want to restart services.

9. Click Yes to restart the service.

The service will be restarted.

10. Click OK to close the Avid Workgroup Properties dialog box.

11. The next step is to configure the Service Configuration on the AirSpeed Multi Stream 
server. 

For more information, see “Configuring the Integration Service on the AirSpeed Multi 
Stream” on page 168.
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Configuring the Integration Service on the AirSpeed Multi Stream

The next step is to configure the Integration Service on the AirSpeed Multi Stream for use in 
a standalone environment.

There are six stages (one optional) to configure the Avid Service Configuration for 
Standalone AirSpeed Multi Stream. They are listed in the checklist below and each is 
described in detail following the checklist:

Enabling Standalone Mode

The next step is to enable Standalone mode in the Avid Service Configuration.

To enable Standalone mode:

1. On the AirSpeed Multi Stream system, select Start > Programs > Avid > Avid 
Framework > Avid Service Configuration.

The Avid Service Configuration dialog box opens to the Service tab, and a list of all of 
the servers connected to the Avid Service Framework appears. In the Hosts column, 
your AirSpeed Multi Stream system name appears in the list in Bold type (if you are 
connected to that system).

Enable Standalone Mode. See “Enabling Standalone Mode” on page 168.

Set up User profiles. See “Setting Up User Profiles” on page 170. 

Set up Record templates. See “Setting Up Record Templates” on page 171. 

n It is not necessary to set up Destination templates in a standalone environment.

Select Default templates. See “Selecting Default Templates” on page 173.

Set up Inventory rules. See “Setting Up Inventory Rules” on page 175.

(Optional) Install the AirSpeed Multi Stream Device Service. See “(Option) Installing the 
AirSpeed Multi Stream Device Service” on page 176.
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2. In the left pane, within your AirSpeed Multi Stream server name, select “Avid AirSpeed 
Multi Stream-Integration Service”.

3. On the Service tab, deselect both the “Interplay Enabled?”and “Transfer Engine 
Enabled?” check boxes.

n Disabling both of these check boxes, disables Interplay and your Transfer Engine in the 
Monitor application.

4. The next step is to create a user that will have the necessary privileges to administer the 
AirSpeed Multi Stream with the AirSpeed Multi Stream Remote Console. For more 
information, see “Setting Up User Profiles” on page 170.
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Setting Up User Profiles

The next step is to set up user profiles to create a user that will have the necessary privileges 
to administer the AirSpeed Multi Stream with the AirSpeed Multi Stream Remote Console.

To set up user profiles:

1. Click the User Profiles tab to create a user that will have the necessary privileges to 
administer the AirSpeed Multi Stream with the AirSpeed Multi Stream Remote 
Console..

n For the Standalone configuration to work, you need to be logged in as this user on the local 
Avid editing machine.

2. Create a new user by doing the following:

a. Click the Add button.

The text “NewUser” appears in the Name field.

b. In the Name field, type over the supplied user name with the name of the new user 
that you want to create.

c. (Optional) In the Description field, type a title or description pertaining to the new 
user.

d. Select the Inventory and Channel privileges that you want to assign to the user you 
are creating. 

e. Click Apply.



Standalone Transfer Manager Configuration

171

The user you create must have the same username and password as your Shared Storage 
environment.

3. (Optional) If you already have created a user, and you want to create another user with 
the same or similar Inventory and Channel privileges, do the following:

a. Select (to highlight) an existing user from the User Profile list

b. Click the Copy button.

The text “NewUser” appears in the Name field and the Inventory and Channel 
privileges are the same as the user you had selected.

c. In the Name field, type over the supplied user name with the name of the user that 
you want to create.

d. (Optional) In the Description field, type a title or description pertaining to the new 
user.

e. (Optional) If you want to change the Inventory and Channel privileges, select the 
desired privileges that you want to assign to the user you are creating. 

f. Click Apply.

4. Repeat Steps 2 or 3 for each additional user that you want to create.

5. The next step is to set up Record templates. For more information, see “Setting Up 
Record Templates” on page 171.

Setting Up Record Templates

Once you have configured your AirSpeed Multi Stream with a standalone Transfer Manager, 
you must set up your Record templates for your AirSpeed Multi Stream capture.

n  Record templates can only be set up through the Avid Service Configuration. 

n For Standalone Transfer Manager configurations, you do not need to make any changes to 
the Destination templates tab.
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To set up your Record templates:

1. Click the Record Templates tab.

The Record Templates tab opens.

2. Select a pre-defined Record template from the list, and click the Copy button. 

A new Record template based on the one you selected is created.

3. In the Name field, type a name for your new Record template.

4. (Option) In the Description field, type information that will appear as metadata for your 
recorded clips.

5. In the Audio Settings section, do the following:

a. (Option) Assign a name for each audio stream by typing a name for the audio 
settings in the Name field next to the stream you want to name.

b. In the Type field for each audio stream, select the audio format for each stream you 
are recording. 

Keep in mind that SD and DNxHD models have 1-4 streams or audio, and MPEG-2 
HD, and AVC-Intra models have 1-8 streams of audio.

Keep in mind, each stream represents a stereo pair.

6. Click the Apply button (upper left) to create the new Record template.

7. Repeat this procedure for any additional Record templates that you want to create for 
your site.
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Now that you have created Record templates, you must apply them. For more 
information, see “Selecting Default Templates” on page 173.

Selecting Default Templates

Next, you must setup your default templates that AirSpeed Multi Stream will use for your 
site.

n For standalone Transfer Manager configurations, you will notice the Destination tab is 
greyed out.

To select default templates:

1. Click the Default Templates tab.
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2. (Option) For each channel menu, select the Record template that best fits your site’s 
requirements. 

n For each channel, the Record drop-down list contains all supported Record templates based 
on the video standard (NTSC, PAL, 1080i or 720p) of the channel. 

n Every time you switch the video standard of the channel (for example, from NTSC to 720p, 
or from 720p to 1080i59.94), the Record template is set back to None by default. You have to 
reconfigure it.

For more information, see “Modifying Clip File Data” on page 255.

a. (Option) Below the Record Templates for channels 1-4, select a default setting for 
each format. The formats are displayed in the following Format Default Template 
fields:

t NTSC or PAL (for SD)

t 1080i

t 720p

n With each of these formats predefined, when you change the format for a given channel in 
the AirSpeed Multi Stream application and restart the application, the predefined template 
for that format will be applied to the appropriate channel. 

If the Format Default Templates are not predefined, and you switch formats of a given 
channel, the template for that channel will be set to NONE in the Avid Service 
Configuration, and you will need to manually configure each channel respectively.

3. Click the Apply button to save your changes.

4. Next, you must set up Inventory rules. For more information, see “Setting Up Inventory 
Rules” on page 175.
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Setting Up Inventory Rules

Next, you can set up Inventory rules. 

n The fields that are greyed out are for use in a Workgroup environment.

To set up inventory rules:

1. Click the Inventory tab.

The Inventory tab opens.

2. (Option) If you want to allow for control of the “overwrite” behavior during a Send To 
Playback (STP) operation, make sure the “Allow Overwrite on Send to Playback” 
checkbox is enabled. This check box is enabled by default and allows Editors to 
overwrite clips on the server when performing STPs as in all previous releases. 

When this selection is disabled, an Editor will not be able to overwrite a clip that exists 
on the AirSpeed Multi Stream, even when they select the “overwrite” flag in the 
send-to-playback dialog of the editor. This is to prevent unexpected or unauthorized 
overwriting of assets on the server. If this is attempted, the transfer will fail with an error 
saying “Error: item already exists”.

3. (Option) If you want to generate a low-res MPEG-1 proxy after playback transfer 
completes, click the “Generate local MPEG-1 proxy after playback transfer 
completes?” check box. Otherwise, leave it unchecked.

n MPEG-1 proxies are for local playback on the AirSpeed Multi Stream only.
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c Under heavy loads, generating proxies while ingesting or playing out can inhibit system 
performance. Therefore, it is recommended to not generate proxies while recording or 
playing out.

4. (Option) If you want to begin delete at a specific metric based on time, click the “Begin 
delete” check box, and type a percentage in the field for each option that you want to 
specify deletion parameters.

Media will delete starting with the oldest clips first.

5. (Option) If you want to delete all inventory daily, select the “Delete all inventory daily 
at (24 hour HH:MM)” check box, and enter a time when you want to delete your 
inventory in hour and minute (HH:MM) format.

6. Click Apply.

7. Close the AirSpeed Multi Stream Service Configuration dialog box.

Next, you must launch Transfer Manager if it is not already running. For more information 
on launching Transfer Manager, see “Starting the Interplay Transfer Engine on the Avid 
Editor” on page 163.

(Option) Installing the AirSpeed Multi Stream Device Service

If your site uses Avid iNEWS Command to control AirSpeed Multi Stream channels for 
capture or playout, you need to install the Interplay AirSpeed Multi Stream Device Service 
on the AirSpeed Multi Stream server. The AirSpeed Multi Stream Device Service (located 
on the Command CD) needs to be installed on the AirSpeed Multi Stream server that is 
being controlled by either Command.

To install AirSpeed Multi Stream Device Service on the AirSpeed Multi Stream server:

1. Locate your Avid iNEWS Command CD, or navigate to somewhere on your network 
where it is located.

2. Navigate to the Avid_Framework_Workstation folder in the installation location for 
your site.

3. Double-click the AvidAirSpeedMultiStreamDeviceService.exe to launch the installer.

A splash screen appears, followed by a Welcome dialog box.

4. Click Next. 

The License Agreement dialog box opens.

5. Read the License Agreement, accept the terms, and click Next. 

6. Click Install to install the AirSpeed Multi Stream Device Service. 
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7. You now must create a new database for the AirSpeed Multi Stream. For more 
information, see “Creating a New Database in the AirSpeed Multi Stream Application” 
on page 100.
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6 Setting Up for Team Configuration

This chapter provides information on setting up the AirSpeed Multi Stream for a Team 
configuration. In this configuration, AirSpeed Multi Stream supports playout automation 
applications such as iNEWS ® Command, DNF controllers and other solutions using VDCP 
or AMS API. 

In a Team configuration, AirSpeed Multi Stream uses Shared storage, and clips are visible 
through the AirSpeed Multi Stream Remote Console and can be used to drag and drop files 
into the Editor bin. 

AirSpeed Studio is supported for AirSpeed Multi Stream servers configured in a Team 
Configuration, with the following minimum software versions:

• AirSpeed Multi Stream v1.8

• TM Client v2.4

• NewsCutter v9.5.2

• Media Composer v5.5.2

• Symphony v5.5.2

In a Team Configuration, AirSpeed Multi Stream does not support the features or software 
listed below:

• Interplay Capture

• CaptureManager

For more information, see the following topics:

• Team Configuration

• Optional AirSpeed Multi Stream Configuration Procedures

n Prior to proceeding with AirSpeed Multi Stream configuration, ensure that your AirSpeed 
Multi Stream is installed and connected using the information in “Installing the Hardware 
and Setting Up Your System” on page 61.
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Team Configuration

When AirSpeed Multi Stream is configured in the Team Configuration, it operates in 
environments where you have shared storage without Interplay. In a Team configuration, the 
AirSpeed Multi Stream application does not require Interplay to transfer media to storage.

The following table lists the minimum supported Editor and Transfer software versions 
(Windows only, not Macintosh support) and the associated documentation.

All of the documentation for configuration is available on the Avid Knowledge Base. This 
documentation assists users in configuration of the standalone TransferManager. The Avid 
Interplay Transfer Setup and User’s Guide, and the Avid Interplay Transfer v1.0 Readme are 
available at the top level of the Avid Interplay Transfer CD-ROM. 

n You must be sure that your AirSpeed Multi Stream, ISIS storage, and your Avid editing client 
system times are in close proximity to each other. Otherwise media might appear to be 
offline.

n For the latest versions of the documentation, see the Avid Knowledge Base. Go to 
www.avid.com.

n The terms “Interplay Transfer” and “TransferManager” refer to the server and Client 
Transfer software included with your version of NewsCutter or Media Composer. Therefore, 
these terms can be interchangeable when discussing the server or Client Transfer software 
in general. However, when you are referred to other documents, you must look in the 
document that relates to the actual product that you have in your environment (“Interplay 
Transfer” or “TransferManager”).

System Requirements  

Editor Version Transfer Software

NewsCutter v9.5.2 or later Avid Interplay Transfer Client v2.4 or later

Media Composer v5.5.2 or later Avid Interplay Transfer Client v2.4 or later

Symphony v5.5.2 or later Avid Interplay Transfer Client v2.4 or later

http://www.avid.com
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Configuration Requirements for AirSpeed Multi Stream

Each AirSpeed Multi Stream must be configured with the following:

•  Site-specific settings need to be applied for the AirSpeed Multi Stream to operate in a 
Team configuration. Each AirSpeed Multi Stream server that is installed needs to be 
uniquely configured. 

• You must create a site-specific host name/domain name of the AirSpeed Multi Stream, 
including an IP address and mask for the network interface.

• The Shared Storage Client for Avid Unity ISIS 5000 or ISIS 7000. 

n In a Team configuration, neither Unity MediaNetwork or Macintosh clients are supported.

• Avid strongly recommends that when you are set up in a Team configuration, you must 
time sync the AirSpeed Multi Stream(s), editor system(s), and your ISIS shared storage 
system together. Otherwise, you run the risk of having media appearing to be off-line.

Once these requirements are met, and you have installed all of the necessary hardware and 
software for your site, you can configure the AirSpeed Multi Stream. For more information 
on specific tasks involved when configuring your AirSpeed Multi Stream for a Team 
configuration, see “AirSpeed Multi Stream Configuration Checklist” on page 182.

Software Requirements for the Avid Editing Client

In order to work with AirSpeed Multi Stream in a Team configuration, each Avid Editing 
client must have the following software loaded:

• an Avid editing application (Media Composer, NewsCutter, or Symphony)

• Standalone AirSpeed Multi Stream Remote Console application

• The Shared Storage Client for Avid Unity ISIS

• Avid Interplay Transfer Engine (client)

• Avid Framework (installed with the AirSpeed Multi Stream application)
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AirSpeed Multi Stream Configuration Checklist

The following table provides a checklist of tasks that must be performed when setting up 
your AirSpeed Multi Stream in a Team Configuration. 

Depending on your site’s configuration, some tasks are optional.

Configuring the Standalone Settings for the Avid Editor

Once all of the required software is installed, you must next configure the standalone 
settings for the Avid editor.

To configure the standalone settings for the Avid Editor:

1. In the Avid editor, do the following:

a. Open the Project Window

b. Click the Settings tab

c. Click Transfer

The Transfer Settings - Current dialog box opens.

Configure standalone settings for the Avid editor, as described in “Configuring the 
Standalone Settings for the Avid Editor” on page 182.

Set up the AirSpeed Multi Stream for Team configuration, as described in “Configuring 
the AirSpeed Multi Stream for Team Configuration” on page 184.

Configure the Integration Service on the AirSpeed Multi Stream, as described in 
“Configuring the Integration Service on the AirSpeed Multi Stream” on page 186.
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2. Select the TMClient.ini tab.

3. In the My Workgroup area, do the following:

a. Click Edit.

The Edit My Workgroup dialog box opens. You will notice that the AirSpeed Multi 
Stream server (standaloneams-1) is listed at the top and the other AirSpeed Multi 
Stream servers are listed in the “Other Workgroups” section.

b. In the Server field, type the name of the AirSpeed Multi Stream server that you 
want to perform the ingests and send to playback operations.

c. In the Workgroup field, type a name for your workgroup that you want the 
AirSpeed Multi Stream (for example “standalone”) to be associated with, and click 
OK.
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4. In the Other Workgroups area, add the names of any other AirSpeed Multi Stream 
servers that you might use for ingest or send to playback. 

n Make sure you use the same Workgroup name as you entered in the previous step.

5. Click OK.

6. Next, you must configure the AirSpeed Multi Stream for Team configuration. For more 
information, see “Configuring the AirSpeed Multi Stream for Team Configuration” on 
page 184.

Configuring the AirSpeed Multi Stream for Team Configuration

The next step is to set up the AirSpeed Multi Stream server for Team configuration. 

To set up the AirSpeed Multi Stream for Team configuration:

1. On the AirSpeed Multi Stream server, select Start > Programs > Avid > Avid 
Framework > Avid Workgroup Properties.

The Avid Workgroup Properties dialog box opens to the Services tab.
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2. In the Login tab, make sure that the “Automatically join the preferred workgroup” 
option is not selected. 

n This is so you are prompted to select a Workgroup in the Avid Service Configuration.

3. Click the Lookup tab.

4. Type the name of the Workgroup (for example “localhost”) that you want the AirSpeed 
Multi Stream to be associated with, and click OK.
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5. Select the Lookup tab, do the following:

a. In the Workgroup area, (left pane), highlight the local machine (server name).

b. In the Lookup Services area (right pane), click Add to add a Lookup service.

The Add Lookup Service dialog box opens.

6. In the Host name field, type “localhost”.

7. Click to select the Expected check box, and click OK to save the changes, and close the 
Add Lookup Service dialog box.

8. In the Avid Workgroup Properties dialog box, click Apply to restart the services. 

The Restart Avid Services message box opens asking if you want to restart services.

9. Click Yes to restart the service.

The service will be restarted.

10. Click OK to close the Avid Workgroup Properties dialog box.

11. The next step is to configure the Service Configuration on the AirSpeed Multi Stream 
server. 

For more information, see “Configuring the Integration Service on the AirSpeed Multi 
Stream” on page 186.

Configuring the Integration Service on the AirSpeed Multi Stream

The next step is to set up the Integration Service on the AirSpeed Multi Stream for use in a 
Team configuration.

There are six stages (one optional) to configure the Avid Service Configuration for Team 
configuration. They are listed in the checklist below and each is described in detail following 
the checklist:

Enable Standalone Mode. See “Enabling Standalone Mode” on page 187.

Set up User profiles. See “Setting Up User Profiles” on page 189. 
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Enabling Standalone Mode

The next step is to enable Standalone mode in the Avid Service Configuration.

To enable Standalone mode:

1. On the AirSpeed Multi Stream system, select Start > Programs > Avid > Avid 
Framework > Avid Service Configuration.

The Avid Service Configuration dialog box opens to the Service tab, and a list of all of 
the servers connected to the Avid Service Framework appears. In the Hosts column, 
your AirSpeed Multi Stream system name appears in the list in Bold type (if you are 
connected to that system).

2. In the left pane, within your AirSpeed Multi Stream server name, select “Avid 
AirSpeed Multi Stream-Integration Service”.

Set up Record and Destination templates. See “Setting Up Record and Destination 
Templates” on page 190. 

Select Default templates. See “Selecting Default Templates” on page 193.

Set up Inventory rules. See “Setting Up Inventory Rules” on page 195.

(Optional) Install the AirSpeed Multi Stream Device Service. See “(Option) Installing the 
AirSpeed Multi Stream Device Service” on page 197.
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3. On the Service tab, click to disable the “Interplay Enabled?” check box, and leave the 
“Transfer Engine Enabled?” check box enabled.

n This combination disables Interplay, and enables your Transfer Engine in the Monitor 
application.

4. The next step is to create a user that will have the necessary privileges to administer the 
AirSpeed Multi Stream with the AirSpeed Multi Stream Remote Console. For more 
information, see “Setting Up User Profiles” on page 189.
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Setting Up User Profiles

The next step is to set up user profiles to create a user that will have the necessary privileges 
to administer the AirSpeed Multi Stream with the AirSpeed Multi Stream Remote Console.

To set up user profiles:

1. Click the User Profiles tab to create a user that will have the necessary privileges to 
administer the AirSpeed Multi Stream with the AirSpeed Multi Stream Remote 
Console.

n For the Team configuration to work, you need to be logged in as this user on the local Avid 
editing machine.

2. Create a new user by doing the following:

a. Click the Add button.

The text “NewUser” appears in the Name field.

b. In the Name field, type over the supplied user name with the name of the new user 
that you want to create.

c. (Optional) In the Description field, type a title or description pertaining to the new 
user.

d. Select the Inventory and Channel privileges that you want to assign to the user you 
are creating. 

e. Click Apply.
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The user you create must have the same user name and password as your Shared Storage 
environment.

3. (Optional) If you already have created a user, and you want to create another user with 
the same or similar Inventory and Channel privileges, do the following:

a. Select (to highlight) an existing user from the User Profile list

b. Click the Copy button.

The text “NewUser” appears in the Name field and the Inventory and Channel 
privileges are the same as the user you had selected.

c. In the Name field, type over the supplied user name with the name of the user that 
you want to create.

d. (Optional) In the Description field, type a title or description pertaining to the new 
user.

e. (Optional) If you want to change the Inventory and Channel privileges, select the 
desired privileges that you want to assign to the user you are creating. 

f. Click Apply.

4. Repeat Steps 2 or 3 for each additional user that you want to create.

5. The next step is to set up Record templates. For more information, see “Setting Up 
Record and Destination Templates” on page 190.

Setting Up Record and Destination Templates

Once you have set up your AirSpeed Multi Stream in the Team configuration, you must set 
up your Record and Destination templates for your AirSpeed Multi Stream capture.

n  Record templates can only be set up through the Avid Service Configuration. 

n For Team configurations, you cannot configure a per-channel Destination template. Instead, 
a template selected on the Default Templates tab will determine the location that the media 
and metadata is transferred to. Workspace steering via the API is supported.
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To set up your Record and Destination templates:

1. Click the Record Templates tab.

The Record Templates tab opens.

2. Select a pre-defined Record template from the list, and click the Copy button. 

A new Record template based on the one you selected is created.

3. In the Name field, type a name for your new Record template.

4. (Option) In the Description field, type information that will appear as metadata for your 
recorded clips.

5. In the Audio Settings section, do the following:

a. (Option) Assign a name for each audio stream by typing a name for the audio 
settings in the Name field next to the stream you want to name.

b. In the Type field for each audio stream, select the audio format for each stream you 
are recording. 

Keep in mind that SD and DNxHD models have 1-4 streams or audio, and MPEG-2 
HD, and AVC-Intra models have 1-8 streams of audio.

Keep in mind, each stream represents a stereo pair.

6. Click the Apply button (upper left) to create the new Record template.

7. Click the Destination Templates tab.
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The Destination Templates tab opens. Use the Destination Templates tab to specify the 
folder in which AirSpeed Multi Stream should store ingested clips and the workspace in 
which it should store the ingested media.

8. Click the New button (lower left). 

A “new” template is created called “New Template”.

9. In the Name field, highlight the “New Template” and type a name for your new 
Destination template. 

n The names of your Destination templates must be unique. You cannot have two Destination 
templates with the same name.

10. (Option) Enter additional information regarding your Destination template in the 
following fields: 

t Description

n Since the Clip Name field is greyed out in this configuration, if you want clips that are 
generated to have a unique name in the AirSpeed Multi Stream database, you can do so in 
the AirSpeed Multi Stream user interface by typing “.$n” at the end of the clip name in the 
Name field in either the Edit Template for Channel dialog box or the Item Properties dialog 
box. For more information, see “Recording a Clip” on page 235.
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t Ingest Folder Path - Type the name of a subfolder in the Ingest folder path in which 
to store the ingested clips.

n If these characters (* | “ < > ?) are used in the Ingest Folder Path field, they will be 
translated to (_). The ( / and \ ) characters behave as folder level separators.

11. In the Workspace field, specify the workspace or workspaces in which AirSpeed Multi 
Stream should store the ingested media. You must specify a workspace in the 
Workspace field. 

12. Click the Apply button to create the new Destination template. 

13. .Now that you have created both Record and Destination templates, you must apply 
them. For more information, see 

For more information, see “Selecting Default Templates” on page 193.

Selecting Default Templates

Next, you must setup your default templates that AirSpeed Multi Stream will use for your 
site.

To select default templates:

1. Click the Default Templates tab.
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2. (Option) For each channel menu, select the Record template that best fits your site’s 
requirements. 

n For each channel, the Record drop-down list contains all supported Record templates based 
on the video standard (NTSC, PAL, 1080i or 720p) of the channel. 

n Every time you switch the video standard of the channel (for example, from NTSC to 720p, 
or from 720p to 1080i59.94), the Record template is set back to None by default. You have to 
reconfigure it.

For more information, see “Modifying Clip File Data” on page 255.

a. (Option) Below the Record Templates for channels 1-4, select a default setting for 
each format. The formats are displayed in the following Format Default Template 
fields:

t NTSC or PAL (for SD)

t 720p

t 1080i

n With each of these formats predefined, when you change the format for a given channel in 
the AirSpeed Multi Stream application and restart the application, the predefined template 
for that format will be applied to the appropriate channel. 

If the Format Default Templates are not predefined, and you switch formats of a given 
channel, the template for that channel will be set to NONE in the Avid Service 
Configuration, and you will need to manually configure each channel respectively.

3. (Option) For MPEG-2 HD (XDCAM) formats only, in the “XDCAM Send-to-playback 
format based on” field, set it to the HD format that you are using for MPEG-2 HD.

4. In the “Ingest transfer workspace/project based on” field, select the Destination template 
that includes the workspace that you want to transfer the media to.

5. (Option) If you want to automatically create .AAF files, in the “Master clip location 
(Standalone)” field, select the ISIS workspace for which you want the AAF file to be 
transferred to.

n It is recommended that the location you select matches the location where the media resides.

6. Click the Apply button to save your changes.

7. Next, you must set up Inventory rules. For more information, see “Setting Up Inventory 
Rules” on page 195.
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Setting Up Inventory Rules

Next, you can set up Inventory rules. 

n Any fields that appear greyed out are for use in a Workgroup environment.

To set up inventory rules:

1. Click the Inventory tab.

The Inventory tab opens.

2. (Option) If you want to allow Play While Transfer (PWT) functionality, make sure the 
“Allow Play While Transfer?” check box is enabled.

n As of AirSpeed Multi Stream v1.8.1, Play While Transfer (PWT) functionality is available in 
both the Team and Workgroup configurations. In previous versions, PWT functionality was 
not yet available for those configurations. Therefore, if you are not running version 1.8.1 or 
later (or, if you do not want to allow Play While Transfer functionaility), do not check the 
“Allow Play While Transfer?” check box. 
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3. (Option) If you want to allow for control of the “overwrite” behavior during a Send To 
Playback (STP) operation, make sure the “Allow Overwrite on Send to Playback” 
checkbox is enabled. This check box is enabled by default and allows Editors to 
overwrite clips on the server when performing STPs as in all previous releases. 

When this selection is disabled, an Editor will not be able to overwrite a clip that exists 
on the AirSpeed Multi Stream, even when they select the “overwrite” flag in the 
send-to-playback dialog of the editor. This is to prevent unexpected or unauthorized 
overwriting of assets on the server. If this is attempted, the transfer will fail with an error 
saying “Error: item already exists”.

4. (Option) The “Delete XDCAM Temporary Files after Transfer?” check box is for 
diagnostic purposes and should be left checked during normal operation. The default 
state of this check box is to be On (selected). Only disable (deselect) this setting when 
an Avid representative recommends that you deselect it. It is used internally by Avid to 
gather system data.

5. (Option) If you want to transfer the D track (The D track is available with later Editor 
versions) to Interplay, select the “Transfer Ancillary Streams to Shared Storage?” 
check box.

6. (Option) If you want to generate a low-res proxy after playback transfer completes, click 
the “Generate a local MPEG-1 proxy after playback transfer completes?” check 
box. Otherwise, leave it unchecked.

n Low res proxies are for local playback on the AirSpeed Multi Stream only.

c Under heavy loads, generating proxies while ingesting or playing out can inhibit system 
performance. Therefore, it is recommended to not generate proxies while recording or 
playing out.

7. (Option) If you want to begin delete at a specific metric based on time, click the “Begin 
delete” check box, and type a percentage in the field for each option that you want to 
specify deletion parameters.

Media will delete starting with the oldest clips first.

8. (Option) If you want to delete all inventory daily, select the “Delete all inventory daily 
at (24 hour HH:MM)” check box, and enter a time when you want to delete your 
inventory in hour and minute (HH:MM) format.

9. Make sure that the “Restart transfer engine daily at” check box is selected, and enter a 
time when you want the Transfer Engine to restart in hour and minute (HH:MM) format. 

n This enables the application to handle larger file counts on the Shared storage. By creating 
additional folders, the files will be listed in more manageable groups.

10. Click Apply.
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11. Close the AirSpeed Multi Stream Service Configuration dialog box.

Next, If your site uses Avid iNEWS Command to control AirSpeed Multi Stream channels 
for capture or playout, you need to install the Interplay AirSpeed Multi Stream Device 
Service on the AirSpeed Multi Stream server. For more information, see “(Option) Installing 
the AirSpeed Multi Stream Device Service” on page 197.

(Option) Installing the AirSpeed Multi Stream Device Service

If your site uses Avid iNEWS Command to control AirSpeed Multi Stream channels for 
capture or playout, you need to install the Interplay AirSpeed Multi Stream Device Service 
on the AirSpeed Multi Stream server. The AirSpeed Multi Stream Device Service (located 
on the Command CD) needs to be installed on the AirSpeed Multi Stream server that is 
being controlled by either Command.

To install AirSpeed Multi Stream Device Service on the AirSpeed Multi Stream server:

1. Locate your Avid iNEWS Command CD, or navigate to somewhere on your network 
where it is located.

2. Navigate to the Avid_Framework_Workstation folder in the installation location for 
your site.

3. Double-click the AvidAirSpeedMultiStreamDeviceService.exe to launch the installer.

A splash screen appears, followed by a Welcome dialog box.

4. Click Next. 

The License Agreement dialog box opens.

5. Read the License Agreement, accept the terms, and click Next. 

6. Click Install to install the AirSpeed Multi Stream Device Service. 

7. You now must create a new database for the AirSpeed Multi Stream. For more 
information, see “Creating a New Database in the AirSpeed Multi Stream Application” 
on page 100.
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7 Fundamentals

This chapter describes an overview of the various components of the AirSpeed Multi Stream 
application.

The following topics are included:

• Starting AirSpeed Multi Stream

• AirSpeed Multi Stream Database Overview

• Opening a Database

• User Interface

• Main Menu

• Network Tree

• Browse Window

• Headframes

• MiniMonitor Window

• Preview Dialog Box

• Dockable Items

• Main Toolbar

• Air Toolbar

• Right-Click Menus

• Selecting Clips

• Status Bar

• Numeric Keypad

• Keyboard Shortcuts
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Starting AirSpeed Multi Stream

During the installation process, a shortcut to AirSpeed Multi Stream was installed on your 
computer’s desktop. 

n Before starting AirSpeed Multi Stream, ensure that all Anti-virus software is completely 
disabled while the AirSpeed Multi Stream application is running. Anti-virus software can 
only be run when AirSpeed Multi Stream is off-line. 

To start AirSpeed Multi Stream:

t Log into Windows® XP.

AirSpeed Multi Stream and related components will automatically launch.

AirSpeed Multi Stream Database Overview

The term “database” as used in AirSpeed Multi Stream refers to an actual database as well as 
all of the associated image and clip files that are associated with that database. Therefore, the 
term database can refer either to the actual database file itself, or the database file plus all of 
the associated files. 

The files in a database are as follows:

• The database itself. These files are located at the root of the database structure and are 
named as follows:

- t_flash_st.db

- t_flash_st.idx

- flashtkn.tku

- flash_st.lok

• The Essence files. These contain the actual video and audio essence. They have a suffix 
of .tmf and are in the “clips” subdirectory.

• The head frame files. These contain a full resolution uncompressed YUV still image of 
the selected headframe. They also contain a redudant copy of the metadata for the clip. 
They have a suffix of .g and are located in the “pic_dir” subdirectory.

• The icon files. These contain low resolution YUV still images in several sizes and are 
used by the GUI to draw the images on the VGA screen. They have a suffix of .D and 
are located in the “bw_pics” subdirectory.

• The proxy files. These contain low resolution video and audio. They have a suffix of 
.mpg and .mpg.index, and are located in the “proxies” directory.
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You can repair a database that has become damaged, remove unneeded files and reclaim disk 
space by rebuilding a database using the Rebuild Database Options dialog box. For more 
information on repairing an AirSpeed Multi Stream database, see “Rebuilding a Database” 
on page 340.

Opening a Database

A database in AirSpeed Multi Stream is a collection of clips, represented by thumbnail 
images called headframes, and associated data. When opened, it’s contents are displayed in a 
Database window, also called the Browse window. This data includes the name of the clip, 
notes about its content, the dates captured, and so on. If the AirSpeed Multi Stream system 
has multiple databases created, there can be several folders in the Network Tree with one 
database (.pff) file in each folder.

A database can contain both SD and HD clips as long as they have related frame rates. For 
example, an NTSC 29.97 FPS clip can be in the same database as a 1080i 59.95 FPS clip, 
and a PAL 25 FPS clip can be in the same database as a 1080i 50 FPS clip.

To open an AirSpeed Multi Stream database:

1. Do one of the following: The contents of the folder display in the Network Tree. 

t Double-click on a folder

As an alternative, you can also select or reopen a file from Recents Files under the 
File Menu.

t Select File > Open

t Type Ctrl + O

2. Double-click on the icon for the .pff file (.pff is the extension for a database in AirSpeed 
Multi Stream). The database opens. The network tree shows all of the databases that 
your system is aware of. If no folders are shown, there are no databases currently 
selected on your system.

3. If you know a database exists somewhere on your system, select File > Open, and 
navigate to the location of the database. 

4. Select the .pff file, then click Open in the Browse window.

5. If there are no other databases on your system, create one by selecting File > Advanced 
> Create New Database. For more information, see “Creating a New Database in the 
AirSpeed Multi Stream Application” on page 105.



7  Fundamentals

202

Closing a Database

AirSpeed Multi Stream provides many ways to close previously opened databases.

To close a database:

t Select the database, and then select File > Close.

t Click the X to the right of the Database window.

t Type Ctrl + F4.

Locking and Unlocking a Database

You can lock a currently selected database, so that other users cannot access it. You can also 
unlock a database to allow access. 

To lock a database:

t Select the database, and then select File > Lock Database.

To unlock a database:

t Select the database in the Network tree, and then right-click, and select Remove all 
Locks from the menu.

Showing Properties for a Database File

This feature displays properties for a selected database. This is the same dialog box that is 
displayed when you create a new database. The only difference is that the dialog box title 
will be “Database Properties” instead of “Create New Database” and all the fields will be 
“read only” since you are not allowed to change a database after it has been created.
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To view the properties of a database:

1. Right-click a database in the Database tree view and select Properties.

The Database Information dialog box opens.

2. View information, such as the Location, and any other pertinent database information.

For more information on the fields in this dialog box, see “Creating a New Database in 
the AirSpeed Multi Stream Application” on page 105.
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User Interface

AirSpeed Multi Stream has a graphic user interface incorporating windows, toolbars and 
menus. The following illustration identifies the key elements of the AirSpeed Multi Stream 
user interface. The function and use of these elements is discussed in this chapter and 
throughout this guide.

MiniMonitor

Main
toolbar

Air
toolbar

Network
tree

Browse
window

Headframe
of a clip
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Main Menu

Located at the top of the application, the Main menu contains the following menus:

• File

• Edit

• View

• Air

• Window

• Help

For more information, see each of the menu topics.

• For information on the File menu, see File Menu

• For information on the Edit menu, see Edit Menu

• For information on the View menu, see View Menu

• For information on the Air menu, see Air Menu

• For information on the Window menu, see Window Menu

• For information on the Help menu, see Help Menu
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File Menu

The File menu contains the following submenus. Each is described in the following table.

File Menu Submenus  

Option Description

Open Opens an existing database. For more information, see “Opening a 
Database” on page 201.

Close Closes a currently selected database. For more information, see “Closing 
a Database” on page 202.

Lock Database Locks a currently selected database for exclusive use. For more 
information, see “Locking and Unlocking a Database” on page 202.

Print Prints the contents of a database.

Print Preview Displays the document on the screen as it will appear when printed.

Page Setup Selects the page format and printer information.

Preferences Accesses a series of system preferences. For more information, see “File 
> Preferences Menu” on page 207.

Advanced Accesses the Create Database and Restore Database commands. For 
more information, see “File > Advanced Menu” on page 209.
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File > Preferences Menu

The File > Preferences menu contains the following submenus allowing you to change your 
AirSpeed Multi Stream preferences. Each is described in the following table.

Recent Files Shows a list of the last ten windows closed. Use this list to quickly reopen 
these files without searching for them on your system. 

For a list of open windows, click the Window menu.

Exit Closes the AirSpeed Multi Stream Application and exits to the Windows 
desktop.

File Menu Submenus  

Option Description

File > Preferences Menu Submenus  

Option Description

Channel Configuration Enables you to name channels, display in MiniMonitors, select video 
standards, stop behavior, and VITC Playback and Reocrd information. 
For more information, see “Configuring Channels on AirSpeed Multi 
Stream” on page 115.

Channel Assignments Locks channel assignments of MiniMonitors. You can also use the Air 
toolbar. For more information, see “Locking Channel Assignments” on 
page 144.

Select Background Color Enables you to select a background color behind headframes, and 
background of the Browse window.
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Protocol Setup Configures communication with external devices that control AirSpeed 
Multi Stream (such as Automation systems). For more information, see 
“Configuring Communication Protocols in AirSpeed Multi Stream” on 
page 136.

Database Option Enables you to tweak the behavior of how your databse works to your 
site’s preferences. For more information, see “Configuring Auto Logon” 
on page 143.

Default Headframe Enables you to select a default headframe for a selected clip. Options are 
First, Middle, Last, or a Black headframe. For more information, see 
“Selecting a Default Headframe for a Clip” on page 251.

Assign GPIs Programs and enables GPI control. For more information, see 
“Configuring General Purpose Interface (GPI) Inputs and Outputs” on 
page 138.

Enables GPI Triggers Enables GPI triggers. For more information, see “Configuring General 
Purpose Interface (GPI) Inputs and Outputs” on page 138.

Timecode Setup Enables you to select the timecode format. Options are Dropframe, and 
Non-dropframe. For more information, see “Selecting the Timecode for a 
Clip” on page 251.

Generate Proxy After 
record

Enables you to toggle to automatically generate a proxy for a newly 
recorded clip. A check mark next to this menu item indicates that a proxy 
will be generated after the clip is recorded. The default for this option is 
set to not generate a proxy after the clip is captured. For more 
information, see “Recording a Clip” on page 235.

c Under heavy loads, generating proxies while ingesting or 
playing out can inhibit system performance. Therefore, it is 
recommended to not generate proxies while recording or 
playing out.

File > Preferences Menu Submenus  

Option Description
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File > Advanced Menu

The File > Preferences menu contains the following submenus allowing you to change your 
AirSpeed Multi Stream preferences. Each is described in the following table.

Edit Menu

The Edit menu contains the following submenus. Each is described in the following table.

File > Advanced Menu Submenus  

Option Description

Rebuild Database Repairs a damaged database, removed unnecessary files, and reclaims 
disk space. 

This functionality is reserved for Avid use only. Do not use. 

Create New Database Names, specifies the type, and sets the file paths of a new database. For 
more information, see “Creating a New Database in the AirSpeed Multi 
Stream Application” on page 105.

Edit Menu Submenus  

Option Description

Cut Not implemented.
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View Menu

The View menu contains the following submenus. Each is described in the following table.

Copy Copies selected clips from a database to the clipboard.

Paste Pastes selected clips from the clipboard to the currently active database.

Paste Master Clip Pastes selected master clips from the clipboard to the currently active 
database.

Paste Frames Used Pastes selected frames from clips from the clipboard to the currently 
active database.

Delete Deletes selected frames from clips from a database.

Select All Selects all of the items in the current window.

Renumber Renumbers clips in a database. For more information, see “Renumbering 
Clips” on page 248.

Edit Template Edits template information. For more information, see “Editing the 
Current Template” on page 257.

Edit Menu Submenus  

Option Description
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View Menu Submenus  

Option Description

Show Main Toolbar Toggles the display of the Main Toolbar. For more information, see 
“Main Toolbar” on page 224.

Show Air Toolbar Toggles the display of the Air Toolbar. For more information, see “Air 
Toolbar” on page 225.

Show MiniMonitors Toggles the display of the MiniMonitors. For more information, see 
“MiniMonitor Window” on page 222.

Show Tree Toggles the display of the Network Tree. For more information, see 
“Network Tree” on page 213.

Show Status Bar Toggles the display of the Status bar at the bottom of the screen. For more 
information, see “Status Bar” on page 228.

Show Diskmeter Showes how much free space is on the disk.

Text Below Displays the clip number below the headframe.

Text Right Displays the clip number to the right of the headframe.

Details Displays detailed database information.

Select Details Selects which items will be displayed in the database header. For more 
information, see “Changing the Order and Number of Fields in the 
Browse Window” on page 216.

Tiny Images Displays tiny headframes. For more information, see “Changing 
Headframe Sizes” on page 220.

Small Images Displays small headframes. For more information, see “Changing 
Headframe Sizes” on page 220.

Large Images Displays large headframes. For more information, see “Changing 
Headframe Sizes” on page 220.

Sort Images Changes the headframe sort order. For more information, see 

Search Allows you to use search criteria to search for clips. For more 
information, see “Searching for Clips” on page 264.

Refresh Refreshes the current window.
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Air Menu

The Air menu contains the following submenus. Each is described in the following table.

Window Menu

The Window menu contains the following submenus. Each is described in the following 
table.

Air Menu Submenus  

Option Description

Take Performs a Take from Cued to Play. For more information, see 
“Performing a Take” on page 252.

Window Menu Submenus  

Option Description

New Window Creates a new windows that is a copy of the currently selected window.

Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of closed windows.
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Help Menu

The Help menu contains the following submenus. Each is described in the following table.

Network Tree
Keyboard shortcut: Ctrl+T

Use the keyboard shortcut to show or hide the Network Tree.

Help Menu Submenus  

Option Description

Help Topics Displays the AirSpeed Multi Stream Online Help file. The Online Help 
provides links to topics that provide reference information, as well as 
step-by-steps instructions for using the AirSpeed Multi Stream.

About Displays the copyright notice and software version number.
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The Network Tree shows each AirSpeed Multi Stream system with its associated files. Each 
system is represented as a folder. To open a folder, click on the + sign to the left of the folder 
or double-click on the folder title. Once open, a list of databases on that system appears. 

A database is identified by the blue AirSpeed Multi Stream icon and a .pff file extension. To 
open a database, double-click the left mouse button on the icon or name. 

The Tree can be shown or hidden by using the Tree View command in the View Menu. A 
check mark next to the menu item indicates the Tree is visible. For more information, see 
“Expanding the Network Tree” on page 214.

Expanding the Network Tree

The Network Tree shows each AirSpeed Multi Stream with its associated files. Each system 
is represented as a folder. 

To expand the network tree:

1. Click the + (plus) sign to the left of the folder or double-click on the folder title. 

Once opened, the database (.pff) file appears. 

n There can be only one database (.pff) file within a database folder.

A database is identified by the red and gray AirSpeed Multi Stream icon. It also has a 
.pff file extension. 
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To access Network Tree menus:

t Right-click inside the Network Tree area to access the menu.

Browse Window

The Browse Window, also known as the Database window, shown in the following 
illustration, is a headframe view of a database and has several modes and sort orders. You 
can open multiple Browse windows (one for each database) by double-clicking on multiple 
database (.pff) files. With multiple Browse windows open, the active window appears in the 
title bar of the AirSpeed Multi Stream, and is also the tab that is displayed in front in the 
application.

Network Tree Menu  

Command Description

Delete Item Deletes the selected folder or sequence. 

Set Default Database Selects the database that will open when AirSpeed Multi Stream is 
started. 

Remove All Locks Removes the lock from a database that another user has accessed and 
locked or started a process such as copying.
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If you want to change the order and quantity of fields in the Browse window, click View > 
Select Details. For more information, see “Changing the Order and Number of Fields in the 
Browse Window” on page 216. 

Headframes might have additional symbols on them to identify the files they represent. For 
information on these symbols, see “Headframes” on page 218.

Changing the Order and Number of Fields in the Browse Window

This topic contains information on how to change the order and quantity of fields in the 
Browse window. There are options for detailed and non-detailed views.

When a Browse window is active and you select this command, you choose which details 
will show in the header and their corresponding information is shown to the right of the 
headframes. Use this command to show only needed information so you can reduce the 
window sizes and save space on your desktop.

To change the order and number of fields in the Browse window:

1. Select View > Select Details.

The Select Items to Display in Header dialog box opens.

2. Use the Add button in the Detailed View area to add fields to display in the header.

3. Use the Remove button in the detailed View area to remove fields that you do not want 
to see in the header.

4. (Option) Click Reset Defaults to return the default settings.
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5. (Option) If you want to select headings to display in a non-detailed view, select the 
items in the Display Item field.

6. Click OK.

Changing the Sort Order of Clips in the Browse Window

This topic contains information on changing the sort order of clips in the Browse window.

To change the sort order of the clips in the Browse window:

1. Click View > Details.

2. Click on the column heading to sort by at the top of the window (ItemNum, Date, Title, 
Category, User, and so on). Alternatively, you can use a shortcut button on the Main 
Toolbar to access the Details view.

The following table describes the different types of sorts. 

Sort Category  

Option Description

Item Number Clips are sorted in ascending numerical order.

Date Clips are sorted by the date they were saved in descending order, that is, 
the newest clips are first and the oldest ones last.

Name Clips are sorted alphabetically by the name. 
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n When a Name, Category, User or Memo sort is active, items with no information in these 
fields are moved to the top of the window. Clips that contain a numerical entry in the first 
position of these fields are sorted next, followed by all remaining clips sorted alphabetically.

Headframes

The term “Headframe” refers to individual clips used in AirSpeed Multi Stream’s Browse 
window. Headframes might have additional symbols on them to identify the kinds of files 
they represent. Headframes represent clip files that AirSpeed Multi Stream stores and 
manages.

Green film icon upper right corner: This image is a clip residing on AirSpeed Multi Stream 
or another clip server. When the film icon turns RED, the clip will not play. For help in 
correcting the problem, see “Clip Headframes” on page 250. 

Category Clips are sorted alphabetically by category information.

User Clips are sorted alphabetically by user information.

Memo Clips are sorted alphabetically by memo information.

Media Id Clips are sorted alphabetically by a unique ID for the clip.

Master Clip Clips are sorted numerically by their master clip numbers.

Duration Clips are sorted numerically by their length.

Transfer Status Clips are sorted alphabetically by their transfer status.

Sort Category (Continued)  

Option Description
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Green film icon with shortcut arrow: This clip is a sub-clip of the original. It contains 
instructions to play a portion of the original clip as edited.

Green film icon with curved arrow: This clip has been set for loop play (available for SD 
clips only).

A colored (yellow or blue) rectangle in the lower left corner of the clip indicates a 16:9 clip 
format. 

• A yellow rectangle indicates a 1080i 16:9 clip.

• A blue clip indicates a 720p 16:9 clip.

This headframe (which has a yellow rectangle) represents a 1080i clip.

When you first save a clip in AirSpeed Multi Stream, you have a choice of headframes. You 
can specify an all-black headframe and select a representative frame for the headframe later. 
For more information, see “Changing a Clip’s Headframe” on page 253.

The following topics provide more information about headframes:

• “Selecting Headframes” on page 220

• “Changing Headframe Sizes” on page 220

• “Clip Numbers” on page 221
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• “Clip Headframes” on page 250

• “Changing a Clip’s Headframe” on page 253

Selecting Headframes

Select headframes by clicking, Shift+clicking, and Ctrl+clicking on them using standard 
Windows techniques. 

For more information, see “Selecting Clips” on page 228.

Changing Headframe Sizes

Headframes can be displayed in three sizes: Large, Small and Tiny. To change sizes, click 
the desired size in the View Menu. A dot next to the menu entry indicates it is the currently 
selected size. 

The keyboard shortcut, Shift+F2 switches between the three settings each time the key 
combination is pressed.
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Large headframes are appropriate when using a small VGA monitor or on the composite or 
Y/C output. Tiny headframes let you see the most database information and are appropriate 
when using a large VGA monitor. Note that the green film icon, identifying the item as a 
clip, does not appear on the Tiny selection.

To change the headframe size, do one of the following:

t Click View and select the size you want (Tiny, Small, or Large) from the menu.

t Click the headframe size icon you want in the Main Toolbar.

t Right-click on the Browse window (not on a headframe) and select the size you want 
(Tiny, Small, or Large).

Clip Numbers

Each clip has an individual number, and where applicable, a workspace number and a 
database number. In this example, the clip is identified by the number 19.

Clips will play individually from any database that is accessible from the AirSpeed Multi 
Stream.



7  Fundamentals

222

MiniMonitor Window 

The MiniMonitor section contains multiple individual MiniMonitors. Each MiniMonitor 
corresponds to a system channel and can be turned on or off in the Channel Configuration 
dialog box. For more information, see “Configuring Channels on AirSpeed Multi Stream” 
on page 115. 

For AirSpeed Multi Stream SD and DNxHD models, you have a maximum of four 
MiniMonitors. For AirSpeed Multi Stream MPEG-2 HD models, you have a maximum of 
six MiniMonitors. There are two kinds of system channels: hardware and software. The 
MiniMonitor window might be hidden and revealed using the View menu, or by selecting 
Ctrl+M. A check mark in the View menu indicates that the MiniMonitor window is currently 
visible. You can click and drag an image from any MiniMonitor to a database to quick save 
it using the current template information.

Each MiniMonitor has the components shown in the following figure.

n In Playback mode, the Pause button pauses the clip. However, in Record mode, the Pause 
button actually cues the clip for record. The next time you press the Record button, the 
record will begin immediately after the Record button is pressed.

System channel number

Record

Record 
duration

Stop

Clip number

Function controls

Pause
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Preview Dialog Box

The Preview dialog box, also called Preview window, enables you to do the following 
with clips:

• Play clips

• Scrub and trim clips

• Mark in and out points

• Create subclips

• Set headframes

n Proxy clips need to be generated in order for Preview features to work.

To access the Preview window:

1. Select the headframe of the clip.

2. Do one of the following:

t Press F3.

t Right-click on the headframe and select Preview from the menu.

For more information on using the Preview dialog box to edit clips, see “Editing Clips 
Using the Preview Dialog Box” on page 245.
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Dockable Items
The Main toolbar, and the Air toolbar are dockable items. This means that they can be 
moved about the top of the screen (very confined area) in horizontal or vertical orientation. 
Click on the left side of the toolbar, and the bar will be undocked. You can then drag it 
anywhere within the top portion of the screen that you like. When you close the application, 
AirSpeed Multi Stream remembers the new location for these toolbars.

n Toolbars and windows can sometimes “disappear” when they are moved. For example, the 
toolbar might have moved behind another object where you cannot see it. To locate the 
missing toolbar, use the View menu to hide each of the tools one by one until you locate the 
missing toolbar. You can then reposition it where it is visible.

Main Toolbar 

The Main Toolbar is usually displayed across the top of the application window and below 
the menu bar, providing quick point-and-click mouse access to many tools used in the 
application. To show or hide the Main Toolbar, choose Show Main Toolbar from the View 
Menu. You can also move the toolbar to another location.

Main Toolbar Icons  

Icon Function

Open a file

Save the currently active window

Cut the selected item(s) to the clipboard, deleting them from the clip

Copy the selected clip(s) to the clipboard

Insert the contents of the clipboard into the current database

Print the active database
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Air Toolbar
Keyboard shortcut: Ctrl+i 

The Air Toolbar is usually displayed across the top of the application window below the 
menu bar and provides quick mouse access to two additional tools used for on-air 
operations. The Air Toolbar can be moved to another location if you so desire. To display the 
Air Toolbar, select View > Show Air Toolbar. A check mark next to the menu item indicates 
that it is currently displayed. The functions on the Air Toolbar are also available on the Air 
Menu.

Display the About Box

Display the Online Help.

Change the current database to Text Below display

Change to Text Right display

Change to Detail display

Change the size of the headframes in the current window to Large Images

Change size to Small Images

Change size to Tiny Images

Lock the Database

Main Toolbar Icons (Continued)  

Icon Function
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Right-Click Menus
Clicking the right mouse button accesses one of three function-specific popup menus. These 
menus act as additional shortcuts for the related functions.

Air Toolbar Icons  

Icon Function

Perform a Take (F12).

Channel Lock. Locks the channel assignments to their current settings. Once locked, you 
cannot control another channel. 

Right-clicking on a headframe displays this menu, allowing you to:

• Play - Plays the clip file to the Preview MiniMonitor.

• Delete - Deletes the clip file.

• Protect - Protects this clip file from being deleted.

• Show Picture- Opens a large size headframe of the clip in a 
separate tab in the Browse window.

• Renumber - Renumbers the clip file.

• Generate New Proxy - Generates a new proxy for this clip.

• Transfer to Interplay - Transfers this clip to Interplay.

• Preview - Launches the Preview Window with the clip pre-loaded.

• Properties - Opens the Item Properties dialog box. For more 
information, see “Modifying Clip File Data” on page 255.

Right-clicking on a headframe and dragging the mouse over another 
headframe in a Browse window allows you to:

• Copy the clip or its shortcut to this new location.

• Copy the Master Clip.

• Copy only the frames used from the Master Clip.



Right-Click Menus

227

When you right-click on the background of a Browse window (not on 
a headframe), this popup menu appears. 

Most of these are the same functions as the View Menu. 

When you right-click in a MiniMonitor window, this popup menu 
appears. A few of these are the same functions as the Air Menu.

The most important functions are:

Select Input — Enables you to view the input for the channel. 
Options are Adaptive, Frame Avg., and Footprint.

Playback Mode — Configures AirSpeed Multi Stream to play clips.

Record Mode — Configures AirSpeed Multi Stream to record clips.

Record — Prompts with the Item Properties dialog box before 
recording clips.

Quick Record — Records clips using settings in the current 
template.

Cue Record — Prompts with the Item Properties dialog box, then 
waits until you click the Record button on the MiniMonitor before 
recording.

Quick Cue Record — Waits until you click the Record button on the 
MiniMonitor, then records clips using settings in the current template.

Edit Template — Opens the Edit Template for Channel dialog box 
and enables you to edit the template for the selected channel. For 
more information, see “Editing the Current Template” on page 257.

Eject — Ejects the clip.

Display Current Timecode — Toggles the time count displayed in 
the MiniMonitor. When checked, it counts up from zero during 
playback. Uncheck it to show the time remaining in the clip.
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Selecting Clips
Simply click on a clip to select it.You can also select multiple clips. There are two methods 
for selecting multiple clips.

To select individual clips

t Ctrl+click and select individual non-consecutive clips.

To select a series of clips

t Shift+click and select multiple consecutive clips.

Status Bar

Use the Status Bar command by selecting View > Status Bar to show or hide the Status bar 
which displays across the bottom of the application window. A check mark appears next to 
the Status Bar command in the View menu when the Status bar is displayed.

The left area shows the action triggered by buttons and menu items as you move around the 
menu screen with arrow keys or the mouse cursor. The areas at the right of the Status bar 
example indicate the following:

Indicator Description 

Ref OK The reference signal is working properly.

! NO REFERENCE The system cannot detect a reference signal.

! REFERENCE UNLOCKED The reference is unlocked.

! WRONG REFERENCE TYPE The system detected that you have the wrong reference type.

This occurs when you are supplying an SD Reference (which is 
expecting Blackburst) to an HD based database (which is 
expecting Tri-level) or vice versa.

536951 MB Free The amount of free space on the hard drive that holds this 
database.

Items:1/14/14 Indicates that 1 item is selected out of 14 displayed in the currently 
active window, and that there are a total of 14 items in the 
database.
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For more information about the Status bar, see “Background Tasks” on page 229.

Background Tasks

The Background Tasks feature allows you to program AirSpeed Multi Stream to perform 
time-consuming, low-priority tasks in the background while you continue your work. When 
AirSpeed Multi Stream is working on background tasks, a progress bar appears on the Status 
bar.

If you click on the Status bar while a task (such as generating a proxy) is taking place, the 
Background Task Status dialog box opens.

You are not required to do anything or wait for processing to take place.

You can do one of the following, depending upon the tasks that are pending:

• Cancel the current task by clicking the Cancel Current button.

• Cancel pending tasks, by clicking the pending task in the Pending Tasks area, and then 
clicking the Cancel Task button.

• Move a pending task to the top of the list by selecting the pending task, and then 
clicking the RushTask button.

09/16/09 Shows the current date.

16:13 Shows the current time.

Indicator Description 
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Numeric Keypad
AirSpeed Multi Stream has different interpretations for the two sets of number keys on the 
keyboard. The numbers across the top of the keyboard are used to select the AirSpeed Multi 
Stream output channels.

The numbers on the keypad (far right of the keyboard) are used to enter clip numbers.
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Keyboard Shortcuts
This section contains information on the available keyboard shortcuts. For more 
information, see the following topics:

• “General Keyboard Shortcuts” on page 231

• “Preview Dialog Box Keyboard Shortcuts” on page 233

General Keyboard Shortcuts

The following table describes the available General keyboard shortcuts for the AirSpeed 
Multi Stream.

Key Description 

Escape Ends Spreadsheet Edit.

Tab  When editing in the spreadsheet, moves to the next editable field.

J With focus on a MiniMonitor, goes to Previous frame of the clip.

L With focus on a MiniMonitor, goes to Next frame of the clip. 

U With focus on a MiniMonitor, fast rewinds to the In point of the clip. The 
default In point is the first frame of the capture.

O With focus on a MiniMonitor, fast forwards to the Out point of the clip.

Shift + Tab When editing in the spreadsheet, moves to the previous editable field.

Ctrl + A Selects all items.

Ctrl + C Copies currently selected items to the Clipboard.

Ctrl + F Opens the Find dialog box

Ctrl + H Tiles windows Horizontally.

Ctrl + I Shows/hides the Air toolbar.

Ctrl + M Shows/hides MiniMonitors.

Ctrl + O Opens the Open File dialog box.

Ctrl+ P Opens the Print dialog box.

Ctrl + R Refreshes the current view.

Ctrl + T Shows/hides Tree view.
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Ctrl + V Pastes information from the Clipboard.

Ctrl + X Cuts selected information to the Clipboard.

Ctrl + Shift+V Pastes Master Clip (physical copy of essence).

Del Deletes selected items.

Shift + Del Cuts selected text from the Properties dialog to the Clipboard.

F1 Launches the Online Help.

Shift + F2 Advances to the next Headframe size.

F3 Opens the Preview Window.

F4 Opens the Find dialog box

F5 Refreshes the view.

F6 Opens the Template dialog box.

F12 Performs a Take.

Key Description 
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Preview Dialog Box Keyboard Shortcuts

The following table describes the available keyboard shortcuts available from within the 
Preview dialog box.

Key Description 

P Toggle Play/Pause

S Pause

Left Arrow Go to Previous frame

Right Arrow Go to Next frame.

Home Cue to beginning of clip

End Cue to end of clip.

I Cue to In point.

Ctrl + I Sets In point.

Alt + I Go to the Mark In field.

O (not zero) Cue to Out point.

Ctrl + O Sets Out point.

Alt + O Go to the Mark Out field.

N Cue to Headframe

Ctrl + N Set HeadFrame.

Alt + N or 

Alt+H

Go to the Head Fr (Headframe) field.

Alt+T Go to the Time Code field.

Escape Close dialog box
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8 Working with Clips

This chapter describes how to create individual clips, edit them, and subdivide them multiple 
times to generate sub-clips, each with its own in-point, out-point, database information and 
headframe. The following sections are included:

• Recording a Clip

• Creating Subclips

• Editing Clips

• Playing Clips

• Sending Sequences from an Avid Editor to AirSpeed Multi Stream

• Modifying Clip File Data

• Editing the Current Template

• Searching for Clips

Recording a Clip

You can record clips from your live video feed. A database (Browse) window must be open 
and selected to record the new clips. 

n Recording durations with AirSpeed Multi Stream should be limited to values no greater than 
six hours.

n AirSpeed Multi Stream does not support recorded playout of clips that are less than 10 
seconds in length.

To record a clip:

1. Select a Channel’s MiniMonitor.

2. (Option) If you want to generate a proxy (for preview only) after the clip is captured, 
select File > Preferences > Generate Proxy After record. 

A check mark next to this menu item indicates that a proxy will be generated for 
preview only after the clip is recorded. The default for this option is set to not generate a 
proxy after the clip is captured.
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3. Right-click the MiniMonitor window and select Record Mode from the menu. 

The MiniMonitor turns red and displays REC MODE, indicating it is in Record Mode.

n The video signal present at the selected channel’s input will display in the corresponding 
channels output.

4. Right-click the window again and select Edit Template from the menu (or with the 
desired channel highlighted, select Edit > Edit Template.

The Template for Channel dialog box opens. 

5. Make your entries on the tabs as required and click OK to close the dialog box and begin 
recording the clip.

n The Name field can be edited only if you have not specified a clip name in the Clip Name 
field (or if the Clip Name field is greyed out) in the Destination Template of the Avid Service 
Configuration. In the event that the Clip Name field is greyed out, you can create unique clip 
names by appending the .$n at the end of the clip name in the Name field.

The following topics provide more information about recording a clip:

• “Clip Recording Methods” on page 239

• “Playing While Recording a Clip (PWR)” on page 237
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Playing While Recording a Clip (PWR)

The Play While Record (PWR) feature enables you to start recording a clip in SD or HD on 
one channel, and then begin to play the same recording out of another channel after 20 
seconds. In a PWR workflow, the recorded media will continue to transfer to the shared 
storage and be checked into Interplay.

n For MPEG-2 HD models, you can perform a maximum of two Play While Records (PWRs) 
at the same time on one AirSpeed Multi Stream. This is also true for AVC-Intra models, 
although we support two PWRs at 50mbit, or only one at 100mbit. 

For SD and DNxHD models, we support only one PWR at a time. Although, for DNxHD at 
220mbit, we only support one channel of operation at any time, so PWR is not available.

To play while recording a clip:

1. Select an unused MiniMonitor. For more information, see “Clip Recording Methods” on 
page 239.

2. Start recording on that channel.

3. After 20 seconds, play the clip to an empty MiniMonitor window (different channel) 
that is configured for the video standard of the clip you are cueing. For more 
information, see “Cueing Clips” on page 250.

Playout will begin automatically.

n When performing a Play While Record, you must wait at least 20 seconds before starting the 
playback. If you try to drag the recording clip to another channel before 20 seconds, playout 
will have problems.
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4. (Option) If you do not want to play the clip from the beginning, you can trim the In 
point of the clip to where you want it to start playback by doing the following:

a. On the Playback MiniMonitor, locate the spot in the clip where you want to set the 
Mark In by using the J (Previous Frame) and L (Next Frame) keys to move to the 
desired start location.

b. With focus on the Browse window, select View > Details to provide a detailed view 
of the clips in the database.

c. Locate the clip you want to edit the In point.

d. Edit the In point of the clip to match the value you selected in your Playback 
MiniMonitor by typing the value in the In field.

n You cannot modify the clip In point using the Properties dialog box. It must be done in the 
Browse window. The Preview dialog box is not available for clips during record.

5. Once you have set your In point in the Browse window, reload the clip (drag it back into 
the same or a different channel or double-click it).

The clip will play from the new In point, and cueing the clip will now cue to the new In 
point.
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The following topic provides more information about playing while recording a clip:

• “Clip Recording Methods” on page 239

Clip Recording Methods

To record clips, you must be in Record Mode. Right-click on a MiniMonitor to see the 
popup menu and select Record Mode. When a check mark appears beside it, Record Mode is 
the active mode.

The table below describes the four clip recording methods that the AirSpeed Multi Stream 
supports:

In all four clip recording modes, AirSpeed Multi Stream assigns the clip the next 
consecutive number and places it in the active database.

n This ID is not the same as the Video ID used for automation playback.

Recording Methods  

Setting Description

Record Brings up the Item Properties dialog box. When you press the OK 
button on the dialog box, recording begins. Recording continues 
until you click the Stop button (black square) or as programmed on 
the Clip page of Item Properties.

Quick Record Bypasses the Item Properties dialog box. Recording starts 
immediately and continues until you click the Stop (square) button 
or as programmed.

Cue Record Brings up the Item Properties dialog box. Recording does not start 
until you press the Record (round) button. Recording continues 
until you click the Stop (square) button or as programmed.

Quick Cue Record Bypasses the Item Properties dialog box. Recording does not start 
until you press the Record (round) button. Recording continues 
until you click the Stop (square) button or as programmed.
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The control buttons (Stop, Pause, and Record) change to red when active in the MiniMonitor 
while in Record Mode. 

To turn off the recording process, do one of the following:

t Right-click the MiniMonitor and select Playback Mode.

t Play a clip to the same channel that you were previously recording to.

Stop Pause Record

Control Buttons  

Button Description

Stop Stops recording of the clip. AirSpeed Multi Stream then saves the clip to 
the active database.

Pause Temporarily stops recording of the clip. When recording is paused, click 
on Record to resume or Stop to finish recording.

Record Starts or resumes recording of the clip.
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Copying or Moving Clips
You can copy or move clips from one AirSpeed Multi Stream Database to another over a 
network in either of two ways: Drag and Drop or using the Clipboard.

To copy a clip from one database window to another database window:

1. From the Network Tree, open the Database from which you want to copy the files.

2. Again from the Network Tree, open the Database to which you want copy the files.

3. With the two Browse windows open, tile them with one above the other.

4. Select the files you want to copy.

5. Do one of the following:

t Drag the files from one Browse window to the other and release the mouse button.

t Click Edit > Copy, then click on the other window and select Edit > Paste. 

t Press Ctrl+C, then click on the other window and press Ctrl+V. 

n If any of the files you are copying have the same numbers as files that already exist in the 
target database, you will be asked if you want to overwrite the files. If you do, click “Yes” or 
“Yes All” to complete the copy and overwrite the files in the target database. If you don’t, 
click “No” or “No All,” and the new files will be copied to the next available numbers in the 
target database.

n If the Databases are not under your Network Tree, click File > Open to open a Database 
under the Network Tree.

Creating Subclips

A subclip is a subset of a master clip. A master clip is an original clip recorded into 
AirSpeed Multi Stream. The sub-clip function enables you to use parts of a master clip 
individually as many times as required without having to fill up the hard disk with several 
copies of the same material.

To create a subclip:

1. Select a clip from the active database.

2. Right-click to display the popup menu, and select Preview.
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The Preview dialog box appears.

3. In the Preview dialog box, click the New Sub-Clip button. 

AirSpeed Multi Stream assigns the subclip a number. 

4. Use the slider or thumbwheel controls to view the clip as necessary.

5. Set the starting point of the subclip with the slider or type in the values and click the 
Mark In button.

6. Set the ending point of the subclip with the slider or type in the values and click the 
Mark Out button.

7. Position the slider or type in a value for the frame you want for a headframe and click 
the Headfr (Headframe) button.

8. Click the close window button to close the Preview dialog box.

The new subclip is added to the Database. The film icon with an arrow indicates this is a 
subclip rather than a master clip.
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Deleting Clips
Clips can be deleted from a database (or Browse window) as described below.

To delete clips from the database:

1. Select the database containing the item(s) to be deleted.

2. Select the desired image files.

3. Do one of the following:

t Press Delete.

t Select Edit > Delete. 

The Delete Warning appears.

4. Click Yes or press Enter to confirm the delete. The selected clip(s) are permanently 
deleted from the active Browse window. 

n Once clips have been deleted from a database window, they are permanently lost and cannot 
be recovered, unless they were previously transferred to Unity.

Editing Clips
Editing clips can be done using the following two methods:

• Editing Clips Using the Item Properties Dialog Box

• Editing Clips Using the Preview Dialog Box

Editing Clips Using the Item Properties Dialog Box

To edit a clip:

1. Right-click the clip headframe and select Properties from the popup menu. 

The Item Properties dialog box appears. 
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2. Click the Clip tab. 

The dialog box provides the following fields for data entry:

Item Properties — Clip Tab  

Option Description

In The in-point of this clip.

Out The out-point of this clip.

Duration The duration of this clip.

Loop In The point in the clip where looping starts.

n This functionality is available for SD, DNxHD, and AVC-Intra 
clips only. You cannot loop MPEG-2 HD clips.

Master Clip Master clip, if any.

Base TC Base timecode used by the clip. If the Base timecode is changed, the 
Timecoude source (TC Src) of a clip is reset to “None”.
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Editing Clips Using the Preview Dialog Box

To edit an existing clip:

t Right-click the headframe and select Preview from the popup list. 

TC Src Check box that identifies the Timecode source for this clip. Options 
include:

• None

• TOD (LTC)

n If LTC is not attached to the system, the AirSpeed Multi Stream 
syncs to TOD system time. If LTC is attached to the system, the 
AirSpeed Multi Stream syncs to LTC time, not system time.

• VITC

Looping Enables you to determine whether or not to loop the clip, and if so, how 
many times you want to loop the clip. the default is Don’t Loop.

n This functionality is available for SD, DNxHD, and AVC-Intra 
clips only. You cannot loop MPEG-2 HD clips.

Record Duration The duration of this clip.

Item Properties — Clip Tab (Continued)  

Option Description
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The Preview dialog box opens. A proxy of the clip appears in the window.

The following are the fields and controls used to edit a clip: 

Monitor 
Window

Mark In/Out
buttons

Current
position

Clip
name

Go To
buttons

Timeline 
scrubber

Playback
controls

Thumbwheel Headframe 
button

Clip
duration

Loop
button

Preview Dialog Box Fields and Controls  

Setting Description

Item Name of the clip file to load, delete or create.

Timecode Displays current clip position. Click here to specify a timecode position. 

Length Displays the length of the clip.



Editing Clips

247

Mark In

Mark Out

Duration

Specifies which portion of the clip to play. Click on the Mark In, Mark 
Out and Duration buttons to make changes to these items.

Headfr (Headframe) Sets the headframe image. When the monitor window displays an image 
representative of the clip, click this button. The timecode shows the 
position in the clip from which the image was taken.

Loop Click to set the clip to loop.

Goto Moves you to the beginning, end or headframe set point of the clip.

Audio Channels AirSpeed Multi Stream records the audio portion of its clips in two stereo 
pairs. This allows you to record and play back two different sound tracks, 
for programs broadcast in two different languages. For the purpose of 
editing a clip, use the radio buttons to select either stereo pair.

Use Hardware Channel Select this check box if you want to use the selected hardware channel.

New Sub-Clip Click on this button to create a subclip based on the clip you 
are previewing.

Timeline Scrubber Moves you forward and backward through the full length of the clip. 

Thumbwheel Allows fine-tuned searches, but it is limited to a small area. When you 
reach the end of the scrub, lift the mouse to continue. 

Playback Controls Allows you to play the clip to verify your settings. For more information 
on the behavior of these button, see “Playback Controls” on page 248.

Preview Dialog Box Fields and Controls (Continued)  

Setting Description
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Playback Controls

The Playback controls are the buttons on the bottom of the Preview dialog box. 

Renumbering Clips

AirSpeed Multi Stream allows you to renumber one or more clip files at a time.

To renumber clips in a database window:

1. Select the clip files to be renumbered in the Browse window.

2. Select Edit > Renumber. 

n You can also select the clip or clips you want to renumber, and right-click and select 
Renumber.

Preview Dialog Box Playback Controls  

Button Description

Moves you to the start of the clip

Moves you to the previous frame of the clip.

Pauses the clip.

Plays the clip.

Moves you to the next frame of the clip.

Moves you to the end of the clip.
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The Renumber Items dialog box appears.

3. Enter the new clip file number.

4. (Option) Check the Keep Selection Order check box to renumber the clip files in the 
order you selected them.

5. Click OK. 

The clip files selected are given new numbers starting from the number specified. If clip 
files already exist within the destination range specified, a dialog box appears, asking if 
you want to overwrite the items at those numbers or place the new items at the next 
available numbers.

Playing Clips
The following topics describe functions you can perform when playing clips:

• “Cueing Clips” on page 250

• “Performing a Take” on page 252

• “Changing a Clip’s Headframe” on page 253
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Cueing Clips

To play a clip to the selected output, do one of the following:

t Type the clip file number on the numeric keypad and then press the channel number key 
at the top of the keyboard.

For example, to play image file 45 to Channel 1, type 45 on the keypad, then press 1 on 
the number keys at the top of the keyboard

t Type the clip file number on the numeric keypad and then press a letter A through F 
(where A=Channel 1, B= Channel 2, C= Channel 3, and so on). 

For example, to play image file 45 to Channel 1, type 45 on the keypad, then press A.

t Click+drag a headframe to the MiniMonitor to play the clip.

t Click+drag a clip from one MiniMonitor to another.

t If there is a clip in the Cue window under the MiniMonitor, press the Space bar cue the 
clip on the MiniMonitor.

t If there is a cued clip or paused clip on the MiniMonitor, press the Space bar to play it.

Clip Headframes

Clips are identified within the database by a headframe with a green film icon, located in the 
upper right corner. When a red icon appears on a clip headframe, it indicates that one or 
more of the following must be corrected in order for the clip to play:

• The AirSpeed Multi Stream or other clip server where this clip resides is unknown or 
improperly selected.

• The clip has invalid In and Out points. For more information, see “Editing Clips” on 
page 243.

The MiniMonitor display turns brown when AirSpeed Multi Stream begins recording and 
orange when it begins playing back.
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Selecting a Default Headframe for a Clip

You can select one of four default headframes for clips.

To select a default headframe for a clip:

1. Select the clip you want to set a default headframe for.

2. Select File > Preferences > Default Headframe, and then select the item from the menu. 
Options are: 

t First Frame

t Middle Frame

t Last Frame

t Black

Selecting the Timecode for a Clip

You can select the timecode format for clips. Options are Dropframe, and Non-dropframe.

To select a timecode format for a clip:

1. Select the clip you want to set timecode format for.

2. Select File > Preferences > Timecode Setup, and then select the item from the menu. 
Options are: 

t Drop Frame

t Non-Dropframe
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Performing a Take

You can transfer a cued clip to play on the Output channel. This is called performing a Take.

To perform a Take:

1. Select the MiniMonitor that contains the cued clip you want to appear on the selected 
Output channel and corresponding MiniMonitor. 

You will see a small thumbnail image of the cued clip below the MiniMonitor.

2. Do one of the following:

t Press F12

t Select Air > Take

t Press the Space bar

The cued clip will transfer to the MiniMonitor and begin playing on the selected Output 
channel.
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Changing a Clip’s Headframe

A clip's headframe image is taken from the first, middle or last frame of the clip, or it is 
completely black, depending on the Default Headframe setting. See “Selecting a Default 
Headframe for a Clip” on page 251.

To change the headframe image: 

1. Right-click on the headframe and select Preview, or press F3.

The Preview dialog box appears. 

2. Move the timeline slider to until the picture field shows a frame you want to represent 
this clip. 

3. Click the Headframe button to set the image.

The clip now has a new headframe image and is ready to play.
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When a clip is a subclip of another master clip, it displays the subclip icon (arrow within 
the film icon) in the upper right corner.

Transferring a Clip to Interplay

AirSpeed Multi Stream provides an easy way to transfer clips to your shared storage 
(Interplay).

To transfer a clip to Interplay:

1. Right-click the headframe of a clip.

2. Select Transfer to Interplay from the menu.

The clip will be transferred to the Interplay location that you specified as your 
destination location (workspace) in the Avid Service Configuration.

Sending Sequences from an Avid Editor to 
AirSpeed Multi Stream

This topic provides instructions for transferring completed sequences from an Avid editor, 
such as NewsCutter, Media Composer, or Symphony Nitris to an Avid AirSpeed Multi 
Stream system.

These are the media files containing audio and video information. When sequences are 
transferred to the AirSpeed Multi Stream, they are automatically “flattened,” that is, all 
transitions are rendered and all non-linear edits become one continuous piece of media.
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Transfer Setup Checklist

Transferring Sequences from your Avid Editor to AirSpeed Multi 
Stream

To transfer sequences from your Avid Editor to AirSpeed Multi Stream:

1. After completing the sequence, right-click the sequence in the Timeline.

2. Select Send to Playback, and select the AirSpeed Multi Stream device from the pop-up 
menu which was configured in the TM Client setting.

A dialog box opens, asking you the Name and Tape ID of the sequence you want to 
transfer. 

3. If it is not already filled in, enter the Name and Tape ID of your sequence.

4. Click OK to begin the transfer.

A status window appears indicating the time remaining to transfer the sequence.

n If the Status window does not appear, go to the Transfer menu, and select Transfer Status.

Modifying Clip File Data

The Item Properties dialog box enables you to enter or change clip information. When you 
use the Record and Cue Record methods, the Item Properties dialog box displays before 
recording begins. 

n The Quick Record and Quick Cue Record methods use the settings in the Template, so you do 
not see the Item Properties dialog box.

For more information on Clips Recording methods, see “Clip Recording Methods” on 
page 239.

Ensure that there is an appropriate network connection, and TM client setting between the 
desired Avid editor / AirSpeed Multi Stream combination between which files are to be 
transferred, as described in “Installing the Hardware and Setting Up Your System” on 
page 61.

Ensure that communication is configured and tested on both the AirSpeed Multi Stream 
and Avid editing product sides, as described in “Locking Channel Assignments” on page 
144.
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To modify a clip’s database information:

1. Click the headframe to select it. 

2. Do one of the following:

t Press Enter to bring up the Item Properties dialog box. 

t Right-click on the headframe and select Properties from the menu.

The Item Properties dialog box opens to the General tab.

Information from the Destination Template is automatically entered into the Item 
Properties of individual clips as they are quick saved. During a regular save, the Item 
Properties dialog box appears, giving you an opportunity to make changes. 

3. Enter the new database information in the appropriate fields. 

4. Click Apply. 

The new information is immediately transferred to the clip file. 

5. Click OK to close the dialog box and return to the previous window.

n When modifying a clip file’s database, you can only enter information in the Title, Category, 
User, Memo, and Media Id fields. The Number and Date fields are dimmed, indicating they 
cannot be changed.
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For more information on the Item Properties dialog box see: 

- “Template for Channel and Item Properties — General Tab” on page 258

- “Template for Channel and Item Properties — Clip Tab” on page 259

- “Template for Channel and Item Properties — Record Tab” on page 261

- “Editing Clips Using the Item Properties Dialog Box” on page 243

Editing the Current Template
To edit the current template for a clip, select Edit > Edit Template. The Template for 
Channel dialog box appears when this command is selected. 

To make changes in the template:

1. Click in the desired text field.

2. Make your changes.

3. Click OK or press Enter to accept the changes and complete the dialog.

To exit from the dialog box without making changes:

t Click Cancel.

The template can have all data fields filled in or you can use the template to partially fill 
in the database for a series of clips that have common information. For example, if you 
are saving a series of engineering test pattern slides, you might want to create a template 
which has “Test Pattern” in the Category field, and “Engineering” in the User field. As 
you save the clips, you will only need to enter the appropriate title information.

n Regularly using the Template enables you to find clips much faster. 

The following topics provide more information about the submenus in the Edit > Edit 
Template menu:

• “Template for Channel and Item Properties — General Tab” on page 258

• “Template for Channel and Item Properties — Clip Tab” on page 259

• “Template for Channel and Item Properties — Record Tab” on page 261
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Template for Channel and Item Properties — General Tab

The General tab defines the text data that will be associated with the clip. The General tab of 
the Item Properties dialog box shows the same fields as the Template for Channel dialog 
box, although only certain fields are editable. They are Name, Category, User, Memo, Video 
ID, Video (16:9), and Protected.

General Tab Settings  

Settings Descriptions

Number Sets the starting number used for clip files as they are saved. If there 
is already an clip numbered 0, the system will assign the next 
available number.

Date The system automatically assigns the current date when a clip is 
saved.

Name The Clip name. 

n The Name field can be edited only if you have not specified a 
clip name in the Clip Name field (or if the Clip Name field is 
greyed out) in the Destination Template of the Avid Service 
Configuration. In the event that the Clip Name field is greyed 
out, you can create unique clip names by appending the .$n at 
the end of the clip name in the Name field.

Category, User, Memo You can enter any information in these fields.
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Information contained in the clip’s database is an extremely valuable tool. Any or all of the 
fields can be searched to create a new window containing clips matching the search criteria.

Good databases result from careful and consistent use of fields for specific information, 
common abbreviations, and so on. All users should agree on these conventions before 
creating new clips. To perform a database search, select View > Search. 

Template for Channel and Item Properties — Clip Tab

The Clip tab provides the name, in and out points, total duration, and server location of 
video clips. The Clip tab of the Item Properties dialog box shows the same fields as the 
Template for Channel dialog box, although only certain fields are editable. They are In, Out, 
Duration, Loop In, Base TC, and Looping.

Video Id The name of the clip as it appears to external controllers. This field is 
not editable from the AirSpeed Multi Stream user interface.

General Tab Settings (Continued)  

Settings Descriptions



8  Working with Clips

260

Clip Tab Settings

Setting Descriptions

Clip Name File name of the clip itself. To generate a new clip, leave this field blank.

Master Clip If this is a sub-clip, the name of the master clip from which it was taken.

In In-point of this clip. Use the shortcut Ctrl+I to set the in-point.

Out Out-point of this clip. Use the shortcut Ctrl+O to set the out-point.

Duration Duration of this clip.

Loop In Point in the clip where looping starts.

n This functionality is available for SD and DNxHD clips only. You 
cannot loop MPEG-2 HD clips.

Master Clip Master clip, if any

Base TC Base timecode used by the clip for time calculations

TC Src Check box that identifies the Timecode source for this clip. Options 
include:

• None

• TOD (Time-of-Day)

• VITC

Looping How many times to loop the clip. 

n This functionality is available for SD and DNxHD clips only. You 
cannot loop MPEG-2 HD clips.

Server Workstation on which this clip resides
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Template for Channel and Item Properties — Record Tab

The Record tab shows data rate in Mbit/s and has settings for video compression, audio 
input source and duration of the recorded clips. In Item Properties, this tab only gives 
information on the selected clip. You must make these settings in the Template for Channel 
dialog box before recording clips. Select Edit > Edit Template or press F5, then click on the 
Record tab.

Record Tab Settings

Setting Description

Codec The compression method by which clips are stored. The values 
listed in this field are set when configuring the Avid Interplay 
Service configuration tool, a part of the Avid Service Framework. 
What displays in this field varies depending on what was 
configured there.

Bitrate (Mb/sec) The data rate, in Mbit/s, at which clips are recorded.

n The maximum record/compression rate is 50 Mb/s. The rate 
shown in the field applies to the clip. Use the 15 Mb data 
rate as a starting point.
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Bitrate Mode  Check this box to enable Variable Bit Rate recording. VBR can 
result in a better compression rate and smaller file sizes with the 
same level of image quality. Left unchecked, AirSpeed Multi 
Stream uses Constant Bit Rate (CBR) recording. We recommend 
using VBR at all times.

GOP Parameters Need description

GOP Structure When MPEG2 compression is selected in the Video Type field, 
you can view the group of pictures (GOP) structure. The options 
are:

• I-frame, GOP=1

• IP, GOP=4

• IBP, GOP=12

• IBP, GOP=14

GOP The GOP (group of Pictures) structure type. Always displays 
Closed.

Raster Dimension Displays the raster dimension of the clip: Options are:

• 1440x1080

• 1920x1080

Record Tab Settings (Continued)

Setting Description
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Template for Channel and Item Properties — Audio Tab

The Audio tab provides the name and type of audio clips. The Audio tab of the Item 
Properties dialog box shows the same fields as the Template for Channel dialog box, 
although no fields are editable.

Clip Tab Settings

Setting Descriptions

Name The name of the audio stream. Streams 5-8 are for HD only.

Type The source for the audio portion of the clip. The options are:

• Discard - Passes the audio without compression

• PCM-16 Bit

• PCM-24 Bit

• AC-3

• Dolby-E

n You must have at least one stream selected (not discarded).
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Searching for Clips
The Search dialog box is used to search the database for matching clips. 

For more information on basic searching, see “Search Syntax Rules” on page 266.

To search for clips:

1. Click View > Search, or press F4. 

The Search dialog box opens.

2. Type your search criteria in the fields in the Search dialog box to search the database for 
matching items. With the search fields set to their default states, all items in the 
currently selected workspace are shown. For more information on searching, see 
“Search Syntax Rules” on page 266.

3. Click OK when you are done.
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To clear the fields in the search to return to the default state:

t Click Clear.

Search information can be entered into any or all of the following fields. 

Search Fields  

Field Description

Number These two fields set the range of clip file numbers to display. The left 
field contains the lowest clip file number; the right field contains the 
highest. 

Date These two fields set the range of creation dates. 

Title 
/Category/User/Memo

Each of these fields are used to specify the text which must be included 
within that field in order for that clip to be shown. For example, if the 
word “football” is placed in the title field, only those clips with the word 
football somewhere in the title will be shown. If data is entered in 
multiple fields, then all fields must match in order for the clip to display. 
More complex searches can be performed using search syntax. 

MultiMatch Allows you to find clips that contain a given piece of text when you don’t 
know which field it is in. When checked, the Title field is relabeled 
MultiMatch, and the other text fields are disabled. The search engine will 
check whether any of the four text fields have matching data. 

Ignore Case This check box causes all searches to ignore the differences between 
upper and lower case letters. 

Clear This button clears the search fields and restores the default values. 
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Search Syntax Rules

When entering the data for searches, use the following syntax rules:

• A plus (+) sign before any expression makes that expression required. 

• A minus (–) sign before any expression excludes that expression. 

• Quotes (“ ”) can be used to combine multiple words into one expression. 

The following are search syntax examples.

Search Syntax Examples  

Search String Results

dog cat cow Matches all clips containing dog, cat, or cow

+dog cat cow Matches all clips which contain dog. The cat and cow do not matter. 

+dog-cat Matches all clips which contain dog but do not contain cat.

“big dog” Matches “big dog” but does not match “big ugly dog” 

“big dog” “little dog” Matches “big dog” or “little dog” but not “little yellow dog” 



9 AirSpeed Multi Stream Studio and 
Playout

This chapter describes the AirSpeed Studio functionality in the Avid Unity workgroup 
environment. It also describes the steps in configuring the Studio.

n AirSpeed Studio is not supported in the Macintosh environment, or for standalone original 
AirSpeed systems.

AirSpeed Studio is supported for AirSpeed Multi Stream servers configured in a Team 
Configuration, with the following minimum software versions:

• AirSpeed Multi Stream v1.8

• TM Client v2.4

• NewsCutter v9.5.2

• Media Composer v5.5.2

• Symphony v5.5.2

The following topics are included in this chapter.

• Studio Concept

• Creating a Studio

• Using the Studio

• Monitoring Studio Transfers
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Studio Concept

The Studio consists of a group of devices (AirSpeed Multi Stream systems and original 
AirSpeeds) that can share a playout request. A maximum of five AirSpeed Multi Stream 
systems can be part of a Studio that is itself no larger than eight devices. When media is sent 
to the Studio, all the AirSpeeds in the Studio are sent the media. Each AirSpeed in the Studio 
is capable of performing the playout even if some of the Studio members are offline.

The Avid editing system sending a sequence to the Studio looks at the information listed in 
the TMClient.ini tab of the Transfer settings to identify the Studio and its members. The 
Studio information listed in the TMClient.ini tab is the aggregate of all the AirSpeed 
members in the Studio.

n You can create multiple Studios in a Workgroup environment only. Each Studio is created 
using the same process.

Creating a Studio

You create the Studio by naming up to eight AirSpeeds with a common Host Name and a 
unique number after the name. The name and the number are separated with a dash (–). Do 
not add any spaces between the name, dash, and number. Also, do not use more than one 
dash in the name. The Studio consist of AirSpeeds using the naming format of studioname–1 
through studioname–8, which allows the Avid editing system to easily locate the members of 
the Studio. 

When naming the AirSpeed members to create a Studio, the first AirSpeed name in the 
Studio must include the “–1” in the name. The second AirSpeed you add to the Studio must 
include “–2” in the name, and so forth. You cannot skip a number in the Studio name. For 
example, you must use studioname–1, studioname–2, studioname–3 and cannot use 
studioname–1, studioname–3, and studioname–4.

Adding the Studio to Your WorkGroup

The Studio is configured in the “TMClient.ini” tab of the Avid editing application’s Transfer 
setting dialog box. A Studio is identified using the following naming convention in the 
TMClient.ini tab:

• studioname[N]

In this example, studioname is the name entered as the Host Name on each AirSpeed in the 
Studio, and N represents the number of members in the Studio. 
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This naming convention distinguishes the AirSpeed Studio and all other TransferManager 
Servers (including single AirSpeeds). AirSpeed and Studio names must also be added as a 
client on the TransferManager Server Configuration Window. 

n Invalid or inactive playback server name entries in TMClient.ini can delay the Avid editor 
startup.

To add a Studio to an Avid editing system:

1. In the Avid editing application, click the Settings tab in the Project window. 

2. Double-click Transfer in the Settings scroll list

The Transfer Settings window opens.

3. Click the TMClient.ini tab.

The TMClient.ini tab opens.

4. Click Add.

If changing the Studio name, click Edit.

5. Type the Studio name and the number of members in brackets “[ ]” in the Server text 
box.

The number in brackets “[N]” identifies how many AirSpeed members are in the Studio. 
Using the figures in this section as an example, type studioa[3] in the Server text box. 
The AirSpeed members are studioa–1, studioa–2, and studioa–3.
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n If you are adding an individual AirSpeed to the Send to Playback list, type the AirSpeed Host 
Name in the Server text box as it appears in the Setup > Network tab of the AirSpeed UI.

6. Type the name of your workgroup in the Workgroup text box. This can be any name you 
give your workgroup. This entry is case sensitive.

7. Click OK.

Using the Studio

When the Avid editing application starts and connects to the Avid Unity environment, the 
playback devices are made available to the Avid editing system. These devices are displayed 
in the Transfer > Send To Playback menu. If your Studio was not available when you started 
the Avid editing application, select Select Transfer > Reconnect To Server.

For more information, see the following topics:

• “Connect to Playout Server or Studio” on page 270

• “Send to Playout Server or Studio” on page 271

Connect to Playout Server or Studio

The Studio is defined in the TMClient.ini tab on the Avid editing system. The Avid editor 
determines if the playback device is a Studio by the naming convention; see “Adding the 
Studio to Your WorkGroup” on page 268. This determination happens when the Avid editor 
is started. If you are already running the Avid editing application and want to make sure the 
playback servers are available, select “Reconnect To Server” in the Avid editor.

To connect or reconnect to transfer server:

t Select Transfer > Reconnect to Server.
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Send to Playout Server or Studio

The Studio name appears in the Avid editor’s Send To Playback list when you are connected 
to the studio. When a sequence is ready for playout, highlight the sequence and send it to the 
Studio in the playback list.

To send a sequence to a Studio, do one of the following:

t Right-click on the selected sequence and select Send to Playback > studioname.

t Highlight the sequence in your bin, and select Transfer > Send to Playback > 
studioname.

The Send To Playback list is not automatically refreshed with network changes. If the Studio 
has become unavailable, the Studio name remains in the Avid editor’s Send To Playback list. 
To check if the Studio is still available, select Transfer > Reconnect To Server. If the Studio 
name is removed from the Send To Playback list, all of the Studio members are no longer 
unavailable. If you send a sequence to a Studio that is unavailable, the result is a failed 
transfer.

n As long as one member of the Studio is available, the Studio name appears on the Send To 
Playback list and the transfer is successful. A Studio is only unavailable when all of its 
members are unavailable.
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Monitoring Studio Transfers

After you have sent a sequence to playback within the Avid editor, you can monitor the 
transfer in the Avid editor. The AirSpeed Studio Transfer Monitor dialog box automatically 
appears on the Avid editor the first time you send a sequence to a Studio. The dialog box first 
appears minimized in the application. When you click on the minimized dialog box, the 
dialog box opens and stays on top of the Avid editor. This dialog box can be minimized 
again, but cannot be closed. The following figure shows the AirSpeed Studio Transfer 
Monitor dialog box as it appears on the Avid editor.

The dialog box provides a tree listing of the AirSpeed members in the Studio with the 
transfer results. The AirSpeed Studio Transfer Monitor dialog box is updated in the Avid 
editor as the media transfers. A Studio monitor cannot be used to retry or pause transfers.

n Transferred items are listed in the dialog box until you quit the Avid editor or clear the list 
using the Transfer Status window options. For information on the Transfer Status window, 
see “Transfer Status Window” on page 273.
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Transfer Status Window

The Transfer Status window displays all TransferManager activity. 

To open the Transfer Status window:

t Select Transfer > Status Window.

The Transfer Status window opens.

Transfers display as one entry in Transfer Status window. Although multiple sequences 
might be included in the transfer, the window displays status for the entire transfer. If one or 
more members of the Studio are not available, the transfer immediately displays an Error 
with corresponding text. An Error is displayed even if other Studio members are 
successfully transferring.
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If you have administrative privileges or you initiated the transfer, you can cancel, retry, 
pause, or resume transfers. The following table explains the TransferManager Status 
conditions.

Right-click the status line of a particular transfer to select the user options.

TransferManager Status Descriptions  

Status Description User Options

Transferring At least one transfer is running and none 
have failed.

Pause or cancel the transfer.

Paused All transfers are paused. Resume or cancel the transfer.

Error (plus 
information 
indicating the error)

At least one transfer has failed. As soon 
as one transfer fails, regardless of the 
state of any of the other transfers, the 
transfer state is failed. 

Retry or clear the transfer.

Pending All transfers are pending. Cancel the transfer.

Completed All transfers have completed with no 
failures.

Clear the transfer.

Canceled All transfers have been canceled. Clear the transfer.
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The AirSpeed Multi Stream Remote Console is an application that can be installed on up to 
ten PCs on your network. In addition, each instance of the AirSpeed Multi Stream Remote 
Console is able to connect to up to ten AirSpeed Multi Stream servers on your network. 
Once connected to an AirSpeed Multi Stream server (or servers), you can see the channels 
and inventory on the server(s) you are connected to. Then, remotely from your PC, you can 
use the AirSpeed Multi Stream Remote Console application to do the following:

• Cue and play clips

• Cue and record clips

• Retransfer clips

• Manage clip inventory

• Create Playlists and play the clips out on their associated channels

This chapter describes how to install and use the AirSpeed Multi Stream Remote Console.

The following topics are included:

• Installing the Remote Console

• Starting the Remote Console

• Connecting to an AirSpeed Multi Stream Server

• User Interface

• Using the AirSpeed Multi Stream Remote Console

• Keyboard Shortcuts
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Installing the Remote Console

This topic contains information on how to install the AirSpeed Multi Stream Remote 
Console. 

To install the AirSpeed Multi Stream Remote Console:

1. Locate the AirSpeed Multi Stream Remote Console application file 
AirSpeedMultiStreamRemoteConsoleSetup.exe, and copy it to your desktop.

2. Run the AirSpeedMultiStreamRemoteConsoleSetup.exe file.

The AirSpeed Multi Stream Remote Console will automatically be installed on your 
system. 

For information on starting the AirSpeed Multi Stream Remote Console, see “Starting 
the Remote Console” on page 276.

Starting the Remote Console

During the installation process, a shortcut to AirSpeed Multi Stream Remote Console was 
installed on your computer’s desktop. 

To start AirSpeed Multi Stream Remote Console:

1. Log into Windows® XP or Vista.

2. Do one of the following: 

t Click on the AirSpeed Multi Stream Remote Console icon on the desktop.

t Select Start > Programs > Avid > Avid AirSpeed Multi Stream Remote 
Console.
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For Workgroup configurations, the AirSpeed Multi Stream Remote Client dialog box 
opens for you to type in your user name and password for Interplay. Otherwise, the Avid 
AirSpeed Multi Stream Remote Console application will automatically launch.

3. (Option) If you are connected via a Workgroup configuration, do the following: 

a. Select the Workgroup name from the Workgroup list box.

b. Type the name of the Interplay server that you want to connect to in the Interplay 
Server field.

c. Type the name of the Interplay database in the Interplay Database field.

d. Type your user name in the User field.

e. Type your password in the Password field.

f. Click the Login button.

The Avid AirSpeed Multi Stream Remote Console application will launch.
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User Interface

The AirSpeed Multi Stream Remote Console has a graphic user interface consisting of a 
Main menu, a Channels pane (containing either 4 or 6 Channels depending on the AirSpeed 
Multi Stream model that is active), and an Inventory pane. The following illustration 
identifies the key elements of the AirSpeed Multi Stream Remote Console user interface.

n  The function and use of these elements is discussed later.

Channels 
Pane

Main
Toolbar

Status 
Bar

Inventory 
Pane

Filter 
Controls
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Main Menu

Located at the top of the application, the Main menu contains the following menus:

• File

• Options

• About

For more information, see each of the menu topics.

• For information on the File menu, see File Menu

• For information on the Options menu, see Options Menu

• For information on the About menu, see About Menu

File Menu

The File menu contains the following submenus. Each is described in the following table:

File Submenus  

Option Description

Connect Enables you to connect to an AirSpeed Multi Stream server to view 
Channel and Inventory. 

For more information, see “Connecting to an AirSpeed Multi Stream 
Server” on page 295.

Configure Transfer 
Engine

(Only available for 
Standalone version of the 
Remote Console)

Enables you to select the AirSpeed Multi Stream server you want to 
configure. 

If you connect to an MPEG-2 model AirSpeed Multi Stream server, you 
can also select the XDCAM compression format. 

For more information, see “Enabling Transfers for AirSpeed Multi 
Stream Servers” on page 296.
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Options Menu

The Options menu contains the following submenus which are described in the following 
table:

Exit Closes the AirSpeed Multi Stream Remote Client application and exits to 
the Windows desktop.

File Submenus  

Option Description

Options Submenu  

Option Description

Flashing Play/Rec The behavior of the Flashing Play/Rec menu option is as follows:

• If checked, when playing, the Play and Channel Status buttons will 
flash green. When recording, the Record and Channel Status buttons 
will flash red.

• If unchecked, when playing, the Play and Channel Status buttons will 
stay solid green. When recording, the Record and Channel Status 
buttons will stay solid red.

View Playlists The behavior of the View Playlists menu option is as follows:

• If checked, the application will be in Playlist View mode. The 
Channel pane is vertically aligned along the left hand side of the 
screen. Playlists (depending on whether you have created any 
previously, some might be empty) appear to the right of each channel.

• If unchecked, the application will be in its normal state.
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About Menu

The About menu contains the following submenus. Each is described in the following table:

Channels Pane

The Channels pane contains up to six individual channels. Each channel represents a 
channel on the active AirSpeed Multi Stream that you have connected to.

For AirSpeed Multi Stream SD, DNxHD, and AVC-Intra models, you can view a maximum 
of four channels. For AirSpeed Multi Stream MPEG-2 HD models, you can view a 
maximum of six channels.

A slide bar appears beneath the Channels pane so you can view additional channels. 

You can click and drag a clip from the Inventory pane to a channel Precue area or Load area. 
If you drag it to the Precue area, the clip gets precued to play. If you drag it to the Load area, 
the clip is loaded and plays.

About Submenus  

Option Description

Version Selecting About > Version displays the copyright notice and software 
version number.

Help Selecting About > Help brings up the Online Help.
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Each Channel has the components shown in the following figure.

Channel Status

Record

Next Video ID

Transport buttons

Channel ID

Channel Format

Pause

Current Video ID

Time Code / 
Elapsed 
display

Duration / 
Remaining display

StopPlayRecue

Clip Name

Channels Fields  

Option Description

Channel ID Displays the AirSpeed Multi Stream server name followed by an 
underscore, and channel number (CH1-CH6). 

SD, DNxHD, and AVCI models only have 4 channels.

Channel Format The format for the channel.
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Channel Status The following channel statuses are available:

• IDLE – No Active Clip

• PAUSED – Active Clip paused

• PLAYING – Active Clip Playing

• SHUTTLING – Active Clip Shuttling

• JOGGING – Active Clip Jogging

• VARIPLAY – Active Clip Variable Playing

• RECORDING – Active Clip recording

• CUED – Active Clip is cued for playback or record

• UPDATING – Indicates that you switched from one AMS to another, 
and there is a delay in getting status information for the new view. 

• DONE – Active Clip played to end

• ERROR – Last cue operation failed (will stay in this state until 
another cue is issued)

Current Video ID Displays the video ID of the current clip. This field is also where you can 
drag a clip into for playing it. 

For more information, see “Cueing and Playing Clips Directly from the 
Current Video ID Field” on page 304.

Clip Name Displays the clip name of the actively playing or recording clip. You can 
also change the name of a currently recording clip by clicking the field to 
enable it for editing, and then typing the name directly in the field.

n Do not include these characters (* | “ : < > ? / . \ ) in the Clip 
Name field.

n If these characters (* | “ < > ?) are used in the Clip Name field, 
they will be translated to (_). The ( / and \ ) characters behave as 
folder level separators.

Time Code / Elapsed Displays the time code or elapsed time of the currently loaded clip. 

The default is Time Code. 

To toggle (change) the field name display between Time Code and 
Elapsed, right-click on the field, and select the name that you want to 
display from the menu.

Channels Fields  

Option Description
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Duration / Remaining Displays the duration or time remaining of the currently loaded clip.

The default is Duration. 

To toggle (change) the field name display between Duration and Time 
Remaining, right-click on the field, and select the name that you want to 
display from the menu.

You can also change the duration or time remaining of a currently 
recording clip by clicking in the field to enable editing, then typing the 
duration directly in the field. If you reduce the duration or time remaining 
to less than what has already been recorded, the clip will stop recording.

Transport buttons The Transport buttons are used to manipulate the video. Buttons included 
are the following:

• Recue

• Pause

• Play

• Record

• Stop

For more information on the Transport buttons, see “Transport Buttons” 
on page 285.

Next Video ID The Video ID of the next (cued) clip. 

For more information on cueing clips, see “Cueing and Taking Clips via 
the Next Video ID Field” on page 304.

Channels Fields  

Option Description
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Transport Buttons

The Transport buttons are the buttons towards the bottom of each Channel. They are used to 
play, record, pause, eject, and recue the currently loaded clip.

Inventory Pane

The Inventory pane, shown in the following illustration, is a list view of an AirSpeed Multi 
Stream server’s inventory. You connect to an AirSpeed Multi Stream server using the File > 
Connect command. 

If you are connected to more than one AirSpeed Multi Stream server, you can toggle 
between the active AirSpeed Multi Stream, and another AirSpeed Multi Stream server that 
you are connected to by clicking on the Server tab just above the Inventory pane for the 
AirSpeed Multi Stream server that you want to work with. The currently active server’s 
inventory displays in the Inventory pane.

Transport Buttons  

Button Description

Brings you back to the beginning of a clip that is playing in the Current Video ID field.

Pauses the currently playing clip.

Plays the clip that is loaded in the Current Video ID field.

Records the clip that is loaded in the Current Video ID field.

Ejects a playing, recording, cued or paused clip from the channel. 
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n When you connect to multiple AirSpeed Multi Stream servers, they appear as tabs just above 
the Inventory pane.

n The active Server tab is highlighted.

Inventory Pane Fields  

Option Description

Name The name of the clip. 

Video Id The unique video ID of the clip.

Duration The duration of the clip.

In The In timecode of the clip.

Out The Out timecode of the clip.

Creation Date The date the clip was created.

Protected An identifier denoting whether this clip is protected from deletion. For 
information on protecting clips, see “Protecting or Unprotecting Clips 
from Deletion” on page 309.

Format The format of the clip.
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If you want to change the order of fields in the Inventory window, click, see “Changing the 
Sort Order of Clips” on page 299. 

Transfer Status The transfer status of the clip. Options are: 

• Transfer Done 

• Transfer Error

• Transfer Paused

• Transferring Out

• Transferring In

• Transfer Request

• Ready to Transfer

• Recording

Head Frame Displays the head frame of the clip.

Original For subclips, lists the name of the master clip from which the subclip’s 
media is associated with.

Inventory Pane Fields (Continued)  

Option Description
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Filter Controls

The Filter Controls area displays beneath the Inventory panel.

The fields in the Status bar example indicate the following:

Indicator Description 

Filter Enables you to filter on a clip name or video ID. 

For more information, see “Filtering on a Clip Name or Video ID” 
on page 302.

Clip Source Enables you to filter clips based on if they were recorded from 
baseband (locally) or transferred from a Send to Playback 
sequence.

• If the Recorded check box is selected, the filter will only show 
clips that meet the filter criteria and were recorded locally.

• If theTransferred check box is selected, the filter will only 
show clips that meet the filter criteria and were transferred 
from Send to Playback.

• If both or neither the Recorded and Transferred check boxes 
are selected, there is no effect on the filter.
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Status Bar

The Status Bar displays across the bottom of the Remote Console application window.

The fields in the Status bar example indicate the following:

Indicator Description 

Clip Count Displays the number of clips on the selected (active) AirSpeed 
Multi Stream server.

Reference Status Displays the reference status. Options are: 

• Ref OK - The reference signal is working properly.

• ! NO REFERENCE - The system cannot detect a reference 
signal.

• ! REFERENCE UNLOCKED - The reference is unlocked.

•  ! WRONG REFERENCE TYPE - The system detected that 
you have the wrong reference type.

n This occurs when you are supplying an SD Reference 
(which is expecting Blackburst) to an HD based database 
(which is expecting Tri-level) or vice versa.

System Time (11:32:36) Shows the current time.

Free Space (1,576,976 (% 82 
Free))

The amount and percentage of free space on the AirSpeed Multi 
Stream server that holds this Inventory.

Connection Status Displays the connection status. Options are:

• CONNECTED - Indicates that the server is connected.

• NOT CONNECTED - Indicates that the server is not 
connected.
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View Playlists Mode

The View Playlists mode is a part of the AirSpeed Multi Stream user interface that shows 
Playlists for each Playout channel you have on the selected AirSpeed Multi Stream server. 
The Remote Console Playlist enables you to easily create playlists and execute some basic 
tasks using these playlists on the AirSpeed Multi Stream. 

n A Playlist can support up to 24 hours of video, and up to 1000 clips.

You can enable or disable the View Playlists mode at any time, by selecting Options > View 
Playlists.
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Playlist Information Bar

This topic contains information on the Playlist Information bar in the Remote Console 
Playlist View.

Option Description 

Playlist Name The gray box to the left is used to type in a name for the Playlist. 
The pulldown menu to the right of this gray editable field contains 
the following items:

• Open - Loads an existing Playlist.

• Save - Saves the currently loaded Playlist.

• Clear - Clears the currently loaded Playlist.

• Take Control - Takes over control of a Playlist from another 
user.

Cue Select the Cue button to automatically cue the highlighted clip in 
the Playlist. If no clip is highlighted, selecting the Cue button cues 
the first clip in the Playlist. 

For more information, see “Cueing a Playlist” on page 318.

To cue an individual clip, you can also highlight the clip you want 
to start playing from, and right-click. Then, select Cue from the 
menu.

For more information, see “Cueing From a Specific Clip in the 
Playlist” on page 318.

Loop Enables you to toggle the Playlist between Loop On and Loop Off.

• If the button text is Green, it indicates Loop On.

• If the button text is black, it indicates Loop Off.

For more information, see “Setting Loop Behavior in the Playlist” 
on page 315.

Duration The Duration of the entire Playlist.

Remaining The remaining duration in the Playlist. The value in this field 
indicates the time remaining to play from where a clip in the 
Playlist is currently cued or playing.
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Clip Information Bar

This topic contains information on the Clip Information bar in the Remote Console Playlist 
View.

n All Playlist column headings can be reordered by clicking on a column heading and 
dragging and dropping it to the desired location.

You can resize column headings by clicking on the edge of a heading and dragging it.

Option Description 

Clip # Indicates the clip position of the clip in the current Playlist. 

If you want to reorder a clip in the Playlist, you can drag and drop 
a clip to the desired location in the Playlist. 

For more information, see “Reordering Clips within the Playlist” 
on page 316.

Name The name of the clip.

Video ID The video ID of the clip.

In Lists the Mark In timecode of the clip.

For more information, see “Modifying Mark In/Mark Out Points 
for Clips in the Playlist” on page 316.

Out Lists the Mark Out timecode of the clip.

For more information, see “Modifying Mark In/Mark Out Points 
for Clips in the Playlist” on page 316

Duration The total duration of the clip.
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Follow • If the Follow check box is selected (green check mark) for this 
clip, the clip will automatically play if it is the next clip cued.

• If the Follow check box is not selected for this clip, the Playlist 
will stop play when it gets to this clip. You need to manually 
press the Play button, Spacebar, or F12 to continue playout on 
the channel

Status Describes the status of the clip. Options are: 

• Online - A clip is considered to be “Online” when the media is 
present in the Inventory pane, and the video standard is the 
same as the associated channel.

• Offline - A clip is considered to be “Offline” when the media is 
missing from the Inventory pane.

• Cued - The clip is qued to play. When a clip is cued, the row 
appears highlighted yellow.

• Playing - The clip is playing. When a clip is playing the row 
appears green.

•  Unplayable - A clip is considered “Unplayable” when its 
video standard is different than the associated channel, it is in 
the wrong format, or it is less than 10 seconds in length (too 
short). When a clip is unplayable, the row appears grey and the 
text is bold.

n Unplayable and offline clips will be skipped when the 
previous clip has finished playing. The following clip will 
play if Follow is selected.

Option Description 
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Right-Click Menus

The following right-click menus are available in the AirSpeed Multi Stream Remote 
Console.

Right-clicking on a clip in the Inventory pane displays this menu, 
allowing you to:

• Toggle Delete Protect - Protects this clip file from being deleted.

For more information, see “Protecting or Unprotecting Clips from 
Deletion” on page 309.

• Transfer to Interplay - Transfers this clip to storage and checks it 
into Interplay. This option is only available in an Interplay 
environment.

For more information, see “Transferring Clips to Interplay” on 
page 310.

• Create Subclip - Creates a subclip in a new row in the Inventory 
panel. The subclip is based on the media in the master clip. You 
can then set Mark Ins and Mark Outs based on the master clip.

For more information, see “Creating Subclips” on page 307.

Right-clicking on any column headingin the Inventory pane displays 
this menu, allowing you to show or hide selected columns. 

Clicking “Hide This Column” hides the column that you right-clicked 
on in the Inventory pane. 

If the check box next to a column heading is selected, the column will 
appear in the Inventory pane. If it is not selected, it will not appear in 
the Inventory pane. 

Click the More button to open a dialog box to select or deselect 
multiple columns that you want to show or hide in the Inventory pane.

If you want to view the master clip name from which a subclip’s 
media is associated with, you must select the Original column.

For more information, see “Showing or Hiding Columns in the 
Inventory Pane” on page 301.
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Connecting to an AirSpeed Multi Stream Server
This topic contains information on how to connect to an AirSpeed Multi Stream server in 
order to view channel and inventory information for that server.

To connect to an AirSpeed Multi Stream server:

1. Select File > Connect.

The Connect to Remote Server dialog box opens.

Right-clicking on a clip in the Playlist will display this menu. 

• Cue - Selecting Cue automatically cues the highlighted clip. The 
row for the cued clip appears highlighted yellow.

For more information, see “Cueing From a Specific Clip in the 
Playlist” on page 318.

• Remove Clip - Deletes the highlighted clip from the Playlist.

For more information, see “Deleting Clips from the Playlist” on 
page 317.

• Enable Follow - Highlighted clips will all be enabled to play next 
in the Playlist.

• Disable Follow - Highlighted clips will all be disabled to 
automatically play next in the Playlist.

For more information, see “Setting the Follow Behavior for Clips in 
the Playlist” on page 317.
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2. In the Server Host Name field, type the host name  of the AirSpeed Multi Stream server 
that you want to connect to, and click OK.

n If you are configured in a Standalone Transfer Manager, or Team configuration, once you 
successfully connect to an AirSpeed Multi Stream server, its host name appears in the Server 
Host Name list. Therefore, if you ever want to connect to that (or any other previously 
connected to) AirSpeed Multi Stream server, you can simply select it from the list. 

If you are configured in a Workgroup (Interplay) environment, the servers appearing in the 
Server Host Name list consist of the AirSpeed Multi Stream servers that are in the 
Workgroup that you are connected to.

The channel and inventory information for that AirSpeed Multi Stream server is loaded 
into the AirSpeed Multi Stream Remote Console with a Server tab just above the 
Inventory panel, showing the host name  of that AirSpeed Multi Stream server.

3. (Optional) Repeat Steps 1 and 2 to connect to additional AirSpeed Multi Stream servers.

Additional AirSpeed Multi Stream servers that you connect to appear in the Server tabs 
just above the Inventory pane. 

n You can connect to up to ten AirSpeed Multi Stream servers at one time.

Enabling Transfers for AirSpeed Multi Stream 
Servers

Once launched, if your AirSpeed Multi Stream server is set up with a Standalone Transfer 
Manager, or in a Team configuration, you must enable transfers on the AirSpeed Multi 
Stream Remote Console to allow communication between it and the AirSpeed Multi Stream 
server.

To enable transfers for AirSpeed Multi Stream servers:

1.  Connect to the AirSpeed Multi Stream server that you want to use. 

For more information, see “Connecting to an AirSpeed Multi Stream Server” on 
page 295.
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2. Once connected, select File > Configure Transfer Engine.

The Configure Transfer Engine dialog box opens.

3. Select the XDCAM AirSpeed Multi Stream server name that you want to configure 
from the Select Server list.

The Select Server list displays the most recently used AirSpeed Multi Stream servers.

4. Click Add to add the selected server to the Configured Servers list. 

The Configured Servers list displays the AirSpeed Multi Stream servers that are 
configured for use by the standalone Transfer Manager server.

5. (Optional) To remove a server from the Configured Servers list, select the server you 
want to remove and click the Delete button.

6. (Optional) For MPEG-2 HD (XDCAM) systems only, select the compression format 
you want to use for your transfers from the XDCAM STP Format list.

n For SD, DNxHD, and AVC-Intra systems, leave this field blank.

7. Click the Update button to save your changes.

You will be asked to restart the Transfer Engine. Click OK.

8. Manually stop and restart the Transfer Engine.

At this point, the server is configured for ingest and playback. For MPEG-2 (XDCAM) 
servers, a profile is generated that allows you to send to playback MPEG-2, 720p or 
1080i media. This will be denoted by the <AMSservername>-HD in the Avid editor 
upon sending an HD sequence to playback.

9. Next, you should configure the standalone settings for the Avid Editor. For more 
information, see “Configuring the Standalone Settings for the Avid Editor” on page 164 
of the Avid AirSpeed Multi Stream Installation and User’s Guide.
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Using the AirSpeed Multi Stream Remote Console

This topic contains information on how to perform some of the basic tasks in the AirSpeed 
Multi Stream Remote Console.

The following topics are included:

• “Selecting Clips” on page 299

• “Changing the Sort Order of Clips” on page 299

• “Showing or Hiding Columns in the Inventory Pane” on page 301

• “Filtering on a Clip Name or Video ID” on page 302

• “Playing Clips” on page 303

• “Recording Clips” on page 305

• “Creating Subclips” on page 307

• “Editing the In and Out Points of a Clip” on page 308

• “Deleting Clips” on page 308

• “Protecting or Unprotecting Clips from Deletion” on page 309

• “Transferring Clips to Interplay” on page 310

• “Transferring Clips to an Avid Editor” on page 310

• “Working with Playlists” on page 311

• “Playlist Operations” on page 313

• “Working with Clips in the Playlist” on page 316

• “Working with Playlists” on page 311

• “Performing an Edit While Capture (EWC) with Drag and Drop” on page 319

• “Performing an Edit While Capture (EWC) with Auto Transfer” on page 320
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Selecting Clips

You can select clips in the Inventory pane for playing, cueing, deleting, or transferring to 
Interplay.

You can also select multiple clips for deletion only. There are two methods for selecting 
multiple clips.

To select a single clip:

t Simply click on a clip you want to select.

To select individual non-consecutive clips

t Ctrl+click and select individual non-consecutive clips.

To select a series of clips

t Shift+click and select multiple consecutive clips.

Changing the Sort Order of Clips

This topic contains information on changing the sort order of clips based on a single column 
of data in the Inventory Pane.

To change the sort order of clips:

1. To sort on a single column heading, click on the column heading to sort by at the top of 
the Inventory pane (Name, Video ID, Transfer Status, and so on).

n When a Name sort is active, items with no information in the Name field are moved to the top 
of the window. Clips that contain a numerical entry in the first position of these fields are 
sorted next, followed by all remaining clips sorted alphabetically by name.
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2. Click on the column heading again to reverse sort the items in the column.

The following table describes how the columns are sorted. 

Sort Category  

Option Description

Name Clips are sorted alphabetically by the name. 

Video Id Clips are sorted alphabetically by a unique ID for the clip.

Duration Clips are sorted numerically by their length.

In Clips are sorted numerically by their In point.

Out Clips are sorted numerically by their Out point.

Creation Date Clips are sorted by the date they were saved in descending order, that is, 
the newest clips are first and the oldest ones last.

Protected Clips are sorted alphabetically by those that are protected.

Format Clips are sorted alphabetically by format.

Transfer Status Clips are sorted alphabetically by their transfer status.
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Showing or Hiding Columns in the Inventory Pane

The Remote Console enables you to show or hide columns in the Inventory pane. 

n If you want to see the master clip name associated with a subclip, you must show the 
Original column.

To show or hide columns in the Inventory Pane:

1. In the Inventory pane, right-click on a column heading.

The following menu opens:

2.  Do the following to show or hide columns in the Inventory pane.

t To hide only the column pertaining to the column heading you right-clicked on, 
select Hide This Column.

t To display a column, select the check box next to the column heading you want to 
display. It will appear in the Inventory pane.

t To hide a column, select the check box next to the column heading you want to 
hide. It will not appear in the Inventory pane.

3. To select or deselect multiple columns that you want to show or hide in the Inventory 
pane, do the following: 

a. Click the More button to open the Choose Columns to Display dialog box. 

b. Select the columns you want to display (these will be checked) in the Inventory 
pane. To hide columns, click on a column heading check box that is selected. It will 
become deselected.

c. Click OK to save your changes.
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Filtering on a Clip Name or Video ID

This topic contains information on filtering on a clip name or video ID.

To filter on a clip name or video ID:

1. Type a portion or the full clip name or video ID you want to filter on in the Filter field, 
and press Enter to run the filter.

2. (Option) If you want to change the default filter settings, you can also right-click on the 
Filter field to bring up the Filter menu controls as shown in the following illustration:

The following table describes the options available in the Filter menu.

Filter Options  

Option Description

All This is the default. If selected, whatever you type in the Filter field 
applies to both video IDs and clip names.

Video ID If selected, whatever you type in the Filter field applies to Video IDs 
only.

Name If selected, whatever you type in the Filter field applies to clip names 
only.

Case sensitive If selected, whatever you type in the Filter field must be case sensitive for 
the filter to find a match. 

For example, if you typed “Dog”, it would not find “dog”, and vice versa.
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3. (Option) If you want to filter clips based on whether they were recorded from baseband 
(locally) or transferred from a Send to Playback sequence, do one of the following:

t If you want the filter to only show clips that were recorded locally, select the 
Recorded check box, and press Enter.

t If you want the filter will only show clips that were transferred from Send to 
Playback, select the Transferred check box, and press Enter.

n If both or neither the Recorded and Transferred check boxes are selected, there is no effect 
on the filter.

Playing Clips

This topic contains information on the methods on how to cue and play a clip on an 
AirSpeed Multi Stream server channel.

There are two methods for cueing and playing clips:

• Cue and Play directly from the Current Video ID field

• Cue and Take via the Next Video ID field

Case insensitive This is the default. If selected, whatever you type in the Filter field does 
not need to be case sensitive for the filter to find a match. 

For example, if you typed “Dog”, it would also find anything that has 
“dog” in it, and vice versa.

Use wildcards This is the default. If selected, you can type wildcards such as * in the 
Filter field to find everything that contains the text after the wildcard. 
This field is redundant if Match anywhere is selected. For example, if 
you typed “*Do”, it would not find all names or Video IDs (or both) with 
the letters “do”, assuming you have Case sensitive selected.

Match from start If selected, whatever you type in the Filter field must be found at the 
beginning of the name or Video ID for the filter to find a match.

Match exactly If selected, whatever you type in the Filter field must be exactly the same 
as the name or Video ID for the filter to find a match. In other words, the 
whole name must be typed in exactly as it appears in the Inventory Pane.

Match anywhere This is the default. If selected, whatever you type in the Filter field can be 
anywhere in the name or Video ID, and can also be a partial name.

Filter Options  

Option Description
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n  Pre-cued clips get removed when another clip is dragged and dropped to the active window 
of the same channel. When a clip is dragged or cued to in the active channel location of the 
Remote Console or the AirSpeed Multi Stream user interface, it overrides any pre-cued clip 
and causes the pre-cued clips to be ejected.

Cueing and Playing Clips Directly from the Current Video ID Field

This topic contains information on how to cue and play a clip directly from the Current 
Video ID field on an AirSpeed Multi Stream server channel.

To cue and play a clip from the Current Video ID field:

1. Do one of the following: 

t Select a clip in the Inventory Pane to highlight it, then click and drag and drop it 
into the Current Video ID field.

The clip cues, but does not play.

t Type the Video ID of the clip in the Current Video ID field, and press Enter.

The clip cues, but does not play.

2. Click the Play button to begin playback.

Cueing and Taking Clips via the Next Video ID Field

This topic contains information on how to cue and take (F12) a clip on an AirSpeed Multi 
Stream server channel via the Next Video ID field.

To cue and take a clip via the Next Video ID field:

t Do one of the following: 

- Select a clip you want to cue from the Inventory Pane to highlight it, then click and 
drag and drop it into the Next Video ID field.

Click the Take (F12) key to Take the clip to the Current Video ID field.

- Type the Video ID of the clip you want to cue in the Next Video ID field, and press 
Enter.

Click the Take (F12) key to Take the clip to the Current Video ID field.

The clip will automatically begin to play.
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Recording Clips

There are a few basic methods in which to record or capture clips. This topic contains 
information on the methods used to record clips on an AirSpeed Multi Stream server channel 
including:

• “Crash Recording Clips” on page 305

• “Cueing Clips for Record” on page 305

• “Recording Clips with Only a Video ID Specified (no Duration or Name)” on page 306

• “Recording Clips with Both a Video ID and Duration Specified” on page 306

• “Recording Clips with Only a Name Specified (no Duration or Video ID)” on page 306

• “Recording Clips with Only a Duration Specified (No Video ID or Name)” on page 307

Crash Recording Clips

This topic contains information on how to Crash Record a clip on an AirSpeed Multi Stream 
server channel.

To crash record a clip:

1. Click the Record button. 

The clip will record to the location specified on the active AirSpeed Multi Stream server 
for that channel.

n If you do not type a name for the clip, a name will be generated as specified in the Service 
Configuration in Interplay.

2. Click the Stop button when you want to stop the crash record of this clip.

Cueing Clips for Record

This topic contains information on how to cue a clip for record.

To cue a clip for record:

1.  Select the channel you want to record to by clicking on it.

2. Do the following:

a. Click in one of the editable fields (Name, Video ID or Duration).

b. (Optional) Type a clip name, video ID or duration for the clip.

If no video ID, clip name, or duration has been entered for the clip, the clip will be 
assigned this information based on how the Default Template for the AirSpeed 
Multi Stream server you are recording to was configured.
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c. Press Ctrl+Enter to cue the clip for record. 

n To cancel the Record Cue, click the Stop button.

3. Click the Record button to record the cued clip. 

The clip will stop recording at the set duration. However, you can also stop the record by 
pressing the Stop button.

Recording Clips with Only a Video ID Specified (no Duration or Name)

This topic contains information on how to record a clip on an AirSpeed Multi Stream server 
channel with a Video ID, but no duration or name specified.

To record a clip with a Video ID and no duration specified:

1.  Select the channel you want to record to.

2. Type a name for the clip in the Current Video ID field, and press Enter.

3. Click the Record button.

4. Click the Stop button to stop the record at the desired duration.

Recording Clips with Both a Video ID and Duration Specified

This topic contains information on how to record a clip on an AirSpeed Multi Stream server 
channel with both a Video ID and duration specified.

To record a clip with both a Video ID and duration specified:

1.  Select the channel you want to record to.

2. Type a name for the clip in the Current Video ID field.

3. Type a duration of the recording in the Duration field.

4. Click the Record button or press Enter.

Record will continue until the duration specified is met, and the clip will be unloaded 
from the channel.

Recording Clips with Only a Name Specified (no Duration or Video ID)

This topic contains information on how to record a clip on an AirSpeed Multi Stream server 
channel with a name, but no duration or video ID specified.

To record a clip with a name and no duration or video ID specified:

1.  Select the channel you want to record to.

2. Type a name for the clip in the Name field.
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3. Click the Record button or press Enter.

4. Click the Stop button to stop the record at the desired duration.

Recording Clips with Only a Duration Specified (No Video ID or Name)

This topic contains information on how to record a clip on an AirSpeed Multi Stream server 
channel with only a duration specified (no video ID or name).

n If you do not type a name for the clip, a name will be generated.

To record a clip with only a duration specified (no video ID or name):

1.  Select the channel that you want to record to:

2. Type a duration for the recording in the Duration field.

3. Click the Record button, or press Enter. 

Record will continue until the duration specified is met, and when the recording stops, 
the clip will be unloaded from the channel.

Creating Subclips

This topic contains information on how to create subclips from a master clip.

To create subclips:

1. Right-click on any master clip in the Inventory pane, and select Create Subclip from 
the menu.

A new subclip is created in a new row in the Inventory panel.

2. (Optional) View the source master clip from which the subclip was created. You must 
show the Original column.

n The Original column lists the name of the master clip from which the subclip’s media was 
taken from.

For more information, see “Showing or Hiding Columns in the Inventory Pane” on 
page 301.

3. Edit the Mark In and Mark Out points of the subclip. For more information, see Editing 
the In and Out Points of a Clip.
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Editing the In and Out Points of a Clip

This topic contains information on how to edit the In and Out points of a clip.

To edit the In and Out points of a clip:

1. Load a clip into a channel. For more information, see “Selecting Clips” on page 299.

2. Use the J or L keys to shuttle to locate the spot where you want to set the Mark In or 
Mark Out point of the clip. The timecode will change to reflect the In or Out point of the 
clip.

n You cannot modify the clip In point using the Properties dialog box. It must be done in the 
Browse window. The Preview dialog box is not available for clips during record.

3. When you are at the location you are looking for, pause the clip by pressing the Pause 
button or typing the K key.

4. Do one of the following:

a. Type I to mark the new In point of the clip.

b. Type O to mark the Out point of the clip.

You will notice the duration of the clip changes in both the Timecode field of the 
channel, and the Duration field in the Inventory panel. 

n If you changed the In point, the clip will play from the new In point, and cueing the clip will 
now cue to the new In point. If you changed the Out Point, the clip will stop playing at the 
new Out point.

5. (Option) To edit another In or Out point, repeat this procedure.

Deleting Clips

This topic contains information on how to delete a clip. You can only delete unprotected 
clips. For more information, see “Protecting or Unprotecting Clips from Deletion” on page 
309.

You can also select multiple clips for deletion. 

There are two methods for selecting multiple clips.
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To delete a clip:

1. In the Inventory pane, click on a clip you want to delete.

2.  Press the Delete key.

The clip will be deleted from the AirSpeed Multi Stream server and will not appear in 
the Inventory pane.

To delete individual non-consecutive clips:

t Ctrl+click and select individual non-consecutive clips, and press the Delete key.

To delete a series of clips:

t Shift+click and select multiple consecutive clips, and press the Delete key.

Protecting or Unprotecting Clips from Deletion

The Remote Console enables you to protect or unprotect clips from being deleted from the 
AirSpeed Multi Stream server.

You can also select multiple clips. There are two methods for selecting multiple clips.

To protect or unprotect clips from deletion:

1. In the Inventory pane, click on a clip you want to protect or unprotect from being 
deleted. You can also:

t Ctrl+click to select individual non-consecutive clips.

t Shift+click to select multiple consecutive clips.

2.  Once your clip(s) are selected, right-click and select Toggle Delete Protect from the 
menu.

The clip will switch to the opposite behavior that it had when you selected it. For 
instance, if it was protected from deletion (box was checked), it will now be unprotected 
(box unchecked). If it was unprotected (box was unchecked), it will now be protected 
(box checked).
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Transferring Clips to Interplay

This topic contains information on how to transfer clips to Interplay. 

n This option is only available in an Interplay environment.

To transfer clips to Interplay:

1. In the Inventory pane, click on a clip you want to transfer to Interplay. You can also 
select multiple clips at once:

t Ctrl+click and select individual non-consecutive clips.

t Shift+click and select multiple consecutive clips.

2.  Once your clip(s) are selected, right-click and select Transfer to Interplay from the 
menu.

The selected clip(s) will be transferred to Interplay.

Transferring Clips to an Avid Editor

If you are in a Standalone configuration, you can transfer clips directly to an Avid Editor. 
The clips will also be transferred into the local storage location configured in the Interplay 
Transfer Configuration.

Before you can transfer a clip to an Avid Editor, the following must be installed on an Avid 
Editor:

• The standalone version of the AirSpeed Multi Stream Remote Console application.

• The TransferManager Client (TMClient).

To transfer clips to an Avid Editor:

1. In the Inventory pane, click on a clip you want to transfer to an Avid Editor. To select 
multiple clips do one of the following:

t Press Ctrl and then click to select individual non-consecutive clips.

t Press Shift and then click on the last clip of a group to select multiple consecutive 
clips. All clips in between will be selected.

2. Select the clip(s) you want to transfer, and drag them to the bin.

You will be asked if you want to transfer Now or Later.

3. Select Now. 

If you selected Now, the Transfer Status will show the clip transferring to Interplay.
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Working with Playlists

The AirSpeed Multi Stream Remote Console allows you to enable Playlist View to create, 
edit, and execute Playlists on a per channel basis. 

n You can create Playlists for up to the total number of Playout channels on the selected 
AirSpeed Multi Stream server.

Once you enable the View Playlists mode of the AirSpeed Multi Stream Remote Console, 
you can create a Playlists for the Remote Console channel by simply dragging and dropping 
clips from the Inventory pane into the desired Channel Playlists. 

n In the Playlist, you can mix SD and HD clips, as well as clips with different aspect ratios.

n A Playlist can support up to 24 hours of video, and up to 1000 clips.

• Create a Playlist for a channel and drag and drop clips from the Inventory pane to the 
Playlist

• Modify the contents of a playlist while it is playing without interrupting playback

• Control behavior when transitioning between clips (follow on or pause)

• Loop and cue Playlists

• Save and Load playlists to or from a file for sharing with other workstations or for later 
use

For more information on creating Playlists, see “Creating Playlists” on page 311.

Creating Playlists

This topic contains information on how to create Playlists in the AirSpeed Multi Stream 
Remote Console.

To create Playlists:

1. Select Options > View Playlists.

The user interface refreshes and the Channel pane is vertically aligned along the left 
hand side of the screen. 
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Empty playlists appear to the right of each channel, and a check mark appears in the 
View Playlist menu item to indicate that the View Playlist mode is enabled. 

To return to the default mode, select Options > View Playlist again.

2. Drag and drop clips from the Inventory pane to the Playlist area. To position your clip(s) 
in the Playlist, drag the selected clips to the desired location (before or after) any other 
clips in the Playlist. 

The name field appears as “Untitled Playlist”.

t Press Ctrl and then click to select individual non-consecutive clips.

t Press Shift and then click on the last clip of a group to select multiple consecutive 
clips. All clips in between will be selected.

3. To change the Playlist name, type a new name over the existing “Untitled Playlist” name 
in the Name field and press Enter.

4. Save the Playlist by doing the following: 

a. Click on the Playlist Name pulldown menu and select Save. The Save dialog box 
opens.

b. Navigate to the location where you want to save the Playlist, and type a name for 
the Playlist file, and click the Save button. The Playlist is saved.

For more information, see “Saving Playlists” on page 313.
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5. (Option) Once you have clips in your Playlist, you can now do the following:

t Perform basic tasks involving entire Playlists, such as opening, saving, looping, and 
taking control of a Playlist. For more information, see “Playlist Operations” on 
page 313.

t Perform tasks related specifically to clips in the Playlist. For more information, see 
“Working with Clips in the Playlist” on page 316.

Playlist Operations

Some basic Playlist operations are available when in the Playlist View mode:

• “Saving Playlists” on page 313

• “Opening Playlists” on page 314

• “Clearing Playlists” on page 314

• “Taking Control of a Playlist for a Channel” on page 314

• “Setting Loop Behavior in the Playlist” on page 315

Saving Playlists

This topic contains information on how to save Playlists.

To save Playlists:

1. Click the Playlist Name pulldown menu, and select Save.

The Save dialog box opens.

2. Navigate to the location where you want to save the Playlist, and type a name for the 
Playlist file, and click the Save button. 

The Playlist is saved.
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Opening Playlists

Once saved, Playlists can be opened again. This topic contains information on how to open 
previously created Playlists.

To open Playlists:

1. Click the Playlist Name pulldown menu, and click Open.

The Open dialog box opens.

2. Do the following:

a. Navigate to the location where the Playlist was saved.

b. Click on the name of the Playlist file you want to open.

c. Click the Open button.

The selected Playlist is opened into the Playlist View.

Clearing Playlists

This topic contains information on how to clear Playlists.

n Before being allowed to clear, you must unload any Playlist on the channel by clicking the 
Stop button or pressing the E key.

To clear Playlists:

1. Click the Playlist Name pulldown menu, and select Clear.

The Delete Playlist dialog box opens.

2. Click OK.

The Playlist will be cleared from the channel. If the Playlist was previously saved, the 
file will still remain in the location it was previously saved to.

Taking Control of a Playlist for a Channel

This topic contains information on how to take control of Playlists for a given channel. 
When you take control of a Playlist for a channel, it means that only you can make changes 
to the Playlist. 

Users at another AirSpeed Multi Stream Remote Console will see a Lock icon next to the 
Playlist Name pulldown menu that indicates that this Playlist is locked and in use by 
someone else. They will not be able to modify, cue, or play (if a clip is not already precued) 
any clips within the Playlist.
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To take control of a Playlist for a channel:

1. Click the Playlist Name pulldown menu for a channel that you want to take control of, 
and select Take Control.

You now have sole control of this channel. Users at another AirSpeed Multi Stream 
Remote Console will see a Lock icon next to the Playlist Name pulldown menu that 
indicates that this Playlist is locked and in use by someone else. 

2. Once you have control of the Playlist, you can work with clips within the Playlist. For 
more information, see “Working with Clips in the Playlist” on page 316.

n Another user can take control of the Playlist at any time.

Setting Loop Behavior in the Playlist

This topic contains information on how to toggle the Playlist between Loop On and Loop 
Off. 

The default is set to “Off”.

To set loop behavior in the Playlist:

t Click the Loop button.

- If the button text is Green, it indicates Loop On.

- If the button text is black, it indicates Loop Off.
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Working with Clips in the Playlist

This topic contains all the tasks that you can perfrom when working with clips in the 
Playlist. The following tasks are included:

• “Reordering Clips within the Playlist” on page 316

• “Modifying Mark In/Mark Out Points for Clips in the Playlist” on page 316

• “Setting the Follow Behavior for Clips in the Playlist” on page 317

• “Deleting Clips from the Playlist” on page 317

• “Taking Control of a Playlist for a Channel” on page 314

• “Cueing a Playlist” on page 318

• “Cueing From a Specific Clip in the Playlist” on page 318

• “Playing Clips in the Playlist” on page 318

• “Pausing Clips in the Playlist” on page 319

• “Stopping and Unloading Clips in the Playlist” on page 319

Reordering Clips within the Playlist

This topic contains information on how to reorder clips within the Playlist.

To reorder clips within the Playlist:

t Select a clip that you want to reorder in the Playlist, and drag it from one location and 
then drop it into the new location in the Playlist. 

Modifying Mark In/Mark Out Points for Clips in the Playlist

This topic contains information on how to modify the Mark In and/or Mark Out points for 
clips in the Playlist.

To modify the Mark In or Mark Out points for clips in the Playlist:

1. Click in the In or Out field for the clip you want to change the Mark In or Mark Out 
point for.

2. Type the new timecode in the field. 

The new Mark In or Mark Out will reflect the timecode you entered in the field.
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Setting the Follow Behavior for Clips in the Playlist

This topic contains information on how to set the “Follow” behavior for clips in the Playlist. 
When selected for a clip or clips, it will automatically play the clip next in the Playlist.

To set the Follow behavior for clips in the Playlist:

t Click the check box in Follow column for the clip you want to have automatically play 
next in the Playlist.

n If the Follow check box is unchecked, the clip will not automatically play. All playout stops, 
and you need to manually restart playout.

t To set the Follow behavior for multiple clips in the Playlist, do the following:

a. Ctrl or Shift-click the clips you want to change the Follow behavior for.

b. Right-click in the Playlist.

c. Do one of the following:

t To enable follow behavior, select Enable Follow from the menu.

t To disable follow behavior, select Disable Follow from the menu.

The selected clips will change their Follow behavior to what was selected. 

n If the Follow check box is selected for these clips, the clip in the Playlist will automatically 
play. 

n If the Follow check box is unchecked, the clip will not automatically play. All playout stops, 
and you need to manually restart playout.

Deleting Clips from the Playlist

This topic contains information on how to delete clips from the Playlist.

To delete clips from the Playlist:

t Click the clip you want to delete, and press the Delete key (or right-click, and select 
Remove Clip from the menu).

All selected clips will be deleted from the Playlist.
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Cueing a Playlist

This topic contains information on how to cue an entire Playlist on the channel.

To cue a Playlist on the channel:

t Select the Playlist you want to load to the channel, and click the Cue button.

The Playlist will automatically be cued to the first clip and loaded on the channel. This 
is indicated by the first clip row appearing highlighted yellow if no clip is highlighted.

Cueing From a Specific Clip in the Playlist

This topic contains information on how to cue a specific clip in the Playlist to the channel.

To cue a specific clip in the Playlist:

1. Select the clip you want to load to highlight it in the Playlist, and do one of the 
following:

t Select the Cue button. 

t Right-click on the highlighted clip in the Playlist, and select Cue from the Cue 
menu.

The selected clip will be cued to the channel. This is indicated by the cued clip row for 
that clip appearing highlighted yelllow.

n If you multi-select a number of clips in the Playlist, the clip with the lowest clip number 
selected will be cued to the channel.

Playing Clips in the Playlist

This topic contains information on how to start playing cued clips in the Playlist.

To play clips in the Playlist:

t Do one of the following:

- Press the [F12] key.

- Press the Play button on the Channel control.

- Press the [Spacebar].

The clip that is cued in the Playlist will begin playing (the clip row will have a green 
background), and the next playable clip in the Playlist will be cued.

n If you are already playing a clip, and want to play the next one, press F12. The currently 
playing clip will eject and the cued clip will begin to play. Pressing the Play button will have 
no effect if the clip is already playing.
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Pausing Clips in the Playlist

This topic contains information on how to pause currently playing clips in the Playlist.

To pause currently playing clips in the Playlist:

t Do one of the following:

- Press the Pause button on the Channel control.

- Press the [Spacebar].

The clip that is played in the Playlist will be paused. Press the Play button or the 
Spacebar to resume playing the clip.

Stopping and Unloading Clips in the Playlist

This topic contains information on how to stop and unload currently playing clips from the 
Playlist.

To stop and unload currently playing clips from the Playlist:

t Do one of the following:

- Press the Stop button on the Channel control.

- Press the E key.

The currently playing clip will be stopped and ejected from the channel, and any clip 
that is cued will uncue.

Performing an Edit While Capture (EWC) with Drag and Drop

If you are in a Team configuration, you can use the Edit While Capture with Drag and Drop 
workflow to edit in-progress clips as they are being recorded via the AirSpeed Multi Stream 
Remote Console Standalone. The clips will also be transferred into the shared storage 
location configured in the Avid Service Configuration.

n This workflow can only be used with ISIS 5000 or ISIS 7000 shared storage. MediaNetwork 
is not supported.

Before you can perform an Edit While Capture, your system must have been set up using a 
Team Configuration (standalone Transfer Manager with Shared storage).

To perform an Edit While Capture (EWC) with drag and drop:

1. From the AirSpeed Multi Stream Remote Console, start a Record. For more 
information, see “Recording Clips” on page 305.
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2. Once the recording has begun, drag and drop the in-progress recording from the 
AirSpeed Multi Stream Remote Console into an Editor bin.

You will be asked if you want to transfer Now or Later.

3. Select Now. 

The media appears online about 45 seconds after the transfer is started, and you can start 
editing the clip.

n There is a possibility that the clip drag and dropped to your bin will remain in-progress well 
after the clip has completed transferring. In this case, you should navigate to the location 
specified on the Default Templates tab under the Master clip location drop down 
(\\<SystemDirector>\<Workspace>\Avid Masterclips) and import the .AAF file of the clip 
being transferred.  This clip will most likely be noted as <ClipName>_1.aaf in the folder.  
Importing this file will close out the in-progress clip in the bin.

n This behavior might occur in the event that the editor is constantly playing while a transfer 
to the bin is taking place. The editor consumes all necessary resources to achieve playback 
of all frames, which may prevent the bin from being updated upon completion of playback.

n Clips edited while in this in-progress state may encounter issues when being exported.  It is 
required that if you are editing with an in-progress clip, and plan to export the composition, 
that you consolidate the clip before the export is performed.

Performing an Edit While Capture (EWC) with Auto Transfer

If you are in a Team configuration, you can use the Edit While Capture with Auto Transfer 
workflow to enable the AirSpeed Multi Stream server to capture directly to your shared 
storage workspace location configured in the Avid Service Configuration. The metadata for 
these clips will also be transferred to the location defined in the Master clip location 
(Standalone) field in the Avid Service Configuration.

n This workflow can only be used with ISIS 5000 or ISIS 7000 shared storage. MediaNetwork 
is not supported.

Before you can perform an EWC with Auto Transfer, make sure that your system has been 
set up using the Team Configuration (standalone Transfer Manager with Shared storage). 

Also, on the Default Templates tab in the Avid Service Configuration, make sure of the 
following:

• In the “Ingest transfer workspace/project based on” field, make sure that the Destination 
template that is selected includes the workspace that you want to transfer the media to.

• In the Master Clip Location (Standalone) field, select the ISIS workspace for which you 
want the AAF file to be transferred to.
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n It is recommended that the location you select for the master clip location matches the 
location you selected in the Workspace field of the Destination Templates tab of the Avid 
Service Configuration.

To perform an Edit While Capture (EWC) with auto transfer:

1. From the AirSpeed Multi Stream Remote Console, start a Record. For more 
information, see “Recording Clips” on page 305.

2. Do one of the following to locate your clip:

t From Windows Explorer, locate the clip(s) you want to EWC, then drag/drop the 
.AAF file into the Avid editor bin. 

The clip will be imported and an in-progress clip will appear in the Avid editor bin. 
For more information, see Step 4, then continue this procedure on Step 5.

t From the Avid Editor, select File > Import.

The Select Files to Import dialog box opens.
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3. Navigate to the location that is specified in the Master Clip Location (Standalone) field 
in the Default Template tab of the Avid Service Configuration.

4. Highlight the .AAF file of the clip that you started to record, and click Open.

The .AAF file will be imported, and an in-progress clip will appear in the Avid editor 
bin.

n Clips edited while in this in-progress state may encounter issues when being exported.  It is 
required that if you are editing with an in-progress clip, and plan to export the composition, 
that you consolidate the clip before the export is performed.

n Any duration changes to be longer than it was initially, captures stopped short, and so on, 
will need to be reimported to close them out.

n If you are performing a Crash Record, make sure that you update the clip every hour to get 
the updated clip duration.

n When clips are deleted from the Editor bin, the media will also be deleted. However, the 
metadata (.AAF file) used to import the clip will remain. For best results, the .AAF files need 
to be manually managed on a regular basis.

5. When the capture completes, select File > Import (or right-click Import in the Avid 
editor bin).

6. Select the .AAF file again, and click Open to complete the master clip.

The completed master clip appears as follows:
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Keyboard Shortcuts

The AirSpeed Multi Stream Remote Console contains keyboard shortcuts to help you 
perform certain tasks quickly. Some of these keys can be used in combination with the use of 
a mouse. 

The following types of keyboard shortcuts are available:

• Inventory Pane Keyboard Shortcuts

• Channel Keyboard Shortcuts

• Playlist Keyboard Shortcuts

Inventory Pane Keyboard Shortcuts

The following table describes the keyboard shortcuts that can be used when focus is on the 
Inventory pane.

Action Keyboard Shortcut

Select an AirSpeed Multi 
Stream server that is already 
loaded

Press the Ctrl + 1-9 keys, where 1-9 indicates one of the AirSpeed 
Multi Stream servers that is currently loaded.

Delete a clip Press the Delete key.

Load a clip into channel Click on the clip in the Inventory pane to highlight it, then drag and 
drop into the channel.

Move down one clip Press the Down arrow key.

Move up one clip Press the Up arrow key.

Page down Inventory list Press the Page Dn key.

Page up Inventory list Press the Page Up key.

Go to the bottom of the 
Inventory list

Press the Ctrl + End keys.

Go to the top of the 
Inventory list

Press the Ctrl + Home keys.

Open the Online Help. Press the F1 key.
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Channel Keyboard Shortcuts

The following table describes the available keyboard shortcuts when focus is in the Channels 
pane.

Action Keyboard Shortcut

Select a channel Press the 1-6 keys where 1-6 represent the Channel 
number in the Channels pane. 

Only channels 1-4 are available for SD, and DNxHD 
models.

Play or Pause a clip Press the Spacebar.

Pause Press the K key.

Eject /Stop Press the E key.

Fast forward Press the L key. Press repeatedly to shuttle forward at 
2, 4, 8, and 16 times normal speed.

Fast rewind Press the J key. Press repeatedly to shuttle in reverse 
at 2, 4, 8, and 16 times normal speed.

Step frame forward continually 
(repeated single frame jog)

Press and hold the K key, then press and hold the L 
key.

Step frame reverse continually 
(repeated single frame jog)

Press and hold the K key, then press and hold the J 
key.

Step forward one frame at a time Press the K key, then press the L key.

Step in reverse one frame at a time Press the K key, then press the J key.

Go to the In point of the clip Press the Alt + I key.

Go to the Out point of the clip Press the Alt + O key.

Set an In point for the clip Press the I key.

Set an Out point for the clip Press the O key.

Clear the In point for the clip Press the D key.

Clear the Out point for the clip Press the F key.

Clear both the In and Out points for the 
clip

Press the G key.

Perform a Take Press the F12 key.
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Playlist Keyboard Shortcuts

The following table describes the available keyboard shortcuts when focus is in the Playlist.

Precue a clip for Record Press the Ctrl + Enter keys. For more information, see 
“Cueing Clips for Record” on page 305.

Open the Online Help. Press the F1 key.

Action Keyboard Shortcut

Action Keyboard Shortcut

Play a clip Press the Spacebar or L key.

Pause a clip Press the Spacebar or K key.

Stop and Eject a clip Press the E key.

Perform a Take Press the F12 key.

Open the Online Help. Press the F1 key.
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11 Maintaining Your AirSpeed Multi 
Stream

This chapter contains information on how to maintain your AirSpeed Multi Stream system, 
including information on how to create a drive image, restore a drive image, rebuild a 
database, and replace a hard drive should one fail. This chapter includes the following 
sections:

• Copying and Restoring Databases

• Reimaging Your System

• Rebuilding a Database

• Identifying Bad Media Drives

• Replacing Media Drives

• Viewing System Health Status Information

• Accessing the Knowledge Base

Copying and Restoring Databases

As a preventative maintenance task, it is a good idea to occasionally copy database structures 
to an external media drive or network share. Then, if a media drive goes down or becomes 
corrupted, you will have a recent backup that you can restore to your AirSpeed Multi Stream 
server once you replace the failed drive. 

This topic provides information on how to copy and restore the database structures from the 
E: drive of your AirSpeed Multi Stream server. Once you have a database structure copied 
and stored externally on a network share or external media drive, you can replace the failed 
drive or reimage your server, and then copy it back to a new drive on your AirSpeed Multi 
Stream server.

To copy and restore databases on your AirSpeed Multi Stream server:

1. Navigate to the E:\ drive and locate the database that you want to copy.

2. Copy the entire database folder from the E: drive to another location not on the 
AirSpeed Multi Stream Server (such as a network share, or external media drive).
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3. After the disk is replaced or the system is reimaged, copy the database folder back to the 
E: drive.

4. Open the AirSpeed Multi Stream application, and select File > Open.

5. Navigate to the folder containing the database (E:\ database name.pff), and select the 
database .pff file.

The database opens.

6. Set the database to be the default database.

7. Restart the AirSpeed Multi Stream application.

Reimaging Your System

This topic provides information on how to use the USB Flash Drive (UFD) provided to 
install a factory operating system (OS) image in the event of a catastrophic failure, or as 
directed by Avid Customer Support. After performing this procedure, the system will have a 
factory OS. You will need to install the AirSpeed Multi Stream application, and reconfigure 
the software settings.
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Checklist for Reimaging Your System

The following table provides a checklist of tasks that must be performed when reimaging 
your AirSpeed Multi Stream system. Some of the tasks are contained in this chapter, while 
others are contained in other chapters of this guide. 

n Follow this checklist and the procedures closely to ensure a successful reimage.

Save your settings, as described in the topic “Saving and Restoring Your Settings” on page 
330 of this guide.

Load the Windows XPE Restore image, as described in the topic “Loading the Windows 
XPE Restore Image” on page 332 of this guide.

Set up your AirSpeed Multi Stream system, as described in the topic “Setting Up Your 
System” on page 85.

Setting up your system involves the following:

• Changing the computer name

• Adjusting the date, time and time zone

• Re-configuring your media drives for RAID 0 striping within Windows (This procedure 
is different than the procedure for clean systems that have never been configured for 
RAID 0 striping within Windows)

• Verifying your network connection

• (Optional) Creating a Windows User account

• Configuring your shared storage

• Setting up remote access to the AirSpeed Multi Stream server

Install the Interplay Framework Workstation as described in the topic “Installing the Avid 
Service Framework” on page 334.

This must be done before installing the AirSpeed Multi Stream application.

IMPORTANT: Before creating a new database in AirSpeed Multi Stream, make sure you 
delete all old databases from the AirSpeed Multi Stream.

Install the AirSpeed Multi Stream application as described in the topic “Installing AirSpeed 
Multi Stream Application Software” on page 335.

IMPORTANT: When you are done installing the AirSpeed Multi Stream application, a 
dialog box opens, asking if you want to reboot your system. Do the following: 

• Make sure all other applications are closed, and then click Yes.

If outdated, or not in sync, the BIC and HUB will automatically be updated when the 
AirSpeed Multi Stream application is launched.
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Saving and Restoring Your Settings

In the event that you need to reimage your AirSpeed Multi Stream server, you should use the 
AirSpeed Multi Stream Setting Save and Restore Util tool to save and restore the settings on 
your AirSpeed Multi Stream server before you perform the reimage.

Examples of settings that can can saved and restored with this tool are listed below:

• server names

• user names (and passwords)

• database names

• IP addresses

• configuration settings

To save and restore the settings on your AirSpeed Multi Stream server:

1. Navigate to C:\Program Files\Avid\Avid Airspeed Multi Stream and select the 
AsmsSettingsUtil.exe. 

n You can also download the System Settings Recovery tool on the Avid Download Center.

2. Launch the AirSpeed Multi Stream Settings Save and Restore Util tool.

The AirSpeed Multi Stream Save and Restore Util dialog box opens.

(Option) For DNxHD model systems, you can launch the Disk Configuration tool to 
optimize the performance of your AirSpeed Multi Stream server when working with high 
bitrate formats, such as two streams of DNxHD 120/145, as described in the topic “Using 
the Disk Configuration Tool” on page 338. 

Perform General Configuration procedures, as described in the chapter “General 
Configuration Procedures” on page 95. 

Configure your AirSpeed Multi Stream, based on the configuration that you want to use for 
your site. 

• For information on configuring your system in a Workgroup environment, see 
“Configuring the Software in a Workgroup Environment” on page 99.

• For information on configuring your system with a Standalone Transfer Manager, see 
“Configuring the Software with a Standalone Transfer Manager” on page 155.

• For information on configuring your system in a Team configuration, see “Setting Up 
for Team Configuration” on page 179.

Rebuild your database as described in the topic “Rebuilding a Database” on page 340.
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3. Click the Save option, and click Next. 

The Browse for Folder dialog box opens.

4. Navigate to the location where you want to save your settings, such as to a Universal 
Flash Device (UFD).

5. Click OK. A dialog box opens asking if you want to save the settings to the selected 
folder. 

6. Click Yes to save the settings to the Univseral Flash Device (UFD) in the location 
specified.

Your settings are now saved. click OK to confirm and close the dialog box.

7. Re-image your AirSpeed Multi-Stream server.

For more information, see “Reimaging Your System” on page 328.

8.  After re-imaging, do the following:

a. Right-click on My Computer and click on Manage.

b. Under Storage, click on Disk Management.

c. Right-click on a foreign disk in the right pane and select Import Foreign Disks….

d. Click through the OK dialog boxes.

9. Launch the System Settings Recovery tool again and restore the data that was previously 
saved.

10. Click the Restore option, and click Next. 

The Browse for Folder dialog box opens.

11. Navigate to the location where you saved your settings, such as the Universal Flash 
Device (UFD) that includes the compressed system settings file.

12. Select the compressed settings file, and click OK.

Your settings will be restored, and you will be prompted to reboot your system.

13. Reboot the AirSpeed Multi Stream server.

14. Reinstall your software components (such as Storage client software, Interplay 
Framework software, AirSpeed Multi Stream application software, and so on) on your 
server.
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Loading the Windows XPE Restore Image

This topic contains information on how to load a Windows XP Embedded (XPE) restore 
image on your AirSpeed Multi Stream system.

To load the Windows XPE Restore image:

1. Unlatch, (but do not remove) the four media drives from the chassis.

2. Insert the USB Flash Drive (UFD) into one of the USB ports on the back of the 
AirSpeed Multi Stream system.

3. Restart the AirSpeed Multi Stream.

The system will begin to start up.

4. When prompted, press F2 during startup to enter the system BIOS.

The BIOS setting menu opens.

5. Navigate to the Hard Drive BBS Priorities menu, and press Enter. Do the following:

a. Highlight Boot Option # 1 (SATA: Name of your hard drive).

b. Change it to the UFD (such as KingstonDataTraveler), and press Enter.

c. Highlight Boot Option # 2.

d. Change it to SATA: Name of your hard drive, and press Enter.

e. Press ESC to exit the BBS Priorities Menu.

6. Ensure that the Boot Options Priorities menu shows the following:

t Boot Option #1 displays the UFD that you changed to on the Hard Drive BBS 
Priorities menu.

t Boot Option #2 displays the SATA drive that you changed to on the Hard Drive 
BBS Priorities menu.

7. Press F4.

The Save & Exit Setup dialog box opens.

8. With Yes selected, press Enter to save your configuration settings, and boot the system. 

9. When the Restore Menu opens, in the Enter a choice? field, type 2 to recover both the C: 
and D: partitions (the entire system disk), and press Enter.

10. Type Y to confirm your changes.

The Symantec Ghost opens. When it is finished, you will get a message in the Recovery 
Complete dialog box saying “Drive Image Completed Successfully.”
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11. Press and hold the Power button on the front on the AirSpeed Multi Stream to turn it off.

n If the AirSpeed Multi Stream does not shut off when pressing the Power button, unplug the 
power supply to the AirSpeed Multi Stream. Make sure it powers down, and then plug it back 
in.

12.  Unplug the UFD device from the USB port.

n If any device, including the UFD, is left plugged in, the drive-lettering script could fail.

13. Re-insert the four media drives into the AirSpeed Multi Stream chassis.

14. Press the Power button again to restore power to the AirSpeed Multi Stream.

The system will begin to startup.

n If the System Settings Change dialog box opens, it might be because of the USB device that 
was plugged in. Click No to close the dialog box.

15. Right-click on My Computer, and select Manage

16. In the left pane, select Disk Management.

Disks 1-4 will appear in the right pane as Foreign disks.

17. Right-click on any foreign disk, and select Import Foreign Disks...

A message appears asking if you are sure you want to import foreign disks.

18. Click Yes on any Confirmation dialog boxes that appear. The drives will display the 
following information:

Your WINDOWS_MEDIA_RAID (E;) dirve will be available with media and databases 
intact.

19. The next step is to set up your system. This is described in the topic “Setting Up Your 
System” on page 85.
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Installing the Avid Service Framework

This topic describes how to install the Avid Service Framework on the AirSpeed Multi 
Stream server.

n The Avid Service Framework must be installed before the AirSpeed Multi Stream application 
software is installed.

This installation procedure also installs the following components on the AirSpeed Multi 
Stream server:

• Avid Diagnostics

• Avid Health Monitor

• Avid Service Configuration

• Avid Workgroup Properties

n  Regardless of whether the AirSpeed Multi Stream is a capture and/or playback server, 
ensure it is in the Interplay workgroup. If it is a playback server that will be controlled by 
iNEWS Command, it must be configured to join a second workgroup—the same workgroup 
as the Command Servers.

n The AirSpeed Multi Stream device service can be configured to be controlled by up to two 
Command systems.

Although there are no specific changes you need to make to the Avid Service Framework for 
AirSpeed Multi Stream, if you want more information on configuring the Avid Service 
Framework settings, see “Configuring Workstation Settings” in the Avid Service Framework 
User’s Guide.

To install the Avid Service Framework on the AirSpeed Multi Stream server:

1. Navigate to the Avid_Framework_Workstation folder in the AirSpeed Multi Stream 
installation location for your site.

2. Double-click the Setup.exe to launch the installer. You will be asked if you want to run 
this program.

3. Click Run.

The InstallShield Wizard opens to guide you through the rest of the installation process.

4. Click Next. 

The Workgroup Name dialog box opens.
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5. Type the name of your Workgroup in the field, and click Next.

n You can either create a new workgroup or join an existing one. If you are creating a new 
workgroup, make a note regarding the workgroup name so that it can be entered during 
other Avid Service Framework installations. You must use the same workgroup name on all 
Interplay clients that are connected in your network. The workgroup name is case sensitive.

The Custom Setup dialog box opens.

6. Click Next.

7. Click Install.

8. Click Finish.

9. Determine whether the AirSpeed Multi Stream software is pre-installed on your system 
or not. If the Avid AirSpeed Multi Stream software is:

t Pre-installed on your system, go to the next step.

t Not pre-installed on your system, you can now install the AirSpeed Multi Stream 
application software. For more information, see “Installing AirSpeed Multi Stream 
Application Software” on page 335.

10. Determine whether your site is using Avid iNEWS Command, CaptureManager, or 
Interplay Capture for capture or playout. If your site is:

t Using Avid iNEWS Command, Avid CaptureManager, Interplay Capture to control 
AirSpeed Multi Stream channels for capture or playout, you must install the 
AirSpeed Multi Stream Device Service. For more information, see “(Option) 
Installing the AirSpeed Multi Stream Device Service” on page 104.

t Not using Command, CaptureManager, or Interplay Capture to control AirSpeed 
Multi Stream channels for Playout, you are ready to configure your AirSpeed Multi 
Stream. For more information, see “Configuring the Software in a Workgroup 
Environment” on page 99.

Installing AirSpeed Multi Stream Application Software

This topic shows how to install the AirSpeed Multi Stream application software on the 
AirSpeed Multi Stream server.

n If your system has been pre-loaded with the AirSpeed Multi Stream software, you do not 
need to install it again at this time. You must perform this procedure only if you are 
upgrading your software.

This installation procedure also installs the AirSpeed Multi Stream Integration Service on 
the AirSpeed Multi Stream server.
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To install the AirSpeed Multi Stream application software:

1. Navigate to the Avid_AirSpeed Multi Stream folder in the AirSpeed Multi Stream 
Installation location for your site.

2. Double-click AvidAirSpeedMultiStreamSetup.exe. 

You will be asked if you want to run this program.

3. Click Run.

The InstallShield Wizard opens to guide you through the rest of the installation process.

4. Click Install.

The Preparing to install dialog box opens and installs the necessary components. AFAP 
installation will reboot the system. 

The Welcome to InstallShield Wizard dialog box opens.

5. Click Next. 

The License Agreement dialog box opens.
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6. Select your language from the Select License Language list.

The default language is English. 

n If you want to view a copy of the EULA License in all languages,the License file is located 
on your system. Navigate to C:\Program Files\Avid\Avid AirSpeed Multi 
Stream\Licenses\Avid, and select the PDF or RTF License file.

7. Accept the terms of the license agreement, and click Next. 

The Destination Folder dialog box opens.

8. Accept the default location, and click Next. 

9. Click Install.

10. Click Finish. 

A message box opens telling you to restart your system.

11. Click Yes to restart your system. 

When your system restarts, the AirSpeed Multi Stream application will update the HUB 
and other hardware components.

n Sony firmware updates might take up to 10 minutes. When updating the FPGAs, the system 
might reboot multiple times.

When it is done, it will automatically reboot the system. 

12. (Option) If you are using Avid iNEWS Command or Avid CaptureManager to control 
AirSpeed Multi Stream channels for capture or playout, you must install the AirSpeed 
Multi Stream Device Service. For more information, see “(Option) Installing the 
AirSpeed Multi Stream Device Service” on page 104.

If you are not using Command or CaptureManager to control AirSpeed Multi Stream 
channels for Playout, you are ready to configure your AirSpeed Multi Stream. For more 
information, see the appropriate chapter depending on your configuration. 

- For information on setting up in a Workgroup environment, see “Configuring the 
Software in a Workgroup Environment” on page 99.

- For information on setting up in a Standalone Transfer Manager environment, see 
“Configuring the Software with a Standalone Transfer Manager” on page 155.

- For information on setting up in a Team environment, see “Setting Up for Team 
Configuration” on page 179.
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Using the Disk Configuration Tool

In version AirSpeed Multi Stream v1.8.1 and later, you can use the Disk Configuration tool 
to optimize the performance of your AirSpeed Multi Stream server when working with high 
bitrate formats, such as two streams of DNxHD 120/145. Once optimized in this 
configuration, we support the following for the DNxHD 120/145 format:

• Up to two ingests

• One Play While Record 

• Up to two Play While Transfers (PWTs)

n In the DNxHD High Performance Configuration, Play While Transfers (PWTs) always 
receive priorty in the cue. This causes other non-PWTs to pause. Also, if more than two (2) 
PWTs are sent, the additional PWTs will remain in a pending state until one of the original 
PWTs completes.

This behavior only occurs for the DNxHD 120/145 format, and only if you use the Disk 
Configuration tool to optimize your system performance.

c Performing this procedure destroys all media and databases on your media drives. To 
reconfigure your system, you must create a new database, and confirm that your E: 
drive is shared, if it had been previously shared. 

For more information, see “Creating a New Database in the AirSpeed Multi Stream 
Application” on page 100.

If you were configured with a Standalone Transfer Manager and local storage, and your E: 
drive was previously shared with full control, you need to reshare your E: drive. For more 
information, see “(Option) Sharing the E: Drive on the AirSpeed Multi Stream Server” on 
page 100.

n You must install AirSpeed Multi Stream v1.8.1 before you perform this procedure.

n This tool does not increase performance for DNxHD models using DNxHD 185/220 formats.

For more information on AirSpeed Multi Stream performance, see the latest AirSpeed Multi 
Stream Performance Guidelines document on the Avid Knowledge Base.
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To use the Disk Configuration tool for AirSpeed Multi Stream:

1.  Shut down the AirSpeed Multi Stream Application Monitor. 

This also shuts down the Transfer Manager, as well as the AirSpeed Multi Stream 
application.

2.  To locate the AirSpeed Multi Stream Disk Configuration tool, do the following: 

a. Navigate to the C:\Program Files\Avid\Avid AirSpeed Multi Stream folder.

b. Double-click the DiskConfigurationTool.exe.

The AirSpeed Multi Stream Disk Configuration tool dialog box opens.

3. Review the information in the Current Settings section of the dialog box.
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4.  Do one of the following:

t If your system is configured for Default bitrate, indicated by a Partition Type of 
“Full”, and a AFAP Settings Bandwidth of 95000, and you want to optimize your 
system settings for DNxHD 120/145, select the High Bitrate Configuration 
option.

n The Selected Settings section of the dialog box will display the Partition Type as “Half” and 
the AFAP Bandwidth settings as 110000. The Apply button becomes available.

t If your system has previously been configured for high bitrate, indicated by a 
Partition Type of “Half”, and an AFAP Settings Bandwidth of 110000, and you 
want to return to the default settings, select the Default Bitrate Configuration 
option.

n The Selected Settings section of the dialog box will display the Partition Type as “Full” and 
the AFAP Bandwidth settings as 95000. The Apply button becomes available.

5. Click the Apply button.

A message box opens, warning you that this operation will delete all the data on your 
media disk.

6. Click Yes if to continue.

n The Progress bar will keep you informed of the configuration status as the process 
completes.

Finally, when the configuration process is done, a message box opens, asking if you 
want to restart your system.

7. Click Yes to restart your system.

The AirSpeed Multi Stream server will shutdown and restart.

8. Next, you must create a new database. For more information, see “Creating a New 
Database in the AirSpeed Multi Stream Application” on page 100.

Rebuilding a Database

This procedure contains information on how to rebuild a database. The rebuild database 
process attempts to repair damaged database structures. The rebuild of a database involves 
several phases. Before you rebuild a network database, make sure that it is not in use by 
somebody else. 

n This function cannot repair clips.
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n Right-click on the Network Tree to remove all locks before rebuilding.

The Rebuild Database Options dialog box is accessed by selecting File > Advanced > 
Rebuild Database. A warning message appears. Click OK. Following is an example of the 
Rebuild Database Options dialog box.

The check boxes are used to set parameters that affect how the rebuild is performed. Notice 
that the Database - Recreate, and Headframes - Create if Missing check boxes are 
preselected by default. As a general rule, each check box that is selected slows down the 
rebuild, but the rebuild will be more thorough. The choices are described in the following 
table.

Rebuild Database Options

Option Description

Icons (low Res)

- Create if Missing This check box is not for Customer use. Checking this box could 
result in media loss.

- Check Integrity This check box is not for Customer use. Checking this box could 
result in media loss.

- Delete Orphans This check box is not for Customer use. Checking this box could 
result in media loss.

Database

- Recreate If this option is checked, it recreates the database itself. If it is not 
checked, the database files themselves are left alone.
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To rebuild a database:

1. Select File > Advanced > Rebuild Database.

A warning message opens. Click OK to close it.

2. Verify that the Database - Recreate, and Headframes - Create if Missing options are 
selected. Currently, no other options are supported or recommended for customer use.

3. Click the Rebuild button. 

This process takes about 13 minutes to rebuild a database with 1000 clips.

- Reindex Only Quickly repairs a damaged database without looking at the 
index files. If this is checked, the database files are reindexed and 
none of the other files are looked at. If this is checked, the database 
cleans itself up. This is a very fast process. 

- Add if Missing This check box is not for Customer use. Checking this box could 
result in media loss.

Essence Files

- Check Integrity This check box is not for Customer use. Checking this box could 
result in media loss.

- Delete Orphans This check box is not for Customer use. Checking this box could 
result in media loss.

If this option is checked, it checks each .tmf (clip essence) file for 
damage and deletes any orphaned .tmf files. It is somewhat 
dangerous to perform this function.

Headframes

- Create if Missing If this option is checked, it scans the database files, and creates 
missing headframes by recreating any missing .g files.

- Check Integrity This check box is not for Customer use. Checking this box could 
result in media loss.

- Delete Orphans This check box is not for Customer use. Checking this box could 
result in media loss.

If this option is checked, it deletes all headframe orphans for clips 
that have been deleted, and removes any .g (headframe) files that 
do not have a corresponding .tmf file.

Rebuild Database Options

Option Description
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n If the database you want to rebuild is in use by other workstations, the Database in Use 
dialog box will appear. All connected workstations must be disconnected before you can 
apply rebuilding functions.

Identifying Bad Media Drives

This topic shows how to identify bad media drives on your AirSpeed Multi Stream server. 

n A bad drive is any media disk that cannot be recognized by Windows.

To identify a bad media drive on your AirSpeed Multi Stream server:

1. Start the Marvell  Raid Utility by selecting Start > Programs > Marvel RAID Utility.

The Marvel RAID Utility dialog box opens to the Login screen.
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2.  Login to the tool as follows:

a. In the Username field, type administrator.

b. Leave the Password field blank.

c. Click the Login button.

The Marvel RAID Utility opens.

3. Select the Topology menu.

Information from the Topology menu indicates which physical drive (or disk) is bad.

For example, in the following dialog box example, out of the four drives, Physical Disk 
[1] (PHY [1]) is not shown, so that means that Media Disk 1 is bad.
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4. Determine which Media disk is the bad drive by looking at the front of your AirSpeed 
Multi Stream server.

n In the AirSpeed Multi Stream servers, drives are numbered 0-3 from left to right. Therefore, 
as the following diagram shows, when looking at the front of the AirSpeed Multi Stream 
server, Disk 0 is the left most disk drive, and Disk 3 is the right most disk drive.

5. Once you have determined which physical media disk is bad, you can now replace the 
bad disk drive with a new disk drive.

In the event that one or more of your media drives needs to be replaced, you must obtain 
replacement drives and install them in your AirSpeed Multi Stream. Once installed, you 
need to re-configure your media drives for RAID 0 striping within Windows.

For more information, see the topic “Configuring Media Drives for RAID 0 Striping” on 
page 88.

Replacing Media Drives

In the event that one or more of your media drives needs to be replaced, you must obtain 
replacement drives and install them in your AirSpeed Multi Stream. Once installed, you 
need to re-configure your media drives for RAID 0 striping within Windows.

For more information, see the topic “Configuring Media Drives for RAID 0 Striping” on 
page 88.

Windows XPe Security Update Information

Avid qualifies security updates for Microsoft operating systems in coordination with the 
Microsoft monthly security bulletins. For more information regarding this process and the 
patches qualified for your Avid product, please go to the following link:

http://avid.com/securityupdate

NETTMPSAPS

LTC REF ACT WNK

500 500 500 500

Disk 0 Disk 1 Disk 2 Disk 3
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Viewing System Health Status Information

In the event that you have any issues or failures with the AirSpeed Multi Stream server, use 
the Avid Health Monitor to view system health status information. The Avid Health Monitor 
is a good tool to have online when you contact Avid Technical Support.

To access the Avid Health Monitor:

1. Select Start > All Programs > Avid > Avid Service Framework > Avid Health Monitor.

The Avid Health Monitor dialog box opens.

2. In the Hosts column, select the AirSpeed Multi Stream that is in question (has issues).

3. In the left pane for the selected AirSpeed Multi Stream, click the service you want to 
review. Options are: 

t Integration Service

t Avid Workstation Service

t Device Service (Optional)

t TransferManager (this service might not be listed if the TM server is down)

Information for the selected service populates in the right pane of the dialog box.

4. Click the down arrow next to the failed component (marked with a red X) for the 
selected service.

For more information on using the Avid Health Monitor, see the Avid Service 
Framework User’s Guide.

Accessing the Knowledge Base

The Avid Customer Support Knowledge Base (Knowledge Base) provides additional 
information that is frequently updated. 

n Some locations on the Knowledge Base require you to log in as a registered user, but you can 
access most of the information in the Knowledge Base without registering and logging in.

To access the Knowledge Base:

1. Go to www.avid.com.

2. Click Service & Support

3. Click Knowledge Base.

4. (Option) Click Login.

http://www.avid.com
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n If you are not already a registered user of the Knowledge Base, click Register and follow the 
on-screen registration instructions to register now. Registered users can access more 
information.

5. Search for the information you need.
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A Specifications

This appendix provides a detailed listing of all technical system specifications and connector 
pinouts for all AirSpeed Multi Stream models. Models names are provided when there are 
differences in specifications based on model. The following topics are discussed:

• Physical Specifications

• Audio Specifications

• Video Specifications

• Control and Synchronization Specifications

• Data Specifications

• Rear Panel Specifications

• Connector Pinouts and Connections

n All specifications are subject to change without notice.

Physical Specifications
This section describes the physical specifications of the AirSpeed Multi Stream chassis.

Physical Specifications  

Parameter Specification

Dimensions inches: 19.00 (w) x 2.6 (h) x 28.5 (d)
cm: 48.3 (w) x 6.6 (h) x 72.4 (d) 

Rack Units 1.5

Weight pounds: 48 
kilograms: 21.8
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Power and Environment Requirements
This section describes the power and environment requirements of the AirSpeed Multi 
Stream chassis.

Audio Specifications
This section describes the audio specifications of the AirSpeed Multi Stream chassis.

Power and Environment Requirements  

Parameter Specification

Power 100 to 240 Vac, 50/60 Hz Auto Ranging, 780 Watts

Environmental • Operating Temperature is 5°C to 40°C

• Operating Humidity is 5% to 85% RH non-condensing

• Storage Temperature is -40°C to +70°C

• Storage Humidity is 95% Max, non-condensing

Audio Specifications

Parameter Specification

Channels For SD SDI, we support 8 channels (per stream) of embedded 
audio.

For HD SDI, we support 16 channels (per stream) of embedded 
audio. 

Proxy Audio                                      A maximum of two streams of proxy audio is supported.

                   Sampling 48 KHz, 16 or 24 bit precision

                   AC-3 Fully compatible with professional and consumer encoding
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Video Specifications
This section describes the video specifications of the AirSpeed Multi Stream chassis.

Video Specifications  

Parameter Specification

Video Channels (For SD models) Up to 2 Record or 4 Play Channels

(For MPEG-2 HD models) Up to 4 Record or 4 simultaneous Play 
Channels

(For DNxHD models) Up to 2 Record or 2 Play Channels

(For AVC-Intra models) Up to 4 Record or 4 Play Channels

4 SDI Input, 8 SDI outputs ITU-R BT.-601 and ITU-R BT.-709 10 bit Serial Digital 

Video Input (For SD models) 2 SDI (serial digital interface — SMPTE 259M)

(For MPEG-2 HD models) 4 SDI (serial digital interface — SMPTE 
259M, SMPTE 292M, SMPTE 295M, SMPTE 296M)

(For DNxHD models) 2 SDI (serial digital interface — SMPTE 259M, 
SMPTE 292M, SMPTE 295M, SMPTE 296M)

(For AVC-Intra models) 4 SDI (serial digital interface — SMPTE 
259M, SMPTE 292M, SMPTE 295M, SMPTE 296M)

Video Outputs (For SD models) 4 SDI (serial digital interface — SMPTE 259M)

(For MPEG-2 HD models) 6 SDI (serial digital interface — SMPTE 
259M, SMPTE 292M, SMPTE 295M, SMPTE 296M)

(For DNxHD models) 4 SDI (serial digital interface — SMPTE 259M, 
SMPTE 292M, SMPTE 295M, SMPTE 296M)

(For AVC-Intra models) 4 SDI (serial digital interface — SMPTE 
259M, SMPTE 292M, SMPTE 295M, SMPTE 296M)
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Control and Synchronization Specifications
This section describes the control and synchronization specifications of the AirSpeed Multi 
Stream chassis.

Video Compression • DV25

• DV50

• IMX30

• IMX50

• HDV25mb

• MPEG-2-HD 35mb 1080i

• MPEG-2-HD 17.5mb 1080i

• MPEG-2-HD 35mb 1080i

• MPEG-2-HD 50mb 1080i

• MPEG-2-HD 50mb 720p

• MPEG-2 HD 35mb 720p

• DNxHD 120/145 8-bit 1080i

• DNxHD 120/145 8-bit 720p

• DNxHD 185/220 10-bit 1080i

• DNxHD 185/220 10-bit 720p

• AVC-Intra 50mb 1080i

• AVC-Intra 50mb 720p

• AVC-Intra 100mb 1080i

• AVC-Intra 100mb 720p

Video Specifications (Continued)  

Parameter Specification

Control and Synchronization Specifications

Parameter Specification

External Control RS-422 control for each play using VDCP and Sony BVW Extensions, 
We also support an Avid external Application Program Interface (AMS 
API).
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Manual Control Graphical user interface provides basic Record, Play, trimming, and 
configuration capabilities

Timecode Linear Timecode SMPTE 12M Single Ended I/O.

With regards to the use of LTC, we are compliant with SMPTE 12m. 
Here are some specifics:

• 9.6.4 Interface connector (Informative) - The preferred connector for 
double-ended or balanced outputs is a 3-pin XLR (MALE) and for 
inputs a 3-pin XLR (FEMALE). Pin 1 is chassis ground, pins 2 and 3 
carry the double-ended or balanced signals. The preferred connector 
for single-ended or unbalanced outputs or inputs is a BNC 
(FEMALE).

• 9.6.5 Output impedance - The output impedance of a single-ended, 
balanced or unbalanced source shall be no greater than 50 ohms. The 
output impedance of a double-ended output shall be no greater than 
25 ohms for each output side.

• 9.6.6 Output amplitude (Informative) - The preferred output 
amplitude is between 1 V and 2 V peak-to-peak. The allowable 
range of amplitudes is 0.5 V to 4.5 V peak-to-peak.

Vertical Interval Timecode, SMPTE 266 Compatible with Input and 
Output Line Selections.

Reference Analog black burst/tri-level reference, looping input

Internal Time Derived from LTC single ended SMPTE - 12M reference input

Closed Caption Support recording and playback of NTSC SD line 21 captioning as well 
as EIA/CEA-608 and EIA/CEA-708 ancillary caption data in HD 
formats.

Control and Synchronization Specifications (Continued)

Parameter Specification
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Data Specifications
This section describes the data specifications of the AirSpeed Multi Stream chassis.

Rear Panel Specifications
This section describes the rear panel specifications of the AirSpeed Multi Stream chassis.

Data Specifications  

Parameter Specification

Keyboard/Mouse Port 2 USB 2.0 connector, for USB compatible keyboard and mouse

Ethernet Ports (4) RJ-45 connector, 10BASE-T, 100BASE-T, or 1000BASE-T, auto 
sensing (only 1000BASE-T is qualified to use on AirSpeed Multi 
Stream for Avid Unity network inter-connections)

Rear Panel Specifications  

Parameter Specification

Serial Remotes 1-8 Serial Remotes 1 - 8 are all RJ45 connectors, RS-422

EXPANSION PORTs 1 and 2

(Not for connecting VGA 
monitors)

29-Pin female DVI connectors. Each Expansion port has 4 LTC out 
BNCs (1 per SDI channel) along with a General Purpose I/O Pins 
Connector (DB25). 

LTC (IN/THRU) In: 1 BNC female connector
Loop through: 1 BNC connector

SDI In 2 BNC connectors for SD models

4 BNC connectors for MPEG-2 HD models

2 BNC connectors for DNxHD models

4 BNC connectors for AVC-Intra models

SDI Out 4 BNC connectors for SD models

6 BNC connectors for MPEG-2 HD models

4 BNC connectors for DNxHD models

4 BNC connectors for AVC-Intra models

Reference In 1 BNC connector
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Connector Pinouts and Connections

The following connectors are listed in this section:

• RS-422 Serial Control Mechanism Connections

• RS-422 Serial Remote RJ45 Connector Specifications

• Ethernet Connector Specifications

• Expansion Port Connector Specifications

• LTC Timecode Connector Specifications

• USB 2 Connector Specifications

w In order to ensure emission compliance, all cables attached to connectors on the 
AirSpeed Multi Stream chassis must be fully shielded and properly grounded to the 
connector shell where possible.

Reference Loop through In: 1 BNC connector

Loop through: 1 BNC connector

CONSOLE 1 RS-232 input (Avid use for diagnostic testing only).

VGA 1 VGA input (for a VGA monitor).

Rear Panel Specifications (Continued)  

Parameter Specification
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RS-422 Serial Control Mechanism Connections

Avid uses the industry standard guidelines for the RS-422 connection between capture and 
playout servers and the control mechanism. The maximum cable length is 1200 m (4000 ft) 
based on Baud Rate and a other variables (for example the cable type and electrical noise in 
the environment).

RS-422 Serial Remote RJ45 Connector Specifications

The following table lists RS-422 specifications for the 8 Serial Remote RJ45 connectors on 
the rear panel on the AirSpeed Multi Stream. The column labelled “Automation Controller 
Pin Connections” lists the corresponding communication pin connections for an associated 
automation controller or similar device.

The following diagram shows the serial remote RJ45 connection on the AirSpeed 
Multi Stream:

RS-422 Serial Control Cables

Baud Rate Maximum Cable Length

1200 1200 m (4000 ft)

4800 1200 m (4000 ft)

9600 1200 m (4000 ft)

38400 1200 m (4000 ft)

115200 1000 m (3280 ft)

SERIAL
1 2 3 4 5 6 7 8

All ports are 8 pin RJ45 serial ports
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Sony BVW Extensions

The following commands are implemented in Avid products as extensions to the Sony BVW 
protocol. These protocol extensions provide clip name processing support not covered under 
the Sony BVW specification.

In the event of a transmission error, the listener will respond with a NACK followed by a 
status byte. 

In the event of an extension command failure, the listener will respond with an ACK 
followed by a status byte.

Serial Remote RJ45 Connectors  

Pin #
Pin Connections on 
AirSpeed Multi Stream Automation Controller Pin Connections

1 RS-422 Receive data (RX–) RS-422 Transmit data (TX–)

2 RS-422 Receive data (RX+) RS-422 Transmit data (TX+)

3 RS-232 Receive data (RX) RS-232 Transmit data (TX)

4 RS-422 Transmit data (TX–) RS-422 Receive data (RX-)

5 RS-422 Transmit data (TX+) RS-422 Receive data (RX+)

6 Ground Ground

7 Ground Ground

8 RS-232 Transmit data (TX) RS-232 Receive data (RX)

Supported BVW Extensions

Extension Description

Clip Loading Enabled Clip loading is always enabled in AirSpeed Multi Stream.

Disable Clip Loading The AirSpeed Multi Stream accepts the command, but does nothing in 
AirSpeed Multi Stream since clip loading is always enabled.

Clip Length Request The AirSpeed Multi Stream returns the current Mark In and Mark Out 
set for currently loaded clip.

Clip Length Response The AirSpeed Multi Stream returns the current Mark In and Mark Out 
set for currently loaded clip as in the Clip Length Request.
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Supported Optional VDCP Commands

The following commands are implemented in Avid products for the VDCP protocol. Avid 
supports all required VDCP commands, plus the following optional commands. In addition, 
Avid supports fixed 8 and variable length IDs up to 31 characters.

The AirSpeed Multi Stream responds with an ACK upon successful completion of the 
commands listed in the following table. In the event of a transmission error, the AirSpeed 
Multi Stream responds with a NACK followed by a status byte.

Set Clip Length The AirSpeed Multi Stream sets the Mark In and Mark Out timecodes 
for currently active clip. It does not do any trimming or clip 
modification.

Find First Clip Request The AirSpeed Multi Stream finds the first clip. 

Find Next Clip Request The AirSpeed Multi Stream finds the next clip. 

Find Clip Response The AirSpeed Multi Stream sends a response after finding the clip. 

Load Clip The AirSpeed Multi Stream implements a load clip command. 
(playback function)

New Clip The AirSpeed Multi Stream implements a command to create a new 
clip. (capture function)

Delete Clip The AirSpeed Multi Stream deletes the clip. If the clip is locked, the 
clip will not be deleted. 

Issuing a BVW eject command causes the currently active clip to be 
unloaded.

Supported BVW Extensions (Continued)

Extension Description

Supported Optional VDCP Commands

Command Description

0x.0C - LOCAL DISABLE Not currently implemented. Server returns an ACK.

0x.0D - LOCAL ENABLE Not currently implemented. Server returns an ACK

0x.15 - DELETE PROTECT This command prevents an ID from being deleted by an ID DELETE 
command. An UNPROTECT command must be used to enable 
DELETE ID once the ID is protected. The PROTECT ID command 
has no effect on the ID being played or copied.
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0x.16 - DELETE 
UNPROTECT

This command is the opposite of Protect ID and allows the ID to be 
deleted but does not delete the ID by itself. This command has no 
effect on the ID being played or copied.

1x.04 - STILL/PAUSE The STILL command causes the currently playing ID to pause. The 
last frame played prior to receiving the STILL command will continue 
being displayed. The output port must be in PLAY, or in the CUED

1x.05 - STEP The STEP command causes the currently playing and paused ID in 
STILL state or in a play state to advance to the next frame and STILL. 
The output port must be in a PLAY, CUED, or STILL state or an error 
will be logged. This is equivalent to JOG with +1 data.

1x.06 - CONTINUE The CONTINUE command causes the ID currently in the STILL state 
or a PLAY STATE to exit that state and continue playing. The output 
port must be in a PLAY, CUED, or STILL state or an error will be 
logged.

1x.07 - JOG The JOG command causes the controlled device to move the specified 
number of frames forward orbackward with respect to its current 
position.

1x.08 - VARIABLE PLAY When the VARIABLE PLAY command is received the controlled 
device will start running in accordance with the speed and direction 
data defined in SEND DATA-1, SEND DATA-2, and SEND DATA-3.

2x.1D - RENAME This command renames an ID in the video disk from the Original ID 
to the New ID.

The Original ID will no longer exist once the command is executed. 
Video data does not need to be changed. The disk must put the 
Original ID in the ID’s Delete List, and the New ID in the ID’s Added 
List. It must also set both the ID’s Added and ID’s Deleted in the port 
status data.

2x.1F - NEW COPY This command creates a new ID in the video disk from an existing ID. 
In terms of the AirSpeed Multi Stream, a subclip is created. If the 
original clip is deleted, the subclip will also be deleted.

2x.25 - PLAY CUE WITH 
DATA

This command is similar to the CUE command but allows play out of 
just a part of the ID.

Supported Optional VDCP Commands (Continued)

Command Description
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Ethernet Connector Specifications

The following table lists the 4 Ethernet connectors (RJ-45) specifications on the chassis.

2x.2C - RECORD INIT 
WITH DATA

The RECORD INIT WITH DATA command is similar to the 
RECORD INIT command and allows the setting the timecode of the 
first frame.

It does not support Clip Overwrite.

3x.14 - ID SIZE REQUEST This command returns the duration of the specified ID to the 
controller. The format returns the frames in RETURN DATA 1, 
seconds in RETURN DATA 2, minutes in RETURN DATA 3 and 
hours in RETURN DATA 4, in BCD. SEND DATA 1-8 contains the 
ID name.

3x.06 - POSITION 
REQUEST

The POSITION REQUEST query returns the current position 
‘timecode’ or time remaining within the ID which is currently playing 
on the selected port.

3x.07 - ACTIVE ID 
REQUEST

This command returns information to the controller about whether a 
queried port is active (an active port is one that is either recording, 
playing, cued or cueing), and what the active ID is. This query does 
not affect the output of the system.

3x.08 - DEVICE TYPE 
REQUEST

The DEVICE TYPE REQUEST command is used to request the 
specifications of the Controlled Device. The response to this 
command is a 16-byte (maximum) data message advising of the 
specifications of the CONTROLLED DEVICE. The first N bytes will 
be the manufacturer ID followed by a colon ‘:’

Supported Optional VDCP Commands (Continued)

Command Description
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Expansion Port Connector Specifications

This section contains information on the pin assignments for the two 29-pin Expansion Port 
female connectors labeled EXPANSION PORT 1 and EXPANSION PORT 2 on the 
AirSpeed Multi Stream chassis rear panel. On the chassis, the GPIO connectors contain 18 
GPI pins and 10 GPO pins that can be defined any way you want. Each Expansion port is 
equipped with 4 LTC Out BNCs (1 per SDI channel) along with a General Purpose I/O Pins 
Connector (DB25). Expansion Port 1 contains LTC Out 1-4, and Expansion Port 2 contains 
LTC Out 5-6 (MPEG-2 HD models only).

Using the Avid supplied Expansion Port cable connected to Expansion Port 1, you can 
connect the 4 BNCs (for LTC Out 1-4). For MPEG-2 HD models, Expansion Port 2 is used 
to connect to LTC Out 5 and 6. In addition, there is a DB25 connector.

Ethernet Connector Specifications, Female

Pin # Wire Color Signal Function

1 White-Orange TD A+ Positive differential transmit

2 Orange TD A– Negative differential transmit

3 White-Green RD B+ Positive differential receive

4 Blue TD C+ Positive differential transmit

5 White-Blue TD C– Negative differential transmit

6 Green RD B– Negative differential receive

7 White-Brown RD D+ Positive differential receive

8 Brown RD D– Negative differential receive
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n The external connector and cable are Avid supplied. A shielded cable must be used on this 
connector to maintain RFI compliance. The shield of the cable should be connected to the 
connector’s shield or shell.

DB25 and BNC Connectors for LTC Out and SMPTE Alarm

The 4 BNC Connectors on the other end of the GPIO cable are used for connecting LTC Out 
(BNCs labelled A-D) . 

The BNC connector labelled A can be used with MPEG-2 HD models to provide the LTC 1 
Out when connected to Expansion Port 1, and LTC 5 Out when connected to Expansion 
Port 2. 

The BNC connector labelled B can be used with MPEG-2 HD models to provide the LTC 2 
Out when connected to Expansion Port 1, and LTC 6 Out when connected to Expansion 
Port 2. 

C4
17

C2
1

C3

9

24

16

8

C5

C1

GPIO Connector Pin Assignments, Male  

Pin # Signal Pin # Signal Pin # Signal

1 GP Input 8 11 Ground4 21 GP Input 0

2 GP Input 6 12 GP Input 3 22 GP Output 3

3 Ground1 13 Ground5 23 Diff_Pair_P

4 GP Input 4 14 Reserved 24 Diff_Pair_N

5 GP Input 1 15 Ground6 C1 LTC Channel 0

6 GP Output 4 16 GP Output 0 C2 LTC Channel 1

7 GP Output 2 17 GP Input 7 C3 LTC Channel 2

8 GP Output 1 18 GP Input 5 C4 LTC Channel 3

9 Ground2 19 Ground7 C5 Ground8

10 Ground3 20 GP Input 2
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The following diagram illustrates these connectors and their use.

DB25 Connector Specifications

The DB25 Connector on the other end of the Expansion Port cable has the following pinouts

A

B

C

D

E

LTC 1 Out when connected to 

Expansion Port 1

LTC 5 Out if connected to 

Expansion Port 2

LTC 3 Out

LTC 4 Out

Reserved for future use

DB25 Connector

LTC 2 Out when connected to 

Expansion Port 1

LTC 6 Out if connected to 

Expansion Port 2

13 1

25 14

DB25 Connector Pin Assignments, Female  

Pin # Signal Pin # Signal Pin # Signal

1 GP Input 0 10 Ground1 19 Ground5

2 GP Input 1 11 Ground2 20 Ground5

3 GP Input 2 12 Ground3 21 Ground6

4 GP Input 3 13 Ground4 22 Ground6

5 GP Input 4 14 GP Output 0 23 Ground7
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LTC Timecode Connector Specifications

The LTC In is an AC coupled differential input feeding a comparator which requires a 
minimum 100mV differential between the LTC+ and LTC-. Peak-Peak input levels can be 
anywhere between 300 mV and 5.3V. 

 LTC Loopthrough displays Playback, Channel 2.

The following table lists LTC specifications on the rear panel.

n Shielded cable must be used on each connection to maintain RFI compliance. Connect the 
shield of the cable to the shield of the connector.

6 GP Input 5 15 GP Output 1 24 Ground7

7 GP Input 6 16 GP Output 2 25 Ground7

8 GP Input 7 17 GP Output 3

9 GP Input 8 18 GP Output 4

DB25 Connector Pin Assignments, Female (Continued)  

Pin # Signal Pin # Signal Pin # Signal

LTC Timecode Input/Loopthrough Connector Specifications  

Pin # Signal Function

1 + Line Positive differential signal

2 – Line Negative differential signal
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USB 2 Connector Specifications

This is a standard USB 2 connector. We support standard USB 2.0 devices, such as flash 
drives, keyboards and mice.
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B Performing Hardware Diagnostics

The Avid AirSpeed Multi Stream Hardware Test is a diagnostic program that is designed to 
test the Avid-specific hardware components in the Avid AirSpeed Multi Stream. 
Specifically, the diagnostic program can be used to verify that the Avid hardware is working 
properly and it can confirm compatibility with external audio and video devices.

n Quit all applications before running the diagnostic program.

When you start the diagnostic program, it searches the system for the attached Avid 
hardware and the Avid AirSpeed Multi Stream product. Once the diagnostic program starts, 
it identifies the product and displays the information at the top of the diagnostic window.

Once the diagnostic window is open, the diagnostic program is ready to run. For information 
on starting the diagnostic program, see “Starting the Hardware Test” on page 371.

This chapter includes the following topics:

• Reviewing Hardware Information

• Starting the Hardware Test

• Playing a Video Frame

• Capturing from an External Video Source

• Testing Audio Outputs

• Capturing from the Play Frame Video (Loopback Mode)

• Error Log

• Diagnostic Test Failed
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Diagnostic Window Explained

The diagnostic window is divided into four sections:

• The Information section displays revision and identification information about the Avid 
hardware, including Base Board Information, and VIO Board information.

• The Hardware Test allows you to select the loopback cables that are connected to your 
system. When one of these cables is selected for testing, the required connection 
information is displayed in the Required Connections area. If the test fails, the log 
information and error reporting displays in a separate Information Window. Red text 
indicates a failed component, green text indicates a passed component.

• The Video section allows you to choose your video format, Play Frame, and Capture 
source to test the video output or input for Play and Capture.

• The Audio section allows you to select the Audio and Frequency to test the audio 
outputs.

Reviewing Hardware Information

The Information section of the Diagnostic window displays hardware information.

To check the hardware information:

1. Navigate to C:\Program Files > Avid > Avid AirSpeed Multi Stream> Utilities > 
Diagnostics, and select AirspeedMultiStreamTest.exe.
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The Avid AirSpeed Multi Stream Hardware Test dialog box opens. The version shown 
in the following screen example is [01.02]. You might have a later version, and 
therefore, your values might be different.

2. Click the Information icon.
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A text editor opens and displays the information as follows:

Philo Base Board Information

- Serial Number

- Part Number

- XPGA_T Revision

- FPGA_O Revision

VIO Board Information (for Slot 1 and Slot 2)

- Serial Number

- Part Number

- FPGA_B Revision

- FPGA_H Revision

- XPGA_P Revision

- Codec Slot 1

- Codec Slot 2

- Codec Slot 3

- Codec Slot 4

This information is saved in text format as a .log file. You can open the saved file with 
any text editing application and print it. See Error Log for more information about the 
.log file.
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Starting the Hardware Test

The core test verifies the baseboard and VIO board information. If you want, you can run 
additional tests by connecting loopback cables to their respective input signals.

To begin testing:

1. Click the Hardware Test icon.

The Hardware Tests section opens.
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2. (Optional) To run additional tests, connect all the required external cables.

3. (Optional) Select the cables you connected and the additional tests you want to run from 
the “Select loopback cables installed” list.

After you select the external cable installed, the required connections section displays 
information about where to connect the cable. Verify that you have connected the cable 
to the correct connections.

4. Click Start.

The test runs. Information about the test and a status bar appear.

After the test sequence is finished, a Passed or Failed display appears in red or green. 
Green indicates the test sequence has passed. Red indicates the test has failed.

Playing a Video Frame

Playing a video frame allows you to test the video signal and configures the hardware to play 
a video image from the 8 outputs. The video image appears in the Video display.

To play a video image:

1. Click the Video icon.
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The Video section opens.

2. Click Play, and deselect Capture if it is selected.

3. In the Format field, select the video format that you want to test. 

For SD models, select only NTSC and PAL. For MPEG-2 HD systems, all formats are 
supported.

4. Select the Play Frame. Options are:

t Color Bars

t Sweep Pattern

t Test Image

5. Click Start Video.

The video appears in the Video Display window, and appears in all other video outputs.
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6. To stop play at any time, click Stop Video.

Capturing from an External Video Source

You can test capture and display video from a selected source. The video image appears in 
the Video display.

To capture video:

1. Click the Video icon.

The Video section opens.

2. Click Capture, and deselect Play if it is selected.

3. In the Format field, select the video format that you want to test.

4. Select a capture source from the Capture Src list.
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5. Click Start Video.

The video appears in the Video Display window.

6. To stop play at any time, click Stop Video.

Testing Audio Outputs

Audio testing allows you to configure the hardware to play audio tones from all of the audio 
output ports.

To play audio:

1. Click the Audio icon.

The Audio section opens.
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2. Select the Audio tone:

t Count_16

t Lo_1kHz

t Hi_1kHz

3. Select the Frequency (48kHz).

4. Click Play Audio.

The audio tone plays. You will hear the spoken number of the audio channel.

5. To stop audio at any time, click Stop Audio.

The video appears in the Video Display window, and appears in all other video outputs.

Capturing from the Play Frame Video (Loopback 
Mode)

If you connect the video source input to the matching video play output with a loopback 
cable, you can capture the frame and display it in the Video Display window.

To capture video:

1. Click the Video icon.

2. Click Play and click Capture.

3. Connect the loopback cable.

4. Select a video format:

t HD_1080I_2997FPS

t HD_1080I_25FPS

t HD_720P_5994FPS

t HD_720P_50FPS

t SD_NTSC_486

t SD_PAL_576

5. Select a capture source from the Capture Src list.

6. Click Start Video.

The video appears in the Video Display window.

The frame that is captured from the selected source connected to the output appears in 
the Video display window.

7. To stop play at anytime, Click Stop Video.
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Error Log

If an error is detected during a test, information about the error is recorded to the log file. 
The board information along with the log file is saved in a .txt file inside the folder 
DIAG_LOG_FILES. The name of the log file is AED_LOG_YBBKxxxxxx.TXT (where 
YBBKxxxxxx is the board serial number). The log records the results each time the 
diagnostics are performed. To start a clean log file, rename, delete or move the current .txt 
file.

The log file displays the following:

• The name of the test

• If it passed or failed

• If it failed and why it failed

• The time and date that it failed

To view the error log:

t Browse to the .txt file and double-click the file icon. A text editor will open and display 
the information. Print this file from the application if you want a hard copy.

Diagnostic Test Failed

If a test fails, check the following and run the diagnostics again before contacting your Avid 
representative.

Do the following to resolve the problem:

1. Check that all other applications are closed.

2. Reseat all external cables. Make sure you have connected the appropriate cable for the 
test you are running.

3. Quit the diagnostic application and restart it.

4. Run the diagnostics again.

5. If you still are having problems, power cycle the CPU. 

This power cycles the Avid hardware.

6. Run the diagnostics again.

7. If the failure persists, save the log file and contact your Avid representative.

c Avid does not authorize customers to open the Avid hardware. The Avid hardware 
must be replaced in its entirety. 
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C Network Teaming

Overview

Avid Service Framework (ASF) does not yet handle multiple vlan failover well. Therefore, if 
an AirSpeed Multi Stream that Capture is controlling were to have a network related failure 
on the primary network connection, the AirSpeed Multi Stream Device Service 
communication would not automatically start communicating on the other NIC. A reboot of 
the AirSpeed Multi Stream would fix this problem. 

To help prevent this from happening in the first place, the site can setup fault-tolerance 
network teaming for both vlan connections. This results in four connected network adapters, 
two to each vlan.

n The AirSpeed Multi Stream has been tested with adapter fault tolerant teaming to a single 
Cisco 49xx class switch providing Zone 2 connection with ISIS. Avid does not support 
adapter fault tolerant teaming with direct ISIS Zone 1 connections.

Setting Up Network Teaming

This procedure shows you how to set up Network teaming on your AirSpeed Multi Stream.

To set up network teaming:

1.  Provide names for your network adapters as shown in the following screen example:

n It is not important which connections go to which vlans.

2.  Open the Properties of one of those network connections, and click the Configure 
button for the network adapter.
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3. Confirm the network driver is at least version 9.13.16.0. If it is not, upgrade to the latest 
version before continuing.

4. Open the “Teaming” tab and enable Team this adapter with other adapters check 
box.
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5. Create a network team by doing the following:

a. Name the team (for example: “vlan 10 team” or “vlan 20 team”).

b. Select the adapters to be included in the team.

n These are adapter port numbers, which do not correlate with the “Local Area Connection 
1” names.

n Because the first team was already setup, the screen example above only shows two 
adapters. When creating your first network team, all four adapters should display here. If 
they do not, make sure that none of the adapters are “disabled” from network connections.
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c.  In the Select a team type field, select the Adapter Fault Tolerance team type.

d. Click Next until you are done.

6. Repeat step 5 for the second vlan team. 

The finished network connections should look like this:
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n  You can tell from the screen example above that one of the vlan20 connections is not 
plugged in. However, notice that the vlan20 team still says “Connected”. If you navigate to 
the adapter properties of the vlan20 team and open the settings tab, you will see a 
confirmation of that status:
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D Up, Down, Cross Convert (UDX) 
Examples

Overview

This appendix contains information on input and output AFD, including examples of their 
corresponding video formats when performing an Up, Down and Cross conversion with 
AirSpeed Multi Stream.

The conversions described in this section only occur when one of the AutoAFD options is 
selected from one of the list boxes (SD-Cross-Convert, Up-Convert, or Down-Convert) in 
the UDX Options area of the Channel Configuration dialog box. 

For more information, see “Configuring Channels on AirSpeed Multi Stream” on page 111.

The following topics are covered:

• Up Convert AFD Examples

• Down Convert AFD Examples

• HD Cross Convert AFD

• SD Cross Convert AFD Examples
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Up Convert AFD Examples

The table below shows the input and output AFD and examples of their corresponding video 
formats when performing an Up convert.

Input Video Format SD Video Format Output AFD HD Video Format

• AFD = 8  (full 
frame image), or

• AFD = 9  (4:3 
image) Aspect Ratio 
= 4:3

AFD = 9  (4:3 image)

Aspect Ratio = 16:9

(pillarboxed)

• AFD = 8  (full 
frame image), or

• AFD = 10  (16:9 
image) Aspect Ratio 
= 16:9

AFD = 10  (16:9 
image)

Aspect Ratio = 16:9

AFD = 10 (16:9 image) 
Aspect Ratio = 4:3 
(letterboxed)

AFD = 10  (16:9 
image)

Aspect Ratio = 16:9
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Down Convert AFD Examples

The table below shows the input and output AFD and examples of their corresponding video 
formats when performing a Down convert.

HD Cross Convert AFD

We support HD cross convert. However, there are no user configurable options.

Input Video Format HD Video Format Output AFD
SD Video 
Format

• AFD = 8  (full frame 
image), or

• AFD = 10 (16:9 
image) Aspect Ratio 
= 16:9

AFD = 10 (16:9 
image)

Aspect Ratio = 4:3

(letterboxed)

• AFD = 8  (full frame 
image), or

• AFD = 10  (16:9 
image) Aspect Ratio 
= 16:9

AFD = 10  (16:9 
image)

Aspect Ratio = 16:9

• AFD = 9 (4:3 image) 
Aspect Ratio = 16:9 
(pillarboxed)

AFD = 9 (4:3 image)

Aspect Ratio = 4:3

• AFD = 15 (16:9 
image with shoot 
and protect center) 
Aspect Ratio = 16:9

AFD = 9 (4:3 image)

Aspect Ratio = 4:3
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SD Cross Convert AFD Examples

The table below shows the input and output AFD and examples of their corresponding video 
formats when performing an SD cross convert.

There are two methods for SD cross conversion:

• 4:3 SD In to 16:9 SD Out

• 16:9 SD In to 4:3 SD Out

SD Cross Convert for 4:3 SD In to 16:9 SD Out  

SD Cross Convert for 16:9 SD In to 4:3 SD Out  

Input Video Format  4:3 SD In Video Format Output AFD
16:9 SD Out 
Video Format

• AFD = 8  (full frame 
image), or

• AFD = 9 (4:3 
image) Aspect Ratio 
= 4:3

AFD = 9 (4:3 image)

Aspect Ratio = 16:9

(pillarboxed)

AFD = 10 (16:9 image)

 Aspect Ratio = 4:3 
(letterboxed)

AFD = 10  (16:9 
image)

Aspect Ratio = 16:9

Input Video Format  16:9 SD In Video Format Output AFD
4:3 SD Out 
Video Format

• AFD = 8  (full frame 
image), or

• AFD = 10 (16:9 
image) 

Aspect Ratio = 16:9

AFD = 10  (16:9 
image)

Aspect Ratio = 4:3

AFD = 9 (4:3 image)

 Aspect Ratio = 16:9 
(pillarboxed)

AFD = 9 (4:3 image)

Aspect Ratio = 4:3



E Regulatory and Safety Notices

Warnings and Cautions

c Never install equipment if it appears damaged.

c Disconnect the power cord before servicing unit.

c Only perform the services explicitly described in this document. For services or 
procedures not outlined in this document, speak with authorized Avid service 
personnel.

c Follow all warnings and cautions in the procedures.

c Operate the device within its marked electrical ratings and product usage instructions.

FCC Notice
Part 15 of the Federal Communication Commission Rules and Regulations has established 
Radio Frequency (RF) emission limits to provide an interference free radio frequency 
spectrum.  Many electronic devices produce RF energy incidental to their intended purpose. 
These rules place electronic equipment into two classes, A and B, depending on the intended 
use.

Class A devices are those that may be expected to be installed in a business or commercial 
environment.  Class B devices are those that may be expected to be installed in a home or 
residential environment.  The FCC requires devices in both classes to be labeled with the 
interference likelihood and additional operating instructions. The rating label on the 
equipment will show which class the product is (A or B). Class A product will not have an 
FCC logo. Class B equipment will have an FCC logo. The information statements differ on 
the two classes.
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Class A Equipment

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference, in which case the user will be required to correct the interference at 
personal expense.

Modifications

The FCC requires the user to be notified that any changes or modifications made to Avid 
hardware that are not expressly approved by Avid Technology may void the user’s authority 
to operate the equipment.

Cables

Connections to Avid hardware must be made with shielded cables with metallic RFI/EMI 
connector hoods in order to maintain compliance with FCC Rules and Regulations.

LED Safety Notices

Avid hardware might contain LED or Laser devices for communication use. These devices 
are compliant with the requirements for Class 1 LED and Laser Products and are safe in the 
intended use. In normal operation the output of these laser devices does not exceed the 
exposure limit of the eye and cannot cause harm.

Standard to which conformity is declared: (IEC 60825-1:1993+A1:1997+A2:2001)

LED Specifications

• Wave Length: 650 nm

• Output Power: Less than 9.22 uW
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Rear Panel Location of Optical Connections

Optical connections are located on the rear panel and are typically labelled “Optical” or 
“SPDIF/ADAT.” The exact location of optical connections is identified more clearly 
elsewhere in the documentation for the Avid hardware device.

c Use of controls and/or adjustments or the performance of procedures other than those 
specified herein and elsewhere in documentation for the Avid hardware might result in 
hazardous radiation exposure.

Canadian ICES-003
This Class A digital apparatus meets all requirements of the Canadian Interference Causing 
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le 
matériel brouilleur du Canada.

European Union Declaration of Conformity

Declaration of conformity
Konformitätserklärung
Déclaration de conformité
Declaración de Confomidad
Verklaring de overeenstemming
Dichiarazione di conformità

We/Wir/Nous/WIJ/Noi:

Avid Technology
1925 Andover Street
Tewksbury, MA, 01876 USA

OUTIN
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European Contact: Nearest Avid Sales and Service Office or
Avid Technology International B.V.
Sandyford Business Center
Unit 38 Carmenhall Rd
Dublin 18, Ireland

declare under our sole responsibility that the product,
erklären, in alleniniger Verantwortung,daß dieses Produkt,
déclarons sous notre seule responsabilité que le produit,
declaramos, bajo nuestra sola responsabilidad, que el producto,
verklaren onder onze verantwoordelijkheid, dat het product,
dichiariamo sotto nostra unica responsabilità, che il prodotto,

Product Name(s):AirSpeed Multi Stream

Model Number(s):7020-20279-XX, 7020-20280-XX, 7020-30015-XX, 702030069-XX

Product Option(s): This declaration covers all options for the above product(s).

to which this declaration relates is in conformity with the following standard(s) or other 
normative documents.
auf das sich diese Erklärung bezieht, mit der/den folgenden Norm(en) oder Richtlinie(n) 
übereinstimmt.
auquel se réfère cette déclaration est conforme à la (aux) norme(s) ou au(x) document(s) 
normatif(s).
al que se refiere esta declaración es conforme a la(s) norma(s) u otro(s) documento(s) 
normativo(s).
waarnaar deze verklaring verwijst, aan de volende norm(en) of richtlijn(en) beantwoordt.
a cui si  riferisce questa dichiarazione è conforme alla/e seguente/i norma/o documento/i 
normativo/i.

The requirements of the European Council:

Safety: Directive 2006/95/EEC

UL 60950-1, 1st edition
CAN/CSA-C22.2 No. 60950-1, 1st edition
IEC 60950-1, 1st edition
EN 60950-1: 2001

EMC: Directive 2004/108/EC
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EN55022:2006/A1:2007
EN55024:1998 /A1:2001 /A2:2003
EN61000-3-2:2006
EN60000-3-3:1995 /A1:2001 /A2:2005

December 15, 2009

Issued in Tewksbury, MA USA 2009

Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not be disposed 
of with other waste. Instead, it is your responsibility to dispose of your waste equipment by 
handing it over to a designated collection point for the recycling of waste electrical and 
electronic equipment. The separate collection and recycling of your waste equipment at the 
time of disposal will help conserve natural resources and ensure that it is recycled in a 
manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city recycling 
office or the dealer from whom you purchased the product.

Australia and New Zealand EMC Regulations

Nigel Streatfield General Manager
Avid Technology (Australia
Unit B
5 Skyline Place
French Forest NSW 2086
Australia
Phone: 61-2-8977-4800
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Taiwan EMC Regulations
Taiwan EMC Regulations BSMI Class A EMC Warning
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Index

Symbols
.PFF 214

Numerics
1000BASE-T 354
525 lines (NTSC) 29
625 lines (PAL) 29

A
Add to End of Workspace option 126
Air Toolbar 225
AirSpeed Studio Transfer Monitor dialog box 272
Alarm

connector 50
AMS API 120
AMS AutoLogon dialog box 127
Analog reference inputs 49
Applications

requirements 26
Audio

digital input and output 29
specifications 350
supported formats 30

Audio Channels 247
Audio tab, Item Properties dialog box 263
Audio tab, Template dialog box 263
Australia EMC regulations 393
Automatic

deletes 32
Avid

online support 21
training services 21

Avid iNEWS® Command 26
Avid NewsCutter editing products 26
Avid Unity

server 26
use of AirSpeed Multi Stream 23

Avid Unity MediaManager
network server 26

B
Bi-lingual recording and playback 247
Browse Window 215
Buttons

front panel controls 44
BVW

extensions 357, 358

C
Canadian

interference causing equipment regulations 391
Catalogs

creating 31
CBR 262
Channel

specifications 350
Channels, system 222
Clear transfer window 274
Clip numbers 221
Clip Recording Methods 239
Clip tab, Still Properties dialog box 259
Clip tab, Template dialog box 259
Clips, editing 243
Clips, playing 249
Clips, renumbering 226
Closed Caption 36, 353
Command

Avid iNEWS® 26
Compliant media files 24
Compression rate 261
Configuration

AirSpeed 95, 133, 155, 179
connections 27
system 95, 133, 155, 179

Connections
Ethernet, control and configuration 27
rear 47

Connectors
alarm 50
control 50
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keyboard 51, 59
LTC 53, 55, 57, 59
LTC time code 364
media input 52, 54, 54, 56, 58
mouse 51, 59, 365
pinouts 355
PS/2 50
SDI 52, 54, 54, 56, 58
sync 53, 55, 57, 59
timecode 49, 53, 55, 57, 59
USB 50, 51, 59
USB 2.0 354
VGA 51
video 52, 54, 56, 58
video reference 53, 55, 57, 59

Control
specifications 352
VDCP 28

Control and configuration connection (GigE) 50
Controls

command set 28
connection, described 27
serial 28

Copying image files and stills 241
Crash record

explained 28
Create

new projects, bins, and catalogs 31
Create New Database 270, 271
Create New Database dialog box 100
Creating New Database 100
Cue Record 227

D
Data

connector 50
specifications 354

Data rate 261
Database locked while files are saved 126
Database Options 125
Database Options dialog box 125
Database, automatic updates to 126
Database, create new 100
Database, multiple users have access to 126
Deck control

described 28

Default Database 103
Deleting automatically 32
Design of AirSpeed Multi Stream 24
Destination, storage 32
Dialog box, transfer monitor 272
Digital

input and output 29
recorder 23

Dimensions 349
DNS (Domain Name System)

IP address 134
requirement 26

Dockable Items 224
Dual channel playback

applications 33
DVCPRO format 30

E
Edit Template 257
Embedded software 29
Environment

requirements 350
specifications 350
workgroup 133

Error
transfer 274

Ethernet
connections 27
control interface 51
pinouts 360
port specifications 354

European Union notice 391
External control devices 120

F
FCC notice 389
Filter 227
Format

MXF Media format 31
Frame Chase™ Editing 155, 179

G
General tab, Still Properties dialog box 258
General tab, Template dialog box 258
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GigE (gigabit Ethernet)
connector 51

Good databases 259
GOP 262
GPIO (general purpose input/output)

alarm connector 50
connector 51

H
Hardware requirements 26
Headframe, defined 218
Headframe, with red film 218
Host Name 98, 133, 157, 181
Host name

Studio 268

I
Import Image 270, 271
IMX 30
IMX 30 support 30
IMX 50 support 30
In/Out/Duration 247
iNEWS ® Command 155, 179
Inputs

analog reference input description 49
video input description 49

Installation
software 26

Interface
connections 47
described 50

Internal timecode 27
InterPlay

Engine 134
user name and password 134

Inventory Window 285
Item Properties

Record Setup 261
Item Properties dialog box 236, 243, 256

K
Keyboard

connection 59
connector 365

L
Language

non-English, typing in 128
License

agreement 97
List of AirSpeeds for playout 268
LTC (longitudinal timecode)

connector 53, 55, 57, 59
number of IN and OUT 49
pinouts 364, 364
pinouts and specification 364
timecode 354

M
Main Toolbar 224
Master clip 260
Media input connector 52, 54, 54, 56, 58
MediaFiles directory 31
MediaManager

network server 26
Metadata files 31
MiniMonitor section, MiniMonitor window 222
MiniMonitor window, explained 222
Monitor

connector 51
Studio Transfer 272

Mouse
connection 59
connector 51, 365

MPEG
(IMX 30) format 30
(IMX 50) format 30

MPEG 30 (IMX) format 30
MultiMatch 265
MXF (Material Exchange Format)

described 31

N
Network

connection (GigE) 51
connectors 50
pinouts 360
requirements 26
server 26
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specifications 354
Network Tree 214
New projects, creating 31
New Zealand EMC regulations 393
NewsCutter products editing products 26
Non-English keyboard layout 128
NTSC

525 lines 29
support 30

Numeric Keypad 230, 231
Numeric keypad 230, 231

O
OMF (Open Media Format)

used by editing systems 24
Online support 21
Overview, of AirSpeed 23

P
PAL

625 lines 29
support 30

Pause transfer 274
Physical specifications 349
Pinouts 355

Ethernet 360
keyboard and mouse 365
LTC 364
LTC timecode connector 364
mouse connector 365
remote 356

Play while transfer 34
Playback

channels 33
Playback list 271
Playback Mode 227
Playout

available server 270
process 33
server 33
server list 268
TMClient.ini tab 33

Power 350
requirements 350

Power cycling

described 29
Preview dialog box 246
Protocol

VDCP 28
Protocol choices 120
Protocol Setup 120
Proxy 246

Q
Quick Cue Record 227, 227, 227
Quick Record 227
Quick Save 256

R
Rack

units 44
Rack-mount

units 349
Rear

interface connections 47
panel specifications 354

Rebuild Database 270, 271
Reconnect To Server

Studio 270
window 270

Record 227
Record Mode 227
Record rate 261
Record Setup 261
Red clip icon 250
Reference

connector 53, 55, 57, 59
signal 27
specifications 353

Reference inputs 49
Refresh playout list 271
Regional keyboard support 128
Regulatory information 389
Remote

pinouts 356
Renumbering Clips 226
Requirements

environmental 350
hardware and software 26

Right Mouse Menu 226, 294



Index

399

RS-422
connection 28

S
Safety information 389
Sampling

specifications 350
Scrubber 247
SDI (serial digital interface)

connector 52, 54, 54, 56, 58
inputs 49

Search section, Workspace/Search dialog box 264
Search syntax 266
Selecting Stills 228, 295, 299, 301, 308, 309
Send To Playback

menu 270
window 271

Serial
connectors 50
control 28
pinouts 356

Settings scroll list 269
Setup

storage destination 32
system 95, 133, 155, 179

Site settings 98, 133, 157, 181
Slave deck control 28
Software 26

requirements 26
Sony

BVW control 28
BVW extensions 357, 358

Specifications
audio 350
breakout panel 354
channels 350
connector pinouts 355
control and synchronization 352
data 354
dimensions 349
environmental 350
Ethernet 354
LTC 354
physical 349
power 350
rack units 349

rear panel 354
reference 353
sampling 350
timecode 353
USB 2.0 354
video 351, 351
video compression 352
weight 349

Status
information 47

Storage configuration 27
Storage destination 32
Streams, video 33
Studio

cancel transfer 274
clear window 272, 274
creating 268
description 268
error during transfer 274
monitor 272
naming AirSpeed 268
number of members 34
pause transfer 274
playback server list 271
refresh playback server list 271
Transfer Monitor 272
using 270

Sub-Clip 247, 260
Support

audio 30
Synchronization

connector 53, 55, 57, 59
described 27
specifications 352

System
configuration 95, 133, 155, 179
monitoring 47
requirements 26
setup 95, 95, 133, 133, 155, 155, 179, 179

System channel 222

T
Taiwan EMC regulations 394
Take 226
Template

Record Setup 261
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Template dialog box 257
Template, edit 257
Thumbwheel 247
Timecode

connectors 49, 50
input connector 53, 55, 57, 59
internal 27
LTC connector 364
specifications 353

TMClient.ini tab
members listed in Studio 268
playout 33
window 268

TOD (time-of-day) timecode 27
Toolbars, disappearing 224
Training services 21
Transfer

Reconnect To Server 270
Send To Playback 270
sequences for Avid editing system 254, 255
server list 268
settings in an Avid editing system 269
Status window 273

TransferManager
activity 273

Transport pane 281
Tree View 214
Troubleshooting 21

U
UI (user interface)

overview 28
USB connector 50

V
VBR 262
VDCP (video disk control protocol)

described 28
Video

channel specifications 351
compression specifications 352
connectors 52, 54, 56, 58
format, MPEG 30, 30
reference 27
specifications 351, 351

streams 33

W
Warning, hard disk nearly full 126
WAVE format 30
Weight 349
Window, transfer status 273
Windows, disappearing 224
Workgroup

environment 133
Workspace

OMF Version 1.0 compliant 30
Workspace, place new clips at end of 126
Workspace/Search dialog box 264, 266
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Burlington, MA 01803-2756 USA

Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support

Product Information
For company and product information, 
visit us on the web at www.avid.com
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